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Preface

Welcome to the FACTS System software that automates your business operations! The FACTS System is
composed of 22 highly integrated modules. Each module has a manual dedicated its use and functionality.
For ease of use, the manuals are formatted similarly. All of the FACTS manuals contain the following
sections: system overview, program descriptions, references, glossary of terms, and sample reports.

System Overview

This section discusses the function and process flow for each module. Each System Overview section
contains:

*  Anoverview of each module and its interaction with other modules

*  Flow charts of the module’s system

« Anoverview of the modules posting to the General Ledger. This section should be reviewed even
if the General Ledger Module is not being used

»  Procedures and close-out checklists for daily, weekly, periodic (monthly) and yearly processing

Program Descriptions

These chapters detail each program in the module. Each program description includes the functions, user
inputs, and a screen print. The programs are listed in the order that they appear on the menu. There is an
overview preceding each menu that explains the interaction of the programs within the menu.

References

Throughout the documentation the phrase (ref. #) is used. This is referring to the appendix called
“References.”

References are used to prevent the same information from being repeated one program to the next. They are
located at inputs where a user might want further information. References are always numbered. For
example, F2 allows a search (ref.5): this indicates that pressing F2 will allow a search on the input, and more
information on searches can be found in the Reference Appendix under reference #5.

Glossary of Terms

The glossary provides a definition of terms used in the manual and related terms from other modules.

Sample Reports

This section provides a sample printout of most of the reports and prints in the module. A directory is
included that lists each report and the page number in the section.

Copyright © 1984-2004 Aperum, Inc.
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FACTS

System Overview

The FACTS Purchase Order module delivers accurate vendor performance data,
enabling managers to make timely and informed decisions. The system tracks
and controls purchase order transactions through receipts and invoices.

To keep purchases in balance, the system applies calculations from the
Inventory Management system, reviewing scheduled buying frequency,
replenishment frequency, inventory investments and service levels.

You can set the system to automatically post Purchase Order transactions to the
General Ledger module. Transactions can be posted to the current or next GL
period.

The system also supports multiple warehouses and branches and allows you to
set buying targets so that you can take advantage of discounts.

Purchase Orders is comprised of the following menus:

e Entry

e Receiving

* Invoice Receiving
e Inquiries

* Reports & Prints

* End of Period

*  File Maintenances

PO File Maintenace programs

The file maintenance programs enable you to enter, change and delete data in
the Purchase Orders system. Use these programs to enter the initial data
required to set up the system, such as vendor records in Vendor F/M and
vendor/item records in Vendor/Item F/M. You may find that you add, change
and delete data regularly in some file maintenance programs.

Other file maintenance programs, such as PO Static Control F/M, will only be
used during initial installation and setup. We refer to these programs as
Infrequent File Maintenances and place them on their own Infrequent File
Maintenances menu.

Copyright © 1984-2004 Aperum, Inc. 1-1
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Setting up Purchase Orders

Before you start live processing in FACTS, certain records need to be in place so
you can get the maximum benefits from the module. For instance, vendor/item
records, though not required, allow you to track vendor information so that you
can make more accurate buying decisions.

Vendor/ltem Records

FACTS allows you to store individual vendor and individual item information
in Vendor F/M and Item F/M, respectively. However, the system only stores
history on the combination of the two when you create vendor-item records.
They are not a requirement for Purchase Order processing, but they do help you
track lead time, past costs and other information that may affect your buying
decisions.

If you want to keep and maintain these records, set them up prior to live
Purchase Order processing using Vendor/Item F/M (Purchase Orders 2File
Maintenances 2Vendor/Item F/M).

If you have a large number of vendor-item records to create, use Create Vendor-
Item Records (Purchase Orders 2File Maintenances >Create Vendor-Item Records) to
create them automatically. This program reads through the item file in
Inventory Control and sets up a record for each item and the primary vendor
assigned to the item in the Inventory Control’s Item F/M. If you use this setup
method, you can return to Vendor/Item F/M to manually create records for
alternative vendors.

Print vendor/item records as needed using the Vendor/Item Listing and
Vendor/Item History Report. Both programs are located on the Purchase
Orders 2Reports menu.

Ship from addresses

An unlimited number of alternate ship -from addresses can be created for each
vendor. Normally, the PO Entry programs use the address found in the
vendor’s master record in Vendor F/M. However, vendors may ship items from
different locations, just as distributors may ship items from different
warehouses.

The Ship-From F/M (Purchase Orders 2File Maintenances 2Ship-from F/M) lets
you create additional ship-from addresses, which buyers can later import into
their PO documents. The system does not require you to use alternate ship-from
addresses, but they may be useful in the long term.

Normal workflow in Purchase Orders

The Purchase Orders menu is set up in the order that you would normally use
the programs during regular daily processing. The following program
descriptions are overviews intended to help you understand how each of the
purchase order programs fit into the normal workflow process. Refer to the
subsequent chapters in this manual for more details on specific programs.

Purchase Orders—7.40
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Entry Menu

Suggested purchase orders. Think of Suggested POs as shopping lists that you

maintain for each vendor. The Suggested PO Entry program enables all ;‘;gr”r;‘;rt‘?on on

authorized PO users to enter suggested items and quantities that need to be Suggested PO

purchased to either restock inventory or fulfill special orders. Entry, PO Entry
and other Entry

Users can enter suggested POs manually, using Suggested PO Entry, or the Menu programs,

system can automatically create them when: fgﬁtgr},apter 2,

e Users designate items as drop ships in Sales Order Management Suite
programs (Order Entry, Confirmation, etc.).

e Users run the IC Replenishment Report. This report calculates how much
inventory needs to be ordered.

Use the Suggested Order Report to lists suggested orders by type (restocking or
special order), warehouse and vendor.

You can export restocking and special-order items on suggested POs to live
Purchase Orders in PO Entry.

PO Entry not only allows you to import items from suggested POs, but also lets
you manually enter items to create purchase orders by vendor. Imported items
can be edited or deleted once they are on a live PO.

You can print individual purchase orders as you create them in PO Entry, or
you can use PO Print to print them. PO Print lets you output single purchase
orders or a batch of them.

Regardless of which method you use, you must print POs before you can
confirm that you received the items in PO Receipt Entry.

Receiving Menu

When merchandise arrives from the vendor, use the Receiving Document Print For more
to output the POs so you can verify what you merchandise you received and information about

what is still outstanding. E':Sgﬁ,ﬁﬂz ?Tr,‘et:l?
. . . . . see Chapter 3,
Use the Receipt Entry program to enter received items into FACTS. The Receipt “Receiving.”

Entry program is the PO equivalent to the SO Order Confirmation program. It

allows you to confirm that what you ordered from the vendor arrived at your
shipping dock and determine if any merchandise has not yet arrived.

Use the Non-PO Receipt Entry program in situations where you receive
shipments for which a purchase order does not exist — for instance, orders that
were phoned in. This program effectively allows you to create the PO and
receive it at the same time.

After you finish receiving items in either receipt program, run the PO Fill
Report. This provides a list of all restocking and special order items and
indicates which items should be held to fill open sales orders.

At the end of the receiving process, run the Receipt Register to update the on-
hand inventory quantities with the items you received in shipment. Quantities
are not updated until the Receipt Register is printed and updated. The Receipt
Register provides a complete audit trail of all receipts and posts to General
Ledger if the PO module is configured to do so in PO to GL Posting F/M (see
Page 12). If any items have not be received, they remain on the original

Copyright © 1984-2004 Aperum, Inc. 1-3
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purchase order until they are received and updated via the Receipt Register. A
purchase order is not considered closed until you receive all items and
guantities that appear on it.

Invoice Receiving

Invoices received to bill for the purchase orders received are entered through
the Invoice Receipt Entry program. This program is used instead of the
Accounts Payable Document Entry program. It is used specifically for invoices
associated with received purchase orders. The user enters the AP information
(invoice number, terms, invoice amount, etc.) Users may enter all the purchase
order, receipt, line-item information manually or may simply enter the PO
number and the system automatically displays all the line-item information. If
there are no changes to be made (any discrepancies) the user ends the program.
The amount of the invoice must equal the total costs of the line-items plus tax
and freight. Any discrepancies must be adjusted. The Invoice Receipt Register
is then updated to provide an audit trail of all invoices to be posted to the AP
system. The Uninvoiced Receipts Report lists all purchase orders received for
which a bill (invoice) has not been received. Discrepancies between the
purchase order received and the invoice for the purchase order are written to a
discrepancies file. The Period Receipts Discrepancy Report is used to print a list
of all the discrepancies in the file for the period.

Past purchase orders may be stored for a user-determined period of time. They
may be displayed in detail through an Inquiry program. Past purchase orders
are removed by date through the Past Purchase Order Removal program.

Cost Contracts

Many vendors offer special prices (the distributor’s cost) for items or groups of
items. You can use Cost Contracts to more accurately track special prices to
reduce errors and ensure that all available price breaks are taken.

Access Cost Contract Entry (POE510) to enter contracts. When you add lines to
purchase orders, the default cost is calculated. If you override that cost during
the entry process, the cost override flag is set and the origin of any cost entered
is captured and stored in the purchase order line item file. That cost and origin
is also transferred to the past purchase order line file. You can view the cost
origin in the line detail of the PO Document Inquiry or during line detail in the
PO entry programs. Use the Contract Listing program to print the detail of
contracts that are on file. As contracts expire, they can be purged using the Cost
Contract Removal (POU510) program. Inquiries are available for viewing
contracts on file for a vendor.

Inquiries

A wide variety of information is available through the Purchase Order Inquiry
programs. Following are the inquiries available to make purchase order
management an organized and efficient process.

The Vendor Inquiry program allows the user to view purchase order
information by the vendor chosen. Information includes open purchase orders,
past purchase orders, suggested purchase orders, receipts, vendor notes, items,
vendor-item numbers and ship-froms.

Purchase Orders—7.40
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The Document Inquiry program allows the user to view purchase order
documents in detail by the type and status selected. The type options are: open
purchase orders, backorders and noninvoice receipts. The various status codes
include: purchase orders entered, but not printed, purchase orders printed,
received purchase orders, deleted purchase orders and voided printed purchase
orders. Inquiry information includes an overview of the document’s current
status, the actual document as it appeared at time of entry (with updated
amounts and units) and as purchase orders are line-item receivable, each receipt
per line may also be displayed.

The Items-in-Process Inquiry program allows the user to inquire about the
status of a purchase order item. This inquiry displays in item order all the
purchase orders that contain the selected item.

The Item Inquiry program allows the user to display specific information for
items in the inventory control item file. Items may be displayed individually or
sequentially. The user has the option to display general information, packaging
information, warehouse information, open purchase order information, costing
information, pricing information, sales history information and item activity
information. This inquiry is also found on the inventory control inquiries menu.

Reports & Prints

The PO Status Report prints open purchase orders, backorders, received
purchase orders or all purchase orders in document, vendor or item number
order. The Receiving Schedule lists open purchase orders by promised
delivery date. The Cash Requirements Report lists future payments due to
vendors based on open purchase orders.

End of Period

At the end of each period, there are reports to be printed which provide the user
with a list of all receipts for the period, a list of all invoice receipts for the period
and a list of all discrepancies between receipts and invoice receipts. Finally the
End-of-Period Update is run to close the period.

Copyright © 1984-2004 Aperum, Inc. 1-5
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Purchase Orders Flow Charts

The following pages present flow charts that illustrate the flow of information
from Purchase Orders to the other modules in the FACTS System. They also
illustrate the flow of information within Purchase Orders.

Note that not all files and programs are shown. The flow charts simply present
how information flows through the system.

The following symbols represent the types of information shown on the flow
charts.

Register or report with
Program .
optional update
Report
File

\/\

FACTS Module

Copyright © 1984-2004 Aperum, Inc. 1-7
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Purchase Orders Interaction
with Other FACTS Modules

i o cL
: Rona Accounts CodelLight
& Repair Payable
SO PO IC
Sales Orders Purchase »  Inventory
Orders Control

EDI
. JC
Electronic Data
Job Cost
Interchange
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PO Entry and Receiving

Sales Orders Replenishment

Report
Suggested Print
Sugglzer?:red PO PO File Suggested
y (POSUGG) Cost/Price PO Fill Report
PO Receipt
Entry
Job Cost
PO File Ref/Sort
PO Entry (PORDER) (JCREFX)
Non-PO
Receipt Entry
PO Lot

Receipts
File
(POLOTS)

PO Receipts
Register

A 4

JC Posting GL Journal

IC Serial/Lot SO Order
File File
(JCPOST) (GLJRNL)

File File
(ICLOTS) (SORDER)

JC Past
Ilizeynvr::si'lzl Reference/ PO File Purchase IC Cost File
(ICWHSE) Sort File (PORDER) Order File (ICCOST)
(JCREFX) (POPAST)
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PO Invoice Receipts

PO Uninvoiced

Receipts Receipts Ven(lj:(i)lreltem
File Report
(PORECT) y (POVNIT)
Invoice
Invoice Receipts Inv Rcpts AP Docm”t
. . . Entry File
Receipt Entry File Register (APDOCM)
(POINVC)

AP Docmnt
by Vndr Sort
File
(APDOCX)

¥/\

Period Invoice
Rcpts Report

¥/\

Period
Invoice File
(POPDIN)

\/\

Period Rcpts
Discrep Report

¥/\
\/\

Period Rcpts
Report

\/\

Period Rcpt
Discrep File
(POPDRD)

Period
Receipts
File
(POPDRC)
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System Overview

Receiving

Schedule
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Report
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Items-In-
Process

Inquiry

Document
Inquiry
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Requirements
Report
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Posting to General Ledger

Transactions from Purchase Orders may automatically post to General Ledger.
The PO to GL Posting Control F/M program contains flags which determine
how to post to GL for PO receipt transactions.

Through the GL Distribution flag the user determines the detail of the journal
entries posted. The flag may be set to one of the following: 0-indicating no GL
distribution is printed or posted; 1-indicating the GL distribution is printed
(printing is in detail format) but not posted to GL; 2-indicating the GL
distribution is printed (printing is in detail format) and posted to GL in
summary (posting includes the total amount posted to each account number); or
3-indicating the GL distribution is printed (printing is in detail format) and
posted to GL in detail (posting includes each item contributing to the amount
for each account number).

Through the Posting Journal, the user determines which GL journal (where in
the general ledger journal file) to post transactions.

There are standard entries made to general ledger when posting receipts. For
example, when an item is received, one debits the inventory account and credits
the receipts account. When the invoice is received for the purchase order, one
debits the receipts account (i.e., a wash account), the tax and freight accounts
and credits the accounts payable account. The user must set up where these
standard GL account numbers will come from, what they are and how they are
to be used.

The standard procedure for reconciling Purchase Orders with GL (and the
accounts affected) is as follows:

Activity Debit Credit
1. Purchase Order issued None None

2. PO Receipt Entry (Items received) Inventory Receipts
3. PO Invoice Receipt Entry None None

(Vendor’s Invoice received)
PO Invoice Receipt Register Update

Register Update (liability) (liability)
5. SO Invoice Entry Cost of Goods Inventory
(Items sold & shipped) (expense) (asset)

SO Daily Sales Register Update

NOTE: When the Receipt Register is updated in the Purchase Order module, it
may post a journal entry to general ledger to debit the inventory account and
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credit the Receipts account. The invoice receipt GL posting does not take place until
the AP Document Entry Register is updated (which is where invoice receipts GL
information is carried over to). At the time the AP Document Entry Register is
updated, the receipts account is debited (i.e., it is a wash account) along with
the tax and freight accounts (if applicable) and the accounts payable account is
credited.

There are department and branch flags which must be set that have to do with
imbedding the department and branch flags within the GL account number (if
applicable). When entering the department and branch may be entered. If the
user imbeds the department and/or branch within the GL account number, the
system looks at the department and/or branch assigned to each. For example, if
the G/L number to post is 415-00-00 (department is fourth and fifth digits,
branch is sixth and seventh digits), the department is 01 and the branch is 02,
then the system posts to 415-01-02. The system inserts the department and/or
branch in the proper place within the GL account number.

Finally, a default GL account number is set up. Even if the default is not to be
used, it must be entered.

For each account type, the user has a choice of basis, i.e., to use the default
and/or use the account number from the item GL posting table.

Following are item GL posting tables. These may be used to set up the basis for
some of the account types.

For our example, there are two types of items on the system: dock equipment
and warehouse equipment. If dock equipment items and warehouse
equipment items are to be posted separately to general ledger, we will set up
two GL posting tables; one to assign to dock equipment items and one to assign
to warehouse equipment items.

*. GL TABLE DOC
2. DESCRIPTION DOCK EQUIPMENT
G/L # DESCRIPTION

3. INVENTORY 170-00-00 INVENTORY - DOCK

4. SALES 410-00-00 SALES - DOCK

5. COST OF GOODS 520-00-00 COST OF GOODS - DOCK
6. RECEIPTS 390-00-00 RECEIPTS - DOCK

7. ADJUSTMENTS 530-00-00 ADJUSTMENTS - DOCK
8. IN TRANSIT 180-00-00 IN TRANSIT - DOCK

9. PHYSICAL DISCREP 530-00-00 ADJUSTMENTS - DOCK
10. MC FINISHED GOODS 200-00-00 FINISHED - DOCK
11. COMPONENTS 210-00-00 COMPONENTS - DOCK
12. MISC. SALES 420-00-00 MISC SALES - DOCK
13. NONSTOCK INVENTORY 190-00-00 NON-INV - DOCK
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*. GL TABLE WHS
2. DESCRIPTION WAREHOUSE EQUIPMENT
G/L # DESCRIPTION
3.INVENTORY 175-00-00 INVENTORY - WHS
4. SALES 415-00-00 SALES - WHS
5. COST OF GOODS 525-00-00 COST OF GOODS - WHS
6. RECEIPTS 395-00-00 RECEIPTS - WHS
7. ADJUSTMENTS 535-00-00 ADJUSTMENTS - WHS
8. IN TRANSIT 185-00-00 IN TRANSIT - WHS
9. PHYSICAL DISCREP. 535-00-00 ADJUSTMENTS -
WHS
10. MC FINISHED GOODS 205-00-00 FINISHED - WHS
11. COMPONENTS 215-00-00 COMPONENTS - WHS
12. MISC. SALES 425-00-00 MISC SALES - WHS
13. NON STOCK INVENTORY  195-00-00 NON INV - WHS

Following is information about setting up each basis entry: (Please refer to the
GL posting tables above.)

Inventory

Basis - determines where the inventory G/L number comes from. The user has
a choice of always posting to the default inventory G/L number (from this
record) or posting to the inventory G/L number assigned in the item’s GL
posting table. The system may always post to one inventory G/L number or
break out inventory to multiple inventory account numbers (example:
Inventory - Dock Equipment, Inventory - Warehouse Equipment).

Receipts

Basis - determines where the receipts G/L number comes from. The user has a
choice of always posting to the default receipts G/L number (from this record)
or posting to the receipts G/L number assigned in the item’s GL posting table.
The system may always post to one receipts G/L number or break out receipts
to multiple receipts account numbers (example: Receipts - Dock Equipment,
Receipts - Warehouse Equipment).

Tax, Freight

Basis-determines where each account number comes from. The numbers used
always come from the default G/L number (from this record).

Temporary Inventory

This number is used as the inventory G/L number to post instead of the
standard inventory account when receiving a temporary item (an item that does
not exist in the item file). Temporary items are only allowed in purchase orders
if coming from a special order in the Sales Orders module. This entry is set up
like the inventory entry.
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If Posting To Job Cost From Purchase Orders

During the Purchase Order Entry program the user may post the adjustment to
a job number to post to Job Cost. If job cost information is entered the debit
(expense) account number comes from one of two places. If the Post Work-In-
Process flag is set to Y in the JC to GL Posting F/M program, the debit account
number is a work-in-process account number. Depending on the Basis flag set
in this record for work-in-process, the default number is used or the work-in
process account number is assigned to the cost type for the GL posting table
assigned to the job. If the post Work-In Process flag is set to N in the JC to GL
Posting F/M program, the expense account number posted is the nonstock
inventory G/L number.

The nonstock inventory account is posted from the PO to GL Posting Control
F/M record unless basis is set to | and the nonstock inventory account is posted
from the temporary inventory in the item’s GL posting table. The credit posted
is not the PO receipts account but the JC receipts account. The JC receipts
account is posted from the JC to GL Posting Control F/M record unless Basis is
set to J indicating the JC receipts is posted from the JC GL posting table
assigned to the job.

The Receipt Register GL distribution posts to GL as follows:
Debit Credit

Work in Process JC Receipts
Or

Nonstock Inventory

The JC Receipts account is debited in Accounts Payable (i.e., is washed in AP).

The work-in-process or nonstock inventory GL number also posts into the Job
Cost Job Posting Entry file. The Job Posting Register is then run which updates
the WIP or nonstock inventory GL number to the Job Cost transaction file. This
transaction file is used for billing purposes.

Once billing takes place, the JC Invoice Register is printed along with the
Invoice Register GL distribution.

The GL distribution posts as follows:

Debit Credit

Accounts Receivable Sales
Tax
Freight

Cost of Sales WIP or Nonstock
Inventory

The WIP or nonstock inventory GL number was originally debited in Purchase
Orders and in Job Cost is credited. This means the WIP or nonstock inventory
number is a wash account with the amount posting to the Cost of Sales GL
account number.
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Standard Procedures

This section covers standard procedures to be followed for purchase orders.
These procedures may vary depending on how your company’s business is
conducted. The following three sections of standard procedures are provided
as a guideline:

1) Recommended Operating Procedures

An outline is provided of routine procedures on a daily, weekly, period (month, if 12 periods are
used) and yearly basis.

2) End-Of-Period Checklist

The end-of-period procedures are critical to the proper functioning of the system. Certain programs
must be run in a specific order to close the purchase orders module correctly.

It is suggested that copies of the checklist be made and used for each period closeout to be filed for
future reference.

3) End-Of-Period Checklist Explanation

A detailed account is provided of the purpose of each program on the checklist.
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Recommended Operating Procedures

Daily Procedures (or as needed)

el S

Enter suggested PO’s

Enter purchase orders

Enter PO and Non-PO receipts; print/update Receipt Register
Enter invoice receipts; print/update Invoice Receipt Register

Weekly Procedures (or as needed)

1.
2.

Run Uninvoiced Receipts Report
Print any purchase order management reports

Period Procedures (or as needed)

@k whPE

*7.

Enter final purchase orders

Enter final PO and Non-PO receipts; print/update last PO Receipt Register
Enter final invoice receipts; print/update last Invoice Receipt Register
Print/update Period Receipts Report

Print/update Period Invoice Receipts Report

Print/update Period Receipts Discrepancy Report

Run End-of-Period Update

Yearly Procedures

*1.

Run End-of-Period Update (already covered in period procedures —

do NOT run twice)

* indicates the procedure is required and must be performed in the time period
designated
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End-Of-Period Checklist: Purchase Orders

Period  Year

User Date Menu Description

Receiving 1. Complete all PO entry/receipts and print/update
last Receipt Register

Invoices 2. Complete all invoice receipts and print/update
Receiving last Invoice Receipt Register

EOP 3. Print/update Period Receipts Report

EOP 4. Print/update Invoice Receipts Report

EOP 5. Print/update Receipts Discrepancy Report

EOP 6. Run End-of-Period Update
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End-Of-Period Checklist Explanation

1.

Complete all purchase order entry and receipts and print/update last
Receipt Register.

Complete all invoice receipts and run print/update last Invoice Receipt
Register.

If the above procedures are not complete, then the purchase figures will
not be an accurate accounting of the period.

Print/update Period Receipts Report. This report allows the user to
obtain a list of all purchase order receipts for the period. After the report
prints, the user should remove the records just printed in order to clear
the file. (You must print for all options; e.g., all warehouses, all branches,
all vendors, etc., in order to access the optional update.) All Period
Receipts Reports should be kept as an audit trail.

Print/update Period Invoice Receipts Report. This report allows the
user to obtain a list of all invoice receipts for the period. After the report
prints, the user should remove the records just printed in order to clear
the file. (You must print for all options; e.g., all warehouses, all branches,
all vendors, etc., in order to access the optional update.) All Period
Invoice Receipts Reports should be kept as an audit trail.

Print/update Period Receipts Discrepancy Report. This report prints a
list of all discrepancies between the purchase orders received and the
invoices received for those purchase orders. After the report prints, the
user should remove the records just printed in order to clear the file.
(You must print for all options; e.g., all warehouses, all branches, all
vendors, etc., in order to access the optional update.) All Period Receipts
Discrepancy Reports should be kept as an audit trail.

Run End-of-Period Update. This program must be run in order to close
purchase orders for the period. This program will reset the month-to-
date, year-to-date and prior year sales figures as necessary in the
vendor/item file. The current period will also be incremented.

This is the last step to closing the purchase orders current period and
should only be run after all of the above procedures have been
completed. The program clears month-to-date vendor/item information
and closes the current period. If it is the last period of the year, year-to-
date figures are rolled to prior year. When this program is complete, the
user may begin daily procedures in purchase orders in the new (current)
period.

System Overview

Copyright © 1984-2004 Aperum, Inc.

1-19



System Overview Purchase Orders—7.40

Viewing/Entering Notes from Purchase Order Entry
Programs

You can view and/or enter item or vendor notes from Purchase Order entry
programs:

PO Entry (POE120)

PO Receipt Entry (POE210)
Non-PO Receipt Entry (POE220)
Invoice Receipt Entry (POE310)

From the View menu of the Purchase Order entry programs, you can select
View->Vendor Notes, or View—>Item Notes. When you select to view notes, the
system displays the Notes Display or Note Entry (SME710) screen depending
on your user permissions about notes.

For vendors or items with multiple notes, highlight the note line in the browser
and press Enter to display the View Note or Note Entry screen (depending on
your user permissions about notes). Refer to the Notes Security for
Customer/Item/Vendor Notes for user permission details about notes.

When creating or editing documents and lines, the system automatically
displays urgent notes for vendors and items in the Important Notes on File
(SMI710) screen based on your settings in PO Entry Options F/M (POF915).

This screen displays a listing of all urgent notes, by note type and category, for
the specified vendor or item. Double click a note in the browser to display the
View Note screen, which lists the note subject and text, note type, category, date
created, and date edited. Depending on your security settings for notes, the
system displays the Note Entry (SME710) screen which allows you to enter or
modify information for notes. For detailed information on notes processing,
refer to the Note Entry (SME710) topic.

You can also access notes directly from the main screen of Purchase Order Entry
programs that use the 3-Level Entry Driver. The programs include: PO Entry
(POE120), PO Receipt Entry (POE210), and Non-PO Receipt Entry (POE220).

On the left side of the line item browser, you can select:

I, to access Note Entry (SME710) for the item highlighted in line item browser.

V. to access Note Entry (SME710) for the vendor specified in the program.
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The programs on the Purchase Order Entry menu allow you to enter purchase
orders into the system, as well as maintain them.

You can open existing purchase orders, make corrections, and print as often as
necessary until the order is completely received.

Purchase orders may be printed as they are entered or printed in batches.
When entering purchase orders, suggested PO’s may be imported and
converted to an actual PO.

NOTE: Itis recommended that the user run the Replenishment Report before
entering a PO for a vendor. With the report in hand, the user can order any
items that demand action (below order point) and if the vendor has buying
targets, any items that are below line point.

Purchase order numbers may be entered manually or generated automatically.
General information is entered such as vendor, terms, dates, ship-from, etc.
Purchase orders may be direct shipments and the user may enter the new direct
ship address. Multiple ship-from addresses are allowed for each vendor.

Line-items may be input either by item or vendor-item number. Once line-
items are entered, on order quantities are updated.

Entry of a nonstocked item on a PO is not allowed. If the user elects to purchase
a nonstocked item, it must first be on a work order. The user can then import
the sales order line by utilizing the special order option. The logic behind this is
simple: if it is not an item the user wants to stock (set up in the item file) and it
is not sold, then why purchase it?

The user is able to correct and inquire about any existing purchase order. The
order may be changed as often as needed until it has been completely received.
The user has the option of entering a purchase order number to view a
particular order, or bypass this input and enter a vendor number if the PO
number is not known. When a vendor number is entered, a listing of purchase
orders for that vendor is displayed. Any displayed purchase order may be
selected for correction and inquiry.

Purchase orders may be printed and reprinted as often as needed up until the
time that the purchase order is completely received. Orders may be printed as
they are entered or corrected if they have never been printed; or they may be
added to a reprint file and reprinted by batch. After a purchase order is
printed, it must be reprinted from that point on. During correction and inquiry
the user may indicate that the PO is to reprinted by putting the purchase order
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in the reprint file. The next batch of purchase orders reprinted includes that
purchase order. When reprinting purchase orders the user may then choose to
print all purchase orders that were placed in the reprint file during correction.
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Suggested PO Entry (POE110)

Function

This program allows the user to add, change or delete records in the suggested
purchase order file.

Suggested orders are created in this entry program, by line-item (where the
order amount is greater than the on hand amount) in any of the Sales Orders
entry programs, and in the Inventory Control Replenishment Report.

You can edit all suggested PO entry records through this program, regardless of how you created
them.

Special Order Suggested Pos: When a special order suggested PO is created, the system checks to
make sure that a suggested transfer does not already exist for that sales order and line and that the
order and line do not already exist on another suggested PO. The vendor from the suggested PO is
updated back to the sales order line. When a special order suggested PO is deleted, the sales order
receipt line (SORSOL) vendor field is reset to the item’s primary vendor. In the S column in the
browser in the lower portion of the screen you can also review the status of the sales order that created
the special order suggested PO; the S column displays the sales order status: H-hold, L-locked or D-
deleted.

Operating Tips and Suggestions

Using the Suggested PO Report as a worksheet, the user may make any
necessary changes to the items and quantities calculated by the suggested order
program, before entering them as actual PO’s. If users need to, they can import
suggested PO’s during PO Entry for the vendor and warehouse selected in the
header portion. Each item on a suggested purchase order optionally becomes a
line-item on the actual purchase order.

In Suggested PO Entry, while viewing the suggested POs, if the SO is on hold,
an asterisk will appear beside the SO Doc number. This asterisk also appears on
the Suggested PO Report, and the system prints a caption at the end of the
report as follows:; *=SALES ORDER CURRENTLY ON HOLD.

Several features of the program help the user during Suggested PO Entry:

* A vendor search is provided to locate vendor numbers when only the
vendor name is known.

* Anitem search is provided to locate item numbers when only the item
description is known.

* Anitem’s interchange can be entered and displays the ordering item
number.

* A vendor/item number can be entered and displays the ordering item
number.

* Anitem inquiry displays inventory information including the following:
movement class, seasonal status, restocking type, order point, line point,
min stock, max stock, order quantity method, order quantity, lead time
(stored in the IC warehouse/item file), safety allowance %, frozen
ordering controls, inventory quantities, usage by period and average per
period, previous purchases from the displayed vendor, along with the
last cost, last purchase date and lead time.
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e Records may be added, changed or deleted as necessary.

User Inputs

The following inputs are involved in using the Suggested PO Entry program:

1. Warehouse

Enter the 2-character code to indicate the warehouse for which items are to be
purchased. The entry must be a valid warehouse. CR defaults to the
warehouse assigned to the terminal. F2 allows a search (ref. 8).

2. Vendor

Enter the number of the vendor from whom the item is to be purchased. The
entry must be a valid vendor number. If there are any suggested orders on file
for the selected warehouse, Enter CR defaults to the first vendor in the

suggested order file. Press F2 or select the # icon to search. Press F3 or the
icon to display the next vendor on file.

3. Type

Enter whether the Suggested PO type is R-restocking or S-special order. CR
defaults to R.

Character Users:
The prompt-selection input gives the user the following inputs:

# - Enters the line number to change. Enter C-to change or D-to delete this line. CR
defaults to C. During the change routine, F1 allows the currently displayed value to
remain the same.

A - Adds line-items. If the type (input #3) is R-restocking, enter the item number to add to
the suggested PO. The entry must be a valid item. F2 allows a search (ref. 8). F3 ends
entries. Enter the quantity to order. Press F2 to view restocking information, inventory
guantities, and past purchase information. If the type (input #3) is S-special order, enter
the sales order number from which to add the line-item. F2 allows a special item search,
i.e., searching sales orders with special order items (ref. 8). If the search is not used, next
enter the line number on which the line-item appeared on the sales order.

If a sales order is on hold, you cannot import special order lines from the sales order.

D - Deletes line-items. Enter the beginning and ending item(s) to delete. CR defaults to
FIRST and LAST. Upon display of the prompt OK to delete?, enter N or YES. CR
defaults to N.

L - Lists line-items. Enter the beginning item to list or press CR to continue.

T - Displays totals. Enter T to display the total of both restocking and special order
suggested PO’s for the selected vendor and warehouse. Any requirements, buying
targets (dollars and pounds), costs, and weights are also displayed.

Graphical Users:

The system displays the line item browser, the total of both restocking and special order suggested
PO’s for the selected vendor and warehouse, and any requirements, buying targets (dollars and
pounds), costs, and weights in the lower portion of the screen. For new suggested POs, press Enter

(CR) or select the =+ icon to add line items.
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In the browser highlight an existing line number and you can select:

*+ Adds line-items. If you entered R-restocking for the Type, the system displays the
Restocking Line Entry screen:

Enter the item number to add to the suggested PO. The entry must be a valid item. Press F2 or
select the # icon to search for items. Enter the quantity to order in the Units input. Press the
Inquiry button to view restocking information, inventory quantities, and past purchase
information for the item. Press OK to end entries.

If you entered S-special order for the Type, the system displays the Special Order Line Entry
screen.

In the Order input, enter the sales order number that you want to use to add the line item. You
can press F2 or select the # icon to search sales orders with special order items. After you
select the sale order to use, enter the line number where the line item appeared on the sales
order in the Line input. In the Units input, the system displays backorder quantity from the
sales order line. You can modify this value but the units quantity cannot exceed the
backordered quantity on the sales order line. Press the Inquiry button to view restocking
information, inventory quantities, and past purchase information for the item. Press OK to end
entries.

If a sales order is on hold, you cannot import special order lines from the sales order.
¢ Deletes the highlighted line-item

*+ Adds aline item above the highlighted item in the browser.

& Modifies the highlighted line item.

Press the l&l icon to save your changes.

You can press Del Range button to display the Delete Range of Items screen.

To delete line-items: Enter the beginning and ending item(s) to delete; press # to search.
Press Enter or M to default to FIRST and M to default to LAST. When the system displays the
message: OK to delete?, enter N or YES. Press Enter to default to N.

You can press Inquiry to view restocking information, inventory quantities, and past purchase
information for the item highlighted in the line item browser.

You can press Done to complete this suggested PO and enter another one. Press Done again to
exit the program.

Technical Notes

FILES USED - SMCNTL, APVEND, APVALX, ICMAST, ICWHSE, ICALPX,
POVNIT, SORDER, ICCLSX, ICWHVD, ICINTR, POVNIX, ARCUST

FILES UPDATED - POSUGG

2-6
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L2 01-Demo Company, Suggested PO Entry [POE110) [_ =] ]
Help

Warehouse | o1 gk | Atlanta Warehouse
Wendor | Y101 | ¢ Industrial Supply Distributors Type IR - Restocking "l
Description Units | U Crder ﬂ LM# | SR
1100 Fallat Loading Hand Trudk 1000 b zap ) 12 CT
L=l= ] Green Clean hachine 12 EA
add .@
OnHand 1064 CT On Qrder 1447 Commit 3.8 Backorder 9.3
Requirements  Use Vendor-kem numbers on PO Buying Targets: Cost 0 Weight 0
Current Total Sugg (R+5): Cost 14504.4 Weight 6
De| Range | Inguiry | Daone
| v
" Suggested PO Entry (POE110) [_ O] =]
Help
81-Specialty Distributors, 1 Suggested PD Entry POE11d
Warehouse 61 Atlanta Warehouse
Uendor U188 General Industrial MFQ....... + Type R
58% off Freight for bu
Description i Order S LH#
Pallet Loading Hand Truck
1116 Aluminum Dock Plate 36 =
J282 LISA'S ITEH 3 En
J283 LISA'S ITEH 3 En
LW423 Leigh'S ITEM 3 En
STKI188 Added back to Inventory 47 EA
STEKI181 Added back for Inventory 47 EA
HEWI189%2 ADDBACKK 47 EA
SDFSDFSFD GARBAGE 47 EA
add
On Hnd 15382 .5 CT On Ord 186814 Commit 10877 .6 Backord 275 .7
Buying Targets: Cost 2000 Weight 280
Current Total Sugg (R+3): Cost 13282 .66 Weight 52843
Del Range, Inquiry
CR-Edit, DEL, F3-Done |.
Arrows: Up=Prev, Down=Mext, Left/Right=Lines, PgUp, PgDn, Home, End First line
4
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Suggested PO Report (POR110)

Function

This program allows the user to print a report of suggested purchase orders by
vendor. It may be used as a worksheet to edit suggested quantities.

In Suggested PO Entry, while viewing the suggested POs, if the SO is on hold,
an asterisk will appear beside the SO Doc number. This asterisk also appears on
the Suggested PO Report, and the system prints a caption at the end of the
report as follows; *=SALES ORDER CURRENTLY ON HOLD.

The user has the option to:

»  Select the beginning and ending vendor to print.

»  Select the warehouse(s) to print.

» Select suggested orders for restocking orders and/or special orders.
Report information includes the following: vendor number, name, review cycle,

date of last PO, buying targets (dollars and pounds), item number and
description, suggested order quantity, cost, cost extension, and weight.

User Inputs

The following inputs are involved in printing the Suggested PO Report:
1. Beginning Vendor

Enter the beginning vendor number to print. CR defaults to FIRST.
2. Ending Vendor

Enter the ending vendor number to print. CR defaults to LAST.

3. Warehouse

Enter a valid warehouse code to print. The entry must be a valid warehouse.
CR defaults to the warehouse assigned to the terminal. F3 defaults to ALL.

4, Type

Enter whether to print R-restocking order and/or S-special order type. CR
defaults to R.

Technical Notes

The program proceeds to print by reading through the suggested order file
(POSUGG) and printing records that meet the entered criteria. The vendor
(APVEND) and item (ICMAST) files are referenced to obtain names,
descriptions and units of measure. The IC warehouse/item file ICWHSE) and
the PO vendor/item file (POVNIT) are referenced for cost information.

FILES USED - SMCNTL, POSUGG, APVEND, ICMAST, ICWHSE, POVNIT,
ICWHVD, SORDER, ARCUST

FILES UPDATED - NONE

Purchase Orders—7.40
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;¥ Suggested PO Report (POR110)
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L2 Suggested PO Report (FOR110)
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PO Entry (POE120)

Use this program to enter vendor purchase orders into the Purchase Order
system and to update on-order quantities in inventory.

Tip! Make sure you run the Replenishment Report before you enter a PO for a
vendor. With the report in hand, it is easier to see which items demand action
(for instance, if any fall below order point) and if the vendor has buying targets.

To access this program, choose Purchases Orders 2Entry PO Entry from the
FACTS Master Menu.

\Pulchase Order Document 001383 Georgia Shipping Equip. Co. [POE120) M= E3
File Edit %iew DOptions GoTo Help

vendor [ vii0 2ol f] shigtownse [or #h] PO# 001383
shipFram | samE| ] Name [Atianta Warehouse ordered  [12111/2003
Georgia Shipping Eguip. Co. Address 1 |685 Fulton Industrial Requested [12r11/2003 | il
S WS . B, Address 2 [Atlanta, GA 33025 Promised [1271172003 | & |
Address 3 | Terms [ 30) #] Net3o

Atlanta, GA. 30302

ttem [ii10 I |#4 | steel Storage Cabi  Units | 1 Ea Cost [ 180820 _ | En
Item Flags | Description Units | Uk Cost UMJ Extension
159.820 EA 159,820

Steel Storage Cabinet

Ll | 2
Units: 1 Weight: 170.0 Ext: 159.82
Header Line Detail Done |
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™\ PO Entiy [POE120) M= E3

Help

B1-FACTS 7.4 Development Purchase Order Entry PO # AB1389 POE128

Uendorndor u11a

Ship From SAME Ship-to UWhse 01

Georgia Shipping Equip. Co. Atlanta Warehouse Ordered B81/88/2004

3376 Washington fAve. S.E. 685 Fulton Industrial Request 61/88/2804
fAtlanta, GA 33825 Promise 01/708/2004

Atlanta, GA. 308382 Terms 360 Het 30

Item Units Cost

Hotes: UEHD

LNit Item Flags Description Units UM Cost UH
ELili]
Units: Weight: Ext:

Enter item number, {M=Hemo}, F1-Special order, F2-Search, F3-End, F18-Henu

|
PO Entry Processing Notes

When you enter lines on a purchase order, the system checks the normal
restocking path set in Warehouse/Item F/M and displays a message asking you
to verify.

Say that you normally restock item 1100 from Warehouse 02. If you create a PO
for vendor V100 and enter 1100, FACTS displays a message asking you to
confirm that even though your normal restocking path is Warehouse 02, you
want to order the item from V100.

When an item is entered to be ordered, the availability of the item is displayed.
When the entry of the line-item is complete, the on order quantity is updated
immediately.

Special order items (items from a sales order may be a temporary item) and
memo lines may be entered on purchase orders. POs may be flagged to ask for
confirmations or acknowledgments. When all line-items have been entered on a
PO, the system checks the vendor’s buying target (if applicable, due to
discounts, etc.). If the buying target has not been met on the current PO, the
user may allow the program to automatically increase the purchase order up to
the vendor’s buying target by dollars ($).

You can edit or delete purchase orders at any time up until the entire PO has
been received using the PO Receipt program. Purchase orders may be printed
immediately upon entry or may be held for batch printing through the PO Print
program. Open corrected POs may be reprinted at any time.

As line-items on the purchase order come into inventory through receiving (the
PO must have been printed), the user can receive them independently. In other
words the entire PO does not have to be complete before line-items can be put
into the inventory control or sales order systems. As the user receives the goods
on the line-items, they are entered into the system through Receipt Entry. When

i

Entry
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the Receipt Register is updated, each line-items’ status is updated, to partially
received or complete. When all the line-items have been completed the register
moves the entire PO to the past purchase order file.

Deleted purchase orders are not simply removed from the file. Deleted
purchase order line-item records are removed and if all the line-items for a
purchase order are deleted then the header record status is changed to deleted.
The purchase order then appears on the next purchase orders Receipt Register
as deleted and is removed in the subsequent update. This procedure provides a
complete audit trail of all purchase order numbers used.

At any point during the PO entry-receipt process, the PO in its current state or
its overview (history since it was entered) status, can be viewed in detail in
either the purchase orders Vendor Inquiry or Document Inquiry.

The Purchase Order Entry screen consists of three sections: the header, the line-
item entry section and the footer.

During processing, the system automatically displays urgent notes for vendors
and items based on your settings on the Notes tab of PO Entry Options F/M.
Refer to the Viewing/Entering Notes from Purchase Order Programs topic in
the PO Overview section for details.

PO Entry Header Processing

The upper portion of the screen is called the header portion where you enter the purchase order
number, vendor, order date and other general information. Refer to the following procedures for
more information about Purchase Order Entry header processing:

Enter a new document

Delete a document

Open an existing document

Create a document number

After the system creates the header record, all header inputs except the purchase order number,
vendors, and Ship-From are accessible through the change header routine. The PO number, vendor,
type, and ship-from values can only be changed by deleting and re-entering the PO. Refer to the PO
Entry Header Information topic for field/Zinput descriptions.

PO Entry Line Item Processing

The lower portion is called the line item portion where you enter the item number, quantity and cost.
You have the option of changing, adding, removing line items or deleting the purchase order at any
time during the entry process. Purchase orders can be open (entered), partially received, received, and
deleted by line item. They can also be voided.

Refer to the PO Entry Items Information topic for field/input descriptions.

Refer to the following procedures for more information about Order Entry item processing:

Add a line
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Edit a line item
Delete a line item
Insert a line item or memo

Find a line item

PO Entry Footer Processing

The ending routine consists of final inputs prior to completion of the purchase order. The ending
routine is not accessible if you have not entered line items for the PO. At the end of the ending
routine, the new total represents the total amount of the purchase order. Refer to the PO Entry Footer
Information topic for fieldZinput descriptions.

Li# Footer Detail for PO Number 001067

Werno IWE EMJOY DOING BUSINESS WITH YOI

Freight I 9.00 [T Acknowledoement
Tax % | .00 [ Confirmation

Tax § .00
i Doctotal 980.93
[ Ok | Backup |
| Enter Wemo
L PO Entry (POE120) _ (O] =]
Help
81-Demo Company Purchase Order Entry PO # BB1867 POE126
Uendor U115
Ship From SAME Ship-to Whse 02
Mational Conveyors, Inc. DALLAS WAREHOUSE Ordered 89717720802
3121 Industrial Park Drive 3095 LEJ FREEWAY Request 0971772882
SUITE 1187 Promise B89/28/2002
Atlanta, GA 38312 DALLAS, TX 75234 Terms 02 2% 18t
Item Units Cost
[126 GRAVITY ROLLER COHUEY 5 EA 166.398 En
L M Item Flags Description Units UM Cost UM

Footer Detail for PO Humber 0818567
Hemo WE ENJOY DOING BUSIHESS WITH YoUt

Freight 9.88 Acknowledgement H
Tax % ) Confirmation H
Tax & . 8@

Doc total 988.93

CR-Continue, F2-Edit, F4-Backup |

B
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Additional Features

e You can enter direct shipments. Purchase orders can be direct shipped to any customer in the
Accounts Receivable system. You can also enter any new addresses for direct shipments. You can
perform a credit limit check for direct ship customers.

e You can enter vendor/item numbers or item interchanges in lieu of inventory control item
numbers. The corresponding inventory item number is retrieved and displayed along with on
hand, on order and committed quantities.

e You can import suggested POs.

. During processing, the system automatically displays urgent notes for vendors and items based
on your settings on the Notes tab of PO Entry Options F/M. Refer to the Viewing/Entering
Notes from Purchase Order Programs topic in Chapter 1, System Overview for details.

PO Management Reports

The PO Status Report prints open purchase orders, backorders, received
purchase orders or all purchase orders in document, vendor or item number
order.

The Receiving Schedule lists open purchase orders by promised delivery date.
The Cash Requirements Report lists future payments due to vendors based on
open purchase orders.

Technical Notes

At the conclusion of the header portion, the last purchase order number used
field is updated in the nonstatic control record. The header record is created in
the purchase orders file (PORDER).

At the conclusion of the line-item portion, a line-item record is created in the
purchase orders file (PORDER) and the appropriate sort files are maintained.
The on order quantity for each item is updated in the inventory control
warehouse/item file (ICWHSE) at the conclusion of each line.

Also, the purchase order header record (PORDER) is updated along with the
purchase order ready-to-print file (POPRTX), and other sort files.

All Job Cost information is stored in the purchase orders file (PORDER).

This program updates the ready-for-register file (POREGX) only if a document
is deleted through this program. If the Receipt Register is in process, the
temporary ready-for-register file (POTMPX) is updated instead of POREGX.

FILES USED - SMCNTL, APVEND, ICMAST, POVNIT, POVITX, ICALPX,
APVALX, ARCUST, SOITMX, SORDER, POPAST, POSHIP, JCIOBS, JCCODE,
JCIOCX, ICWHVD, ICINTR, ICCLSX, POVNIX, ICWHSX, ARSHIP, PODSSP

FILES UPDATED - PORDER, POITMX, POVITX, POVNDX, POPRTX,
POREGX, ICWHSE, JCREFX, POSUGG, SORDER, POTMPX, PODSSP

See Also

PO Entry Header Information
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PO Entry Items Information

PO Entry Footer Information

How to direct ship POs

How to enter or change purchase orders information
Line Detail for Purchase Order Screen

How to enter PO header information

How to enter line items on a PO

How to enter PO footer information
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PO Entry Header Information

Use the PO Header section to enter the purchase order number, vendor, order
date and other general information. This window contains all the possible
inputs for the PO Entry Header.

Tip: When you press Enter or Tab, the additional inputs that appear, such as reference number,
freight Code, a buyer code, etc., depend on the settings selected in PO Entry Options F/M. This topic
details all possible entries. Most of these entries already display default information; you can modify
these values.

User Inputs

Use the following input descriptions to enter information for a purchase order header:
1. Doc/Vendor

You can enter purchase order numbers or have them automatically assigned by
the system. For manual purchase order numbers, enter any number up to
99999. The system displays information for purchase order numbers already on
file and goes to the prompt-selection input. To use automatic purchase order
numbers, press Enter, and the system assigns the next available number. The
word NEXT is displayed until the header portion is completed.

Graphical Users: To use the next system purchase order number, simply enter
vendor number, and the next purchase order number will be assigned when
you complete the header information. To assign the number of your choice,
press F10 to display the menu options, then select File-->New Document
Number. You can enter the PO number to assign, or use the Assign Next button
if you decide to have the system assign the next available number. When you
complete your header information, the system displays the assigned PO number
at the top of the screen. You can also press Enter to automatically assign the PO
number when you complete your header information.

Character Users: To use automatic purchase order press F10 to display the
menu options, then select File-->New Document Number to access the Assign
PO Number dialog box and click the Assign Next Doc icon. You can enter the
PO number to assign, or the system assigns the next available number. When
you complete your header information, the system displays the assign PO
number at the top of the screen. You can also press Enter to automatically
assign the PO number when you complete your header information.

To Search:

Character Users: Press F2 to perform a vendor search. You can also search by
contact name and alphabetic sort. Press F3 to search for documents by purchase
order number. To search for PO number for a specific vendor, enter the vendor
number in the vendor input (#3) on the screen. Enter a valid vendor code to
display all the purchase orders for that vendor. You can then select a PO for
editing, or press F4--backup to return to the purchase order number input (#1).

You can:

Press Enter to continue listing, select a line number of a document on the screen,
or

2-16 Copyright © 1984-2004 Aperum, Inc.



Purchase Orders—7.40 Entry

press F3 to change warehouses for the search, or
press F4 to back up to input #1.

Graphical Users: Press F2 or select the # icon to perform a vendor search. You
can also search by purchase order number and warehouse. To search for

'}
purchase order documents, select the L= jcon.
For Vendors:

Enter the number of the vendor for the purchase order. If you enter a valid
vendor number, the system displays the vendor name and address, and any
applicable defaults: F.O.B., terms code, and department. At the bottom of the
screen, the vendor’s message, balance, the user’s customer number from the
vendor, contacts 1 and 2, and the phone number are displayed. Press F2 to
search.

2. PO Type (this field is not displayed)

Character Users: The system initially skips the Type input and defaults to W.
Press F4 to back up to this input. Enter whether the type of shipment is W-
warehouse or D-direct. Entering a D forces you to enter the open work order
number from the sales orders file. Once the header portion is complete, the
system imports the line-items from the work order and displays them. Press
Enter to default to W.

To direct ship POs: Graphical Users: (Optional) To access the Warehouse/Direct

Ship Selection dialog box to create a direct shipment, select the L8 icon or press
F1. If the PO is a direct ship, enter the warehouse that is to be the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine
where the PO originated; inventory quantities and restocking controls are not
affected. For new purchase orders, enter the number of the vendor from whom
you are requesting the items.

3. Ship-From

Enter the vendor ship-from number. Press Enter to default to SAME. Press F2
to search.

4.  Ship-To Warehouse

Enter the warehouse code where the goods should be shipped. The entry must
be a valid warehouse. If you enter a valid warehouse code, the system displays
the warehouse, name and address from the warehouse control record. Once the
address displays, you can back up and change any line of the name or address.

If the PO is a direct ship, then enter the warehouse that is to be the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine
where the PO originated; inventory quantities and restocking controls are not
affected. This becomes the ship-to address on the purchase order. You can
press F4-backup and override the address, or continue to back up to the
warehouse prompt.

Character Users: At any point during inputs #5-14, you can press F3 (for default
values). Select F3 to display the defaults on file from that input forward and
skip to input #15. If you are entering a new PO and you have not entered
default values for inputs #5-14, then the default values are the same as if you
pressed Enter through the same inputs. If you enter values on a new PO and
back up to enter new values or decide to change or correct the header portion of
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an existing PO, then the values are the same as if you pressed F1(to skip). If the
program does not skip to input #15, but instead stops at an earlier input, it
means the system could not find a valid default value for that input and you
must enter a valid value before continuing.

5. Ordered Date

Enter the entry date of the PO. Press Enter to default to the system date.
6. Request Date

Enter the requested date of delivery. Press Enter to default to the system date.

7. Promise Date

Enter the date the vendor promises delivery. Press Enter to default to the
requested date.

8. Buyer

Enter a valid buyer code to identify the buyer for the purchase order. When
you enter a valid buyer code, the system displays a partial description. Press
Enter to initially default to the buyer code in the ship-from file for the selected
vendor (if the ship-from is SAME then the default comes from the IC
warehouse/vendor review record). Press F2 to search.

9. Terms

Enter a valid payment terms code for this purchase order. Press Enter to
initially default to the code for the selected vendor from the vendor file. When
you enter a valid code, the system displays a partial description. Press F2 to
search.

10. Freight

Enter whether freight is B-bill later, P-prepaid, C-collect or A - prepay/add.
Press Enter to default to the freight code in the ship-from file (if specified) or the
freight code entered in Vendor F/M for the selected vendor. Also, if the ship-
from warehouse is changed from any value to SAME, the freight code reverts
back to the vendor default freight code.

11. Ship Via

Enter up to 15 characters for the carrier. Press Enter to initially default to the
ship via in the ship- from file for the selected vendor.

12. Lead Time

Enter Y or N to indicate whether the lead-time from this document (number of
days from the ordered date to the date of the first receipt) should update the
average lead-time for the item in the warehouse/item file. The system performs
this update during the Receipt Register update. Press Enter to initially default
toY.

13. F.O.B.

Enter up to 15 characters for freight on board. Press Enter to initially default to
the F.O.B. in the ship-from file for the selected vendor.
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14. Department

Enter the valid general ledger department number. The entry must be a valid
department. Press Enter to initially default to the department assigned to the
terminal. Press F2 to search.

15. Reference Number

Enter the optional reference number (up to 15 characters). For direct ship
orders, press Enter to accept the SO number.

This completes the header portion of the Purchase Order Entry program. At
this time, the system automatically assigns and displays purchase order
number.

Note: After the system creates the header record, all header inputs except #1-4
are accessible through the change header routine. Inputs #1-4 can only be
changed by deleting and re-entering the PO.

16. Suggested orders on file. Do you want to import? (Y or N)

After the PO number is assigned, the system checks the suggested orders file for
suggested orders for the selected vendor and warehouse to automatically add to
the purchase order. If no suggested orders exist, this input is skipped.

If you enter N, the cursor goes to the line-item portion of the screen. If you
enter Y, the system displays the first line-item to import.

Character Users: Press Enter to import the displayed line, F1 to skip the line-item
and display the next, F2 import all line-items, or press F3 to end imports.

Graphical Users: Press | to import the displayed line, S to skip the line-item and
display the next, A import all line-items, K skip all remaining line-items, or
press F3 to end imports.

The system adds one line-item for each item in the suggested purchase orders

file and adds to the weight and total dollar amount in the header of the
purchase order.

See Also

PO Entry (POE120)

PO Entry Items Information

PO Entry Footer Information

PO Entry Menu Options

How to enter or change purchase orders information

Line Detail for Purchase Order Screen
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PO Entry Items Information

The line-item portion of the program allows entry of up to 999 line-item and message lines to complete
the purchase order. Line numbers are assigned automatically beginning with 001 and incremented by
one for each additional line-item up to 999. In the rare case where 999 line-items have been entered on
a single purchase order, the program advances to the prompt-selection input and refuses further
entries.

Tip: When you press Enter or Tab, the additional inputs that appear, such as reference number,
freight Code, a buyer code, etc., depend on the settings selected in PO Entry Options F/M. This topic
details all possible entries. Most of these entries already display default information; you can modify
these values.

Input Descriptions

This window contains all the possible inputs for PO Entry items processing. Use the following input
descriptions to enter information for a purchase order line item.

1. Item Number

You have several options for this entry:

# - Enters an item number
M - Enters a memo
@ﬂ
Sor - Enters a special order line number
F2or#i-  Allows asearch
Character Users: F3 or Graphical Users: Q or F4- Ends line-item entries

Each of these options is described below:
Item number

If the item is not a valid item, the system checks to see if it is an interchange, or
if it is a vendor-item number; if the number is an interchange or vendor-item
number, the system automatically prints the valid item number and sets its
defaults. For valid item numbers, the system displays item Description 1 and
Description 2 fields so you can modify the item description lines as necessary.
Press Enter to default to the existing values in the Item F/M. When you are
satisfied with the descriptions, select the OK button.

Entering non-stock or inactive items for returns;

You can enter non-stock or inactive items for returns in PO Entry. To enter a
non-stock or inactive item, you must enter a negative quantity for the item. If
you attempt to enter a non-stock or inactive item with a non-negative quantity,
the system displays a message stating that the non-stock or inactive item must
be tied to an SO.

Character Users: Enter any item number. If the item is not a valid item, the
system checks to see if it is an interchange, or if it is a vendor-item number; if
the number is an interchange or vendor-item number, the system automatically
prints the valid item number and sets its defaults.
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Entering a valid item number displays the vendor relation, last lead-time,
vendor-item number, item class, standard package size, buying weight, and
inventory quantities. The relation is considered primary if this vendor number
is stored with the item in the inventory control item file. If not a primary
relationship, the relation is considered secondary when there is record of
purchase of the item from this vendor. Otherwise, the relation is considered
unlisted. The program skips to input #19.

The item is verified as being stocked or uninventoried, unless it is tied to a sales
order. Only stocked and uninventoried items may be added to a purchase order
unless the items are tied to a sales order.

Memo

Press M to enter a memo line. The system allows you to enter a memo and
display purchase order when printed.

Special Orders

In the Item Number input, enter S to enter a special order line-item. Enter the sales order number
from which to import the line-item. Press F2 to perform a special item search, i.e., searching sales
orders with special order items. If the search is not used, next enter the line number on which the line-
item appeared on the sales order.

Graphical Users: You can select the } icon to enter a special order line number. The system displays
the Special Order Entry dialog box where you can enter the sales order number (the Order field) from
which to import a line item. Press # to perform a special item search, i.e., searching sales orders with
special order items. If the search is not used, next enter the line number on which the line item
appeared on the sales order in the Line field. You can select the # icon to search for items.

,& If a sales order is on hold, you cannot import special order lines from the sales order.

When a special order line is added to a PO, the sales order receipt line (SORSOL) vendor is updated
with the vendor from the PO. When a special order line is deleted from a PO, the SORSOL vendor
field is reset to the item’s primary vendor.

Search

Press F2 to allow a search.

Graphical Users: You can select the # icon to search for items.
End entry

Press F3 to end entry of line-items. The program then proceeds to the prompt-
selection input.

Graphical Users: Select the Q icon to stop entering line items.

2. Descriptions

Graphical Users: For valid item numbers, the system displays item Description 1
and Description 2 fields so you can modify the item description lines as
necessary. Press Enter to default to the existing values in the Item F/M. When
you are satisfied with the descriptions, select the OK button.
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Character Users: The system initially skips this input except for memo lines.
Enter the item descriptions or memo. If you enter memo lines, the system skips
the remaining inputs. Otherwise, after entering description 1, enter description
2. Press Enter to default to the existing values in the Item F/M.

3.  Units

Enter the quantity to be ordered

Character Users: You can also select a display code.
Graphical Users: You can access display information via the View menu option.

Display information is described below:
Enter whether to display O-ordered, C-committed or R-restocking controls, U-
usage, V-vendor or W-warehouse of past purchases.

O--Ordered. Displays existing purchase orders for the selected item and
warehouse at a time. The display for each purchase order includes: the
purchase order number, type, status, ordered quantity, received quantity,
backordered quantity, unit of measure for the quantities, cost and its
corresponding unit of measure, the promised date and vendor number.

C--Committed. Selecting committed displays four more display codes on the
screen: S-sales orders, T-warehouse transfers, M-manufacturing, and E-
equipment rental. Press Enter to default to S.

Selecting S displays sales orders for the selected item and warehouse at a time.
Each order shows: the document number, type, status, ordered, shipped, and
backordered quantities and corresponding unit of measure, price and
corresponding unit of measure, date and customer number.

Selecting T displays warehouse transfer tickets for the selected item at a time.
Each ticket shows: ticket number, status, requested date, shipped and received
guantities and their corresponding unit of measure, cost and its corresponding
unit of measure, date of transfer, and the warehouse the item was transferred
to.

Selecting M displays manufacturing tickets for the selected item and warehouse
at a time. Each ticket shows: the ticket number, type and status, quantity to be
manufactured and its corresponding unit of measure, scheduled date and if it is
a component item, what the item is a component of.

Selecting E displays equipment rental contracts containing the selected item.
Each contract shows: the contract number, type (C-rental contract, D-
invoice/credit memo), status (E-entered, P-printed, R-returned, I-invoiced, D-
deleted, V-voided), line number on the contract on which the item appears, date
of rental, units rented, stocking unit of measure, rental price, and rental
customer name.

R --Displays the restocking controls for the selected item. Displayed are: order
point, line point, min stock, max stock, order quantity method, order quantity,
lead time (stored in the inventory control warehouse/item file), safety
allowance %, usage rate and frozen ordering controls.

NOTE: You should select W to get the available quantity for the item and
warehouse before selecting usage. The numbers displayed are the numbers
calculated in the End-of-Period Update for IC. If the order point is higher than
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the available quantity, the recommended order amount is the order quantity
displayed. If the available is lower than the line point, then you can order this
item to help the PO meet a buying target.

U--Displays the item’s activity for the last six periods (for nonseasonal items), or
previous six periods (for seasonal items), the number of days stocked out for the
last six periods and the average for both. Also displayed is the seasonal type.

V--Displays by vendor, the last purchase from each vendor that sells the item,
lines at a time. The vendor number is displayed as well as, the vendor-item
number and manual cost, also from the last purchase from that vendor: the last
PO number, and the units purchased and cost with their corresponding units of
measure.

W--Displays the inventory quantities for this item that are currently in each
warehouse. The warehouse number is displayed, as well as the on hand,
committed, available, backorder and on order (not including the line displayed)
guantities and their corresponding units of measure.

4, Cost

Enter the cost per displayed costing unit of measure.

Press F2 to search for cost contracts for the vendor/item combination. If the
current cost is not a contract or the standard PO cost, the cost search program
will highlight the default cost, otherwise the cost currently on the line will be
highlighted.

The system displays (if on file): the manual cost from the item file, the average
and last costs from the warehouse/item file, the manual and last costs or the
contract cost (if available) from the vendor/item file. For contracts that are the
same hierarchy, but have different warehouse scopes, the system uses the
lowest cost as the contract cost value. Depending on the Default PO Cost flag
set in the PO static control record, pressing Enter to default to the manual cost
of the item from item file or the last cost of the item from the vendor/item file.
This input is only used when the Cost flag in the PO Entry Options record is set
to Y or B.

When a new line is being created, the system automatically calculates the
default cost. After the cost is entered, the system captures the origin of the cost.
If you select a cost other than the default cost, the system sets the cost override
flag and displays U for the cost type.

PO Entry uses the default PO cost (set in PO Static Control F/M or dictated by a
Vendor Cost Contract) for all tied PO lines (including direct shipments)
excepting the following cases, in which the SO line item cost will be used:

e The line is a temporary item.
*  There is no default PO cost (cost of $0.00).
* The item is a warehouse item and the cost has been overridden in SO Entry.

* The item is a catalog item and the cost has been overridden in SO Entry (if not, it will
use the cost from ICICAT table).

The system also displays Contract to indicate whether the displayed cost is from
a contract.
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You can access cost details from the View - Cost Origin menu option.

5. Requested

This input is used only when the Requested Date flag in the PO Entry Options
record is set to Y or B. Enter the date you want to request receipt for this item.
The requested date in the header section is the displayed default value.

6. Promised Date

This input is only used when the Promised Date flag in the PO Entry Options
record is set to Y or B. Enter the date this item is promised for delivery. The
requested date is the displayed default value.

7. Lead Time

This input is used only when the Lead Time flag in the PO Entry Options
record is setto Y or B. Enter Y or N to use this document to update the item’s
lead-time in the Receipt Register. Press Enter to default to the lead-time input
in the header portion of the screen. If the quantity is a negative amount, this
input is set to N and skipped.

8. Taxable

This input is used only when the Taxable flag in the PO Entry Options record is
setto Y or B. Enter Y or N to charge tax on this line-item. Press Enter to default
toY.

9. GL (Posting Table)

This input is used only when the GL Table flag in the PO Entry Options control
record is set to Y or B. Enter the GL posting table to use in the Receipt Register
to post this line-item to GL. Press Enter to default to the GL posting table for
the selected item in the item file. Press F2 to search.

10. Character Users: The system displays: CR-Accept Line, J-Job #, F4-Backup

If the Use Job Cost flag is set to N in the purchase orders static control record
or if the item is a special order or the purchase order is a direct ship, the
system skips this input. Press Enter to accept the line and bypass the job
costing information. Enter J to enter job costing information or F4 to back up
to the previous input. If you enter J, inputs #11-17 must be entered.

Graphical Users: The system displays: Enter Job Number Y or N.

If you select Y, the system displays the Job Posting Entry screen. Enter the
valid job number to post this entry against. Press Enter to default to the last
job number entered (if any). Press F2 to search. For valid job numbers, the
system requests customer code, you can enter the customer code or search for
customer codes. The system then requests a memo for the posting entry. You
can indicate whether you want this memo to print on the PO invoice. Note: If
the Use Job Cost flag is set to N in the purchase orders static control record or
if the item is a special order or the purchase order is a direct ship, the system
skips this input. If you enter Y, inputs #11-17 must be entered
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11. Job Number

Enter the valid job number to post this entry against. For valid job numbers, the
system displays the job name, customer number and name, and billing type.
Press Enter to default to the last job number entered (if any). Press F2 to search.

12. Price Message

If the job is a fixed contract or time and materials contract, this input is skipped.
If the job is a cost plus (+) contract or a no charge contract, a message is
displayed indicating the price, which must be billed for the job. Press Enter to
continue.

13. Cost Code

Enter a valid cost code (up to four characters). If you enter a valid cost code, the
system displays the cost code description and the cost type. The cost code sets
the defaults for markup method (for all jobs that are not cost plus) and billing
rate (for jobs that are fixed contracts or time and material). The cost code also
determines whether the user is able to override the defaults. Press F2 to search.

The item entry determines the units, unit of measure and cost rate/extension.

14. Markup

The system initially skips this input and sets it to the markup assigned to the
cost code. You can enter this value only for jobs that are time and materials or
fixed contracts and where the Allow Override Of Billing flag is set to Y in the
cost code record. You can also change this for no charge jobs but the bill rate is
not affected.

Enter the markup method to use for this posting entry. You have the following
options:

#---Enter the markup amount (0-9999999.99). Entering a number tells the
system to mark up the cost by a dollar amount. The system marks up the cost
rate by the dollar amount and calculates the bill extension.

#+% ---Enter the percentage (0-9999999.99%) to mark up the cost. To enter a
percentage, the user must enter an amount and then the percentage sign. If no
percentage sign is present, the system assumes the entered amount is a dollar
amount. The system marks up the cost rate by the percentage amount and
calculates the bill extension.

M---Enter the bill rate/extension manually. Entering M displays the word
MANUAL and the program proceeds to the bill rate input (#30).

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

Enter---initially defaults to the markup method (amount/percentage) from the
cost code record.

15. Bill Rate

This input is unavailable if the Allow Billing Override flag in the cost code
record is set to N. The system initially skips this input unless the markup
method of the cost code is manual. Enter the price per displayed unit of
measure. The bill extension is calculated and displayed. Press Enter to initially
default to 0.
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16. Memo

Enter the memo to post for this job cost transaction and to print on the job cost
invoice (if applicable - see next input). Press Enter to initially default to blanks.

17. Print Memo On Job Cost Invoice?

The system initially skips this input and sets it to N. Enter N or Y to indicate
whether to print the memo (entered in the previous input) on the job cost
invoice. You can set the input to Y only if the Billing Detail for the cost type
(that the cost code is assigned to) is set to A for all transactions in the Job Entry
program. Press Enter to initially default to N.

18. Press Enter to continue, accept the line and return to item input or press F4
to backup.

19. Extension

The line-item extension is calculated and displayed.

This completes the line-item portion of the PO Entry program. The system
updates and displays the running totals for weight and dollar amount. The line
number is incremented by one, displayed, and the program returns to the next
line-item entry if in add mode or the prompt-selection input in change mode.
The on order quantity for the item is updated in the appropriate warehouse.

20. Character Users: Following the entry of the last line-item, the prompt-selection input allows
you to perform a number of functions:

# - Changes a line-item

L - Lists line-items

A - Adds a line-item

D - Deletes the purchase order
F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View menu
of the Warehouse transfer entry programs, you can select F10-Menu, View, Item
Notes or Vendor Notes.

Graphical Users: Select the Q icon to stop entering line items. You can:
Highlight a line item and select the Line Detail button to access the Line Detail
for Purchase Order screen, which is used to view and/or modify item
descriptions, promise and request dates, item details, item/vendor info, and

item cost info. The system displays Job Posting Entry dialog box for change or
review.

Select the E; icon to make changes for the highlighted line item.
Select the ®® icon to add a PO line.

Select the # icon to delete the highlighted PO line.

2-26 Copyright © 1984-2004 Aperum, Inc.



Purchase Orders—7.40 Entry

Select the = button to add a line item above the highlighted item in the
browser.

On the left side of the line item browser, you can select:
I, to access Note Entry (SME710) for the item highlighted in line item browser.

V. to access Note Entry (SME710) for the vendor specified in the program.

Press the l&l icon to save your changes.

See Also

PO Entry (POE120)

PO Entry Header Information

PO Entry Footer Information

PO Entry Menu Options

How to enter or change purchase orders information

Line Detail for Purchase Order Screen
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PO Entry Footer Information

This window contains all the possible inputs for PO Entry footer processing.

The ending routine consists of final inputs prior to completion of the purchase order. The ending
routine is not accessible if you have not entered line-items for the PO. If the vendor and warehouse
have a buying target set up in the vendor/warehouse review record, then the system displays the
buying target only if the PO is over 80% of the buying target but has not reached it. You then have the
option to increase the line-items up to the buying target dollar amount. If you enter N, the program
accesses to the ending routine. If you enter Y, the system automatically orders proportionately more
of each item to hit the dollar-buying target (if the buying target is weight, the system does not calculate
new order amounts automatically). The ending routine information is displayed on the bottom
portion of the screen and a new total is displayed in the lower right (running total of all line-item
extensions plus tax, plus freight, etc.). The new total is initially equal to the purchase order total
amount, but is redisplayed whenever an adjustment (tax, freight, etc.) is made in the ending routine.
At the end of the ending routine, the new total represents the total amount of the purchase order.

You must first print the PO before you can receive it. You can independently receive line items on
purchase orders into inventory. In other words the entire PO does not have to be complete before line
items can be put into the inventory control or sales order systems. As you receive the goods on the PO
lines, enter them into the system through Receipt Entry. When you run the Receipt Register, the
system updates each PO line items’ status to partially received or complete. When all the line items
have been completed the register moves the entire PO to the past purchase order file.

Tip: When you press Enter or Tab, the additional inputs that appear, such as reference number,
freight Code, a buyer code, etc., depend on the settings selected in PO Entry Options F/M. This topic
details all possible entries. Most of these entries already display default information; you can modify
these values.

Input Descriptions

Use the following input descriptions to enter information for purchase order footers.
1. Memo

In the purchase orders static control record you establish the summary memo.
The memo may include special instructions, good will messages, etc., and prints
on the purchase order. Press Enter to initially default to the standard memo. If
no memo is desired, press the space bar before pressing Enter. Press F4 to back
up to the prompt-selection input.

2. Freight

Through the Include Freight flag in the purchase orders static control record,
you establish whether freight is to be entered. If the flag is set to N, no freight is
included and this input is skipped. If freight is included, enter the freight
amount (.00-9999.99). Press Enter to default to 0.

3. Tax % (Percent)

Through the Include Tax flag in the purchase orders static control record, you
indicate whether tax should be entered. If the flag is set to N, no tax is included
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and this input is skipped. If tax is included, enter the tax percent. The amount
is calculated and displayed. If the Change By Line Taxable flag in the purchase
orders static control is set to N then only items with the taxable flag in the
inventory item file set to Y are subject to tax, otherwise only those lines thata Y
was entered for Lead Time are subject to tax.

4. Print Purchase Order Now/Add To Reprint File

Enter Y to print the purchase order now or N to save for batch/printing. If the
PO has already been printed then the prompt asks you if the PO should be
added to the PO reprint file. Press Enter to default to N.

This completes the ending routine of the Purchase Order Entry program. The
purchase order is printed if that option is selected. Upon completion of the
update, the screen is cleared of all input information and the program returns to
the purchase order number input #1 to await further entries.

See Also

PO Entry (POE120)

PO Entry Header Information

PO Entry Items Information

PO Entry Menu Options

How to enter or change purchase orders information
Line Detail for Purchase Order Screen

Header Detail for Purchase Order Screen
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PO Entry Features and Procedures

PO Entry Header Processing

Creating document numbers

The system automatically creates a document number once you complete the
header. At that point, the document number appears in the title bar along with
the vendor’s name. You can also assign a document number manually if you
prefer.

To assign document numbers manually:

1. Open Purchase Order Entry.

2. Graphical users: Choose File>New Document Number from the menu.
Character users: Press F10 and select File=>New Document Number from
the menu.

3. Enter up to six characters to create a document number. Choose OK or
press Enter (CR).

4. Begin entering the order, starting with the Vendor Number. Refer to the
How to enter or change purchase orders information procedure for
additional information.

Creating Direct Ship POs

To access the Warehouse/Direct Ship Selection dialog box to create a direct shipment, select L8 icon
or press F1. If the PO is a direct ship, enter the warehouse that is to be the initiating warehouse. The
warehouse entered for a direct ship is stored only to determine where the PO originated; inventory
guantities and restocking controls are not affected. This becomes the ship-to address on the purchase
order. You can press F4-backup and override the address, or continue to back up to the warehouse
prompt.

Importing Suggested Purchase Order

After the PO number is assigned, the system checks the suggested orders file for suggested orders for
the selected vendor and warehouse to automatically add to the purchase order. If the system finds
suggested purchase orders it displays the message: Suggested orders on file. Do you want to import? (Y
or N) If no suggested orders exist, this input is skipped. If you enter N, the cursor goes to the line-item
portion of the screen. If you enter Y, the system displays the first line item to import. Press Enter to
import the displayed line, F1 to skip the line item and display the next, F2 import all line items, or
press F3 to end imports. The system adds one line item for each item in the suggested purchase orders
file and adds to the weight and total dollar amount in the header of the purchase order.
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Opening existing documents

Access an existing document before you begin entering a new one. Once you begin entering header
information, the system does not allow to you open a document in the same window. You can also
start another session of FACTS if you need to open a document while you are in the middle of entering
one.

To open an existing purchase order:

Enter the purchase order number in the Doc/Vendor input and press Enter (CR). If the document
number is on file, the vendor number appears in the input and the purchase order number appears in
the title bar.

OR

1. Graphical users: Choose File->Open Existing Document.
Search Tips:

Press F2 or select the # icon to perform a document search by vendor.
You can also search by purchase order number and warehouse. To search

']
for purchase order documents, select the L= jcon.

Character users: Press F10 and choose File>Open Existing Document.

2. Use the Document Search window to find the document you want to edit
or review.

3.  Choose OK in the search window to select the document and return to the
main entry window.

Deleting purchase orders

Deleted purchase orders are not simply removed from the file. The system deletes purchase order line
item records and if all the line items for a purchase order are deleted, then it changes the header
record status to deleted. The purchase order then appears on the next purchase orders Receipt
Register as deleted and is removed in the subsequent update. This procedure provides a complete
audit trail of all purchase order numbers used.

At any point during the PO entry-receipt process, you can view in detail the PO in its current state or
its overview (history since it was entered) status via the PO Vendor Inquiry or Document Inquiry
programs.

To delete an order before the header is complete:

Press F4 to back up to the Doc/VVendor input.

To delete an order after the header is complete:

With the purchase order open on screen,

Graphical users: Choose File->Delete Document from the menu.

Character users: Press F10 and choose File> Delete Document from the menu.
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PO Entry Items Processing

Editing Line Items

You can edit line items on a purchase order until it is received.

To edit an existing line item:

Use your mouse or arrow keys to highlight the line in the item browser and press select the [ icon to
make changes for the highlighted line item. Enter (CR).

OR

Highlight the line and press Line Detail to access inputs that do not appear in the line-item entry
section.

Deleting Line Items

Use the mouse or arrow keys to highlight the line in the item browser.

Graphical users: Select the # icon to delete the highlighted PO line, or choose Edit->Delete Item from
the menu.

Character users: Press F2-Delete line and then choose OK to delete the item.

Inserting Line Items or Memos

Use the mouse or arrow keys to highlight a line. The program inserts the new line item above the
selected one.

Graphical users: Select the = button to add a line item above the highlighted item in the browser, or

choose Edit->Insert Line from the menu. Select the Q icon to stop entering line items.

Character users: Press F1-Insert line or press the Insert key. The program stays in Insert mode until you
press F4 from the Item Number input or choose the Cancel button at the right of the screen.

FINDING ITEMS IN THE ITEM BROWSER

This feature may be helpful when you need to find an item you entered on a long order. It eliminates
the need to scroll up and down in the list browser.

Graphical users: Choose Edit->Find Line Item from the menu.
Character users: Press F10 and choose Edit->Find Line Item.
Enter the item number you want to locate. Press Enter (CR) to go to the first occurrence of that item in

the item browser on the main screen. Press F2 to find a different item or F4 to exit the Find Item
window.
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Adding Line Items

1. Select the ®® icon to add a PO line. The system displays the Line Detail for Purchase Order
screen, which is used to view and modify item descriptions, promise and request dates, item details,
item/vendor info, and item cost info.

‘& The program automatically switches to add mode once you complete the header. This means the
cursor appears in the Item Number input after you exit the last header input. The program stays in

add mode until you press F4 to back out of the line-item entry section or press the Q button at the
right of the screen.

‘& Quick entry tip: Enter the item number, the ordered quantity and then press the Down Arrow
key.

2. The program uses the default information in the rest of the line-item entry inputs and returns to
the Item Number input.
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How to enter or change purchase orders information

1.

Access this program by choosing Purchase Orders ->Purchase Order Entry = PO Entry.
Complete steps 2-6 to enter purchase order header information

In the Doc/Vendor field, enter the vendor for the purchase order. If you need to change or delete an
existing purchase order, enter the existing purchase order number in this field to open it.

You can enter purchase order numbers or have them automatically assigned by the system. For manual
purchase order numbers, enter any number up to 99999. The system displays information for purchase
order numbers already on file and goes to the prompt-selection input. To use automatic purchase order
numbers, press Enter, and the system assigns the next available number. The word NEXT is displayed
until the header portion is completed.

Graphical Users: To assign a specific purchase order number, select File-->New Document Number to
access the Assign PO Number dialog box. You can enter the PO number to assign, or the system assigns
the next available number if you click the Assign Next Doc icon. When you complete your header
information, if you have chosen the PO number yourself, the system displays the assigned PO number at
the top of the screen.

Character Users: To use the next system purchase order number, simply enter vendor number, and the
next purchase order number will be assigned when you complete the header information. To assign the
number of your choice, press F10 to display the menu options, then select File-->New Document Number.
You can enter the PO number to assign, or use the Assign Next button if you decide to have the system
assign the next available number. When you complete your header information, the system displays the
assigned PO number at the top of the screen. You can also press Enter to automatically assign the PO
number when you complete your header information.

To Search:

Character Users: Press F2 to perform a vendor search. You can also search by contact name and alphabetic
sort. Press F3 to search for documents by purchase order number. To search for PO number for a specific
vendor, enter the vendor number in the vendor input (#3) on the screen. Enter a valid vendor code to
display all the purchase orders for that vendor. You can then select a PO for editing, or press F4--backup
to return to the purchase order number input (#1).

You can:

Press Enter to continue listing, select a line number of a document on the screen, or
press F3 to change warehouses for the search, or

press F4 to back up to input #1.

Search Tips:
Press F2 or select the # icon to perform a document search by vendor. You can also search by purchase

'}
order number and warehouse. To search for purchase order documents, select the = icon.

Enter a valid vendor code to display all the purchase orders for that vendor. You can then select a PO for
correction or inquiry, or press F4--backup to return to the purchase order number input (#1).

You can:
Press Enter or double click to select a line number of a document on the screen, or
Press F4 to back up to input #1.

(Optional) To access the Warehouse/Direct Ship Selection dialog box to create a direct shipment, select the

bE
®uH jcon or press F1. If the PO is a direct ship, enter the warehouse that is to be the initiating warehouse.
The warehouse entered for a direct ship is stored only to determine where the PO originated; inventory
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guantities and restocking controls are not affected. For new purchase orders, enter the code of the vendor
from whom you are requesting the items.

4. If you enter a valid vendor code, the system displays the vendor name and address, ship-to and ship-from
warehouses, and terms code. The system displays the Vendor Info dialog box, which contains the
vendor’s message, balance, the user’s customer number from the vendor, contacts 1 and 2, and the phone
number.

You can modify these fields.
Ship-From--Enter the vendor ship-from number. Press Enter to default to SAME. Press F2 to search.

Ship-To Warehouse--Enter the warehouse code where the goods should be shipped. The entry must be a
valid warehouse. If you enter a valid warehouse code, the system displays the warehouse, name and
address from the warehouse control record. Once the address displays, you can back up and change any
line of the name or address. If the PO is a direct ship, then enter the warehouse that is to be the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine where the PO originated;
inventory quantities and restocking controls are not affected. This becomes the ship-to address on the
purchase order. You can press F4-backup and override the address, or continue to back up to the
warehouse prompt.

5. In the Ordered Date (entry date of the PO), Request Date (requested date of delivery), and Promise Date
(date the vendor promises delivery) fields, the system displays the current date as the default. You can
modify this date, or press Enter to accept the current date.

Terms--Enter a valid payment terms code for this purchase order. Press Enter to initially default to the
code for the selected vendor from the vendor file. When you enter a valid code, the system displays a
partial description. Press F2 to search.

6. The system displays an optional information dialog box, which is used to enter information in the
following fields:

Freight—Indicate whether freight is B-bill later, P-prepaid , C-collect or A prepay/add. Press Enter to
default to the freight code in the ship-from file (if specified) or the freight code entered in Vendor F/M for
the selected vendor. Also, if the ship-from is changed from any value to SAME, the freight code reverts
back to the vendor default freight code.

Buyer--Enter a valid buyer code to identify the buyer for the purchase order. When you enter a valid
buyer code, the system displays a partial description. Press Enter to initially default to the buyer code in
the ship-from file for the selected vendor (if the ship-from is SAME then the default comes from the IC
warehouse/vendor review record). Press F2 to search.

Ship Via--Enter up to 15 characters for the carrier. Press Enter to initially default to the ship via in the
ship- from file for the selected vendor.

Lead Time--Select the Lead Time checkbox to indicate whether the lead-time from this document (humber
of days from the ordered date to the date of the first receipt) should update the average lead-time for the
item in the warehouse/item file. The system performs this update during the Receipt Register update.

F.O.B.--Enter up to 15 characters for freight on board. Press Enter to initially default to the F.O.B. in the
ship-from file for the selected vendor.

Reference Number-Enter the optional reference number (up to 15 characters). For direct ship orders,
press Enter to initially default to the related SO number.

When you are have completed these fields, press the OK button.

7. After the PO number is assigned, the system checks the suggested orders file for suggested orders for the
selected vendor and warehouse to automatically add to the purchase order. If the system finds suggested
purchase orders it displays the message: Suggested orders on file. Do you want to import? If no suggested
orders exist, this input is skipped.
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Character Users: If you enter N, the cursor goes to the line-item portion of the screen. If you enter Y, the
system displays the first line item to import. Press Enter to import the displayed line, F1 to skip the line
item and display the next, F2 import all line items, or press F3 to end imports. The system adds one line
item for each item in the suggested purchase orders file and adds to the weight and total dollar amount in
the header of the purchase order.

Graphical Users: Press | and Enter to import the displayed line, S and Enter to skip the line item and display
the next, A and Enter import all line items, or press K and Enter to end imports. The system adds one line
item for each item in the suggested purchase orders file and adds to the weight and total dollar amount in
the header of the purchase order.

Complete steps 9-15 to enter line items on a purchase order:
In the Item field, enter the item you want to purchase.

Field Information for Items:

10
You can select the IE" icon to enter a special order line number. The system displays the Special Order
Entry dialog box where you can enter the sales order number (the Order field) from which to import a line
item. Press # to perform a special item search, i.e., searching sales orders with special order items. If the
search is not used, next enter the line number on which the line item appeared on the sales order in the
Line field. You can select the # icon to search for items.

‘& If a sales order is on hold, you cannot import special order lines from the sales order.

If the item is not a valid item, the system checks to see if it is an interchange, or if it is a vendor-item
number; if the number is an interchange or vendor-item number, the system automatically prints the valid
item number and sets its defaults. For valid item numbers, the system displays item Description 1 and
Description 2 fields so you can modify the item description lines as necessary. Press Enter to default to the
existing values in the Item F/M. When you are satisfied with the descriptions, select the OK button.

The system displays the Item Information dialog box, which contains the vendor relation, last lead-time,
vendor-item number, item class, standard package size, buying weight, and inventory quantities. The
relation is considered primary if this vendor number is stored with the item in the inventory control item
file. If not a primary relationship, the relation is considered secondary when there is record of purchase of
the item from this vendor. Otherwise, the relation is considered unlisted. The program skips to input #19.
The item is verified as being stocked or un-inventoried, unless it is tied to a sales order. Only stocked and
un-inventoried items may be added to a purchase order unless the items are tied to a sales order.

In the Units field, enter the quantity to be ordered in the displays default unit of measure. The system
displays the label for the default unit of measure for the item, such as EA or BX.

Multiple UMs

For items with multiple UMs, the system displays a dialog box where you can select to display warehouse
guantities, perform an item catalog, service item, or standard parts search. Select W to display inventory
guantities for this item that are currently in each warehouse. The warehouse number is displayed, as well
as the on hand, committed, available, backorder and on order (not including the line displayed) quantities
and their corresponding units of measure.

The system displays the Cost info dialog box for the item. This dialog box contains the manual item cost,
the manual vendor cost, and the last vendor cost.

In the Cost field, enter the cost per displayed costing unit of measure. The system displays (if on file): the
manual cost from the item file, the average and last costs from the warehouse/item file, and the manual
and last costs from the vendor/item file. Depending on the Default PO Cost flag set in the PO static
control record, you can press Enter to default to the manual cost of the item from item file or the last cost of
the item from the vendor/item file. This input is only used when the Cost flag in the Purchase Orders
Entry Options record is setto Y or B.

The system displays a dialog box for items. Enter information in the following fields:

Requested--This field is used only when the Requested/Promised Dates flag in the PO Entry Options
record is set to Y or B. Enter the date you want to request receipt for this item. The requested date in the
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14.

header section is the displayed default value.

Promised Date--This field is only used when the Requested/Promised Dates flag in the PO Entry Options
record is set to Y or B. Enter the date this item is promised for delivery. The requested date is the
displayed default value.

Lead Time--This checkbox is used only when the Lead Time flag in the PO Entry Options record is setto Y
or B. Select the checkbox to use this document to update the item’s lead-time in the Receipt Register. Press
Enter to default to the lead-time input in the header portion of the screen. If the quantity is a negative
amount, this checkbox is not checked and skipped.

Tax--This field is used only when the Taxable flag in the PO Entry Options record is setto Y or B. Select
the checkbox to charge tax on this line-item. Press Enter to default to selected.

GL--This field is used only when the GL Table flag in the PO Entry Options record is setto Y or B. Enter
the GL posting table to use in the Receipt Register to post this line-item to GL. Press Enter to default to the
GL posting table for the selected item in the item file. Press F2 to search.

Enter Job Number Y or N. If you select yes, the system displays the Job Posting Entry screen. Enter the
valid job number to post this entry against.. Press Enter to default to the last job number entered (if any).
Press F2 to search. For valid job numbers, the system requests cost code, can enter or search. The system
then requests a memo for the posting entry. You can indicate whether you want this memo to print on the
PO invoice. Note: If the Use Job Cost flag is set to N in the purchase orders static control record or if the
item is a special order or the purchase order is a direct ship, the system skips this input.

When you are have completed these fields, press the OK button.

15. The system returns you to the Item field to enter another line item for the

PO. You can:
Repeat steps 8-15 to enter another line item.

GUI Users:

Select the a icon to stop entering line items.

Highlight a line item and select the Line Detail button to access the Line
Detail for Purchase Order screen, which is used to view and modify item
descriptions, promise and request dates, item details, item/vendor info,
and item cost info. The system displays Job Posting Entry dialog box for
change or review.

Select the Header Detail button to access the Header Detail for Purchase
Order Screen, which is used to view and modify header information.

Select the E: icon to make changes for the highlighted line item.
Select the ¥ icon to add a PO line.
Select the #% icon to delete the highlighted PO line.

Select the = button to add a line item above the highlighted item in the
browser.

Press the Il icon to save your changes.
On the left side of the line item browser, you can select:
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L. to access Note Entry (SME710) for the item highlighted in line item

browser.

V. to access Note Entry (SME710) for the vendor specified in the program.

When you are finished with line items, select the Done button.

CUI Users:

# - Changes a line-item

L - Lists line-items

A - Adds a line-item

D - Deletes the purchase order

F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system

displays VEND or ITEM to indicate that notes are present. From the View

menu of the Warehouse transfer entry programs, you can select F10-Menu,

View, Item Notes or Vendor Notes.

16. Complete steps 18-19 to enter purchase order footer information:
17. The system displays the Footer Detail for PO Number dialog box. You can enter information in the

following fields:

Memo--Enter the memo to print on this PO. Press Enter to accept the default memo.

Freight-- If freight is included, enter the freight amount (.00-9999.99). Press Enter to default to 0. Through

the Include Freight flag in the purchase orders static control record, you establish whether freight is to be
entered. If the flag is set to N, no freight is included and this input is skipped.

Tax %-- If tax is included, enter the tax percent. The amount is calculated and displayed. Through the
Include Tax flag in the purchase orders static control record, you indicate whether tax should be entered. If

the flag is set to N, no tax is included and this input is skipped. If the Taxable flag in the PO Entry Options
record is set to N then only items with the taxable flag in the inventory item file set to Y are subject to tax,
otherwise only those lines that a Y was entered for input #24 are subject to tax.

Acknowledgement and Confirmation—Indicates you want the words Acknowledgment only or
Confirmation requested to print on the purchase order, select the appropriate checkbox.

When you are have completed these fields, press the OK button.

18. The system displays the PO Date Change dialog box; select the Update Lead Time checkbox to update the
lead-time for all line items on the PO. The Update request date and Update promised date checkboxes are
displayed only when the Change By Line Requested/Promised Dates flag in the PO Entry Options record
isset to Y or B. This dialog box also displays when you change dates in the header section of the screen.
When you are have completed these fields, press the OK button.

19. The system displays the message: Print purchase order now? Select Yes to print the PO or No to save for
batch printing. If the PO has already been printed then the prompt asks you if the PO should be added to
the PO reprint file. Press Enter to default to No.
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20. The system prints the PO if you selected to do so in step 18 and then returns you to the PO Entry header
portion of the screen.

See Also

PO Entry (POE120)

PO Entry Header Information
PO Entry Items Information
PO Entry Footer Information
PO Entry Menu Options

Line Detail for Purchase Order Screen
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H

eader Detail for Purchase Order screen

The Header Detail for Purchase Order screen provides information about the purchase order in use by
the PO Entry program. You can access it after you enter complete the header information on the PO
document. The system uses this screen to display header information for all PO Entry programs,
including PO Entry, Receipt Entry, and Non-PO Receipt Entry.

Graphical users: Use the mouse or arrow keys to select an item in the browser. Choose the Header
Detail button or select Options—>Line Detail from the menu.

Character users: Use the arrow keys to select an item in the browser. Enter H at the selection prompt
or press F10 and select Options—>Header Detail from the menu.

The Header Detail window contains all possible inputs available for the PO header. This screen is used
to view and modify header information.

Li¥ Header Detail for Purchase Order 001067
Standard
vendor | Y115 HNational Conveyors, Inc. Ship-to Whse | 0z | (Warehouse Shipm)
Ship From | ENE | Marne [DALLAS WAREHOUSE
Mational Conveyars, Inc. Address 1 |3I395 LBJ FREEWAY

3121 Industrial Park Drive Address 2 |5U|'r|;11n:ur

Atlarta, GA 30312 Address 3 |DALLAS,T}{T5234

Ordered IUQI'I?IEEIUE Reguested IUQI’I?IEDDE f-‘l Promised IUQIEEIEUUE f-‘l

Codes
Freight IP-Prepaid 'I Buyer I 300 M|Daniel5immuns
Ship Via IVENDORTRUCK Terms I 0z M|2%1I]thNet3I]
FOB  [ATLANTA Lead Time W

Reference # [7645234H346

Save |

Enter ship-fram #*, SAME, F2-Search

2-40
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L% PO Entry [POE120)
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You can modify the following inputs for a purchase order header. Use the following input
descriptions to modify information for a PO document header.

1. PO Type (This field is display only.)

The system initially skips the Type input and defaults to W. This value indicates
whether the type of shipment is W-warehouse or D-direct. A Direct PO forces you to
enter the open work order number from the sales orders file. Once the header portion is
complete, the system imports the line-items from the work order and displays them. The
default value is W.

2. Vendor (This field is display only.)

The number of the vendor for the purchase order. The system displays the vendor name
and address, and any applicable defaults: F.O.B., terms code, and department.

3. From

Enter the vendor ship-from number. Press Enter to default to SAME. Press F2 or
select the B to search.

4, Warehouse

The warehouse code where the goods should be shipped. If the PO is a direct ship, then
this is the warehouse that is to be the initiating warehouse. The warehouse entered for a
direct ship is stored only to determine where the PO originated; inventory quantities and
restocking controls are not affected. This becomes the ship-to address on the purchase
order.

5. Ship-To

The warehouse code where the goods should be shipped if it is different from the
warehouse.

6. Address 1-3

If you enter a valid warehouse code, the system displays the warehouse, name and
address from the warehouse control record. Once the address displays, you can back up
and change any line of the name or address.

In the Document Detail section of the screen, the system displays the following fields:
7.  Receipt #

Receipt numbers may be entered manually or assigned automatically by the system.
Enter the receipt number or press Enter (CR) for automatic assignment. The system
assigns receipt numbers for each purchase order beginning with 00001 and incrementing
by one for each receipt up to 00099.

8. Received

Enter the date that the purchase order was received. Press Enter (CR) to default to the
system date.

9. Buyer

Enter a valid buyer code to identify the buyer for the purchase order. Entering a valid
code displays a partial description. Press Enter (CR) to default to the buyer code in the
ship-from file for the selected vendor. Press F2 to search.
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10. Terms

Enter a valid payment terms code for this purchase order. Press Enter (CR) to initially
default to the code for the selected vendor from the vendor file. Entering a valid code
displays a partial description. Press F2 to search.

11. Department

The general ledger department number. The entry must be a valid department. Press
Enter to initially default to the department assigned to the terminal. Press F2 to search.
Note: For received POs this field is display only.

12. Freight

Enter whether freight is B-bill later, P-prepaid, or C-collect. Press Enter to default to
the freight in the ship-from file for the selected vendor.

13. Ship Via

Enter up to 15 characters for the carrier. Press Enter to initially default to the ship via
in the ship- from file for the selected vendor.

14. Lead Time

Graphical Users: Select the Lead Time checkbox to indicate whether the lead-time
from this document (number of days from the ordered date to the date of the first
receipt) should update the average lead-time for the item in the warehouse/item file.
The system performs this update during the Receipt Register update.

Character Users: Enter Y or N to indicate whether the lead-time from this document
(number of days from the ordered date to the date of the first receipt) should update the
average lead-time for the item in the warehouse/item file. The system performs this
update during the Receipt Register update. Press Enter to initially default to Y.

15. F.O.B.

Enter up to 15 characters for freight on board. Press Enter to initially default to the
F.O.B. in the ship-from file for the selected vendor.

16. Reference Number
Enter the optional reference number (up to 15 characters).

This completes the header portion of the Purchase Order Entry program. At this time,
the system automatically assigns and displays purchase order number.
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Line Detail for Purchase Order screen

The Line Detail for Purchase Order screen provides information about the highlighted item selected in
the browser in the lower portion of the entry screen. You can access it after you enter items on the PO
document.

Graphical users: Use the mouse or arrow keys to select an item in the browser. Choose the Line Detail
button or select Options—>Line Detail from the menu.

Character users: Use the arrow keys to select an item in the browser. Enter L at the selection prompt or
press F10 and select Options—>Line Detail from the menu.

The Line Detail window contains all possible inputs available for the PO line item. This screen is used
to view and modify item descriptions, promise and request dates, item details, item/vendor info, and
item cost info. When you access this screen, the system also displays Job Posting Entry dialog box for
change or review.

L® Line Detail for Purchase Order 001067
Fil= Edit Yiew QOptions GoTo Help

Itern I 1126 GRAWVITY ROLLER CONVEYER

Standard

Desc 1 |GRAVITY ROLLER COMNYEYER
Desc 2 |1 OFT LEMGTHS, 24" 2"RLR CTRE
Reguested IW Promised IW
[tem Detail
units | & i
Cost Im Mﬂ Ei Taxable [

Extension 831.950 GL Table I oo Ml Inventory

ltemifendor Info

Yendor Relation  Primary Class WHS On Hand 17 EA

LastLead Time 11 Std Pack 1 On Order 5
Vendor-ltern#  W138G-24-12 Weight 180.000 Committed 8
Primary Yendor Y115

ZostInfo
Manual item Cost 166.39 EA Avg Whseltern Cost 166.390
Manual vendor Cost 166.39 LastWhse/ltern Cost 166.390

LastWendor Cost 166.39

Save |

Update lead time?
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L PO Entry (POE120) _ (O] =]
Help
81-Demo Company Purchase Order Entry PO # 661867 POE124

rLine Detail for Purchase Order 801067
Item 1126 GRAUITY ROLLER COMUEYER
Desc 1 GRAVITY ROLLER COHUEYER

Desc 2 18FT LEMGTHS, 24"W/ 12" RLR CTRS

Requested 99/17/2002 Promised 09/28/2002

— Item Detail

Units 3 Lead Time ¥

Cost 166.398 EA Taxable Y

Extension 831.958 GL Table G681 Inventory

— Item/Uendor Info
Uendor Relation Primary Last Lead Time 11 VUendor-Item#t WI38G-24-12

Class WHS Std Pack 1 Weight 180._08008 Primary Uendor U115

On Hand 17 On Order - Committed % EA

— Cost Info

Manual Item Cost 166.39 Whse/Item Cost: Average 166.3980 Last 166.398
Uendor Cost: Manual 166 .39 Last 166.3% ERA

Standard

F2-Edit, F3-Save, Fi8-Menu .

Entry

Use PO Static Control F/M (POF980) to determine which inputs should appear during PO line item

processing.

The system uses this screen to display line item information for all PO Entry programs, including PO

Entry, Receipt Entry, Non-PO Receipt Entry, and Invoice Receipt Entry.

You can modify the following inputs for a purchase order line. Use the following input descriptions to

modify information for a PO document line.

1. Descriptions

Graphical Users: For valid item numbers, the system displays item Description 1 and
Description 2 fields so you can modify the item description lines as necessary. Press
Enter to default to the existing values in the Item F/M.

Character Users: The system initially skips this input except for memo lines. Enter the
item descriptions or memo. If you enter memo lines, the system skips the remaining
inputs. Otherwise, after entering description 1, enter description 2. Press Enter to
default to the existing values in the Item F/M.

2. Units
The quantity ordered in the item’s default UM.
3. Requested

This input is used only when the Requested/Promised Dates flag in the Purchase
Orders Entry Options record is set to Y or B. The date you want to request receipt for
this item. The requested date in the header section is the displayed default value.

4. Promised Date

This input is only used when the Requested/Promised Dates flag in the Purchase
Orders Entry Options record is set to Y or B. The date this item is promised for
delivery. The requested date is the displayed default value.
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5. Units
The quantity of the item on the PO line.
6. Cost

The cost per displayed costing unit of measure. The system displays (if on file): the
manual cost from the item file, the average and last costs from the warehouse/item file,
and the manual and last costs from the vendor/item file. Depending on the Default PO
Cost flag set in the PO static control record, pressing Enter to default to the manual cost
of the item from item file or the last cost of the item from the vendor/item file.

The system also displays Contract to indicate whether the displayed cost is from
a contract.

You can access cost details from the View - Cost Origin menu option.
7. Lead Time

Character Users Enter Y or N to use this document to update the item’s lead-time in the
Receipt Register. Press Enter to default to the lead-time input in the header portion of
the screen. If the quantity is a negative amount, this input is set to N and skipped.

Graphical Users: Select the checkbox to use this document to update the item’s lead-
time in the Receipt Register.

8. Tax

Indicates whether to charge tax for the line item.
Character Users: Press Enter to defaultto Y.
Graphical Users: Select the checkbox to charge tax for the line item.

9. GL (Posting Table)

This input is used only when the GL Table flag in the Purchase Orders Entry Options
record is set to Y or B. Enter the GL posting table to use in the Receipt Register to post
this line-item to GL. Press Enter to default to the GL posting table for the selected item
in the item file. Press F2 to search.

11. Job Number

The valid job number to post this entry against. For valid job numbers, the system
displays the job name, customer number and name, and billing type. Press Enter to
default to the last job number entered (if any). Press F2 to search.
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PO Print (POP110)

Function

This program allows the user to (re)print purchase orders in the purchase order
file.

The printed orders include all pertinent header and line-item information,
addresses and totals.

The user has the option to:

Print an alignment check.

Print all purchase orders not yet printed.

Can also print selected purchase orders not yet printed.
Reprint selected purchase orders.

Reprint all purchase orders in the reprint file.

Select warehouse(s) to print.

Ooooogo

The printing format of the purchase order is determined through the purchase
orders static control file maintenance. The depth of the purchase order is
determined as well as whether the form is preprinted. If the vendor has a
vendor ship-from address on file, this address is printed on the purchase order
rather than the accounts payable vendor address.

‘& A word about vendor-item numbers: You can select to print only the
vendor-item number (and not the FACTS item number) on the PO. If you elect
to do this and the item on the PO does not have a vendor-item number setup in
the FACTS system, then the system prints blanks on the PO in that column,

2To print an alignment or test page, select Print Options, ->Print Alignment. In
character mode, enter A at the selection prompt.

User Inputs

The following inputs are involved in printing purchase orders:
1. Print Or Reprint

Enter whether purchase orders are to be P-printed or R-reprinted. CR defaults
to P.

2. Warehouse

Enter up to twenty 2-character warehouse codes side by side to print. The
program defaults to the warehouse assigned to the terminal. F3 defaults to
ALL.

3. Document Number

Enter the purchase order number(s) to be (re)printed, one at a time. Each entry
must be a valid purchase order number. Received, deleted or voided purchase
orders may not be printed. Press CR to print all unprinted purchase orders or
all documents in the reprint file.
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L2 PO Print [FPOP110)
Template  Print Options

P - Print -

Help

FrintiReprint

Warshouse |01
PO EI dh | <= Al
Template Printer
termplate 2 Remote Printer /MWindx

#h | &| atiantaWwarehou:

Cancel

Purchase Orders—7.40

IS B3

L# PO Print (POP110)
Help

I[=] E3

81-Demo Company PO Print

Print/Reprint F Print
Warehouse Atlanta Wa

PO#

Send Order{s) to the Warehouse at this time?

POP118

Technical Notes

Printing or reprinting purchase orders proceeds by reading through the
purchase orders print file (POPRTX). This record is removed and the
appropriate records in the purchase orders file (PORDER) with improper types
or status codes, i.e., not selected for (re)printing, are skipped. The word
REPRINT is prominently displayed on all reprinted purchase orders.

FILES USED - SMCNTL, APVEND, POSHIP
FILES UPDATED - PORDER, POPRTX
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Receiving (POS200)

The Purchase Orders Receiving menu allows the user to record the receipt of
goods from purchase orders and nonpurchase orders. Receipts may then be
corrected any time before the Receipt Register is updated. A PO Fill Report is
available to check customer orders to see if received purchase order items are to
be warehoused or used to fill open customer orders, and the Receipt Register
may be run providing an audit trail along with updating all receipts and
inventory quantities.

The Receiving Document Print program provides the user with a copy of the list
of goods on the original PO. This enables the user to reconcile the goods
purchased and received at the time of delivery. The entry program allows
receipt of purchase orders. Receipt numbers may be entered manually by the
user or assigned automatically by the system. The received quantity may
automatically be set equal to the order quantity or it may be entered manually.
If the purchase order number is unknown, a search by vendor may be
performed. Backordered items are allowed to remain in the purchase orders file
after receipt. Nonstocked items may also be entered. Once a purchase order is
received in full, it is no longer available through the PO Entry program.

Once a receipt is made, the user may inquire about it or make corrections to it in
purchase orders Receipt Entry. Purchase order receipts, which have been
updated by the purchase orders Receipt Register, may not be corrected.

Goods, for which no purchase order exists, may also be received. The Non-PO
Receipt entry is useful for phone orders. It allows the user to enter and receive
a purchase order at the same time. Such receipts are assigned nonpurchase
order numbers manually by the user or automatically by the system. The user
may enter either the item number or vendor-item number. Nonstocked items
may also be entered. On hand inventory items are not affected by this program.
Inventory quantities are not updated until the Receipt Register is updated.

Once receipts are entered the Document Fill Report (ICR350) allows the user to
check customer orders to see if received purchase order items are to be
warehoused for inventory or used to fill open customer orders. For additional
information about Document Fill Report (ICR350), refer to the FACTS Inventory
Control Users Guide.

Once regular and nonpurchase order receipts are entered and the optional Fill
Report is run, the Receipt Register is run to provide a complete audit trail of all
receipts. A general ledger distribution may be built and printed, if needed. The
update portion of the register updates on hand quantities along with costs,
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activities, history files and period receiving files and may also optionally update

general ledger.

\FACTS 7.4 Distribution Software - Purchaze Orders [POS000)

DISTRIBUTION SOFTWARE

Leaders in Distribution Solutions

(LM ad)

FACTS 7.4 Development- Company 01

01/05/04 - 2:52 pm

ha |

Purchase Orders

@ % e

Feceiving Invoice Receiving

% B

Reports & Prints

Inquiries End of Period

Receiving Tasks:

eceipt Entry
Maon-PO Receipt Entry
Daocument Fill Repart
Receipt Register

b

&

Cost Contracts

File Maintenanees

? Access Code I ﬁl

\Eumpan}l 01. FACTS 7.4 Development M=l E3
Help
81/65 /84 Honday Purchase Orders JLW TS5d 3:83 pm
81-FACTS 7.4 Developme Receiving FOSZ2008
1. Receiving Document Print
2. Receipt Entry
3. Hon-PD Receipt Entry
4_ Document Fill Report
5. Receipt Register
Selection
ENTER SELECTIOHW #, ACCESS CODE, "OFF', ARROWS, F4-PREVIOUS HEHU
| Y
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Receiving Document Print (POR210)

Function

This program allows the user to print a listing of the goods yet to be received
from an existing PO.

The Receiving Document Print should be run just prior to the receipt of goods.
This report enables the user to reconcile the goods arriving with those on order.

Report information includes the following: PO number, warehouse, promised
date, and vendor. For each line-item information includes; item number, item
description, quantity, unit of measure, bin location, sales order number, and line
number for special orders or the job number to post to, if one exists.

Multiple Bin Locations on Receiving Documents

If the PO Static Control F/M setting, Alternate Locations on Receiving
Document, is set to yes and the item has alternate bin locations, the Receiving
Document Print program prints a second line listing all of the alternate locations
and then prints a blank line after. If the PO Static Control F/M setting,
Alternate Locations on Receiving Document, is set to no or the item does not
have alternate locations, no additional lines print on the receiving document.

User Inputs

The following inputs are involved in printing a receiving document:

1. Purchase Order Number

Enter up to 100 purchase order number(s) to be printed, one at a time. Each
entry must be a valid purchase order number. Received, deleted or voided
purchase orders may not be printed.

Technical Notes

Printing purchase orders proceeds by reading through the purchase orders file
(PORDER). All chosen records are printed. The Vendor File (APVEND),
Customer File (ARCUST) and Sales Order File (SORDER) are accessed for
descriptive information for each PO.

FILES USED - SMCNTL, APVEND, PORDER, SORDER, ARCUST
FILES UPDATED - NONE
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;¥ Receiving Document Print [POR210]
Template  Print Optiohs

Po¢ [ N

Ok

Template Frinter

Mone Genicom Line Printer cancel |

| Enter PO to Print

;2 Win with ProvideX M= E3
Help
#1-Demo Company Receiving Document Print PORZ21d

PO L]

— Template — Printer
Hone Genicom Line Printer

CR-Run Report, F1-Template, F2-Printer, F3-Change Answers, F4-Exit .
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Receipt Entry (POE210)

Function

This program allows you to receive purchase orders created through the PO Entry program.
The PO Receipt Entry screen is very similar to the PO Entry screen. In addition to the common header
information, PO receipts include a receipt number and receipt date.

Once you receive a purchase order, it is no longer available through the PO
Entry program. However, changes to received purchase orders may be made
prior to the Receipt Register through this Receipt Entry program.

The PO Receipt Entry and Non-PO Receipt Entry programs allow more than one receipt on a PO
without running the PO receipt register in between, based on settings in PO Static Control F/M
(POF980). Using the Update feature, when the user (with proper security) accesses the footer, the
program provides the option to update the receipt, which adjusts item and warehouse quantities
during PO receipt processing. This allows the received items to be sold or shipped immediately.
Refer to the PO Receiving Feature: Multiple Receipts on a PO topic for details.

_\\Heceiving PO Document 001163 General Industrial MFG [POE210]) !E
File  Edit “iew Options GoTo Help

PO Mumber I o01163 EItheShip Warehouse |D1

Yendor I Y100 Ship-To I Receipt Number I nooo1

shipFrom | samE [ Received [05/30/2005
General Industrial MFG Atlanta Warehouse Buyer 100 ﬁl Ronald Patto
9610 Durwoody, P 685 Fulton Industrial e I 02 #4 | 2% 10th Net 3t
Suite 123-134 Aflanta, GA 33025 _I
Atlanta, GA. 30338

Lead Titme W

Itern ||1 32 lILI Steel Swivel Caster 2" dia. 125 b cap. each

Order I 2 Receive I 2 il Backord I 0 ¢r1 Cost I 23.400 B I CT

Lk | Iltem | Flags | Dlderedl Recei\redl Elad(order| LI b | Cost| Lihd | T | Ex‘tensionl 514

Hea

e — Z_-:_-'-'ll " 1 Ste g
add =
5
4 | 0|
Units: 5 Weight: 359.0 Ext: 151.98
Eip Eereph Header | Line Detail | Done |
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™\ Receipt Entry (POE210) [_ O] =]
Help

M-FACTS 7.4 Development PD Receipt Entry FO# 6011632 T U POE21d|
Uendor U188 From SAME Whse 81 Ship-To Receipt # 86661
General Industrial MFG Atlanta Warehouse Receivd 85/30/2085
9618 Dunwoody, P1. 685 Fulton Industrial

Suite 133-134 Atlanta, GA 33825 Buyer 168 Ronald
Atlanta, GA. 38338 Terms 02 2% 18th
Lead Time ¥

Item Order Receive Backord Cost

1138 3 3 8 EfA 35 .868 EA

Heavy Duty Dock Bumper vertical unit, 6" 28 x 13

= {3y ITEH
LHE Item Flags Ordered Received Backorder UH Cost UM T
g81  I138 3 3 8 EA 35.868 EA U

aez 1132 2 2 8 CT 22.488 CT U
add
Units: &5 Weight: 350.48 Ext: 151.98

Header Detail, Line Detail
CR-Edit, INS, DEL, F2-Done, F18-Henu |.
=Prev, Down=Hext, Left/Right=Lines, PqUp

. Pgbn, Home, End First line

| Y

PO Receipt Entry Processing Notes

According to a flag in the PO Static Control F/M, backorders may be utilized by
the purchase orders system. Purchase orders with backordered items remain in
the purchase orders file after receipt. During the Receipt Register, the type in
the header record is changed to B for backordered and received line-items are
removed as backordered line-items remain.

The on hand quantities of inventory items are not affected by this Receipt Entry
program. Inventory quantities are updated through the Receipt Register. On
order quantities may be changed by adding or deleting line-items or by
changing the order quantity of a line-item.

Serial Numbers that have been received through Receipt Entry and that have
been tied to a Sales Order, will be posted to that Sales Order when the Receipt
Register is processed.

Once a purchase order has been received, it is no longer available through the
PO Entry program. However, changes to received purchase orders may be
made prior to the Receipt Register through this Receipt Entry program.

If the PO number is unknown, a search is provided by vendor. A receipt
number may be assigned automatically by the system or entered manually. The
received amount of each line-item may also be set by the system automatically
or set by the user. The freight and tax may also be entered. The freight may be
factored into the cost of the line-items.

PO Receipt Entry processing takes place in three main sections: header, items, and footer processing.

During processing, the system automatically displays urgent notes for vendors
and items based on your settings on the Notes tab of PO Entry Options F/M.
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Refer to the Viewing/Entering Notes from Purchase Order Programs topic in
the PO Overview section for details.

PO Receipt Entry Header Processing

The upper portion of the screen is called the header portion where you create receipt numbers. When
you enter a valid purchase order number, the system displays information in the header portion of the
purchase order and accesses the Receipt numbers input. Refer to the following procedures for more
information about PO Receipt Entry header processing:

Creating receipt numbers
Receiving Direct Ship POs
Opening existing documents
Deleting purchase orders receipts

PO Receipt Entry Item Processing

In the item section of this program, you enter received quantities for each line item. A time-saving
feature allows the entire order to be received in one step. (This is not available for serial/lot
inventory.) Refer to the following procedures for more information about Order Entry item
processing:

Add a line

Edit a line item

Delete a line item

Insert a line item or memo
Find a line item

PO Receipt Entry Footer Processing

The footer or ending routine requires some final information (freight and tax) to complete the
purchase order receipt. You cannot access the ending routine if you do not enter line items on the PO
receipt.

x
Fraight [la Facior | v ] "'l

Doc Tikal 20000, 00
i, | Lipdale | Backup |

Entes Treigh am cunt
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Qﬂl All of the features available in the PO Entry program are also available in the PO Receipt Entry

program.

1. You can enter direct shipments. Purchase orders can be direct shipped to any customer in the
Accounts Receivable system. You can also enter any new addresses for direct shipments. You

can perform a credit limit check for direct ship customers.

2. You can enter vendor/item numbers or item interchanges in lieu of inventory control item
numbers. The corresponding inventory item number is retrieved and displayed along with on

hand, on order and committed quantities.
3. You can receive serial/lot items on purchase orders
4.

Technical Notes

Upon conclusion of the header inputs, a record is written to the purchase orders
file (PORDER). After the entry of each line-item, a line-item record is written to
the purchase orders file, its sort file (POITMX) and on order quantities in the
inventory control warehouse/item file (ICWHSE) are updated. If serial/lot
items are entered, they are written to the purchase orders serial/lots file
(POLOTS) and the pending serial number file (ICLOTX).

Upon conclusion of the ending routine, the purchase orders (PORDER) and
ready-for-register (POREGX) files are updated. If the Receipt Register is in
process, the record is written to the temporary ready-for-register file (POTMPX)
instead of POREGX.

FILES USED - SMCNTL, ICALPX, APVEND, ICMAST, ARCUST, POVITX,
POVNDX, POVNIT, POSHIP, APVALX, POPAST, SOITMX, JCJOBS, JCCODE,
JCIOCX, ICINTR, ARSHIP, POPAST, ICCLSX, POVNIX, ICWHSX, PORECT,
PODSSP

FILES UPDATED - PORDER, POITMX, POREGX, ICWHSE, POLOTS, ICLOTS,
SORDER, ICLOTX, JCREFX, POTMPX, PODSSP

3-8
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See Also

PO Receipt Entry Header Information

PO Receipt Entry Item Information

PO Receipt Entry Footer Information

How to enter or change PO receipt information
How to enter PO receipt header information

How to enter line items on a purchase order receipt
How to enter PO receipt footer information
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PO Receipt Entry Header Information

You can manually enter receipt numbers, or set the system to automatically assign them. This
program for receipt processing accepts only purchase orders that have been entered and printed.
Received, deleted, voided or not yet printed purchase orders are not accepted. When you enter a valid
purchase order number, the system displays information in the header portion of the purchase order
and accesses the Receipt numbers input.

Tip: When you press Enter or Tab, the additional inputs that appear, such as reference number,
freight Code, a buyer code, etc., depend on the settings selected in PO Entry Options F/M. This topic
details all possible entries. Most of these entries already display default information; you can modify
these values.

Access this program by choosing Purchase Orders—>Receiving—>Receipt Entry.

Input Descriptions

Use the following inputs and features to set up the receipt header:

1. Purchase Order Number

Enter the purchase order number to be received. Only purchase orders that
have been entered and printed are accepted. Received, deleted, voided or not
yet printed purchase orders are not accepted. Entry of a valid purchase order
number displays the header portion of the purchase order and proceeds to the
Receipt numbers input.

If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-PO Receipt
Entry before the receipt register is run, the system displays the PO Receipts Search window with a list
of outstanding receipts for that purchase order. From this window, you can either select an existing
receipt or create a new receipt. Refer to the PO Receipts Search window for detailed information
about this feature.

To Search:

Character Users: Press F2 to perform a vendor search. Press F3 to search for
documents by purchase order number.

You can:

press Enter to continue listing, select a line number of a document on the screen,

press F2-Order to change the search method. You can select D-Document or Vendor. Enter V to
search for non-PO receipt number for a specific vendor. Then enter the vendor code to display all the
non-purchase orders for that vendor. You can then select a non-PO for correction or inquiry, or press
F4 --backup to return to the non-purchase order receipt number input (#1).

press F3-Updated PO to display Updated Purchase Order search window containing purchase
orders that been completely updated in the PO Receipt Entry or Non-PO Receipt Entry programs, if
the “Update in Receipt Entry” option is set to yes in PO Static Control F/M (POF980). If you select a
purchase order from this search, the system displays the PO Receipts Search Window where you can
select a receipt. After you select a receipt, press Enter to view the receipt.
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press F4 to back up to input #1.

Graphical Users: Press F2 or select the # icon to perform a vendor search. You
can also search by purchase order number and warehouse. To search for

purchase order documents, select the = icon. If the “Update in Receipt Entry”
option is set to yes in PO Static Control F/M (POF980), the PO Search window
contains an Updated PO button that displays the Updated Purchase Order
Search window containing purchase orders that been completely updated in the
PO Receipt Entry or Non-PO Receipt Entry programs. If you select a purchase
order from this search, the system displays the PO Receipts Search Window
where you can select to view a receipt.

2.  Vendor

The system skips this input unless you are searching for a PO by vendor (by
press F2 at the Purchase Order number input). Enter the vendor number to
search for. Entering a valid vendor displays all the purchase orders for the
vendor. Press F2 to search.

3. Ship-From

Enter the vendor ship-from number. Press Enter (CR) to default to the
displayed value. Press F2 to search.

4.  Ship-To Warehouse

This input is display-only. The warehouse displayed is where the goods are
being received.

If this PO is a direct ship, then the warehouse displayed is the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine
where the PO originated, inventory quantities and restocking controls are not
affected. The customer number and address on file in the sales order selected at
input #2 is displayed.

If entering a new PO and values for inputs #8-14 have not been entered then the
default values will be the same as if the user pressed Enter (CR) through the
same inputs. If you have entered values on the new PO and has backed up to
enter new values or elected to change or correct the header portion of an
existing PO then the values are the same as if the user selected F1-skip. If the
program does not skip to input #15, and instead stops at an earlier input, the
system could not find a valid default value for that input and the user has to
enter a valid value before continuing.

For new PO receipts, you must enter the Receipt Number, Received Date, and
select the Assume Receipt option immediately after you enter the PO number.

Graphical Users: The Receipt #, Received (Date), and Assume Receipt inputs
display in a dialog box.

5.  Receipt Number

Receipt numbers may be entered manually or assigned automatically by the
system. Enter the receipt number or press CR for automatic assignment. The
system assigns receipt numbers for each purchase order beginning with 00001
and incrementing by one for each receipt up to 00099.
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6. Received Date

Enter the date that the purchase order was received. Press Enter (CR) to default
to the system date.

At this point, you have the option to receive the entire purchase order in one
step.

Character Users: The system displays the message: Assume receipt?. Enter Y to
set all received quantities equal to the ordered quantities. Enter N to receive the
purchase order manually. NOTE: For serial/lot items to be received, the
system does not assume receipt. Serial/lot numbers must be entered and the
user is prompted to do so.

Graphical Users: Select the Assume receipt? checkbox to set all received
guantities equal to the ordered quantities. The system displays this checkbox
selected as the default. If you want to receive the purchase order manually, un-
select this checkbox. NOTE: For serial/lot items to be received, the system
does not assume receipt. Serial/lot numbers must be entered and the system
prompts you to do so

For either manual or automatic receipts, the vendor, ship-to address, buyer,
terms code, freight code, ship via, F.O.B. and reference number are displayed in
the header portion of the screen. All of these fields except vendor number,
purchase order number, and ship-to number may be accessed through the
change header routine. Each line-item is displayed including item number,
description, ordered quantity, received quantity, backordered quantity, buying
unit of measure, cost and extension. You now have the option to change, list,
add, stop receipt or delete line-items. The line-item portion of the program is
identical to the Purchase Order Entry program, with the exception of the
received and backordered quantity inputs. Extensions are calculated as
received quantity multiplied by the cost and then multiplied by the unit of
measure conversion.

NOTE: When using the change line routine, press F1 to skip a field and leave
the displayed value. At any point during inputs #8-14, you can select F3-
Defaults. Selecting F3 causes the program to display the defaults on file from
that input forward and skip to input #15.

7. Buyer

Enter a valid buyer code to identify the buyer for the purchase order. Entering
a valid code displays a partial description. Press Enter (CR) to default to the
buyer code in the ship-from file for the selected vendor. Press F2 to search.

8. Terms

Enter a valid payment terms code for this purchase order. Press Enter (CR) to
initially default to the code for the selected vendor from the vendor file.
Entering a valid code displays a partial description. Press F2 to search.

9. Freight

Enter whether freight is B-bill later, P-prepaid, C-collect or A prepay/add.

Press Enter to default to the freight code in the ship-from file (if specified) or the
freight code entered in Vendor F/M for the selected vendor. Also, if the ship-
from warehouse is changed from any value to SAME, the freight code reverts
back to the vendor default freight code.
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10. Ship Via

Enter the code that corresponds to the carrier used (up to 15 characters). The
program initially defaults to the ship via in the ship-from file for the selected
vendor. Press F2 to search.

11. Lead Time

Character Users: Enter Y or N to indicate whether the lead time from this
document (number of days from ordered date to date of first receipt) should
update the average lead time for the item in the warehouse/item file. This
updating takes place during the Receipt Register update. Press Enter (CR) to
defaultto Y.

For either manual or automatic receipts, the system displays the vendor, ship-to
address, buyer, terms code, freight code, ship via, F.O.B. and reference number
are displayed in the header portion of the screen. You can access of these fields
except vendor number, purchase order number, and ship-to number by
selecting the Header button in the lower portion of the screen. In the browser,
each line item is displayed including item number, description, ordered
guantity, received quantity, backordered quantity, buying unit of measure, cost
and extension.

12. F.OB

Enter the description for freight on board (up to 15 characters). Press Enter
(CR) initially defaults to the F.O.B in the ship-from file for the selected vendor.

13. Department

Enter a valid general ledger department number. The entry must be a valid
department. Press Enter (CR) initially defaults to the department assigned to
the terminal. Press F2 to search.

14. Reference #
Enter the optional reference number (up to 15 characters).

See Also

Receipt Entry (POE210)

PO Receipt Entry Item Information

PO Receipt Entry Footer Information

How to enter or change PO receipt information
How to enter PO receipt header information

How to enter line items on a purchase order receipt
How to enter PO receipt footer information
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PO Receipt Entry Item Information

In the item section of this program, you must also enter received quantities for each line item. A time-
saving feature allows the entire order to be received in one step. (This is not available for serial/lot
inventory.) In doing this, the system sets the received quantity equal to the ordered quantity. You can
manually change the received quantity, backordered quantity, or cost for any automatic receipt. If
items received are serial/lot items, you must enter the serial or lot numbers of the items you are
receiving.

Tip: When you press Enter or Tab, the additional inputs that appear, such as reference number,
freight Code, a buyer code, etc., depend on the settings selected in PO Entry Options F/M. This topic
details all possible entries. Most of these entries already display default information; you can modify
these values.

'Iﬂl All of the features available in the PO Entry program are also available in the PO Receipt Entry
program.

According to a setting in the PO Static Control F/M program, you can use backorders in the Purchase
Orders system. Purchase orders with backordered items remain in the purchase orders file after
receipt. During the Receipt Register, the type in the header record is changed to B for backordered
and received line items are removed and backordered line items remain.

The on-hand quantities of inventory items are not updated by this program; the system updates
inventory quantities through the Receipt Register. On-order quantities can be changed by adding or
deleting line items or by changing the order quantity of a line item.

Serial Numbers that have been received through Receipt Entry and that have been tied to a sales
order, post to that sales order when the Receipt Register is processed.

Once you receive a purchase order, it is no longer available through the PO Entry program. However,
changes to received purchase orders may be made prior to the Receipt Register through this Receipt
Entry program.

Editing Lines in PO Receipt Entry programs: When you edited a line in the PO receipt entry programs
(PO Receipt Entry and Non-PO Receipt Entry), the received amount remains the default value it was
when you chose to edit the line; it does not automatically default to the ordered amount when you edit
the line.

Input Descriptions

Use the following to enter line items in the receipt entry program:

The line-item portion of the program allows entry of up to 999 line-item and
message lines to complete the purchase order.

Line numbers are assigned automatically beginning with 001 and incrementing
by one for each additional line-item up to 999. In the rare case where 999 line-
items have been entered on a single purchase order, the program proceeds to
the prompt-selection input.

1. Item Number
You have several options for this entry:

# - Enters an item number
M - Enters a memo
S . .
S or= -  Enters a special order line number
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F2or#-  Allows a search

F3or Q Ends line-item entries
ltem number

Enter any valid item number. If the item is not a valid item, the system will
check to see if it is an interchange, or if it is a vendor-item number; if either of
the latter are true the system automatically prints the valid item number and
sets its defaults.

Entering a valid item number displays the vendor relation, last lead time,
vendor-item number, item class, standard package size, buying weight, and
inventory quantities. The relation is considered primary if this vendor number
is stored with the item in the inventory control item file. If not a primary
relationship, the relation is considered secondary when there is record of
purchase of the item from this vendor. Otherwise, the relation is considered
unlisted. The program skips to input #18.

Only stocked and un-inventoried items may appear on a PO without being tied
to a sales order document.

Memo

Press M to enter a memo line. Any entry is accepted as a memo and will appear
when the purchase order is printed.

Special order

Press S to enter a special order line-item. Enter the sales order number from
which to import the line-item. F2 allows a special item search, i.e., searching
sales orders with special order items. If the search is not used, next enter the
line number on which the line-item appeared on the sales order.

In the Item Number input, enter S to enter a special order line-item. Enter the
sales order number from which to import the line-item. Press F2 to perform a
special item search, i.e., searching sales orders with special order items. If the
search is not used, next enter the line number on which the line-item appeared
on the sales order.

10
Graphical Users: You can select the k} icon to enter a special order line number.
The system displays the Special Order Entry dialog box where you can enter the
sales order number (the Order field) from which to import a line item. Press #
to perform a special item search, i.e., searching sales orders with special order
items. If the search is not used, next enter the line number on which the line
item appeared on the sales order in the Line field. You can select the # icon to
search for items.

If a sales order is on hold, you cannot import special order lines from the sales
order.

Search

Press F2 to allow a search.

Graphical Users: You can select the # icon to search for items.
End entry

Press F3 to end entry of line-items. The program then proceeds to the prompt-
selection input.
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Graphical Users: Select the Q icon to stop entering line items.

2. Descriptions

This input is initially skipped except for memo lines. Enter the item
descriptions or memo. If you enter memo lines, the system skips the remaining
inputs. Otherwise, after entering description 1, enter description 2. Press Enter
(CR) to default to the existing values.

3  Ordered (Quantity)
Enter the ordered quantity (1-999999999) for this item or select a display code.

Character Users: Enter whether to display O-ordered, C-committed or R-
restocking controls, U-usage, V-vendor or W-warehouse.

Graphical Users: You can access display information via the View menu option

Display information is described below:

O Ordered. Displays existing purchase orders for the selected item and
warehouse at a time. The display for each purchase order includes: the
purchase order number, type, status, ordered quantity, received quantity,
backordered quantity, unit of measure for the quantities, cost and its
corresponding unit of measure, the promised date and vendor number.

C Committed. Selecting committed displays more display codes on the
screen: S-sales orders, T-warehouse transfers, M-manufacturing and E-
equipment rental. Press Enter (CR) to default to S.

Selecting S displays sales orders for the selected item and warehouse at a time.
Each order shows: the document number, type, status, ordered, shipped, and
backordered quantities and corresponding unit of measure, price and
corresponding unit of measure, date and customer number.

Selecting T displays warehouse transfer tickets for the selected item at a time.
Each ticket shows: ticket number, status, requested date, shipped and received
guantities and their corresponding unit of measure, cost and its corresponding
unit of measure, date of transfer, and the warehouse the item was transferred
to.

Selecting M displays manufacturing tickets for the selected item and warehouse
at a time. Each ticket shows: the ticket number, type and status, quantity to be
manufactured and its corresponding unit of measure, scheduled date and if it is
a component item, what the item is a component of.

Selecting E displays equipment rental contracts containing the selected item.
Each contract shows: the contract number, type (C-rental contract, D-
invoice/credit memo), status (E-entered, P-printed, R-returned, I-invoiced, D-
deleted, V-voided), line number on the contract on which the item appears, date
of rental, units rented, stocking unit of measure, rental price, and rental
customer name.

R  Displays the restocking controls for the selected item. Displayed are:
restocking type, order point, line point, min stock, max stock, order quantity
method, order quantity, lead time (stored in the IC warehouse/item file), safety
allowance %, and frozen ordering controls.
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U Displays the items activity for the last six periods (for nonseasonal items)
or the previous six periods (for seasonal items), the number of days stocked out
for the last six periods and the average for both. Also displayed is the seasonal

type.

V  Displays the last purchase from each vendor that sells the item, by vendor
lines at a time. The vendor number is displayed as well as the vendor-item
number and manual cost, also from the last purchase from that vendor: the last
PO number, and the units purchased and cost with their corresponding units of
measure.

W Displays the inventory quantities that are currently in each warehouse for
this item. The warehouse number is displayed, as well as the on hand,
committed, available, backordered and on order (not including the line
displayed) quantities and their corresponding units of measure.

4. Received (Quantity)

Enter the quantity of the item received. Press Enter (CR) to set the received
guantity equal to the ordered quantity. Press F1 to skip the input.

5  Serial/Lot Number (Optional)

If the item being received is not a serial/lot number, this input is skipped. If the
item is a serial/lot item, the serial/lot numbers must be entered that are being
received. Press Enter (CR) to continue. Press F2 to enter the serial/lot number.
*For serialized items, enter one serial number for each unit being received. If
entering multiple serial numbers, enter the first serial number and press F1-
Auto Assign to have the system generate the remaining numbers. The automatic
serial number assignment will increment the last series of numeric digits found
within the entered. *For lotted items, the lot number is entered along with the
quantity. In either case, the serial/lot quantities entered must equal the amount
in the received column.

6. Backordered (Quantity)

The Allow Backorders flag in the PO Static Control F/M establishes whether
backorders are permitted. If backorders are not permitted, this input is
skipped. If backorders are allowed, enter the quantity backordered. Press
Enter (CR) to allow the backorder quantity to be set equal to the ordered
guantity minus the received quantity. This input is only used when the
Backordered flag in the Purchase Orders Entry Options record is set to Y or B.

7. Cost
Enter the cost per displayed costing unit of measure.

Press F2 to search for cost contracts for the vendor/item combination. If the
current cost is not a contract or the standard PO cost, the cost search program
will highlight the default cost, otherwise the cost currently on the line will be
highlighted.

The system displays (if on file): the manual cost from the item file, the average
and last costs from the warehouse/item file, the manual and last costs or the
contract cost (if available) from the vendor/item file. Depending on the Default
PO Cost flag set in the PO static control record, pressing Enter to default to the
manual cost of the item from item file or the last cost of the item from the
vendor/item file. This input is only used when the Cost flag in the PO Entry
Options record is setto Y or B.
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When a new line is being created, the system automatically calculates the
default cost. After the cost is entered, the system captures the origin of the cost.
If you select a cost other than the default cost, the system sets the cost override
flag. The system also displays Contract to indicate whether the displayed cost is
from a contract.

You can access cost details from the View - Cost Origin menu option.

8. Requested
The system displays the date requested from the PO receipt header information.

9. Promised
The system displays the date promised from the PO receipt header information.

10. Lead Time

This input is used only when the Lead Time flag in the Purchase Orders Entry
Options F/M is setto Y or B.

Character Users: Enter Y or N to use this document to update the item’s lead
time in the Receipt Register. Press Enter (CR) to default to the lead time input in
the header portion of the screen. If the quantity is a negative amount, this input
is set to N and skipped.

Graphical Users: Select the checkbox to indicate you want to update the item’s
lead time in the Receipt Register. Press Enter (CR) to default to the lead time
input in the header portion of the screen. If the quantity is a negative amount,
this input is skipped.

11. Tax

Character Users: This input is used only when the Taxable flag in the Purchase
Orders Entry Options record is set to Y or B. Enter Y or N to charge tax on this
line-item. Press Enter (CR) to defaultto Y.

Graphical Users: Select the checkbox to indicate you want to charge tax on this
line-item.
12. GL

This input is used only when the GL Table flag in the Purchase Orders Entry
Options record is set to Y or B. Enter the GL posting table to use in the Receipt
Register to post this line-item to GL. Press Enter (CR) to default to the GL
posting table for the selected item in the item file. Press F2 or # to search.

13. Extension
The line-item extension is calculated and displayed.

This concludes an entry in the line-item portion of the Receipt Entry program.
The running totals for weight and dollar amount are updated and displayed.
The line number is incremented by one, displayed, and the program returns to
the next line-item entry if in add mode or the prompt-selection input in change
mode.

Following the entry of the last line-item, the prompt-selection input allows the
user to perform a number of functions:

# - Changes a line-item
L - Lists line-items

A - Adds a line-item
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S - Stops receipt of purchase order
- Deletes the purchase order
F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View menu
of the Warehouse transfer entry programs, you can select F10-Menu, View, Item
Notes or Vendor Notes.

Graphical Users: Select the Q icon to stop entering line items.

Highlight a line item and select the Line Detail button to access the Line Detail
for Purchase Order screen, which is used to view and/or modify item
descriptions, promise and request dates, item details, item/vendor info, and
item cost info. The system displays Job Posting Entry dialog box for change or
review.

Select the Header Detail button to access the Header Detail for Purchase Order
screen, which is used to view and modify header information.

Select the E: icon to make changes for the highlighted line item.
Select the ¥ icon to add a PO line.
Select the #% icon to delete the highlighted PO line.

Select the = button to add a line item above the highlighted item in the
browser.

Press the Il icon to save your changes.

On the left side of the line item browser, you can select:
1. to access Note Entry (SME710) for the item highlighted in line item browser.

V. to access Note Entry (SME710) for the vendor specified in the program.

When changing a line-item - after changing the line-item information
displayed on the screen, the job cost information appears if the Use Job Cost
flag is set to Y in the static control record and if job cost information was entered
for the line-item in the PO Entry program. In the job cost prompt, you can press
Enter (CR)to continue, F2 to change job cost information or D-to delete job cost
information. If press Enter (CR) to continue, you can then press Enter (CR) to
accept the line or enter J to return to the job cost prompt. If you presses F2 to
change the entry, you can enter N or Y to indicate whether to print the memo on
the job cost invoice, or you can press F4 to back up to the job cost information
entered to make corrections or changes. If D to delete the job cost information is
used, enter the N or YES to indicate whether to delete.
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If entering or changing job cost information, the following inputs are used:

14. Job Number

Enter the valid job number to post this entry against. Entering a valid job
number displays the job name, customer number and name, and billing type.
Press Enter (CR) to default to the last job number entered (if any). Press F2 to
search.

15. Price Message

If the job is a fixed contract or time and materials contract, this input is skipped.
If the job is a cost plus (+) contract or a no charge contract, a message is
displayed indicating the price which must be billed for the job. Press Enter
(CR) to default to continue.

16. Cost Code

Enter a valid cost code (up to four characters). Entering a valid cost code
displays the cost code description and the cost type. The cost code sets the
defaults for markup method (for all jobs that are not cost plus) and billing rate
(for jobs that are fixed contracts or time and material). The cost code also
determines whether the user is able to override the defaults. Press F2 to search.

The item entry determines the units, unit of measure and cost rate/extension.

17. Markup

This input is initially skipped and set to the markup assigned to the cost code.
This may only be entered for jobs that are time and materials or fixed contracts
and the Allow Override Of Billing flag is set to Y in the cost code record. This
may also be changed for no charge jobs but the bill rate is not affected.

Enter the markup method to use for this posting entry. You have the following
options:

#  Enter the markup amount (0-9999999.99). Entering a number tells the
system to mark up the cost by a dollar amount. The system marks up the cost
rate by the dollar amount and calculates the bill extension.

#+% Enter the percentage (0-9999999.99%) to mark up the cost. To enter
a percentage, the user must enter an amount and then the percentage sign. If no
percentage sign is present, the system assumes the entered amount is a dollar
amount. The system marks up the cost rate by the percentage amount and
calculates the bill extension.

M  Enter the bill rate/extension manually. Entering M displays the word
MANUAL and the program proceeds to the Bill Rate input.

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

Enter (CR) initially defaults to the markup method (amount/percentage) from
the cost code record.

18. Bill Rate

This input is unavailable if the Allow Billing Override flag in the cost code
record is set to N. This input is initially skipped unless the markup method of
the cost code is manual. Enter the price per displayed unit of measure. The bill
extension is calculated and displayed. Press Enter (CR) to initially default to 0.

19. Memo
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Enter the memo to post for this job cost transaction and to print on the job cost
invoice (if applicable - see next input). Press Enter (CR) to initially default to
blanks.

20. Print Memo On Job Cost Invoice?

This input is initially skipped and set to N. Enter N or Y to indicate whether to
print the memo (entered in the previous input) on the job cost invoice. The
input may only be set to Y if the billing detail for the cost type (that the cost
code is assigned to) is set to A for all transactions in the Job Entry program.
Press Enter (CR) to initially default to N.

21. CR-Continue, F2-Change Entry, D-Delete Entry

Press Enter (CR) to continue, accept the line and return to the prompt-selection
input.

See Also

Receipt Entry (POE210)

PO Receipt Entry Header Information

PO Receipt Entry Footer Information

How to enter or change PO receipt information
How to enter PO receipt header information

How to enter line items on a purchase order receipt
How to enter PO receipt footer information
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Receipt Entry Footer Information

The footer or ending routine requires some final information (freight and tax) to complete the
purchase order receipt. You cannot access the ending routine if you do not enter line items on the PO
receipt. In the Footer for Purchase Order dialog box, the system displays a new total (running total of
all line-item extensions plus tax, plus freight, etc.). The new total is initially equal to the purchase
order total amount, but is redisplayed whenever an adjustment (tax, freight, etc.) is made in the
ending routine. At the end of the ending routine, the new total represents the total amount of the
purchase order same as above.

Input Descriptions

The ending routine consists of final inputs prior to completion of the purchase order receipt. The
ending routine is not accessible if no line-items have been entered. Ending routine information is
displayed on the bottom portion of the screen and a new total is displayed in the lower right (running
total of all line-item extensions plus tax, plus freight, etc.). The new total is initially equal to the
purchase order total amount, but is redisplayed whenever an adjustment (tax, freight, etc.) is made in
the ending routine. At the end of the ending routine, the new total represents the total amount of the
purchase order same as above.

1. Freight

Through the Include Freight flag in the purchase orders static control record,
the user establishes whether freight is to be entered. If the flag is set to N, no
freight is included and this input is skipped. If freight is included, enter the
freight amount (.00-9999.99). Press Enter (CR) to default to 0. Press F4 to back
up to the prompt-selection input.

2. Factor

Enter the means to factor the freight; i.e., divide the freight equally over the line-
item costs. The freight factor is stored and not displayed in the screen. The
freight factor is applied to the cost of line-items during the Receipt Register.
Enter U-to divide the freight by the total units, W-to divide the freight by the
total pounds, $-to divide the freight by the dollar amount, or N-to not factor the
freight at all. Press Enter to initially defaults to the Default Freight Factor flag
stored in the purchase orders static control record.

3. Tax %

Through the Include Tax flag in the purchase orders static control record, the
user establishes whether tax is to be entered. If the flag is set to N, no tax is
included and this input is skipped. If tax is included, enter the tax percent. The
amount is calculated and displayed. If the Change By Line Taxable flag is set
to N then only items with the taxable flag in the inventory item file set to Y are
subject to tax, otherwise only those lines that a Y was entered for input #26.

Upon completion of the update, the user can select F4 to back up to input #30 or
CR to continue. If continued, the program clears the screen and returns to the
purchase order number input (#1) to await further entries.

4. Update

Accesses the optional Update feature to update the receipt, which will adjust item and warehouse
guantities. Refer to the Update Window section of the PO Receipt Entry Features and Procedures
topic for detailed information about this feature.
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See Also

Receipt Entry (POE210)

PO Receipt Entry Header Information

PO Receipt Entry Item Information

How to enter or change PO receipt information
How to enter PO receipt header information

How to enter line items on a purchase order receipt
How to enter PO receipt footer information
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PO Receipt Entry Features and Procedures

PO Receipt Header Processing

Creating receipt numbers

The system automatically creates a receipt number once you complete the header. At that point, the
document number appears in the title bar along with the vendor’s name. You can also assign a
document number manually if you prefer.

To assign document numbers manually:

1. Open Receipt Entry.

2. Enter the PO number you are receiving, and the system displays the default header information
for the PO

3. Inthe Receipt Number field, enter up to six characters to create a document number. You can
manually enter receipt numbers, or set the system to automatically assign them. .

4.  To continue receiving the PO, refer to the How to enter or change PO receipt information
procedure for additional information.

Receiving Direct Ship POs

If this PO is a direct ship, then the warehouse displayed is the initiating warehouse. The warehouse
entered for a direct ship is stored only to determine where the PO originated, inventory quantities and
restocking controls are not affected. The customer number and address on file in the sales order
selected at Vendor input is displayed.

Opening existing documents

You can access existing purchase order documents that have not been received. Once you begin
receiving a purchase order, the system does not allow to you receive a document in the same window.
You can also start another session of FACTS if you need to receive another PO while you are in the
middle of receiving one.

To receive an existing purchase order:
Enter the purchase order number in the PO Number input and press Enter (CR). If the document
number is on file, the vendor number appears in the input and the purchase order number
information displays in the header.
OR
1. Graphical users: Choose File>Open Existing Document.

Search Tips:

Press F2 or select the # icon to perform a document search by vendor. You can also search by

purchase order number and warehouse. To search for purchase order documents, select the =
icon.

Character users: Press F10 and choose File>Open Existing Document.
2. Use the Document Search window to find the document you want to edit or review.
3. Choose OK in the search window to select the document and return to the main entry window.

Deleting purchase orders receipts

Deleted purchase order receipts are not simply removed from the file. The system voids purchase
order line item records and if all the line items for a purchase order are deleted, then it changes the
header record status to deleted. The purchase order then appears on the next purchase orders Receipt
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Register as deleted and is removed in the subsequent update. This procedure provides a complete
audit trail of all purchase order numbers used.

At any point during the PO entry-receipt process, you can view in detail the PO in its current state or
its overview (history since it was entered) status via the PO Vendor Inquiry or Document Inquiry
programs.

To delete an order before the receipt header is complete:

Press F4 to back up to the Doc/VVendor input.

To delete an order after the header receipt is complete:

With the purchase order open on screen,

Graphical users: Choose File->Delete Document from the menu.

Character users: Press F10 and choose File->Delete Document from the menu.

PO Receipts Entry Items Processing

Editing Line Items Receipts

You can edit line items on a purchase order receipt.
To edit an existing line item receipt:

Use your mouse or arrow keys to highlight the line in the item browser and press select the [ icon to
make changes for the highlighted line item. Press Enter (CR).

OR

Highlight the line and press Line Detail to access inputs that do not appear in the line-item entry
section.

Deleting Line Iltems Receipts
Use the mouse or arrow keys to highlight the line in the item browser.
Graphical users: Select the # icon to delete the highlighted PO line receipt, or choose Edit->Delete

Item from the menu.
Character users: Press F2-Delete line and then choose OK to delete the item.

Inserting PO Receipts Line Items or Memos

Use the mouse or arrow keys to highlight a line. The program inserts the new line item above the
selected one.
Graphical users: Select the = button to add a line item above the highlighted item in the browser, or

choose Edit=>Insert Line from the menu. Select the Q icon to stop entering line items.
Character users: Press F1-Insert line or press the Insert key. The program stays in Insert mode until you
press F4 from the Item Number input or choose the Cancel button at the right of the screen.

Finding Items in the PO Receipt Item Browser

This feature may be helpful when you need to find an item you entered on a long order. It eliminates
the need to scroll up and down in the list browser.

Graphical users: Choose Edit>Find Line Item from the menu.

Character users: Press F10 and choose Edit->Find Line Item.

Enter the item number you want to locate. Press Enter (CR) to go to the first occurrence of that item in
the item browser on the main screen. Press F2 to find a different item or F4 to exit the Find Item
window.
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1.

Adding PO Receipt Line Items

select the ¥ icon to add a PO receipt line. The system displays the Line Detail for Purchase
Order screen, which is used to view and modify item descriptions, promise and request dates,
item details, item/vendor info, and item cost info.

‘& The program automatically switches to add mode once you complete the header. This means
the cursor appears in the Item Number input after you exit the last header input. The program

stays in add mode until you press F4 to back out of the line-item entry section or press the
button at the right of the screen.

‘& Quick entry tip: Enter the item number, the ordered quantity and then press the Down
Arrow key.

The program uses the default information in the rest of the line-item entry inputs and returns to
the Item Number input.

PO Receiving Feature: Multiple Receipts on a PO

Overview

The Update option in PO Receipt Entry and Non-PO Receipt Entry allows more than one receipt on a
PO without running the PO receipt register in between. The Update also allows on-hand inventory to
be updated during PO receipt processing. This allows the received items to be sold or shipped
immediately. Once you select the Update button and complete the security required based on your PO
Static Control F/M settings, the system updates the on-hand and committed amounts in various files
and returns you to the PO# prompt in PO Receipt Entry or Non-PO Receipt Entry for more processing.

Li® Footer ler Purchase Order 001248 ﬁl
Freight | '.I'] Facion | i ' |

Do Talal Fai LT
QK |  Updale | Backup

Enlar Te ina & madnt

% Receipt Entry (POE210) M= B3
Help

81-Specialty Distributors, InPO Receipt Entry PO# 661327 T D POE214
Vendor U181 From SAME Whse 61 Ship-To C128 Receipt # 68681

Industrial Supply Distributors HMiller's Office Equipment Co. Receivd 81/23/2803
19874 Hountain Industrial Park 36699 Wilson Way S.E.
Buyer 200 Sally F

Atlanta, GA 38335 Minneapolis, MN 54332 Terms 61 1% 18 He|
Item Order Receive Backord Cost
1132 1 1 i BY 23.488 CT

Steel Swivel Casters 2" dia. 125 LB cap. each

Item Flags Ordered Received Backorder UH Cost UM T

Footer for POH 881337 BX 23.488 CT U

add Freight 32.08 Factor H
Tax % 2.080%
Tax $ .85
Doc Total 34.39

Update
CR-Continue, F2-Edit, F4-Backup .
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Purchase Orders with receipts that were updated in PO Receipt Entry or Non-PO Receipt Entry still
need to go through the Receipt Register to update GL and invoice files. For purchase orders updated
in PO Receipt Entry and Non-PO Receipt Entry, the Receipt Register skips updating inventory but
updates all other files in the register. If a receipt was not updated in PO Receipt Entry or Non-PO
Receipt Entry, the Receipt Register updates on-hand inventory files as well as GL and invoice files.

The Update feature is controlled through a series of prompts in PO Static Control F/M (POF980). The
prompts ask if you want to implement the receipt entry update feature. If you answer is "Y" the next
prompt ask for the security code you must have to be allowed to access and use the Update. You can
also enter a password in PO Static Control F/M that will allow the Update processing if the current
user in PO Receipt Entry or Non-PO Receipt Entry doesn’t have proper security.

Displaying Purchase Orders

If you completely receive a purchase order in Receipt Entry (POE210) and Non-PO Receipt Entry
(POE220) and update it from the entry program, that PO will not appear in the PO Doc search feature
or in the Document Inquiry (POI1620) program. After you run the Receipt Register (POR230), the PO
will appear in the Past Doc search window and PO Doc Inquiry for Past Documents if the proper
controls are set in PO Static Control F/M (POF980).

If the "Update in Receipt Entry" option is set to yes in PO Static Control F/M (POF980), the PO Search
window contains an Updated PO button that displays the PO Receipts Search window containing
purchase orders that been completely updated in the PO Receipt Entry or Non-PO Receipt Entry
programs. If you select a purchase order from this search, the system PO Receipts Search Window
where you can select to view receipts.

: ﬁ Updated Purchase Order Search M= B
" Options  Export  Print

| Document | Wendor

T Starts witt | GoTo |

-Filter:
Keywords | (And| | G | ?l

In Use PO#

Shipment  WH Armaount

T
a681344 P R 01/208/2003 Whse a1 25481 .48
881378 P R 1278272002 Uhse 81 1886.88 U188 Ge
* 881376 B P B6/86/2888  Uhse a1 1527 .17 U188 Ge
861431 P R 1278572002 Whse 81 750.80 U188 Ge
a@zeze P R 81/17 /72003 Whse a1 4aa. 08 U188 Ge

oY o

QK | Cancel |

|Enter characters PO# must start with 4

Copyright © 1984-2004 Aperum, Inc. 3-27



Receiving Purchase Orders—7.40

E% Receipt Entry (POE210) [_[O]x]
Help
81-Specialty Distributors, InP0 Receipt Entry PO# T POE218
Uendor From Whse Ship-To Receipt #

Receivd

r Updated Purchase Order Search

KEYWORDS Hone AND Hone STARTS WITH Hone

Vendor A1l Tupe All Whse All

LH In Use PO# Type Stat Date Shipment WH Amount Uendor Hame
2 81344 P R 81/208/2003 Whse a1 25481.48 U188 Gener
3 ap1378 P R 12/82/2002 Whse a1 16688.88 U188 Gener
4 = ap1376 B P 86/86/2888  Whse a1 1527 .17 U188 Gener
5 aei431 P R 12785728082 Whse a1 758.088 U188 Gener
6 BeT3aF B P T1/18/28082 Whse a1 ‘“58.88 U178 Georg
r ag1352 P P 85/38/20088 Direct 61 ] U181 Indus
8 ae1355 P R 81/86/20083 Whse a1 .88 U188 Gener
9 * ae1357 P P 86/81/2888  Whse a1 .88 U188 Gener
18 = ap1358 P P 86/81/2888  Whse a1 .88 U188 Gener
ah| Be1367 P P 86705720088 Direct 61 13.16 U116 World

Enter beg PO#, F1-Set filters, *+F1-Options, F4-Backup 886886

PO Receipts Search Window

If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-PO Receipt
Entry before the receipt register is run, the system displays the PO Receipts Search window with a list
of outstanding receipts for that purchase order, an indicator that tells you whether the receipt has been
updated, the date (if any) of the update, and the received amount. When you access this window, the
receipt that has not been updated (if any) will be highlighted and listed first. After that, receipts will
be listed in descending order.

E% Receipts for PO 001431 - ¥100 [ (=] x]

Help

PO has heen completety received and updated

Receipt #

Updated L ate Recaived A

1] o
List Fram I ]

oK | EmREeERt] B Cancel |

e
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ES Receipt Entry (POE210] [_ O] %]
Help
@1-Specialty Distributors, InPO Receipt Entry PO 1Zun T POEZ21d
Uendor From Whse Ship-To Receipt #

Receivd

rReceipts for PO 881246 - U188 (POC999)
PO has been completely received and updated| Buyer

Terms
Receipt Updated Date Received Amt
T | LT Yes 61/23/2003 125600. 6008 JiS
aaee3 Yes 8572572002 -8ea
Ut Cost UK _T

UK
F3-Cancel |.
=Prev, Douwn=Next, Left/Right=Lines, PgUp

, Pqbn, Home, End First line

From this window, you can either select an existing receipt or create a new receipt.

To select a receipt, highlight and press the OK button. If you select a receipt that has been updated,
you can only view the receipt in PO Receipt Entry or Non-PO Receipt Entry. Receipts are not editable
once they have been updated in PO Receipt Entry or Non-PO Receipt Entry.

If all existing receipts have been updated, you can select the New Receipt button to create a new
receipt for the PO. All existing receipts must be updated before you can create a new receipt.

If a PO has never been updated, PO Receipt Entry or Non-PO Receipt Entry programs do not display
the PO Receipts Search window.

After you create a receipt and access the footer section of PO Receipt Entry or Non-PO Receipt Entry,
the system displays the Update option via the Update button, depending on how the update
processing inputs of PO Static Control F/M are set. Based on those settings, the system may ask for
the password you must have to be allowed to access and use the Update.

Update Window

The Update window displays the extension, freight, tax, document total and factor type entered in the
footer section for the receipt.

w PO 123456 Receipt 12345 for -10] x|

E =tenzion 1000.00
Freight 20,00 Factor  Weight

Tax 70.00

Doc Total 1090.00

Imwentory quantities will get updated and no further changes
will be allowed ta this receipt. Continue with update?

fNo- Do not update ==

Ok

Copyright © 1984-2004 Aperum, Inc. 3-29



Receiving Purchase Orders—7.40

EX Receipt Entiy (POEZ210) H= E
Help

81-Specialty Distributors, InPO Receipt Entry PO# 001337 T D POE21@
Uendor U181 From SAME Whse 81 Ship-To 128 Receipt # 06681

Industrial Supply Distributors Miller's Office Equipment Co. Receivd @1/23/20883
19874 Hountain Industrial Park 36699 Wilson Way S.E.
Buyer 206 Sally F

Atlanta, GA 38335 Minneapolis, MM 54332 Terms 61 1% 18 He|
rAttention?
Extension 2.34
Freight 32.080

Steel Swivel Tax -85
— | Doc Total 34.39 —
ae1 Inventory quantities will get updated and no 23.408 CT U
add further changes will be allowed to this receipt.

Continue with update? _

Doc Total 3439 ‘

Continue with update? (H/¥), F4-Exit

o

In the lower portion of the window the system displays the message: Inventory quantities will get
updated and no further changes will be allowed to this receipt. Continue with update?

Answer No--Do not update or Yes—Update. If you select No, the system returns you to the footer
window. If you select Yes, the update runs (with an hourglass indicator), the footer window closes,
and the system returns you to the PO prompt in the header portion of the screen to await further
entries.

Update Processing Logic in PO Static Control F/M (POF980)

Processing logic for the update processing inputs of PO Static Control F/M can be set as follows:

If Allow update in receipts is "No" — the update option does not appear at all.

If Allow update in receipts is "Yes", security code exists and no password was entered — the update
option only appears if current user has correct security code.

If Allow update in receipts is "Yes", password exists, but no security code is set — the update option
always appears but prompts the user for the password if the Update button is selected.

If Allow update in receipts is "Yes", security code exists and password exists — update option will
always appear. If current user does not have security, user will be prompted for a password when the
update option is selected.

Limitations/Exclusions

With this feature, once a receipt has been updated from within Receipt Entry or Non-PO Receipt
Entry, the PO receipt cannot be changed in any way until you run the Receipt Register. If a PO is
partially received and run through the register, it can be deleted in PO Entry, Receipt Entry, or Non-
PO Receipt Entry, and you cannot create new receipts on deleted PO’s.

If the "Store Past PO’s", "Use Period Receiving Report", and "Use Invoice Receipts"” inputs are set to No
in PO Static Control F/M, receipt numbers can be reused on backorder PO’s after the Receipt Register
is run but, not after the new update feature is run from Receipt Entry or Non-PO Receipt Entry.

The update feature updates ICWHSE, ICLEDG, ICMAST, SORSOH, SORSOL, PORPOH, PORPOL,
POVNIT, ICLOTS, POLOTS, SOLOTS, POPLTS, ICCOST, ICFUCT, ICTRAN and SOBOMS records
while the rest of the files are updated by the Receipt Register. Therefore some inquiries and views will
reflect updated information after the receipt register is run. The following files are updated by the
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Receipt Register and not the new update: PORECT, POPDRC, POPASH, JCREFX, POPASL, SMCNTL
("PON").

Currently the PO header file (PORPOH) has a 2-digit field (C5$(3,2)) that contains the number of
receipts for a PO. Note that a 5-digit receipt number is allowed in the Receipt Entry or Non-PO Receipt
Entry programs, but a PO can only have a max of 99 receipts.)
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How to enter or change PO receipt information

1  Access this program by choosing Purchase Orders = Receiving > PO
Receipt Entry.

Complete steps 2-5 to enter PO receipt header information:

2. Inthe PO Number field, enter the order number to be received. If you need to change or delete
an existing PO receipt, enter the existing PO receipt number in this field to open it. To search for

purchase order documents, select the = jcon.

If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-PO
Receipt Entry before the receipt register is run, the system displays the PO Receipts Search
window with a list of outstanding receipts for that purchase order. From this window, you can
either select an existing receipt or create a new receipt. Refer to the PO Receipts Search window
for detailed information about this feature.

3. The vendor for the PO displays in the Vendor field. For valid PO
numbers, the system displays the Ship-from, Warehouse, and Ship-to
Codes for the purchase order. The ship-from and Ship warehouse
displayed is where the goods received. If this PO is to be a direct ship,
then the warehouse displayed is the initiating warehouse. The warehouse
entered for a direct ship is stored only to determine where the PO
originated; inventory quantities and restocking controls are not affected.
The customer number and address on file in the purchase order is
displayed.

NOTE: If you do not enter a purchase order number, you can enter a valid
vendor code in the Vendor field to display all the purchase orders for that
vendor. You can then select a PO receipt for correction or inquiry, or press
F4--backup to return to the purchase order number field (#1). Press Enter
to default to D. If you select D-document, the program asks for the
beginning document number to start listing from.

You can:

Press Enter to continue listing, select a line number of a document on the
screen, or

Press F3 to change warehouses for the search, or

Press F4 to back up to input #1. The documents initially listed on the
screen are for the warehouse assigned to the terminal. If you want to see
documents for a different warehouse or for all warehouses, press F3. Once
you press F3, you have the following options: press Enter to default to the
warehouse assigned to the terminal; press F2 to search; press F3 to select all
warehouses and displays all documents on file for the user’s company, or
F4 to back up.

4.  For new purchase orders receipts, the system displays the Purchase Order
dialog box.
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In the Receipt # field, manually enter the receipt number or press Enter to
allow the system to automatically assign it. The system assigns receipt
numbers for each purchase order beginning with 00001 and incrementing
by one for each receipt up to 00099.

In the Received Date field, the system displays the current date as the
default for the date the purchase order was received. Press Enter to accept
the system date or enter the date you received this purchase order.

At this point, you can receive the entire purchase order in one step. Select
the Assume receipt? checkbox to set all received quantities equal to the
ordered quantities. The system displays this checkbox selected as the
default. If you want to receive the purchase order manually, un-select this
checkbox. NOTE: For serial/lot items to be received, the system does not
assume receipt. Serial/lot numbers must be entered and the system
prompts you to do so.

When you are have completed these fields, press the OK button.

5. For either manual or automatic receipts, the system displays the vendor,
ship-to address, buyer, terms code, freight code, ship via, F.O.B. and
reference number are displayed in the header portion of the screen. You
can access the Header Detail for Purchase Order screen to modify header
fields except vendor number, purchase order number, and ship-to number
by selecting the Header button in the lower portion of the screen. In the
browser, each line item is displayed including item number, description,
ordered quantity, received quantity, backordered quantity, buying unit of
measure, cost and extension.

Complete steps 6-16 to enter line items on a purchase order receipt:

6. Select the *¥ icon to add a line to the PO receipt.

Field Information for adding/editing items:

You can select the icon to add a special order line number. The system
displays the Special Order Entry dialog box where you can enter the sales
order number (the Order field) from which to import a line item. Press #4
to perform a special item search, i.e., searching sales orders with special
order items. If the search is not used, next enter the line number on which
the line item appeared on the sales order in the Line field. You can select
the Binocular icon to search for items.

If the item is not a valid item, the system checks to see if it is an
interchange, or if it is a vendor-item number; if the number is an
interchange or vendor-item number, the system automatically prints the
valid item number and sets its defaults. For valid item numbers, the
system displays item Description 1 and Description 2 fields so you can
modify the item description lines as necessary. Press Enter to default to
the existing values in the Item F/M. When you are satisfied with the
descriptions, select the OK button.

7. Inthe Ordered field, enter the ordered quantity for the item.
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8. Inthe Received field, enter the quantity of the item received. Press Enter
(CR) to set the received quantity equal to the ordered quantity

9. Receiving serial/Lot items:

(Optional) For Serial/Lot items, the system displays the Serial/Lot Entry #
dialog box. You must enter the serial/lot numbers you are receiving and
their quantities. *For serialized items, enter one serial number for each unit
being received. If entering multiple serial numbers, enter the first serial
number and press F1-Auto Assign to have the system generate the
remaining numbers. The automatic serial number assignment will
increment the last series of numeric digits found within the entered serial
number. *For lotted items, enter the lot number and the quantity. In either
case, the serial/lot quantities entered must equal the amount in the
received column.

You can select:

The List button to display the available serial/lot numbers and quantities
to be received.

The Add button to add another serial/lot number for the item.

The End button to stop your additions.

The OK button to accept the serial/lot numbers and quantities you have
entered. The system checks to see if you have entirely distributed the items
received.

10. Inthe Backordered field, enter the quantity of the item that was not
received. Press Enter (CR) to set the backorder quantity equal to the
ordered quantity minus the received quantity. The Allow Backorders flag
in the PO Static Control F/M establishes whether backorders are
permitted. If backorders are not permitted, this input is skipped. This
input is only used when the Backordered flag in the Purchase Orders
Entry Options record is setto Y or B.

11. Inthe Cost field, the system displays the cost per displayed costing unit of
measure. Displayed if on file is: the manual cost from the item file, the
average and last costs from the warehouse/item file, and the manual and
last costs from the vendor/item file. Depending on the Default PO Cost
flag set in the PO Static Control F/M, press Enter (CR) defaults to the
manual cost of the item from item file or the last cost of the item from the
vendor/item file. This input is only used when the Cost flag in the
Purchase Orders Entry Options record is setto Y or B.

Press F2 to search for cost contracts for the vendor/item combination. If the
current cost is not a contract or the standard PO cost, the cost search
program will highlight the default cost, otherwise the cost currently on the
line will be highlighted.

When a new line is being created, the system automatically calculates the
default cost. After the cost is entered, the system captures the origin of the
cost. If you select a cost other than the default cost, the system sets the cost
override flag. The system also displays Contract to indicate whether the
displayed cost is from a contract.

You can access cost details from the View - Cost Origin menu option.
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12. The system displays a dialog box for items. Enter information in the
following fields:;

Requested--This field is used only when the Requested Dates flag in the
Purchase Orders Entry Options record is set to Y or B. Enter the date you
want to request receipt for this item. The requested date in the header
section is the displayed default value.

Promised Date--This field is only used when the Promised Dates flag in
the Purchase Orders Entry Options record is set to Y or B. Enter the date
this item is promised for delivery. The requested date is the displayed
default value.

Lead Time--This checkbox is used only when the Lead Time flag in the
Purchase Orders Entry Options record is set to Y or B. Select the checkbox
to use this document to update the item’s lead-time in the Receipt Register.
Press Enter to default to the lead-time input in the header portion of the
screen. If the quantity is a negative amount, this checkbox is not checked
and skipped.

Tax--This field is used only when the Taxable flag in the Purchase Orders
Entry Options is set to Y or B. Select the checkbox to charge tax on this
line-item. Press Enter to default to selected.

GL--This field is used only when the GL Table flag in the Purchase Orders
Entry Options record is set to Y or B. Enter the GL posting table to use in
the Receipt Register to post this line-item to GL. Press Enter to default to
the GL posting table for the selected item in the item file. Press F2 to
search.

13. The system displays the Job Number dialog box. At the question: Enter the
job number? Answer Yes to enter valid job number to post this entry
against. Entering a valid job number displays the job name, customer
number and name, and billing type. Select No to not enter a job number
and exit the dialog box.

14. When you have completed these fields, press the OK button.

15. Youcan
GUI Users:

Select the E: icon to make changes for the highlighted line item.
Select the # icon to delete the highlighted PO receipt line.

Select the = button to add a line item above the highlighted item in the
browser.

Select the a icon to stop entering line items.

Select the Header Detail button to access the Header Detail for Purchase
Order Screen, which is used to view and modify header information.

Select the Line Detail button to access the Line Detail for Purchase Order
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CuU

16.

17.

screen, which is used to view and modify item descriptions, promise and
request dates, item details, item/vendor info, and item cost info.

On the left side of the line item browser, you can select:

L. to access Note Entry (SME710) for the item highlighted in line item
browser.

V. to access Note Entry (SME710) for the vendor specified in the program.

Press the Il icon to save your changes.

Users: You can enter:

#- Changes a line-item

L - Lists line-items

A - Adds a line-item

S - Stops receipt of purchase order
D - Deletes the purchase order

F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View

menu of the Warehouse transfer entry programs, you can select F10-Menu,
View, Item Notes or Vendor Notes.

Select the Stop Receipt button to the receipt process for this PO.

Complete steps 17-18 to enter PO receipt footer information:

Select the Done button to display the Footer for Purchase Order dialog
box. Enter information in the following fields:

Freight-- If freight is included, enter the freight amount (.00-9999.99).
Press Enter to default to 0. Through the Include Freight flag in the
purchase orders static control record, you establish whether freight is to be
entered. If the flag is set to N, no freight is included and this input is
skipped.

Tax %-- If tax is included, enter the tax percent. The amount is calculated
and displayed. Through the Include Tax flag in the purchase orders static
control record, you indicate whether tax should be entered. If the flag is
set to N, no tax is included and this input is skipped. If the Taxable flag in
the Purchase Orders Entry Options record is set to N then only items with
the taxable flag in the inventory item file set to Y are subject to tax,
otherwise only those lines that a Y was entered for input #24 are subject to
tax.

Factor--Enter the means to factor the freight; i.e., divide the freight equally
over the line-item costs. The freight factor is stored and not displayed in
the screen. The freight factor is applied to the cost of line items during the

Purchase Orders—7.40
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18.

Receipt Register. Enter U-to divide the freight by the total units, W-to
divide the freight by the total pounds, $-to divide the freight by the dollar
amount, or N-to not factor the freight at all. Press Enter to initially default
to the Default Freight Factor flag value stored in the purchase orders static
control record.

When you have completed these fields, you can :

Press the OK button to return to the PO Receipt Entry header portion of
the screen.

Press the Backup button to step back through the footer fields.

Press the Update button to update the receipt, which will adjust item and
warehouse quantities. Refer to the Update Window topic for detailed
information about this optional feature.

The system then returns you to the PO Receipt Entry header portion of the
screen.

See Also

Receipt Entry (POE210)

PO Receipt Entry Header Information
PO Receipt Entry Item Information
PO Receipt Entry Footer Information
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Non-PO Receipt Entry (POE220)

Function

Use the non-PO Receipt Entry program to receive purchase order merchandise from purchase orders
not generated through the Purchase Orders system. For example, if an order is placed over the phone
but never entered into the system, when the merchandise arrives it must be received. Such receipts are
assigned non-purchase order numbers. The non-purchase order number may be manually assigned or
automatically assigned by the system.

The PO Receipt Entry and Non-PO Receipt Entry programs allow more than one receipt on a PO
without running the PO receipt register in between, based on settings in PO Static Control F/M
(POF980). Using the Update feature, when the user (with proper security) accesses the footer, the
program provides the option to update the receipt, which adjusts item and warehouse quantities
during PO receipt processing. This allows the received items to be sold or shipped immediately.
Refer to the PO Receiving Feature: Multiple Receipts on a PO topic for details.

T\ Non-PO Receipt Entry (POE220) M=l E3
Help
M1-FACTS 7.4 Development Hon PO Receipt Entry PO# HPB117 T ¥ POE226
Uendord U188 From SAME Whse 61 Ship-To Receipt # 67877
General Industrial MFG Atlanta Warehouse Receivwd 81/788/2084
92618 Dunwoody, P1. 685 Fulton Industrial
Suite 133-134 Atlanta, GA 33825 Buyer 186 Ronald
Atlanta, GA. 308338 Terms 02 2% 18th
Item Order Receive Backord Cost
Hotes: [ll=;))]
LH#t Item Flags Ordered Received Backorder UM Cost T U
add

Ext: -8

Enter item number {M=Memo), F1-Special Order, F2-Search, F3-End, F18-Menu
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T\ Mon Purchase Order Document NPO116 General Industrial MFG (POE220) M= E3
File  Edit Wiew QOptiohs GoTo Help
wvendor vinn Fal | warehouse I 01 | Purchase Order  MPO116
Ship From SAME b I Ship-To I Receipt Number I aoom
General Industrial MFG |A1Ianta Warehouse Received |1 201152003
gﬁ?tu ?3';';"1"23”\‘ Fl. [555 Futtan Industrial Buver [ 100 # | Ronald Patto
uite =
AMlanta, GA. 30338 |Atlanta, GA 33025 Terms I 02 b I 2% 10th Met 30
Warehouse Ship |
milEE =
Itern |I1 i} 1| Pallet Loading Hand Truck 1000 |b capacity 1
Order 10 Receive I e | Backord I 0ooor Cost I 120000 © | EA |
Item Flags Ordered Recaived Backorder | Uhd Cost| T Uhd Extension | De:s i
§|:||:|'1 1100 1.0 1.0 o CcT 120000 M EA 1Z200.000 Fal Z._
add
=
[E]
|1 | 0|
Ext: 1200.00
Header | Line Detail Done |

Non-PO Receipt Entry Processing Notes

Entering a non-purchase order receipt is similar to entering purchase orders and purchase order
receipts. You must enter all header and line-item information before you can exit the document. If
you receive serial/lot items, you must also enter the serial or lot numbers.

The Purchase Order Entry processing takes place in three sections: Header, items, and footer
processing.

During processing, the system automatically displays urgent notes for vendors
and items based on your settings on the Notes tab of PO Entry Options F/M.
Refer to the Viewing/Entering Notes from Purchase Order Programs topic in
the PO Overview section for details.

Header Processing

The upper portion of the screen is called the header portion where you enter the non-PO receipt
number, vendor, order date and other general information. Refer to the following procedures for
more information about Non-PO Receipt Entry header processing:

Enter a new document

Delete a document

Open an existing document

Create a document number

After the system creates the header record, all header inputs except the purchase order number,
vendors, and Ship-From are accessible through the change header routine. The PO number, vendor,
type, and ship-from values can only be changed by deleting and re-entering the PO. Refer to the Non-
PO Receipt Header Information topic for field/Zinput descriptions.

Copyright © 1984-2004 Aperum, Inc. 3-39



Receiving

Line Item Processing
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The lower portion is called the line item portion where you enter the item number, quantity and cost.
You have the option of changing, adding, removing line items or deleting the non-PO receipt at any

time during the entry process.

Refer to the Non-PO Receipt Items Information topic for field/input descriptions.

Refer to the following procedures for more information

Add a line

Edit a line item

Delete a line item

Insert a line item or memo
Find a line item

Non-PO Receipt Footer Processing

about Non-PO Receipt item processing:

The ending routine consists of final inputs prior to completion of the non-PO receipt. The ending
routine is not accessible if you have not entered line items for the non-PO receipt. At the end of the
ending routine, the new total represents the total amount of the purchase order. Refer to the Non-PO
Receipt Footer Information topic for field/input descriptions.

LT Footer for Purchose Drder M1 246
ﬂa Facior | 4 . |

Freight

20000.00
ok |

Doc Toka

Lipdale | Backup

x|

Enter Treighi anmount

m Mon-PO Receipt Entry [POE220)

Help

81-Specialty Distributors, InHon PO Receipt Entry
Uendord U118 From SAHE Whse 61  Ship-To
Georgia Shipping Equip. Co...+ Atlanta Yarehouse
3376 Washington Ave. S.E + 685 Fulton Industrial
Suite 218 Atlanta, GA 33825
Atlanta,

GA. 308382

PO# HPB264 T U POEZ226
Receipt # 60002
Receivd 01/23/2003

Buyer 168 Ronald
Terms 1 Manual

Item order Receiuve Backord

Cost

Item Flags Ordered
Footer for Purchase Order HPB264

Received Backorder

UK
ERA

Cost
367388

T U
M E

ECLI | Freignt 12,00 Factor §
Tax % 1.080%
Tax § 3.67
Doc Total 383.86
l/pdate

CR-Continue, F2-Edit, F4-Backup .
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Additional Features

* You can enter direct shipments. Non-PO Receipts can be direct shipped to any customer in the
Accounts Receivable system. You can also enter any new addresses for direct shipments. You can
perform a credit limit check for direct ship customers.

* You can enter vendor/item numbers or item interchanges in lieu of inventory control item numbers.
The corresponding inventory item number is retrieved and displayed along with on hand, on order
and committed quantities.

* You can automatically assign serial numbers.

Technical Notes

Upon conclusion of the header inputs, a record is written to the purchase orders
file (PORDER).

With the entry of each line-item, a record is written to the purchase orders file
(PORDER), the sort file (POITMX) and the on order quantity is updated in the
inventory control warehouse/item file (ICWHSE). If serial/lot items are
entered, they are written to the purchase orders serial/lots file (POLOTS) and
the pending serial number file (ICLOTX).

Upon completion of the receipt, the purchase orders file (PORDER)and ready-
for-register file (POREGX) are updated. If the Receipt Register is in process, the
record is written to the temporary ready-for-register file (POTMPX) instead of
POREGX.

FILES USED - SMCNTL, ICAPLX, APVEND, ARCUST, ICMAST, POVNIT,
POVITX, POVNDX, POSHIP, APVALX, POPAST, SOITMX, JCJOBS, JCCODE,
JCIOCX, ICINTR, ARSHIP, POPAST, ICCLSX, POVNIX, ICWHSX

FILES UPDATED - PORDER, POITMX, ICWHSE, POREGX, POLOTS,
ICLOTS, SORDER, ICLOTX, POTMPX

See Also

Non-PO Receipt Entry Header Information
Non-PO Receipt Entry Items Information

Non-PO Receipt Entry Footer Information

How to enter or change non-PO receipt information
How to enter non-PO receipt header information
How to enter line items on a non-PO receipt

How to enter non-PO receipt footer information
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Non-PO Receipt Entry Header Information

Use the Non-PO Receipt Entry Header section to enter the purchase order number, vendor, order date
and other general information. This window contains all the possible inputs for the PO Entry Header.
You can manually enter receipt numbers, or set the system to automatically assign them. You can
enter direct shipments for non-PO receipt. You can enter memo lines for the non-PO receipt. You can
use the vendor search (press F2 in the vendor field/input point to search) to locate vendor numbers
when only the vendor name is known.

Input Descriptions

Use the following inputs to enter a non-PO receipt header:

1. PO/Vend (Non-Purchase Order Number)
Enter the non-purchase order number to be received.

If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-PO Receipt
Entry before the receipt register is run, the system displays the PO Receipts Search window with a list
of outstanding receipts for that purchase order. From this window, you can either select an existing
receipt or create a new receipt. Refer to the PO Receipts Search window for detailed information
about this feature.

To Search:

Character Users: Press F2 to perform a vendor search. Press F3 to search for
documents by purchase order number.

You can:

press Enter to continue listing, select a line number of a document on the screen,

press F2-Order to change the search method. You can select D-Document or Vendor. Enter V to
search for non-PO receipt number for a specific vendor. Then enter the vendor code to display all the
non-purchase orders for that vendor. You can then select a non-PO for correction or inquiry, or press
F4 --backup to return to the non-purchase order receipt number input (#1).

press F3-Updated PO to display Updated Purchase Order search window containing purchase
orders that been completely updated in the PO Receipt Entry or Non-PO Receipt Entry programs, if
the “Update in Receipt Entry” option is set to yes in PO Static Control F/M (POF980). If you select a
purchase order from this search, the system displays the PO Receipts Search Window where you can
select a receipt. After you select a receipt, press Enter to view the receipt.

press F4 to back up to input #1.

Graphical Users: Press F2 or select the # icon to perform a vendor search. You
can also search by purchase order number and warehouse. To search for

purchase order documents, select the = icon. If the “Update in Receipt Entry”
option is set to yes in PO Static Control F/M (POF980), the PO Search window
contains an Updated PO button that displays the Updated Purchase Order
Search window containing purchase orders that been completely updated in the
PO Receipt Entry or Non-PO Receipt Entry programs. If you select a purchase
order from this search, the system displays the PO Receipts Search Window
where you can select to view a receipt.
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Vendor

Enter the number of the vendor for the purchase order receipt. If you enter a
valid vendor number, the system displays the vendor name and address, and
any applicable defaults: F.O.B., terms code, and department. At the bottom of
the screen, the vendor’s message, balance, the user’s customer number from the
vendor, contacts 1 and 2, and the phone number are displayed. Press F2 to
search.

2. Type (this field is not displayed in GUI mode)

Character Users: The system initially skips the Type input and defaults to W.
Press F4 to back up to this input. Enter whether the type of shipment is W-
warehouse or D-direct. Entering a D forces you to enter the open work order
number from the sales orders file. Once the header portion is complete, the
system imports the line-items from the work order and displays them. Press
Enter to default to W.

To direct ship POs: Graphical Users: (Optional) To access the Warehouse/Direct

Ship Selection dialog box to create a direct shipment, select the L8 icon or press
F1. If the PO is a direct ship, enter the warehouse that is to be the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine
where the PO originated; inventory quantities and restocking controls are not
affected. For new purchase orders, enter the number of the vendor from whom
you are requesting the items.

3. Ship-From

Enter the vendor ship-from number. Press Enter (CR) to default to the
displayed value. Press F2 to search.

4. Ship-To Warehouse

Enter the number of the warehouse at which goods are received. Only a valid
warehouse code is accepted. Entry of a valid warehouse code displays the
warehouse, name and address from the warehouse control record. Once the
address has been displayed, you can back up and change any line of the name
or address.

If this PO is to be a direct ship, then enter the warehouse that is to be the
initiating warehouse. The warehouse entered for a direct ship is stored only to
determine where the PO originated, inventory quantities and restocking
controls are not affected. The address for the initiating warehouse appears
briefly as the customer number and address on file in the work order selected at
input #2 overprints. This becomes the ship-to address on the purchase order.
You can press F4-backup and override the address, or continue to backup to the
warehouse prompt where pressing Enter (CR) resets the customer and address
once again to be the address on file in the work order selected at input #2.

5.  Receipt Number

Receipt numbers may be entered manually or assigned automatically by the
system. Enter the receipt number or CR for automatic assignment. The system
assigns receipt numbers for each non-purchase order beginning with 00001 and
incrementing by one for each receipt up to 00099. The word NEXT appears as
the receipt number until all header information is entered.

6. Received Date

Enter the date that the purchase order was received. Press Enter (CR) to default
to the system date.
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NOTE: Atany point during inputs #8-14, you can select F3-Defaults. Pressing
F3 causes the program to display the defaults on file from that input forward
and skip to input #15. If entering a new PO and values for inputs #8-14 have
not been entered then the default values will be the same as if the user hit CR
through the same inputs. If the user has entered values on the new PO and has
backed up to enter new values or elected to change or correct the header portion
of an existing PO then the values remain the same as if you selected F1-skip. If
the program does not skip to input #15, and instead stops at an earlier input,
the system could not find a valid default value for that input and the user has to
enter a valid value before continuing.

7. Buyer

Enter a valid buyer code to identify the buyer for the purchase order. Entering
a valid code displays a partial description. Press Enter (CR) to initially default
to the buyer code in the ship-from file for the selected vendor, (if the ship-from
is SAME, the default comes from the IC warehouse/vendor review record).
Press F2 to search.

8. Terms Code

Enter a valid payment terms code for this purchase order. Press Enter (CR) to
initially default to the code for the selected vendor from the vendor file.
Entering a valid code displays a partial description. Press F2 to search.

9. Freight

Enter whether freight is B-bill later, P-prepaid C-collect or A prepay/add.

Press Enter to default to the freight code in the ship-from file (if specified) or the
freight code entered in Vendor F/M for the selected vendor. Also, if the ship-
from warehouse is changed from any value to SAME, the freight code reverts
back to the vendor default freight code.

10. Ship Via

Enter the ship via (carrier) (up to 15 characters). Press Enter (CR) to initially
default to the ship via in the ship-from file for the selected vendor.

11. Lead Time

Enter N or Y to indicate whether the lead time from this document should
update the average lead time for the item in the warehouse/item file. This
updating takes place during the Receipt Register update. Press Enter (CR) to
initially default to N.

NOTE: If Y is entered, there is a risk of corrupting the vendor review cycles
and order quantities. This corruption is due to the order date and receipt date
being the same. If a true order date is entered (for example the date the order
was placed over the phone) then the lead time may safely be updated.

12. F.O.B.

Enter the description for freight on board (up to 15 characters). Press Enter
(CR) to initially default to the F.O.B. in the ship-from file for the selected
vendor.

13. Department

Enter a general ledger department number. The entry must be a valid
department. Press Enter (CR) to initially default to the department assigned to
the terminal. Press F2 to search.

14. Reference Number

Enter the optional reference number (up to 15 characters).
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See Also

Non-PO Receipt Entry (POE220)

Non-PO Receipt Entry Items Information

Non-PO Receipt Entry Footer Information

How to enter or change non-PO receipt information
How to enter non-PO receipt header information
How to enter line items on a non-PO receipt

How to enter non-PO receipt footer information
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Non-PO Receipt Entry Items Information

The lower portion is called the line item portion where you enter the item number, quantity
information and cost. You have the option of changing, adding, removing line items or deleting the
non-PO receipt at any time during the entry process.

You can use the item search (press F2 in the item field/input point to search) to locate item numbers
when only the item description is known. You can enter an item’s interchange, and the system
displays the ordering item number. You can enter a vendor/item number, and the system displays
the ordering item number. You can receive non-stocked items.

You can access the Item Inquiry, which displays inventory information including the following:
movement class, seasonal status, restocking type, order point, line point, min stock, max stock, order
guantity method, order quantity, lead time (stored in the IC warehouse/item file), safety allowance %,
frozen ordering controls, inventory quantities, usage by period and average per period, previous
purchases from the displayed vendor, along with the last cost, last purchase date and lead time.

The on-hand quantities of inventory items are not affected by this Non-PO Receipt Entry program.
Inventory quantities are updated during the Receipt Register. On-order quantities may be changed by
adding or deleting line items or by changing the order quantity of a line item.

Editing Lines in PO Receipt Entry programs: When you edited a line in the PO receipt entry programs
(PO Receipt Entry and Non-PO Receipt Entry), the received amount remains the default value it was
when you chose to edit the line; it does not automatically default to the ordered amount when you edit
the line.

Access this program by choosing Purchase Orders -Receiving =Non-PO Receipt Entry.

Input Descriptions

Use the following to input Non-PO receipt line items:

The line-item portion of the program allows entry of up to 999 line-item and
message lines to complete the purchase order.

Line numbers are assigned automatically beginning with 001 and incrementing
by one for each additional line-item up to 999. In the rare case where 999 line-
items have been entered on a single purchase order, the program proceeds to
the prompt-selection input.

1. Item Number
You have several options for this entry:

# - Enters an item number
M - Enters a memo
i - :
Sor - Enters a special order line number
F2ord#i-  Allowsasearch

F3or Q - Ends line-item entries
Each of these options is described below:

If the item is not a valid item, the system checks to see if it is an interchange, or
if it is a vendor-item number; if the number is an interchange or vendor-item

3-46 Copyright © 1984-2004 Aperum, Inc.



Purchase Orders—7.40 Receiving

number, the system automatically prints the valid item number and sets its
defaults. For valid item numbers, the system displays item Description 1 and
Description 2 fields so you can modify the item description lines as necessary.
Press Enter to default to the existing values in the Item F/M. When you are
satisfied with the descriptions, select the OK button.

Character Users: Enter any item number. If the item is not a valid item, the
system checks to see if it is an interchange, or if it is a vendor-item number; if
the number is an interchange or vendor-item number, the system automatically
prints the valid item number and sets its defaults.

Entering a valid item number displays the vendor relation, last lead-time,
vendor-item number, item class, standard package size, buying weight, and
inventory quantities. The relation is considered primary if this vendor number
is stored with the item in the inventory control item file. If not a primary
relationship, the relation is considered secondary when there is record of
purchase of the item from this vendor. Otherwise, the relation is considered
unlisted. The program skips to input #19.

The item is verified as being stocked or un-inventoried, unless it is tied to a sales
order. Only stocked and un-inventoried items may be added to a purchase
order unless the items are tied to a sales order.

Memo

Press M to enter a memo line. The system allows you to enter a memo and
display purchase order when printed.

Special Orders

In the Item Number input, enter S to enter a special order line-item. Enter the
sales order number from which to import the line-item. Press allows a special
item search, i.e., searching sales orders with special order items. If the search is
not used, next enter the line number on which the line-item appeared on the
sales order.

10
Graphical Users: You can select the k} icon to enter a special order line number.
The system displays the Special Order Entry dialog box where you can enter the
sales order number (the Order field) from which to import a line item. Press #
to perform a special item search, i.e., searching sales orders with special order
items. If the search is not used, next enter the line number on which the line
item appeared on the sales order in the Line field. You can select the # icon to
search for items.

Search

Press F2 to allow a search.

Graphical Users: You can select the # icon to search for items.
End entry

Press F3 to end entry of line-items. The program then proceeds to the prompt-
selection input.

Graphical Users: Select the Q icon to stop entering line items.
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2. Descriptions

Graphical Users: For valid item numbers, the system displays item Description 1
and Description 2 fields so you can modify the item description lines as
necessary. Press Enter to default to the existing values in the Item F/M. When
you are satisfied with the descriptions, select the OK button.

Character Users: The system initially skips this input except for memo lines.
Enter the item descriptions or memo. If you enter memo lines, the system skips
the remaining inputs. Otherwise, after entering description 1, enter description
2. Press Enter to default to the existing values in the Item F/M.

3. Ordered Quantity
Enter the ordered quantity (1-999999999) for this item or select a display code.

Character Users: Enter whether to display O-ordered, C-committed or R-
restocking controls, U-usage, V-vendor or W-warehouse.

Graphical Users: You can access display information via the View menu option

Display information is described below:

O Ordered. Displays existing purchase orders for the selected item and
warehouse at a time. The display for each purchase order includes: the
purchase order number, type, status, ordered quantity, received quantity,
backordered quantity, unit of measure for the quantities, cost and its
corresponding unit of measure, the promised date and vendor number.

C Committed. Selecting committed displays more display codes on the
screen: S-sales orders, T-warehouse transfers, M-manufacturing and E-
equipment rental. Press Enter (CR) to default to S.

Selecting S displays sales orders for the selected item and warehouse at a time.
Each order shows: the document number, type, status, ordered, shipped, and
backordered quantities and corresponding unit of measure, price and
corresponding unit of measure, date and customer number.

Selecting T displays warehouse transfer tickets for the selected item at a time.
Each ticket shows: ticket number, status, requested date, shipped and received
guantities and their corresponding unit of measure, cost and its corresponding
unit of measure, date of transfer, and the warehouse the item was transferred
to.

Selecting M displays manufacturing tickets for the selected item and warehouse
at a time. Each ticket shows: the ticket number, type and status, quantity to be
manufactured and its corresponding unit of measure, scheduled date and if it is
a component item, what the item is a component of.

Selecting E displays equipment rental contracts containing the selected item.
Each contract shows: the contract number, type (C-rental contract, D-
invoice/credit memo), status (E-entered, P-printed, R-returned, I-invoiced, D-
deleted, V-voided), line number on the contract on which the item appears, date
of rental, units rented, stocking unit of measure, rental price, and rental
customer name.

R  Displays the restocking controls for the selected item. Displayed are:
restocking type, order point, line point, min stock, max stock, order quantity
method, order quantity, lead time (stored in the IC warehouse/item file), safety
allowance %, and frozen ordering controls.
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U Displays the items activity for the last six periods (for nonseasonal items)
or the previous six periods (for seasonal items), the number of days stocked out
for the last six periods and the average for both. Also displayed is the seasonal

type.

V  Displays the last purchase from each vendor that sells the item, by vendor
lines at a time. The vendor number is displayed as well as the vendor-item
number and manual cost, also from the last purchase from that vendor: the last
PO number, and the units purchased and cost with their corresponding units of
measure.

W Displays the inventory quantities that are currently in each warehouse for
this item. The warehouse number is displayed, as well as the on hand,
committed, available, backordered and on order (not including the line
displayed) quantities and their corresponding units of measure.

4. Received (Quantity)

Enter the quantity of the item received. Press Enter (CR) to accept the current
value. Press F1 to change the received amount to the ordered quantity.

5  Serial/Lot Number (Optional)

If the item being received is not a serial/lot number, this input is skipped. If the
item is a serial/lot item, the serial/lot numbers must be entered that are being
received. Press Enter (CR) to continue. Press F2 to enter the serial/lot number.
*For serialized items, enter one serial number for each unit being received. If
entering multiple serial numbers, enter the first serial number and press F1-
Auto Assign to have the system generate the remaining numbers. The automatic
serial number assignment will increment the last series of numeric digits found
within the entered serial numbered. *For lotted items, the lot number is entered
along with the quantity. In either case, the serial/lot quantities entered must
equal the amount in the received column.

6. Backordered

The Allow Backorders flag in the PO Static Control F/M establishes whether
backorders are permitted. If backorders are not permitted, this input is
skipped. If backorders are allowed, enter the quantity backordered. Press
Enter (CR) to allow the backorder quantity to be set equal to the ordered
guantity minus the received quantity. This input is only used when the
Backordered flag in the Purchase Orders Entry Options record is set to Y or B.

7. Cost
Enter the cost per displayed costing unit of measure.

Press F2 to search for cost contracts for the vendor/item combination. If the
current cost is not a contract or the standard PO cost, the cost search program
will highlight the default cost, otherwise the cost currently on the line will be
highlighted.

The system displays (if on file): the manual cost from the item file, the average
and last costs from the warehouse/item file, the manual and last costs or the
contract cost (if available) from the vendor/item file. Depending on the Default
PO Cost flag set in the PO static control record, pressing Enter to default to the
manual cost of the item from item file or the last cost of the item from the
vendor/item file. This input is only used when the Cost flag in the PO Entry
Options record is setto Y or B.
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When a new line is being created, the system automatically calculates the
default cost. After the cost is entered, the system captures the origin of the cost.
If you select a cost other than the default cost, the system sets the cost override
flag. The system also displays Contract to indicate whether the displayed cost is
from a contract.

You can access cost details from the View - Cost Origin menu option.

8. Requested

This input is used only when the Requested Dates flag in the Purchase Orders
Entry Options record is set to Y or B. Enter the date you want to request receipt
for this item. The requested date in the header section is the displayed default
value.

9. Promised Date

This input is only used when the Promised Dates flag in the Purchase Orders
Entry Options record is set to Y or B. Enter the date this item is promised for
delivery. The requested date is the displayed default value.

10. Lead Time

This input is used only when the Lead Time flag in the Purchase Orders Entry
Options record is set to Y or B. Enter Y or N to use this document to update the
item’s lead-time in the Receipt Register. Press Enter to default to the lead-time
input in the header portion of the screen. If the quantity is a negative amount,
this input is set to N and skipped.

11. Taxable

This input is used only when the Taxable flag in the Purchase Orders Entry
Options record is set to Y or B. Enter Y or N to charge tax on this line-item.
Press Enter to defaultto Y.

12. GL (Posting Table)

This input is used only when the GL Table flag in the Purchase Orders Entry
Options record is set to Y or B. Enter the GL posting table to use in the Receipt
Register to post this line-item to GL. Press Enter to default to the GL posting
table for the selected item in the item file. Press F2 to search.

13. Character Users: The system displays: CR-Accept Line, J-Job #, F4-Backup

If the Use Job Cost flag is set to N in the purchase orders static control record or
if the item is a special order or the purchase order is a direct ship, the system
skips this input. Press Enter to accept the line and bypass the job costing
information. Enter J to enter job costing information or F4 to back up to the
previous input. If you enter J, inputs #11-17 must be entered.

Graphical Users: The system displays: Enter Job Number Y or N.

If you select Y, the system displays the Job Posting Entry screen. Enter the valid
job number to post this entry against. Press Enter to default to the last job
number entered (if any). Press F2 to search. For valid job numbers, the system
requests customer code; you can enter a value or search. The system then
requests a memo for the posting entry. You can indicate whether you want this
memo to print on the PO invoice. Note: If the Use Job Cost flag is setto N in
the purchase orders static control record or if the item is a special order or the
purchase order is a direct ship, the system skips this input. If you enter Y,
inputs #11-17 must be entered.
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14. Job Number

Enter the valid job number to post this entry against. For valid job numbers, the
system displays the job name, customer number and name, and billing type.
Press Enter to default to the last job number entered (if any). Press F2 to search.

15. Price Message

If the job is a fixed contract or time and materials contract, this input is skipped.
If the job is a cost plus (+) contract or a no charge contract, a message is
displayed indicating the price, which must be billed for the job. Press Enter to
continue.

16. Cost Code

Enter a valid cost code (up to four characters). If you enter a valid cost code, the
system displays the cost code description and the cost type. The cost code sets
the defaults for markup method (for all jobs that are not cost plus) and billing
rate (for jobs that are fixed contracts or time and material). The cost code also
determines whether the user is able to override the defaults. Press F2 to search.

The item entry determines the units, unit of measure and cost rate/extension.

17. Markup

The system initially skips this input and sets it to the markup assigned to the
cost code. You can enter this value only for jobs that are time and materials or
fixed contracts and where the Allow Override Of Billing flag is set to Y in the
cost code record. You can also change this for no charge jobs but the bill rate is
not affected.

Enter the markup method to use for this posting entry. You have the following
options:

#---Enter the markup amount (0-9999999.99). Entering a number tells the
system to mark up the cost by a dollar amount. The system marks up the cost
rate by the dollar amount and calculates the bill extension.

#+% ---Enter the percentage (0-9999999.99%) to mark up the cost. To enter a
percentage, the user must enter an amount and then the percentage sign. If no
percentage sign is present, the system assumes the entered amount is a dollar
amount. The system marks up the cost rate by the percentage amount and
calculates the bill extension.

M---Enter the bill rate/extension manually. Entering M displays the word
MANUAL and the program proceeds to the bill rate input (#30).

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

Enter---initially defaults to the markup method (amount/percentage) from the
cost code record.

18. Bill Rate

This input is unavailable if the Allow Billing Override flag in the cost code
record is set to N. The system initially skips this input unless the markup
method of the cost code is manual. Enter the price per displayed unit of
measure. The bill extension is calculated and displayed. Press Enter to initially
default to 0.

19. Memo

Enter the memo to post for this job cost transaction and to print on the job cost
invoice (if applicable - see next input). Press Enter to initially default to blanks.
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20. Print Memo On Job Cost Invoice?

The system initially skips this input and sets it to N. Enter N or Y to indicate
whether to print the memo (entered in the previous input) on the job cost
invoice. You can set the input to Y only if the Billing Detail for the cost type
(that the cost code is assigned to) is set to A for all transactions in the Job Entry
program. Press Enter to initially default to N.

18. Press Enter to continue, accept the line and return to item input or press F4
to backup.

21. Extension
The line-item extension is calculated and displayed.

This completes the line-item portion of the Non-PO Receipt Entry program. The
system updates and displays the running totals for weight and dollar amount.
The line number is incremented by one, displayed, and the program returns to
the next line-item entry if in add mode or the prompt-selection input in change
mode. The on order quantity for the item is updated in the appropriate
warehouse.

20. Character Users: Following the entry of the last line-item, the prompt-
selection input allows you to perform a number of functions:

# - Changes a line-item

L - Lists line-items

A - Adds a line-item

D - Deletes the purchase order
F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View menu
of the Warehouse transfer entry programs, you can select F10-Menu, View, Item
Notes or Vendor Notes.

Graphical Users: Select the Q icon to stop entering line items.

Highlight a line item and select the Line Detail button to access the Line Detail
for Purchase Order screen, which is used to view and/or modify item
descriptions, promise and request dates, item details, item/vendor info, and
item cost info. The system displays Job Posting Entry dialog box for change or
review.

Select the Header Detail button to access the Header Detail for Purchase Order
Screen, which is used to view and modify header information.

Select the E: icon to make changes for the highlighted line item.
Select the ¥ icon to add a PO line.

Select the #% icon to delete the highlighted PO line.
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Select the = button to add a line item above the highlighted item in the
browser.

Press the Il icon to save your changes.

On the left side of the line item browser, you can select:
L./ to access Note Entry (SME710) for the item highlighted in line item browser.

V. to access Note Entry (SME710) for the vendor specified in the program.

See Also

Non-PO Receipt Entry (POE220)

Non-PO Receipt Entry Header Information
Non-PO Receipt Entry Footer Information

How to enter or change non-PO receipt information
How to enter non-PO receipt header information
How to enter line items on a non-PO receipt

How to enter non-PO receipt footer information
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Non-PO Receipt Entry Footer Information

The Footer routine requires some final information (freight and tax) to complete the purchase order
receipt. You cannot access the ending routine if you do not enter line items on the PO receipt. In the
Footer for Purchase Order dialog box, the system displays a new total (running total of all line-item
extensions plus tax, plus freight, etc.). The new total is initially equal to the purchase order total
amount, but is redisplayed whenever an adjustment (tax, freight, etc.) is made in the ending routine.
At the end of the ending routine, the new total represents the total amount of the purchase order same
as above.

The ending routine is not accessible if you have not entered line items for the non-PO receipt. At the
end of the footer routine, the new total represents the total amount of the purchase order.

Input Descriptions

Use the following input descriptions to enter PO receipt footer information:

1. Freight

Through the Include Freight flag in the purchase orders static control record,
the user establishes whether freight is to be entered. If the flag is set to N, no
freight is included and this input is skipped. If freight is included, enter the
freight amount (.00-9999.99). Press Enter (CR) to default to 0. F4 backs up to
the prompt-selection input.

2. Factor

Enter the means to factor the freight; i.e., divide the freight equally over the line-
item costs. The freight factor is stored and not displayed in the screen. The
freight factor is applied to the cost of line-items during the PO Receipt Register.
Enter U-to divide the freight by the total units, W-to divide the freight by the
total pounds, D-to divide the freight by the dollar amount, or N-to not factor the
freight at all.

3. Tax % (Percent)

Through the Include Tax flag in the purchase orders static control record, the
user establishes whether tax is to be entered. If the flag is set to N, no tax is
included and this input is skipped. If tax is included, enter the tax percent. The
amount is calculated and displayed. If the Taxable flag is set to N, then only
items with the taxable flag in the inventory item file set to Y are subject to tax,
otherwise only those lines that a Y was entered for the Taxable input are
eligible for tax.

When you finish the ending routine, you can select F4 to back up or Enter (CR)
to continue. If continued, the program clears the screen and returns to the non-
purchase order number input (#1) to await further entries.

4. Update

Accesses the optional Update feature to update the receipt, which will adjust item and warehouse
qguantities. Refer to the Update Window topic for detailed information about this feature.

When you finish the ending routine, you can select F4 to back up or Enter (CR) to continue. If
continued, the program clears the screen and returns to the non-purchase order number input (#1) to
await further entries.
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See Also

Non-PO Receipt Entry (POE220)

Non-PO Receipt Entry Header Information
Non-PO Receipt Entry Items Information

How to enter or change non-PO receipt information
How to enter non-PO receipt header information
How to enter line items on a non-PO receipt

How to enter non-PO receipt footer information
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Non-PO Receipt Features and Procedures

Non-PO Receipt Entry Header Processing

Creating Non-PO Receipt document numbers

The system automatically creates a document number once you complete the header. At that point,

the document number appears in the title bar along with the vendor’s name. You can also assign a

document number manually if you prefer.

To assign document numbers manually:

1. Open Non-PO Receipt Entry.

2. Graphical users: Choose File>New Document Number from the menu. Character users: Press
F10 and select File->New Document Number from the menu.

3. Enter up to six characters to create a document number. Choose OK or press Enter (CR).

4. Begin entering the order, starting with the Vendor Number. Refer to the How to enter or change
purchase orders information procedure for additional information.

Creating Direct Ship POs

To access the Warehouse/Direct Ship Selection dialog box to create a direct shipment, select L8 icon
or press F1. If the Non-PO receipt is a direct ship, enter the warehouse that is to be the initiating
warehouse. The warehouse entered for a direct ship is stored only to determine where the PO
originated; inventory quantities and restocking controls are not affected. This becomes the ship-to
address on the purchase order. You can press F4-backup and override the address, or continue to
back up to the warehouse prompt.
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How to enter or change non-PO receipt information

1. Access this program by choosing Purchase Orders = Receiving 2>Non-PO
Receipt Entry.

Complete steps 2-6 to enter non-PO receipt header information

2. Inthe Doc/Vendor input, enter the non-purchase order number to be
received or the vendor for the purchase order receipt. If you need to
change or delete an existing non-PO receipt, enter the existing non-PO
receipt number in this field to open it.

If you try to pull up a purchase order with updated receipts in PO Receipt
Entry or Non-PO Receipt Entry before the receipt register is run, the
system displays the PO Receipts Search window with a list of outstanding
receipts for that purchase order. From this window, you can either select
an existing receipt or create a new receipt. Refer to the PO Receipts Search
window for detailed information about this feature

Search Tips:

Character Users: Press F2 to perform a document search by vendor. Press F3
to search for documents by non-PO receipt number. To search for non-PO
receipt number for a specific vendor, enter the vendor number in the
vendor input (#3) on the screen. Enter a valid vendor code to display all
the non-purchase orders for that vendor. You can then select a non-PO for
correction or inquiry, or press F4--backup to return to the non-purchase
order receipt number input (#1).

Graphical Users: Press F2 or select the # icon to perform a document search
by vendor. You can also search by non-purchase order receipt number and
warehouse. To search for non-purchase order receipt documents, select the

u

L= jcon.

Press F2 or select the # icon to perform a document search by vendor.
You can also search by purchase order number and warehouse. To search

']
for purchase order documents, select the L= jcon.

3. Enter avalid vendor code to display all the non-purchase orders for that
vendor. You can then select a non-PO for correction or inquiry, or press
F4--backup to return to the non-purchase order number input (#1).

Field Information for Documents:

You can enter non-purchase order numbers or have them automatically
assigned by the system. For manual non-purchase order receipt numbers,
enter any number up to 999999. The system displays information for non-
purchase order numbers already on file. To use automatic non-purchase
order numbers, select File-->New Document Number to access the Assign
non-PO Number dialog box and click the [ icon. You can manually
select anon-PO receipt number to assign, or the system assigns the next
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7.

available number. The system displays the word NEXT at the top of the
screen until the header portion is completed.

(Optional) To access the Warehouse/Direct Ship Selection dialog box to

create a direct shipment, select the L8 icon or press F1. If the non-PO is a
direct ship, enter the warehouse that is to be the initiating warehouse. The
warehouse entered for a direct ship is stored only to determine where the
PO originated; inventory quantities and restocking controls are not
affected. For new non-PO receipts, enter the number of the vendor from
whom you are requesting the items.

If you enter a valid vendor number, the system displays the vendor name
and address, ship-to and ship-from warehouses, and terms code. You can
modify these fields.

Freight--Enter whether freight is B-bill later, P-prepaid, C-collect or A
prepay/add. Press Enter to default to the freight code in the ship-from file
(if specified) or the freight code entered in Vendor F/M for the selected
vendor. Also, if the ship-from warehouse is changed from any value to
SAME, the freight code reverts back to the vendor default freight code.

Lead Time--Select the Lead Time checkbox to indicate whether the lead-
time from this document (number of days from the ordered date to the
date of the first receipt) should update the average lead-time for the item in
the warehouse/item file. The system performs this update during the
Receipt Register update.

F.O.B.--Enter up to 15 characters for freight on board. Press Enter to
initially default to the F.O.B. in the ship-from file for the selected vendor.

Reference Number-Enter the optional reference number (up to 15
characters).

When you are have completed these fields, press the OK button.

The system displays the Vendor Info dialog box, which contains the
vendor’s message, balance, the user’s customer number from the vendor,
contacts 1 and 2, and the phone number.

Complete steps 7-15 to enter line items on a non-PO receipt:

(Optional) For Serial/Lot items, the system displays the Serial/Lot Entry #
dialog box. You must enter the serial/lot numbers you are receiving and
their quantities. *For serialized items, enter one serial number for each unit
being received. If entering multiple serial numbers, enter the first serial
number and press F1-Auto Assign to have the system generate the
remaining numbers. The automatic serial number assignment will
increment the last series of numeric digits found within the entered serial
number. *For lotted items, enter the lot number and the quantity. In either
case, the serial/lot quantities entered must equal the amount in the received
column.

You can select:

The List button to display the available serial/lot numbers and quantities to
be received.
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The Add button to add another serial/lot number for the item.

The End button to stop your additions.

The OK button to accept the serial/lot numbers and quantities you have
entered. The system checks to see if you have entirely distributed the items
received.

8. You can:

Select the = icon to add a line to the PO receipt.

Field Information for Items:
10

You can select the icon to enter a special order line number. The system
displays the Special Order Entry dialog box where you can enter the sales
order number (the Order field) from which to import a line item. Press # to
perform a special item search, i.e., searching sales orders with special order
items. If the search is not used, next enter the line number on which the line
item appeared on the sales order in the Line field. You can select the
Binocular icon to search for items.

If the item is not a valid item, the system checks to see if it is an interchange,
or if it is a vendor-item number; if the number is an interchange or vendor-
item number, the system automatically prints the valid item number and
sets its defaults. For valid item numbers, the system displays item
Description 1 and Description 2 fields so you can modify the item
description lines as necessary. Press Enter to default to the existing values
in the Item F/M. When you are satisfied with the descriptions, select the
OK button.

The system displays the Cost info dialog box for the item. This dialog box
contains the manual item cost, the manual vendor cost, and the last vendor
cost

9. Inthe Cost input, enter the cost per displayed costing unit of measure.

Press F2 to search for cost contracts for the vendor/item combination. If the
current cost is not a contract or the standard PO cost, the cost search
program will highlight the default cost, otherwise the cost currently on the
line will be highlighted.

The system displays (if on file): the manual cost from the item file, the
average and last costs from the warehouse/item file, the manual and last
costs or the contract cost (if available) from the vendor/item file.

Depending on the Default PO Cost flag set in the PO static control record,
pressing Enter to default to the manual cost of the item from item file or the
last cost of the item from the vendor/item file. This input is only used when
the Cost flag in the PO Entry Options record is setto Y or B.

When a new line is being created, the system automatically calculates the
default cost. After the cost is entered, the system captures the origin of the
cost. If you select a cost other than the default cost, the system sets the cost
override flag. The system also displays Contract to indicate whether the
displayed cost is from a contract.

You can access cost details from the View - Cost Origin menu option.
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10. GUI Users: You can:

Select the Q icon to stop entering line items.

Select the Line Detail button to access the Line Detail for Purchase Order
screen, which is used to view and modify item descriptions, promise and
request dates, item details, item/vendor info, lead-time update flag, and
item cost info.

Select the Header Detail button to access the Header Detail for Purchase
Order Screen, which is used to view and modify header information.

Select the Stop Receipt button to stop the receipt process for the document
lines.

Select the [ icon to make changes for the highlighted line item.
Select the #% icon to delete the highlighted PO receipt line.

Select the = button to add a line item above the highlighted item in the
browser.

Press the l&l icon to save your changes.

On the left side of the line item browser, you can select:

1. to access Note Entry (SME710) for the item highlighted in line item
browser.

V4 to access Note Entry (SME710) for the vendor specified in the program.

CUI Users: You can:

#- Changes a line-item

L - Lists line-items

A - Adds a line-item

S - Stops receipt of purchase order
D - Deletes the purchase order

F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View

menu of the Warehouse transfer entry programs, you can select F10-Menu,
View, Item Notes or Vendor Notes.

11. When you are finished with line items, select the Done button or F3.

Complete steps 12-19 to enter non-PO receipt footer information:

Purchase Orders—7.40
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12. The system displays the Footer Detail for PO Number dialog box. You can
enter information in the following fields:

The system displays a dialog box for footer information. Enter information
in the following fields:

Freight-- If freight is included, enter the freight amount (.00-9999.99). Press
Enter to default to 0. Through the Include Freight flag in the purchase
orders static control record, you establish whether freight is to be entered. If
the flag is set to N, no freight is included and this input is skipped.

Tax %-- If tax is included, enter the tax percent. The amount is calculated
and displayed. Through the Include Tax flag in the purchase orders static
control record, you indicate whether tax should be entered. If the flag is set
to N, no tax is included and this input is skipped. If the Taxable flag in the
Purchase Orders Entry Options record is set to N then only items with the
taxable flag in the inventory item file set to Y are subject to tax, otherwise
only those lines that a Y was entered for input #24 are subject to tax.

Factor--Enter the means to factor the freight; i.e., divide the freight equally
over the line-item costs. The freight factor is stored and not displayed in the
screen. The freight factor is applied to the cost of line items during the
Receipt Register. Enter U-to divide the freight by the total units, W-to
divide the freight by the total pounds, $-to divide the freight by the dollar
amount, or N-to not factor the freight at all. Press Enter to initially default
to the Default Freight Factor flag value stored in the purchase orders static
control record.

When you have completed these fields, press the OK button.

13. The system displays the PO Date Change dialog box; select the Update Lead
Time checkbox to update the lead-time for all line items on the PO. The
Update request date and Update promised date checkboxes are displayed
only when the Requested/Promised Dates flag in the Purchase Orders
Entry Options record is setto Y or B. If you change dates in the header
section of the screen, the system also displays this dialog box.

14. When you have completed these fields, you can.

Press the OK button or F3 to return to the PO Receipt Entry header portion
of the screen.

Press the Backup button or F4 to step back through the footer fields.

Select the Update option to update the receipt, which will adjust item and
warehouse quantities. Refer to the Update Window topic for detailed
information about this optional feature.

See Also

Non-PO Receipt Entry (POE220)

Non-PO Receipt Entry Header Information
Non-PO Receipt Entry Items Information
Non-PO Receipt Entry Footer Information
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Receipt Register (POR230)

Function
This program allows the user to:

» Print a register of purchase order and a nonpurchase order receipts.

» Optionally build and print a general ledger distribution.

» Post to general ledger, if needed.

» Update inventory quantities, costs and activities, purchase order history
files, the purchase order period receiving file, the purchase order
receipts file and the job cost files.

If the cost is a contract cost, the system does not update the last cost with
the contract cost value and sets the contract cost flag for the line.

Purchase Orders with receipts that were updated in PO Receipt Entry or Non-PO Receipt Entry still
need to go through the Receipt Register to update GL and invoice files. For purchases orders updated
in PO Receipt Entry and Non-PO Receipt Entry, the Receipt Register skips updating inventory but
updates all other files in the register. If a receipt was not updated in PO Receipt Entry or Non-PO
Receipt Entry, the Receipt Register updates on-hand inventory files as well as GL and invoice files.

Receipt Register information includes the following: purchase order number, receipt number, vendor,
ship-to and buyer. For each line item on the order, the item number, description, requested date,
promised date, received date, ordered, received and backordered quantities, cost and extension and
total (including tax and freight) are displayed. The report also includes totals of line-item extensions
and purchase order receipt totals.

Lead Time: The PO Receipt Register flags abnormal (A) lead time for stocked
items where the Replenish flag (on the Main screen of Warehouse/Item F/M
(ICF920)) is “Y” before checking all other conditions that would flag the item
with an abnormal lead time.

Templates that store “current period” (or similar values like “system date”)
resolve to the “current period at the time the report is run” rather than what the
“current period” was at the time the template was created. For example: If you
save a template for the PO Period Receipts Report and select “Current Period”
for the Period input, when that template is selected to run again (either
manually or via Job Stream) the current period is determined using the setting
of Current period in the PO Non-Static F/M.

NOTE: Any purchase orders tied to special orders in SO, i.e., the line item on
the PO is directly tied to the line item on the SO, when updated, will update the
sales order. The special order line item on the sales order (optionally including
serial number) becomes committed by the quantity received on the line item of
the PO.

User Inputs
The following inputs are involved in printing and updating the Receipt
Register:

1. Warehouse

Enter the 2-character code to indicate the warehouse for which the Receipt
Register should print. The entry must be a valid warehouse. CR defaults to the
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warehouse assigned to the terminal. F3 defaults to all warehouses. Press F2 to
search.

2. Date

Enter the purchase orders Receipt Register date. This date is used to determine
the correct period in which to post in the inventory control, purchase orders and
general ledger systems. The date must be within the current or next GL period.
CR defaults to the system date (ref. 2).

3. PO#
Enter the purchase order number to process or press CR for ALL.

The GL distribution is built during the printing of the Receipt Register
according to parameters established by the user through the PO to GL Posting
F/M program and IC GL posting tables.

For users printing the GL distribution, the following input is displayed:

4a. Check Register. OK to Print GL Distribution?

After printing the Receipt Register, Verify the printout. If there is a correction
to be made, enter N to exit the program. After the correction is made, the
register can be rerun. If everything is correct, enter YES to continue. The
program then prints the GL distribution. Once the GL distribution is printed,
proceed to input #5.

For users not printing the GL distribution, the following input is displayed:

4b. Check Register. OK to Update?

After printing the Receipt Register, verify the printout. If there is a correction
to be made, enter N to exit the program. After the correction is made, the
register can be rerun. If everything is correct, enter YES to continue and no GL
distribution will be printed, the following input (#5) is skipped and the
program proceeds with the update.

5. Check GL Distribution. OK to Update?

After printing the distribution, verify the printout. If everything is correct,
enter YES to continue. The program proceeds with the update. If there isa
correction to be made, enter N to exit the program. After the correction is made,
the entire register process begins again. The register is run first. The GL
distribution is printed, followed by the optional update.

Technical Notes

To allow processing of POs while the register is running, the register first sets
the Terminal Running Receipt Register flag in the PO to GL Posting F/M to
the user’s terminal code. All other users are then locked out of the ready-for-
register sort file (POREGX) while the register is running. However, the
programs that update POREGX can still continue processing while the register
is running by writing to the temporary ready-for-register file (POTMPX).

Printing of receipts proceeds by reading through POREGX and referencing the
appropriate purchase orders file record. All deleted and voided purchase
orders appear on the register to provide a complete audit trail of all purchase
order numbers used.

The GL distribution is built during the printing of the Receipt Register
according to parameters set by the user in the PO to GL Posting F/M. If the GL
distribution flag is set to zero, building the distribution is eliminated. If the flag
is set to one, two or three, the distribution is built in one of two formats: either
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by PO posting record or by GL numbers of inventory GL posting table. The
user also determines if the system will make a journal posting (summary or
detail) following the header update.

The header update writes records to two files. If the use invoice receipts flag in
the purchase orders static control record is set to Y, the header portion updates
the purchase order receipts file (PORECT). This file is later used for comparison
to the invoice. If the use period receiving report flag in the purchase order static
control record is set to Y, the period receipts file (POPDRC) is updated.

The line-item update begins by updating the inventory item file as to date of last
purchase, last cost and average cost. If the purchase order is a direct shipment
the inventory control warehouse update is skipped. Otherwise, the update
inventory flag stored with the item is checked. If the flag is setto Y, on hand,
committed, and on order quantities are updated in the inventory control
warehouse/item file (ICWHSE). If a purchase order line item is tied to a sales
order line item, the item becomes committed in the warehouse/Zitem file by the
guantity received and the item also becomes committed in the sales order
document file (SORDER) by the quantity received. The period to date receipts
and adjusted quantities are also updated. If FIFO or LIFO costing is used, the
cost file (ICCOST) is updated.

The line-item update continues by updating various purchase order system
files. If vendor-item numbers are used, the vendor/Zitem file (POVNIT) is
updated. If the use past purchase history flag in the purchase orders static
control record is set to Y, the past purchases file (POPAST) and if this is a lot
item, the past purchase order lots file (POPLTS) are updated. Next, line-item
records are written to the purchase orders receipts (PORECT) and period
receipts (POPDRC) files if the control flags are set to Y. Job cost information is
written to the job cost activity by module file JCREFX). Finally, if the line-item
contains no backordered quantity, it is removed from the purchase orders
(PORDER) and purchase order by item sort (POITMX when all line-items are
complete) files. Otherwise, the record is updated, with the backordered
guantity becoming the new order quantity.

At the end of the line-item update, tax and freight amounts are updated in the
purchase order receipts file (PORECT). Next, the purchase orders header
(PORDER), ready-for-register (POREGX) and purchase order by vendor sort file
(POVNDX) records are removed. The last receipt number used is updated in
the PO nonstatic control record.

If the GL distribution posts automatically, the journal update follows.
Otherwise, the program returns to the purchase order selector. The GL journal
update posts a journal entry to the journal file (GLJRNL) according to the
information appearing on the GL distribution report. The GL sort file
(GLIJRNX) is also updated.

When the register has completed processing, it moves any records in POTMPX
to POREGX in preparation for the next register to be run. The Terminal
Running Receipt Register flag is then set back to blanks.

FILES USED - APVEND, GLMSTR, ICWHSX, JCCODE, PODSSP

FILES UPDATED - SMCNTL, SMGLD?, GLIRNL, GLIRNX, ICMAST,
ICWHSE, ICCOST, ICFUCT, ICLOTS, ICLEDG, ICLOTX, JCREFX, JCIOBS,
PORDER, POITMX, POVNIT, POPAST, PORECT, POPDRC, POREGX,
POVNDX, POLOTS, POPASX, POPALX, SORDER, POTMPX
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;7 Beceipt Register [POR230)

R

L Receipt Reagister [POR230]
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How to run the Receipt Register

Access this program by choosing Purchase Orders > Receiving > Receipt
Register.

In the Warehouse field, enter the 2-character code to indicate the
warehouse to use for the Receipt Register print. Press Enter to default to

the warehouse assigned to the terminal. Select the S icon to default to all
warehouses for the Receipt Register. Select the # to search for
warehouses.

In the Date field, enter the purchase orders Receipt Register date. This
date is used to determine the correct period in which to post in the
inventory control, purchase orders and general ledger systems. The date

must be within the current or next GL period. Select the icon to default
to the system date. Note: The system displays the current PO, AP, and GL
periods in the upper left portion of the screen as a reference.

In the PO field, enter the purchase order number(s) to process. Select the
L icon to process all received POs in the selected warehouse(s) for the

Receipt Register. Select the # to search for purchase orders. Select the =l
icon to remove the last PO number entered.

Select the OK button to print the report.

If you are printing the GL distribution, the system displays the following
message: Receipt Register. OK to Print GL Distribution?

After printing the Receipt Register, verify the printout. If you need to
correct the register data, select Cancel or enter N to exit the program.
After you make the correction, you can rerun the Receipt Register. If
everything is correct, select OK or enter YES to continue. The program
then prints the GL distribution.

Once the GL distribution is printed, the program displays the message:
Check GL Distribution. OK to Update?

After printing the distribution, verify the printout. If everything is correct,
select OK or enter YES to continue. The program proceeds with the
update. If you need to make a correction, select Cancel or enter N to exit
the program. After you correct the information the correction is made, re-
run the entire register process—meaning run the register first, then print
the GL distribution, followed by the optional update.

Purchase Orders—7.40
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Invoice Recelving (POS300)

The Purchase Orders Invoice Receiving menu allows the user to enter vendor
invoices for merchandise received on a purchase order. A register may be run
to list and update all invoice receipts. A report may also be run to list all
purchase order receipts for which no invoice has been received.

Invoices for the receipt of merchandise from purchase orders may be entered
through the purchase orders Invoice Receipt Entry. Invoice receipts may be
changed, added to, or deleted up until they are run through the Invoice Receipt
Register. Invoice Receipt Entry replace the Document Entry program in
accounts payable and is used to enter only invoices for merchandise received on
a purchase order. As with the accounts payable Document Entry program, the
invoice is entered and must be expensed to one or more general ledger account
numbers.

The Invoice Receipt Register provides a complete audit trail of invoices to be
posted to accounts payable. Invoices are not posted until the Invoice Receipt
Register is updated. If, when running the register, it is incorrect; the user may
choose not to update it, go back into the entry program correct the receipts and
run the register again.

The Uninvoiced Receipts Report prints a report that lists all purchase orders
which have been received, but for which no invoice has been entered. After the
Invoice Receipt Register has been run only uninvoiced receipts remain on file.
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Software - Purchase Orders [PO5S000])
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Invoice Receipt Entry (POE310)

Function

Purchase Orders—7.40

Use the Invoice Receipt Entry program to enter invoices for merchandise received from purchase
orders. Itis available only if the Use Invoice Receipts flag in the PO Static Control F/M is activated.

I 1\!]1 -f_4 Development, Invoice Receipt Entrp [POE310]) !Elﬁ

- File Edit Wiew Optiohs GoTo Help

Period [0oz004 [ |

Wendaor

Document I 234231231
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General Industrial MFG GL Thl I 0as _I Doc Amount I 1.00  Due Date |10r3012|:||:|4 _I
:Ei‘tu ?:;‘:’gidy' il Doc Grp I 01 Doc Disc § 1.00 Discount I
uie - —
Mlanta, GA. 30338 Branch 0 | Dot Date IDQIDHEDM Disc Date |1ur1 2004
Terms | 02 #h| 29 10th Het 30 Mema |
Po# [ ooooot Reptt [ 00007 wH [ 01 f% | atiantawarehouse
tern  [1100 | Desc [Pallet Loading Hand Truck
ol [ 390010 ¢4 | purchases-Inventory Units | 10| 1 cost | 100 EA
FO# | Ropt# | Flags | Hem [ oL# [ Units | um | Cost| UM | Estension | WiH | ﬂ
— Fooooo aonoq 1Moo 390-01-0 1.0 CT 100 EA 1.00 01 ¢ ')/
add —
[
Last PO Rept Tatal Received Undist: 00
MewPO | DeletePO |  Header | Line Detail | Dore |
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1".llnval'l:ui-::rtz Receipt Entry [FOE310) M=] E3
Help
81-FACTS 7.4 Development Invoice Receipt Entry POE318H
Period 69/20604 AP CP=0972804 SEP

Uendor U180 Document 456532
General Industrial HFG Amount Disc § Date
2618 Dunwoody, P1. GL Tbl @85 Doc 67 .88 67 .88 8178872004
Suite 133-134 Doc Grp 61 Due B2/29/2004
Atlanta, GA. 38338 Branch 61 Disc 1.34 B2/18/20084
femo Terms 92 2% 18th Het 30
PO# Rcpt# WH @1
Item Desc
GL# AB88-80 B Units Cost
Hotes: |/2,]1

PO# Rcpt#f Flags Item GL # Units UM Cost UM Ext
add
Last PO Rcpt Total Rcud Undist: 67 .88
Header Detail, lLine Detail, Hew PO, Delete FO
CR-Add line, F3-Done, F18-Henu .
Arrows: Up=Prev, Down=Hext, Left/Right=Lines, PqgUp, PgDn, Home, End

Invoice Receipt Entry Processing Notes

The information you enter via this program appears on the Invoice Receipt Register. The number of
units received, the number of units invoiced, the cost of the item when it was received and the cost of
the item on the invoice are all stored in the invoice receipts file. Information on the cost and number of
units received is retrieved from the purchase order receipts file and stored in the invoice receipts file.
During Invoice Receipt Entry these amounts are compared to locate discrepancies between received
and invoiced amounts. Any discrepancies may be reported through the Period Discrepancy Report.
This feature provides a method to ensure that invoice amounts match the amounts actually received.

The Invoice Receipt Entry screen consists of two sections. The upper portion of the screen is called the
header portion where the document number, date, amount, vendor and other general information are
entered. The lower portion of the screen is called the line item section where line-item corresponds to
a particular received purchase order line-item and contains information (purchase order number,
receipt number, item number, cost, etc.) specific to that item.

During processing, the system automatically displays urgent notes for vendors
and items based on your settings on the Notes tab of PO Entry Options F/M.
Refer to the Viewing/Entering Notes from Purchase Order Programs topic in
the PO Overview section for details.

Invoice Receipt Entry Header Processing

The upper portion of the screen is called the header portion where you create invoice receipt numbers.
From the header section of the screen, you can automatically calculate invoice discounts based on the
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terms code. You can also enter an invoice memo via this program to appear on the accounts payable
check.

Refer to the following procedures for more information about PO Receipt Entry header processing:

Add an invoice receipt document

Opening existing documents

Deleting purchase order invoice receipts

Enter invoice receipt header information

Selecting Individual Lines from a PO Receipt for Importing

In the Invoice Receipt Entry program, you can select individual lines from a PO Receipt to import into
the invoice instead of having to import the entire receipt. When you select the New PO option, an
additional prompt allows you to import of all remaining receipt lines or select individual receipt lines.
If you select to import all lines, the open lines will immediately import onto the invoice with no further

user interaction. If you choose to select lines, the Receipt Item Selection screen appears and by using
the Toggle, None and All buttons can select which lines will return onto the invoice. You can modify

the line quantity and cost by double-clicking the line or highlighting it and selecting E; . When you
close this selection window, all lines that were selected add onto the invoice.

Invoice Receipt Entry Item Processing

In the item section of this program, you must also enter received quantities for each line item. A time-
saving feature allows the entire order to be received in one step. (This is not available for serial/lot
inventory.) In doing this, the system sets the received quantity equal to the ordered quantity. You can
manually change the received quantity, backordered quantity, or cost for any automatic receipt. If
items received are serial/lot items, you must enter the serial or lot numbers of the items you are
receiving. You can automatically display received purchase order line items.

Refer to the following procedures for more information about Order Entry item processing:

Add a line item

Edit a line item

Delete a line item

Insert a line item or memo

Find a line item

Additional Features

e You can receive serial/lot items on PO invoice receipts.
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Technical Notes

Upon conclusion of the header portion and each line-item, a record is written to
the invoice receipt file (POINVC).

FILES USED - SMCNTL, POVNIT, POVITX, APVEND, APVALX, GLMSTR,
ICMAST, APOPEN, APPAST, GLALPX, ICALPX, POPAST, PORDER, POITMX,
SORDER, SOITMX, APDOCM, ICINTR, ICWHSE, ICCLSX

FILES UPDATED - PORECT, POINVC

See Also

Invoice Receipt Entry Header Information

Invoice Receipt Items Information

How to enter or change invoice receipt information
Line Detail for Invoice Receipt Entry Screen
Header Detail for Invoice Receipt Entry Screen
How to enter invoice receipt header information

How to enter invoice receipt header line-item information

4-6 Copyright © 1984-2004 Aperum, Inc.



Receiving Purchase Orders—7.40

Invoice Receipt Entry Header Information

The upper portion of the screen is called the header portion where you create invoice receipt numbers.
. From the header section of the screen, you can automatically calculate invoice discounts based on the
terms code. You can also enter an invoice memo via this program to appear on the accounts payable
check.

Access this program by choosing Purchase Orders = Invoice Receiving = Invoice Receipt Entry.

Input Descriptions
Use the following inputs to setup an invoice receipt header:

1. Period

Enter the period to which this information should be posted (PPYY). The
current accounts payable period is displayed in the upper right corner of the
screen and is the default value. The period may not be before the current
accounts payable period and must be either the current or next general ledger
period.

2.  Vendor

Enter the number of the vendor from whom the invoice was received. Entry of
a valid vendor number displays the vendor name, address, message, GL table,
document group, branch (if used) and terms code from the vendor’s record in
the accounts payable vendor file. Press F2 to search. Press F3 to perform a
document search.

If you search for an existing document, then you can enter the beginning vendor
for the search. If you press Enter, the program lists in document order any
existing invoice receipt documents that exist and displays the date entered, due
date, amount, and vendor number and name.

3. Document

Enter the number that appears on the invoice as the invoice or document
number (up to 10 characters). Document numbers already on file for this
vendor in either the open payables or past documents files are not accepted.
This prevents the accidental double entry of an invoice. If the document
number/vendor number combination entered is already in the invoice receipts
file, all screen information is displayed. This allows you to make changes to
entered invoices prior to running the Invoice Receipt Register.

4. GL Posting Table

Enter the number of the accounts payable General Ledger posting table to be
used for this invoice. The general ledger posting table number stored with the
vendor is the displayed default value. The entry must be a valid GL posting
table. This table is used in the line-item portion of the entry to provide default
values for the General Ledger account number input. Press F2 to search.

5.  Document Group

Enter the document group number that applies to this invoice. The program
defaults to the group code created in the vendor’s record in AP Vendor F/M.
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This group number is stored with the Accounts Payable document record when
it is created by the Invoice Receipt Register update. Document group numbers
are used by several Accounts Payable reports to categorize documents.

6. Branch

Enter the valid branch number that applies to this invoice. Press Enter to
default to the branch assigned to the terminal. Press F2 to search.

7. Terms Code

Enter the valid payment terms code that applies to this invoice. The terms code
stored with the vendor is the displayed default value. The terms code is used to
determine the due date and discount amount. Press F2 to search.

8. Document Amount
Enter the document (invoice) total amount (+/-9,999,999.99).
9. Discountable Amount

At the bottom of the screen, enter the amount on which to compute a discount.
Press Enter to default to the document amount. (Freight may not be
discountable.)

10. Document Date

Enter the document (or invoice) date. The system date is the displayed default
value.

11. Due Date

Enter the due date for this document (invoice). Press Enter (CR) to allow
automatic calculation of the due date based on the terms code and to proceed to
input #14.

12. Discount

If the automatic date and amount calculation were selected in input #11, this
entry is skipped. Otherwise, enter the invoice discount. The discount may be
entered as a dollar amount or a percent of the invoice amount. Entry of a
discount percent must include the percent symbol (%) after the number. The
discount amount is calculated and displayed. The default value is the amount
calculated by the system based on the entered terms code. Any amount less
than or equal to the invoice amount is accepted. It is not necessary to enter the
negative symbol (-) for normal discount amounts.

13. Discount Due Date

If automatic date and amount calculation are to be selected in input #11, this
entry is skipped. Enter the date by which payment must be made to be eligible
for the discount. Press Enter (CR) to initially default to the date calculated by
the system based on the given terms code.

14. Memo

Enter the document memo (up to 25 characters). Press Enter (CR) to skip this

entry. The memo entered appears on the stub portion of the accounts payable
check, generated through the entry of this invoice, the Invoice Receipt Register
and the normal accounts payable check selection process.

Receiving
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This concludes entry of the header portion of the invoice receipt. After the
record is created, all inputs except #1-3 are accessible through the change
header routine. Inputs #1-3 can only be changed by deleting and re-entering
the invoice.

PO Invoice Receiving Menu Options
Character Users: Press F10 to display the menu options for the current screen.

File Edit View Options Help

See Also

Invoice Receipt Entry (POE310)

Invoice Receipt Items Information

How to enter or change invoice receipt information
Line Detail for Invoice Receipt Entry Screen
Header Detail for Invoice Receipt Entry Screen
How to enter invoice receipt header information

How to enter invoice receipt header line-item information
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Invoice Receipt Entry Item Information

In the item section of this program, you must also enter received quantities for each line item. A time-
saving feature allows the entire order to be received in one step. (This is not available for serial/lot
inventory.) In doing this, the system sets the received quantity equal to the ordered quantity. You can
manually change the received quantity, backordered quantity, or cost for any automatic receipt. If
items received are serial/lot items, you must enter the serial or lot numbers of the items you are
receiving.

Input Descriptions

Use the following inputs to enter line-items:

The line-item entry portion of the program allows the input of up to 999 line-
items to complete the invoice receipt.

Line numbers are assigned automatically beginning with 001 and incrementing
by one for each additional line-item up to 999. In the rare case where 999 line-
items have been entered on a single invoice, the program advances to the
prompt-selection input and refuses further entries.

Character Users: The program proceeds to the prompt-selection input.

At this point, the prompt-selection input allows the user to:

# - Changes a line-item

L - Lists line-items

A - Adds line-items

D - Deletes a purchase order or the entire invoice document
N - Enters a new purchase order number

F2 - Changes the header

F3 - Ends the program

Enter N to add line-items (purchase orders).

In the Notes: area of the screen, just above the line item section, the system
displays VEND or ITEM to indicate that notes are present. From the View menu
of the Warehouse transfer entry programs, you can select F10-Menu, View, Iltem
Notes or Vendor Notes.

Graphical Users:

Select the E; icon to make changes for the highlighted line item.
Select the ™ icon to add an invoice line.
Select the # icon to delete the highlighted PO line.

Select the = button to add a line item above the highlighted item in the
browser.
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Press the Il icon to save your changes.

Select the e icon to stop entering line items.

On the left side of the line item browser, you can select:
I, to access Note Entry (SME710) for the item highlighted in line item browser.

Vi to access Note Entry (SME710) for the vendor specified in the program.

Highlight a line item and select the Line Detail button to access the Line Detail
for Purchase Order screen, which is used to view and/or modify item
descriptions, promise and request dates, item details, item/vendor info, and
item cost info. The system displays Job Posting Entry dialog box for change or
review.

Select the Header Detail button to access the Header Detail for Purchase Order
Screen, which is used to view and modify header information.

Select the Done button to end the program. The undistributed amount of the
invoice must equal zero to end the program. If no line-items were entered, the
program may not be ended.

Process Descriptions

# - Changes or deletes a line. The purchase order number, receipt number and
item number may not be changed. Individual line-items created from the
purchase order receipts file may not be deleted.

L - Lists line-items. Line numbers can be entered from which to start listing
(only if more than six line-items).

Aor*- Adds

Line-items may be added as necessary. Any purchase order number and
receipt number are accepted. An item search is available. Non-stocked items,
vendor/item numbers and interchanges may be entered. NOTE: Entering a
non-stocked item number called FRT results in a default description of
FREIGHT and entering a non-stocked item number called Factored FRT results
in a default description on FACTORED FREIGHT. Similarly, entering a non-
stocked item number called TAX defaults to a description of TAX. The GL
account number, quantity invoiced and cost are also input. When using A to
add line-items, no line-item numbers get tied to a PO receipt regardless if a PO
number was added.

D or # - Deletes a PO or document. Entire purchase orders or documents can
be deleted. A verification of the deletion is displayed before anything is
deleted. The user may delete a purchase order (including all its line-items) or
delete the entire invoice receipt document. To delete a purchase order, the
purchase order number and receipt number must be entered. All line-items for
that purchase order are deleted and the undistributed amount is updated.

N or New PO button- Adds line-items (purchase orders). Line items from
purchase orders may be added as necessary. You can input an entire existing
PO by using this prompt. After selecting N, enter the PO number that is to be
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received. Press F2 to search. Enter a receipt number for the selected PO. Press
Enter to default to the first receipt number available for the selected PO. Once
the receipt number is entered, the system displays in the center portion of the
screen: PO number, receipt number, total for the PO and its received date.

When using N and a purchase order number to add line-item numbers, line-
item numbers get tied to the line number on the PO receipt.

When you select New PO button or N, the system displays the following inputs:

When you select the +or A, the system displays the following fields as well:

1. PO#

For new POs, enter the purchase order number that corresponds to this invoice.
Press Enter to default to the displayed value. Press F2 to search for POs for the
selected vendor. F3 or F4 ends entries and proceeds to the prompt-selection
input.

For received POs, enter the received purchase order number.

Receipt #

For new POs, enter the receipt number (up to five characters) that corresponds
to this invoice.

For received POs, enter the receipt number that was entered during Receipt
Entry for this purchase order. The number displayed is default value. Press
Enter to default to the receipt number entered on the previous line (if
applicable).

Import: Indicate whether to import all lines or only the line you specify on the Receipt Item Selection
Screen. You can select:

A-Import All Lines
S-Select Lines to Import

If you select S-Select Lines to Import, the system displays the Receipt Item Selection Screen, which is
detailed in the PO Invoice Receipt Entry Features and Procedures section of this chapter.

2. WH (Warehouse)

If the PO and receipt number entered are the same as the previous line, this
input is skipped and the warehouse is set to the same warehouse as the
previous line. Enter the warehouse the item on this PO was received at. Press
Enter to default to the warehouse assigned to the purchase order.

3. Item

Enter the item number. If the item is not a valid item, the system checks to see if
it is an interchange or a vendor-item number; if either of the latter are true the
system automatically prints the valid item number and sets its defaults.
Entering a valid item number displays the vendor relation, last lead time,
vendor-item number, item class, standard package size, and buying weight.

The relation is considered primary if this vendor number is stored with the item
in the inventory control item file. If not a primary relationship, the relation is
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considered secondary when there is record of purchase of the item from this
vendor. Otherwise, the relation is considered unlisted.

Entering an invalid item number allows the user to enter non-stocks. If the item
is a non-stocked item, the program requires the unit of measure and a
description for the non-stocked item.

4. Description

This input is initially skipped except for non-stocked items. Enter the item
description. Press Enter to default to the displayed value.

5 GIL#

Enter a GL account number. The entry must be a valid GL account number.
This is the GL account number that the Invoice Receipt Register expenses the
cost of the item against. Press F2 to search.

6. Units

Enter the quantity of items to be received. The entered amount should be equal
to the invoice quantity. Press Enter to default to displayed value.

7. Cost

Enter the cost per displayed costing unit of measure. Displayed if on file is: the
manual cost from the item file, the average and last costs from the
warehouse/item file, and the manual and last cost from the vendor/item file.
Depending on the Default PO Cost flag set in the PO static control record, Press
Enter to default to the manual cost of the item from the item file or the last cost
of the item from the vendor/item file. This input is only used when the Cost
flag in the Purchase Orders Entry Options record is set to Y or B.

If you change the cost on a line, the system does not update the contract cost
flag.

8.  Character Users: The system displays: CR-Accept Line, J-Job #, F4-Backup

If the Use Job Cost flag is set to N in the purchase orders static control record
or if the item is a special order or the purchase order is a direct ship, the
system skips this input. Press Enter to accept the line and bypass the job
costing information. Enter J to enter job costing information or F4 to back up
to the previous input. If you enter J, inputs #11-17 must be entered.

Graphical Users: The system displays: Enter Job Number Y or N.

If you select Y, the system displays the Job Posting Entry screen. Enter the
valid job number to post this entry against. Press Enter to default to the last
job number entered (if any). Press F2 to search. For valid job numbers, the
system requests customer code, can enter or search. The system then requests
a memo for the posting entry. You can indicate whether you want this memo
to print on the PO invoice. Note: If the Use Job Cost flag is set to N in the
purchase orders static control record or if the item is a special order or the
purchase order is a direct ship, the system skips this input. If you enterY,
inputs #11-17 must be entered.

9. Job Number
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Enter the valid job number to post this entry against. Entering a valid job
number displays the job name, customer number and name, and billing type.
Press Enter to default to the last job number entered (if any). Press F2 to search.

10. Price Message

If the billing type for the job entered is fixed, contract or time and material, this
input is skipped. If the billing type is cost + (plus) or no charge, the program
displays the price (bill rate) that will be used to calculate the extension. If the
job is no charge, then the markup method can be changed if the allow billing
override flag for the cost code is set to Y and neither the bill rate nor extension
will be affected. Press Enter (CR) to continue.

11. Cost Code

Enter a valid cost code (up to 4 characters). Entering a valid cost code displays
the cost code description and the cost type. If the cost code is not set up to use
units (unit of measure field is blank in Cost Code F/M), the program displays a
message displaying this information. The cost sets the defaults for markup
method (for all jobs that are not billed as cost plus) and the billing rate for jobs
that are billed as a fixed contract or as time and material. If the billing type is
not cost plus, the cost code also determines whether the user is able to override
the markup method and or bill rate. Press F2 to search.

The item entry determines the units, unit of measure and cost rate/extension.
12. Markup

This input is initially skipped and set to the markup assigned to the cost code.
This may only be entered for jobs which are time and materials or fixed
contracts and the Allow Override Of Billing flag is set to Y in the cost code
record. This may also be changed for no charge jobs but the bill rate is not
affected.

Enter the markup method to use for this posting entry. You can enter one of the
following:

# Enter the markup amount (0-9999999.99). Entering a number tells
the system to mark up the cost by a dollar amount. The system marks up
the cost rate by the dollar amount and calculates the bill extension.

#+%  Enter the percentage (0-9999999.99%) to mark up the cost. To enter
a percentage, the user must enter an amount and then the percentage sign.
If no percentage sign is present, the system assumes the entered amount is
a dollar amount. The system marks up the cost rate by the percentage
amount and calculates the bill extension.

M Enter the bill rate manually. Entering M displays the word
MANUAL and the program proceeds to the bill rate input.

The fixed markup method is unavailable for selection, but can be used. To
utilize the fixed method, select a cost code whose markup method is fixed.

Enter initially defaults to the markup method (amount/percentage) from
the cost code record.

13. Bill Rate

This input is unavailable if the Allow Billing Override flag in the cost code
record is set to N. This input is initially skipped unless the markup method of
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the cost code is manual. Enter the price per displayed unit of measure. The bill
extension is calculated and displayed. Press Enter (CR) to initially default to 0.

14. Memo

Enter the memo to post for this job cost transaction and to print on the job cost
invoice (if applicable - see next input). Press Enter (CR) to initially default to
blanks.

15 Print memo on job cost invoice?

This input is initially skipped and set to N. Enter N or Y to indicate whether to
print the memo (entered in the previous input) on the job cost invoice. The
input may only be set to Y if the billing detail for the cost type (that the cost
code is assigned to) is set to A for all transactions in the Job Entry program.
Press Enter (CR) to initially default to N.

Enter -continue, F4-backup

Press Enter to continue, accept the line and return to the prompt-selection
input or press F4 backup.

See Also

Invoice Receipt Entry (POE310)

Invoice Receipt Entry Header Information

How to enter or change invoice receipt information
Line Detail for Invoice Receipt Entry Screen
Header Detail for Invoice Receipt Entry Screen
How to enter invoice receipt header information

How to enter invoice receipt header line-item information
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PO Invoice Receipt Entry Features and Procedures

PO Receipt Header Processing

Opening existing documents

You can access existing purchase order documents that have not been received. Once you begin
receiving a purchase order, the system does not allow to you receive a document in the same window.
You can also start another session of FACTS if you need to receive another PO while you are in the
middle of receiving one.

To open an existing purchase order:
1. Graphical users: Choose File->Open Existing Document.

Character users: Press F10 and choose File>Open Existing Document.
Search Tips:

The system displays the PO Document Search screen. In the Go To field, you can enter beginning
vendor for the search. To narrow your search, you can enter keywords for the filter values and
the characters for the vendor code to start the listing.

2. Use the Document Search window to find the document you want to edit or review.

3. Choose OK in the search window to select the document and return to the main entry window.

Deleting purchase order invoice receipts

Deleted purchase order invoice receipts are not simply removed from the file. The system voids
purchase order invoice receipt line item records and if all the line items for a purchase order invoice
receipt are deleted, then it changes the header record status to deleted. The purchase order invoice
receipt then appears on the next purchase orders Invoice Receipt Register as deleted and is removed in
the subsequent update. This procedure provides a complete audit trail of all purchase order numbers
used.

At any point during the PO entry-receipt process, you can view in detail the PO in its current state or
its overview (history since it was entered) status via the PO Vendor Inquiry or Document Inquiry
programs.

To delete an order before the receipt header is complete:

Press F4 to back up to the Document input.
To delete an order after the header receipt is complete:

With the purchase order open on screen,

Graphical users: Choose File->Delete Document from the menu.
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Character users: Press F10 and choose File> Delete Document from the menu.

PO Invoice Receipt Items Processing

Editing Invoice Receipt Line Items

You can edit line items on a purchase order invoice receipt.

To edit an existing line item receipt:

Use your mouse or arrow keys to highlight the line in the item browser and press select the [ icon to
make changes for the highlighted line item. Press Enter (CR).

OR

Highlight the line and press Line Detail to access inputs that do not appear in the line-item entry
section.

Deleting Invoice Receipt Line Items

Use the mouse or arrow keys to highlight the line in the item browser.

Graphical users: Select the # icon to delete the highlighted PO line invoice receipt, or choose
Edit->Delete Item from the menu.

Character users: Press F2-Delete line and then choose OK to delete the item.

Inserting PO Invoice Receipt Line Items or Memos

Use the mouse or arrow keys to highlight a line. The program inserts the new line item above the
selected one.

Graphical users: Select the =’ button to add a line item above the highlighted item in the browser, or

choose Edit>Insert Line from the menu. Select the Q icon to stop entering line items.

Character users: Press F1-Insert line or press the Insert key. The program stays in Insert mode until you
press F4 from the Item Number input or choose the Cancel button at the right of the screen.

Finding Items in the PO Invoice Receipt Item Browser

This feature may be helpful when you need to find an item you entered on a long order. It eliminates
the need to scroll up and down in the list browser.

Graphical users: Choose Edit>Find Line Item from the menu.
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Character users: Press F10 and choose Edit>Find Line Item.

Enter the item number you want to locate. Press Enter (CR) to go to the first occurrence of that item in
the item browser on the main screen. Press F2 to find a different item or F4 to exit the Find Item
window.

Adding PO Invoice Receipt Line Items

1. Select the ¥® icon to add a PO receipt line. The system displays the Line Detail screen, which is
used to view and modify item descriptions, promise and request dates, item details, item/vendor
info, and item cost info.

‘& The program automatically switches to add mode once you complete the header. This means
the cursor appears in the Item Number input after you exit the last header input. The program

stays in add mode until you press F4 to back out of the line-item entry section or press the
button at the right of the screen.

‘& Quick entry tip: Enter the item number, the ordered quantity and then press the Down
Arrow key.

2. The program uses the default information in the rest of the line-item entry inputs and returns to the
Item Number input.
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Receipt Item Selection Screen (POC315)

The system displays the Receipt Item Selection Screen when you indicate you want to select the PO
lines to import to an invoice receipt. This screen displays from the PO Invoice Receipt Entry program.
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In the upper portion of the screen, the system displays the purchase order number, receipt number,
vendor number, amount, received date, and warehouse.

In the browser in the lower portion of the screen, the system displays the PO lines that are available
from the PO and receipt you specified. All lines populate the browser with the Sel (selection) column
marked as Y. Use the Toggle button at the bottom of the screen to change the Sel value from Y (yes) to
N (no) and vice versa. To select all of the PO lines, select the All button. To not select any of these
lines, select the None button.

You can edit the units and cost for an item on a PO line by double clicking the line or highlighting it
and selecting the [ icon. The system makes the units and Cost inputs in the center of the screen

available for editing. Select the a icon to stop modifying the PO line item. Press the Il icon to save
your changes to the PO line item.

Press the Done button to complete the receipt item selection and return to the PO Invoice Receipt
Entry program.
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How to enter or change invoice receipt information

1. Access this program by choosing Purchase Orders = Invoice Receiving
-> Invoice Receipt Entry.

Complete steps 2-6 to enter invoice receipt header information

2. Inthe Period field, the system displays the current system period. This
is the period to which this invoice receipt information posts (PPYY).
The current accounts payable period is displayed in the upper right
corner of the screen and is the default value. The period cannot be
before the current accounts payable period and must be either the

the current period.

3. Inthe Vendor field, enter the number of the vendor for the invoice.

The system displays the vendor name, address, message, GL table,
document group, branch (if used) and terms code from the vendor’s
record in the accounts payable vendor file.

Search Tips:
Press F2 or select the # icon to perform a document search by vendor.
You can also search by invoice receipt numbers.

To search for invoice receipt documents, select the = icon. You can
enter the beginning vendor to search for. If you press Enter, the
program lists in document order any existing invoice receipt documents
that exist. Also displayed are the date entered, due date, amount, and
vendor number and name.

4. Inthe Document field, enter the document number for the invoice
receipt.

5. You can enter or modify information in the following fields:

GL Tbl--Enter the number of the accounts payable General Ledger
posting table to be used for this invoice. The general ledger posting
table number stored with the vendor is the displayed default value.
The entry must be a valid GL posting table. This table is used in the
line-item portion of the entry to provide default values for the General
Ledger account number input. Press F2 to search.

Doc Grp --Enter the document group number that applies to this
invoice. The program defaults to the group code created in the
vendor’s record in AP Vendor F/M. This group number is stored with
the Accounts Payable document record when it is created by the Invoice
Receipt Register update. Document group numbers are used by several
Accounts Payable reports to categorize documents.

Branch--Enter the valid branch number that applies to this invoice.

Press Enter to default to the branch assigned to the terminal. Press F2
to search.
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Terms Code--Enter the valid payment terms code that applies to this
invoice. The terms code stored with the vendor is the displayed default
value. The terms code is used to determine the due date and discount
amount. Press F2 to search.

Doc Amount--Enter the document (invoice) total amount (+/-
9,999,999.99).

‘& When you add invoice receipt lines in the lower portion of the
screen, you can modify the Doc Amount value via the Header button to
distribute the costs for the additional lines.

Doc Dis--At the bottom of the screen, enter the amount on which to
compute a discount. Press Enter to default to the document amount.
(Freight may not be discountable.)

Document Date--Enter the document (or invoice) date. The system
date is the displayed default value.

Due Date--Enter the due date for this document (invoice). Press Enter
(CR) to allow automatic calculation of the due date based on the terms
code and to proceed to input #14.

Discount--If the automatic date and amount calculation were selected
in input #11, this entry is skipped. Otherwise, enter the invoice
discount. The discount may be entered as a dollar amount or a percent
of the invoice amount. Entry of a discount percent must include the
percent symbol (%) after the number. The discount amount is
calculated and displayed. The default value is the amount calculated
by the system based on the entered terms code. Any amount less than
or equal to the invoice amount is accepted. It is not necessary to enter
the negative symbol (-) for normal discount amounts.

Discount Due Date--If automatic date and amount calculation are to be
selected in input #11, this entry is skipped. Enter the date by which
payment must be made to be eligible for the discount. Press Enter (CR)
to initially default to the date calculated by the system based on the
given terms code.

Memo--Enter the document memo (up to 25 characters). Press CR to
skip this entry. The memo entered appears on the stub portion of the
accounts payable check, generated through the entry of this invoice, the
Invoice Receipt Register and the normal accounts payable check
selection process.

This concludes entry of the header portion of the invoice receipt. After
the record is created, all inputs except #1-3 are accessible through the
change header routine. Inputs #1-3 can only be changed by deleting
and re-entering the invoice.

In the lower portion of the screen the system displays any existing PO
receipt lines for the invoice receipt

Receiving
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Complete steps 6-15 to enter invoice receipt lines. You can:

6.

10.

11.

Select the Delete PO button to delete purchase orders or documents.
The system verifies you want to delete the selected PO receipt line item
before completing the process. Highlight the line you want to delete
then select the Delete PO button.

Select the Header button to modify header information invoice receipt.
Refer to Header Detail for PO Invoice Receipt Entry topic for field
descriptions.

Highlight an existing PO receipt line item and select the Line Detail
button to access the Line Detail for PO Invoice Receipt Entry screen.
You can modify information in the following fields:

Select the E: icon to make changes for the highlighted line item.

Select the New PO button to access the New PO dialog box, which is
used to enter new PO Receipt line items for invoice receipt. From the
New PO dialog box, you can select to import all line items from a
specified PO receipt or only selected PO lines. If you select to import
selected lines, the system displays the Receipt Item Selection Screen so
you can select PO receipt lines to import for invoice receipt.

Line numbers are assigned automatically beginning with 001 and
incrementing by one for each additional line-item up to 999. In the rare
case where 999 line-items have been entered on a single invoice, the
program advances to the prompt-selection input and refuses further
entries. The inputs for entering new POs are the same as for adding
received purchase orders. Refer to step 11 for input descriptions.

Select the & icon (CUI users: enter A-Add Line) to add an invoice line

to the PO invoice receipt. Select the =’ button to add a line item above
the highlighted item in the browser. Enter information in the following
fields:

PO #
For received POs, enter the received purchase order number.

Receipt #

For received POs, enter the receipt number that was entered during
Receipt Entry for this purchase order. The number displayed is default
value. Press Enter to default to the receipt number entered on the
previous line (if applicable).

WH (Warehouse)

If the PO and receipt number entered are the same as the previous line,
this input is skipped and the warehouse is set to the same warehouse as
the previous line. Enter the warehouse the item on this PO was
received at. Press Enter to default to the warehouse assigned to the
purchase order.

Item
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Enter the item number. If the item is not a valid item, the system checks
to see if it is an interchange or a vendor-item number; if either of the
latter are true the system automatically prints the valid item number
and sets its defaults. Entering a valid item number displays the vendor
relation, last lead time, vendor-item number, item class, standard
package size, and buying weight. The relation is considered primary if
this vendor number is stored with the item in the inventory control item
file. If not a primary relationship, the relation is considered secondary
when there is record of purchase of the item from this vendor.
Otherwise, the relation is considered unlisted.

Description
This input is initially skipped except for non-stocked items. Enter the
item description. Press Enter to default to the displayed value.

G/L#

Enter a GL account number. The entry must be a valid GL account
number. This is the GL account number that the Invoice Receipt
Register expenses the cost of the item against. Press F2 to search.

Units

Enter the quantity of items to be received. The entered amount should
be equal to the invoice quantity. Press Enter to default to displayed
value.

Cost

Enter the cost per displayed costing unit of measure. Displayed if on
file is: the manual cost from the item file, the average and last costs
from the warehouse/item file, and the manual and last cost from the
vendor/item file. Depending on the Default PO Cost flag set in the PO
static control record, Press Enter to default to the manual cost of the
item from the item file or the last cost of the item from the vendor/item
file. This input is only used when the Cost flag in the Purchase Orders
Entry Options record is setto Y or B.

If you change the cost on a line, the system does not update the contract
cost flag.

The system displays: Enter Job Number Y or N.

If you select Y, the system displays the Job Posting Entry screen. Enter
the valid job number to post this entry against. Press Enter to default to
the last job number entered (if any). Press F2 to search. For valid job
numbers, the system requests customer code, you can enter a value or
search. The system then requests a memo for the posting entry. You
can indicate whether you want this memo to print on the PO invoice.
Note: If the Use Job Cost flag is set to N in the purchase orders static
control record or if the item is a special order or the purchase order is a
direct ship, the system skips this input. If you enter Y, inputs #11-17
must be entered.

Job Number
Enter the valid job number to post this entry against. Entering a valid
job number displays the job name, customer number and name, and

Receiving
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billing type. Press Enter to default to the last job number entered (if
any). Press F2 to search.

Price Message

If the billing type for the job entered is fixed, contract or time and
material, this input is skipped. If the billing type is cost + (plus) or no
charge, the program displays the price (bill rate) that will be used to
calculate the extension. If the job is no charge, then the markup method
can be changed if the allow billing override flag for the cost code is set
to Y and neither the bill rate nor extension will be affected. Press Enter
(CR) to continue.

Cost Code

Enter a valid cost code (up to 4 characters). Entering a valid cost code
displays the cost code description and the cost type. If the cost code is
not set up to use units (unit of measure field is blank in Cost Code
F/M), the program displays a message displaying this information. The
cost sets the defaults for markup method (for all jobs that are not billed
as cost plus) and the billing rate for jobs that are billed as a fixed
contract or as time and material. If the billing type is not cost plus, the
cost code also determines whether the user is able to override the
markup method and or bill rate. Press F2 to search.

The item entry determines the units, unit of measure and cost
rate/extension.

Markup

This input is initially skipped and set to the markup assigned to the cost
code. This may only be entered for jobs which are time and materials or
fixed contracts and the Allow Override Of Billing flag is set to Y in the
cost code record. This may also be changed for no charge jobs but the
bill rate is not affected.

Enter the markup method to use for this posting entry. You can enter
one of the following:

#  Enter the markup amount (0-9999999.99). Entering a number tells
the system to mark up the cost by a dollar amount. The system marks
up the cost rate by the dollar amount and calculates the bill extension.

#+%Enter the percentage (0-9999999.99%) to mark up the cost. To enter
a percentage, the user must enter an amount and then the percentage
sign. If no percentage sign is present, the system assumes the entered
amount is a dollar amount. The system marks up the cost rate by the
percentage amount and calculates the bill extension.

M  Enter the bill rate manually. Entering M displays the word
MANUAL and the program proceeds to the bill rate input.

The fixed markup method is unavailable for selection, but can be used.
To utilize the fixed method, select a cost code whose markup method is
fixed.

Enter initially defaults to the markup method
(amount/percentage) from the cost code record.
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12.

Bill Rate

This input is unavailable if the Allow Billing Override flag in the cost
code record is set to N. This input is initially skipped unless the
markup method of the cost code is manual. Enter the price per
displayed unit of measure. The bill extension is calculated and
displayed. Press Enter (CR) to initially default to 0.

Memo

Enter the memo to post for this job cost transaction and to print on the
job cost invoice (if applicable - see next input). Press Enter (CR) to
initially default to blanks.

Print memo on job cost invoice?

This input is initially skipped and set to N. Enter N or Y to indicate
whether to print the memo (entered in the previous input) on the job
cost invoice. The input may only be set to Y if the billing detail for the
cost type (that the cost code is assigned to) is set to A for all transactions
in the Job Entry program. Press Enter (CR) to initially default to N.
Enter -continue, F4-backup

Press Enter to continue, accept the line and return to the prompt-
selection input or press F4 backup.

GUI Users: Press the Il icon to save your changes.

Select the e icon to stop entering line items.

Select the #% icon to delete the highlighted PO receipt line.

On the left side of the line item browser, you can select:

1. to access Note Entry (SME710) for the item highlighted in line item
browser.

V. to access Note Entry (SME710) for the vendor specified in the
program.

CUI Users: You can enter:

#- Changes a line-item

L - Lists line-items

A - Adds a line-item

S - Stops receipt of purchase order
D - Deletes the purchase order

F2 - Changes the header

F3 - Accesses the ending routine

In the Notes: area of the screen, just above the line item section, the
system displays VEND or ITEM to indicate that notes are present. From

Receiving
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the View menu of the Warehouse transfer entry programs, you can
select F10-Menu, View, Item Notes or Vendor Notes.

13. Select the Done button or F3, and the system checks to ensure the
undistributed amount of the invoice equals zero then processes the
invoice receipt. The undistributed amount of the invoice must equal

zero to end the program. If no line items were entered, the program
may not be ended.

See Also

Invoice Receipt Entry (POE310)

Invoice Receipt Entry Header Information
Invoice Receipt Items Information

Line Detail for Invoice Receipt Entry Screen

Header Detail for Invoice Receipt Entry Screen
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Invoice Receipt Register (POR310)

Function

This program allows the user to print a register of all invoice receipts that have
been entered since the last Invoice Receipt Register. It may be used as a tool to
locate discrepancies in invoice amounts and actual received amounts.

The optional update creates documents in the AP document entry file, updates
various purchase orders files, and removes invoice receipt and purchase orders
receipt records. This program is available only if the Use Invoice Receipts flag
in the purchase orders static control record is setto Y.

Note: If the cost is a contract cost, the system does not update the last cost with
the contract cost value and sets the contract cost flag for the line.

Report information includes the following: vendor number, document (invoice)
number, branch, total amount, period, due date and payment terms. Each line
of the invoice includes purchase order number, receipt number, item number,
description, received quantity, invoiced quantity, cost at time of receipt, cost on
invoice, the extension (invoice quantity multiplied by the invoice cost) and the
GL account number. An asterisk (*) is printed on any line where the invoiced
amount is unequal to the received amount. Vendor and register totals are also
included.

NOTE: This register does not print a GL distribution or post to general ledger.
During the update, the program writes documents to the AP document entry
file. Users should run the AP Document Entry and Adjustment Register
immediately following this update. The AP register prints the documents to
post into the open payables file and prints the GL distribution (if used). The
update posts documents to the open payables file and optionally posts to
general ledger.

User Inputs

The following inputs are involved in printing and updating the Invoice Receipt
Register:

1. Beginning Vendor

Enter the beginning vendor to print. CR defaults to FIRST. Press F2 to search.
2. Ending Vendor

Enter the ending vendor to print. CR defaults to LAST. Press F2 to search.
3. Branch

Enter a branch number for which to run the register. The entry must be a valid
branch. CR defaults to the branch assigned to the terminal. F3 defaults to ALL.
Press F2 to search.

The program now proceeds to print the register for the selected vendors. Upon
completion of printing the following prompt appears.
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4. Check Register. Ok to Update?

After printing the Invoice Receipt Register, Verify the printout. If everything is
correct, enter YES to continue. The program proceeds with the update. If there
is a correction to be made, enter N to exit the program. After the correction is
made, run the register again.

Technical Notes

Printing of the register proceeds by reading through the invoice receipts file
(POINVC) for records of the selected vendors. The accounts payable vendor file
(APVEND) is then referenced to obtain vendor names.

The header update begins by creating the accounts payable open documents
(APDOCM) header record. If an open document record for this vendor and
invoice already exist in the accounts payable file, a duplicate record is not
created. The update is halted to allow for clarification. If the period invoice
receipts report flag is set to Y, the header record of the period invoice receipts
file (POPDIN) is created. The line-item update creates line-item records in the
accounts payable open documents file and the period invoice receipts file. If the
period receipts discrepancy report flag is set to Y, any discrepant line-items are
created in the period receipts discrepancy file (POPDRD). Next, all
corresponding line-items in the invoice receipts file (POINVC) are removed.
The header record of the purchase order receipts file is removed once all line-
items for that purchase order are removed. The last Invoice Receipt Register
number used is updated in the purchase orders nonstatic control record.

FILES USED - APVEND

FILES UPDATED - APDOCM, APDOCX, POPDIN, POPDRD, POVNIT,
PORECT, POINVC, SMCNTL
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How to run the Invoice Receipt Register

1.  Access this program by choosing Purchase Orders - Invoice Receiving
—>Invoice Receipt Register.

2. Inthe Beginning Vendor field, enter the starting vendor code for the

register. Select the 4 icon to start with the first vendor code on file. Select
the # to search for vendors.

3. Inthe Ending Vendor field, enter the ending vendor code for the register.

Select the M icon to end with the last vendor code on file. Select the # to
search for vendors.

4. Inthe Branch field, enter the branch number for which to run the register.

The program defaults to the branch assigned to the terminal. Select the S
icon to process all branches for the Invoice Receipt Register. Select the
to search for branch.

5. Select the OK button to print the register. The system prints the register for
the selected vendors.

6. The system displays the message: Invoice Receipt Register: OK to Update?

After printing the Receipt Register, verify the printout. If you need to
correct the register data, select Cancel or enter N to exit the program.
After you make the correction, you can rerun the Invoice Receipt Register.
If everything is correct, select OK or enter YES to continue. The program
then prints the GL distribution.

NOTE: This register does not print a GL distribution or post to General
Ledger. During the update, the program writes documents to the AP
document entry file. You should run the AP Document Entry and
Adjustment Register immediately following this update. The AP register
prints the documents to post into the open payables file and prints the GL
distribution (if used). The update posts documents to the open payables
file and optionally posts to General Ledger.
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Uninvoiced Receipts Report (POR320)

Function

This program allows the user to print a report of any purchase orders that have
been received but for which no invoice has been entered.

This program is only available if the Use Invoice Receipts flag in the purchase
orders static control record is setto Y.

The Invoice Receipt Register update removes, from the purchase orders receipts
file, all purchase orders for which invoices have been entered. Therefore, only
uninvoiced purchase orders remain in the file after the Invoice Receipt Register
Update has been run. Those records are available for printing through the
Uninvoiced Receipts Report.

The user has the option to:

»  Select the beginning and ending vendor to print.

» Select the beginning and ending received dates to include.
»  Select warehouse(s) to print.

*  Print vendor totals.

e Print summary or detail information.

Report information includes the following:

e Summary: vendor number, name, purchase order number, receipt
number, received date, warehouse and total amount of the purchase
order.

* Detail: summary information plus item number and description, units
and cost for each purchase order.

* Vendor Totals: totals for purchases (including factored freight), freight
and tax.

User Inputs

The following inputs are involved in printing the Uninvoiced Receipts Report:
1. Beginning Vendor

Enter the beginning vendor to print. CR defaults to FIRST. Press F2 to search.
2. Ending Vendor

Enter the ending vendor to print. CR defaults to LAST. Press F2 to search.

3. Beginning Date

Enter the earliest received date on a purchase order to be included on the report
(ref. 2). CR defaults to FIRST. Press F2 to search.

4. Ending Date

Enter the latest received date on a purchase order to be included (ref. 2). CR
defaults to LAST.
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5. Warehouse

Enter a 2-character warehouse code to print. The entry must be a valid
warehouse. CR defaults to the warehouse assigned to the terminal. F3 defaults
to ALL. Press F2 to search.

6. Vendor Totals

Enter Y or N to indicate whether to include detailed vendor totals. CR defaults
toY.

7. Scope

Enter whether to print S-summary or D-detail information. CR defaults to S.

Technical Notes

Printing proceeds by reading through the purchase order receipts file
(PORECT) for all purchase orders meeting the entered criteria. The accounts
payable vendor file is referenced to obtain vendor names. Upon completion of
printing, the program returns to the purchase orders invoice receipts menu.

FILES USED - SMCNTL, PORECT, APVEND
FILES UPDATED - NONE
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Cost Contracts (POS500)

Many vendors offer special prices (the distributor’s cost) for items or groups of items. You can use
Cost Contracts to more accurately track special prices to reduce errors and ensure that all available
price breaks are taken.

Access Cost Contract Entry (POE510) to enter contracts. When you add lines to purchase orders, the
default cost is calculated. If you override that cost during the entry process, the cost override flag is
set and the origin of any cost entered is captured and stored in the purchase order line item file. That
cost and origin is also transferred to the past purchase order line file. You can view the cost origin in
the line detail of the PO Document Inquiry or during line detail in the PO entry programs. Use the
Contract Listing program to print the detail of contracts that are on file. As contracts expire, they can
be purged using the Cost Contract Removal (POU510) program. Inquiries are available for viewing
contracts on file for a vendor.

You can access the following programs from the PO Cost Contracts menu:
Cost Contract Entry (POE510), which is used to enter contracts for specified vendors.
Cost Contract Listing (POR510), which is used to print the detail of contracts that are on file.

Cost Contract Removal (POU510), which is used to purge contracts as they expire.
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Cost Contract Entry (POES510)

This program allows you to enter cost contracts for vendors. You can store cost contract information
by vendor, including costs that get calculated from other values, like list price. Cost contracts establish
the default cost that gets entered on purchase orders.

Cost contracts can be based on specific items, items of a specific cost class, or all items, and the default cost must
be selectable by vendor. Contracts can be specific to a warehouse or valid for all warehouses, and they can only
be valid when selling to a specific customer (via a special order).

When you enter contract lines, the Scope determines the entry fields that display (e.g. Item or Cost
Class). After you enter the warehouse, effective date, scope and customer information, the system
displays the Contract detail screen so you can enter quantity break/costing information for the
contract line.

Cost Hierarchy Information

For each vendor, you can specify which contract scopes take precedence on the Costing view of
Vendor F/M (APF910). The Contract Scope options are “specific item contracts, “cost class contracts,
“all item contracts, and “standard cost (per PO Static Control).

You can set the order in which the costs are considered, so that if the first one isn’t found the next one
is taken and indicate whether the lowest cost is always taken, regardless of the hierarchy.

Cost contracts for the specific warehouse placing the order are always considered before contracts for
all warehouses (unless the select lowest flag is set and an “all warehouses contract is lower than the
specific warehouse contract).

Cost contracts for the specific customer being sold to on a special order PO are always considered
before contracts that aren’t for a specific customer.

Cost contracts are selected in the following order:

Specific Customer Contracts per the hierarchy — check required flag
Specific Warehouse Contracts per the hierarchy

All Warehouse Contracts per the hierarchy
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Header Input Descriptions

Use the following inputs to enter contract header information:
1.  Vendor

Enter the vendor for this contract. Press F2 or the # icon to search for vendors.
If contracts already exist for this vendor, the system displays them by the
effective date order in the list view in the lower portion of the screen. At the
bottom of the screen, you can enter a date in the List from field to limit the
display by effective date.

2.  Warehouse

Enter the warehouse for this contract. Press F1 for All, F4 to backup, F2 or the
# icon to search for warehouses.

3. Effective Date

Enter the effective contract date

4. Scope

Enter the item scope of the contract. You can select from I-Specific Item, C-Cost
Class, or A-All Items. Press Enter (CR) to accept A, the default.

If you select I, the next prompt is Item. If you select C, the next prompt is Cost
Class. If you select A, the system disables the next prompt.

5. Item/Cost Class

Enter the item for this contract. Press F2 or the # icon to search or F4 to back
up.

_Or_

Enter the cost class for this contract. Press F2 or the 8 icon to search or F4 to
back up.

6. Customer

Enter the customer for this contract. Press F1 to enter N/A, F2 to search for
customers, or F4 to backup. Enter customer number for contracts used for
special orders (i.e. a purchase order tied to sales order). If you enter a customer
number for the cost contract, then it is available only for special orders for the
customer indicated.

Once all header fields have been entered, the program determines if the contract is already on file or if
it overlaps another contract with the same scope. For new contacts, the system displays the Contract
Detail screen for line entry on the contract.

In the list view in the lower portion of the screen, the system displays any existing contracts
Contract Detail Screen—Line Entry
Use the Contract detail screen to enter quantity break/costing information for the contract line.

If the contract is not for a specific item, you can enter the basis and multipliers.
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You can enter a single level contract (i.e. a contract that applies to any quantity purchased) by leaving
the first quantity break set to blank, and doing so, all other breaks are disabled. If you enter a
guantity, all breaks are enabled.

If the contract is for a specific item, you can enter a fixed cost or a basis/multiplier, but all breaks must
have the same kind of costs (i.e. all fixed or all basis/multiplier).

Each quantity must be progressively larger. If you leave a quantity blank, all subsequent breaks are
disabled.

Once you have designated an item cost as fixed cost or basis/multiplier, you cannot change the type.
You can edit the fixed cost, basis and multiplier values, but you must delete and reenter the contract to
change it from a fixed cost to a basis/multiplier cost or to add/remove quantity breaks.

Effective and expiration dates cannot overlap for contracts with the same scope (including warehouse,
scope and entity, and customer).

¥ Cost Contract Information Ed
Warehouse I Aall Effective 0972052002 Expires |1 273152002 Gl
Scope  Cost Class Class DSE  DOCK SUPPLY EQUIPMENT
Quantity By L Basis Multiplier
Break1 | 10 Ju-listrice =] 5000
Breakz | 20 L- List Price =] 4500
Break3 | 30 L-Listrice | | 4000
Break4 | Ju- List Price i
Breaks | - List Price =L
Breakf | [L-tstpice ] |
Mermo |
ok | _ Backup |
Enter the contract expiration date, F1-Mewer
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| ‘

Cost Contract Line Input Descriptions

Use the following inputs to enter contract line detail information:

,& Quantity Breaks: The first break can be either a fixed cost or a basis and multiplier. The second
break can be the same as the first or it can be a basis and multiplier even if the first is fixed. The only
restriction for the second one is that it can’t be fixed if the first is a basis and multiplier. Breaks three
through six must be the same type (fixed or basis and multiplier) as the second.

1. Expiration Date Prompt

Enter the contract expiration date, F1-None, F4-Backup If the date causes the
contract to overlap another contract with the same scope, a message will be
given, and a new date must be entered.

2. Required

Indicate whether this is the required cost when selling to this customer. If you
select this checkbox the system uses this contract cost even if the Use Lowest
Cost checkbox is s elected on the Costing view of Vendor F/M (APF910).

3. Quantity Breaks

Indicate whether to include quantity breaks for cost information.

If you select the Quantity Breaks checkbox, for level 1:

Enter the quantity for break 1. Press F1 to enter None or F2 to change the UM,
or F4 to backup. You can leave the quantity blank, and if it is, all remaining
breaks are disabled and blanked. If this is the first break and the value is left
blank, you can still enter a cost. But if you enter a blank in the quantity of
subsequent breaks, you cannot enter a cost.
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The quantity must be greater that the previous break’s quantity.

You can press F2-Change UM only for the first break and only when the scope
is for a specific item. Press F1 to set the field to blank and move on to next field.
Press F2 to select any valid buying UM for the item. If quantities are already
entered, the system converts the quantities to the new UM.

4. Fixed Cost
Enter the contract cost. For Break 1, you can press F1 to enter Basis/Multiplier

instead. Press F4 to backup. This field is only available if the scope is for a
specific item.

The cost entered should be lower than the previous break’s cost, and if it isn't,
the system displays a message indicating this.

5. Basis

Enter the basis for the contract cost. You can press F1 to enter a Fixed Cost or F4
to backup. For the Basis you can select from: M--Manual Cost, L--List Price, 1--
Quantity Break 1, 2--Quantity Break 2, 3--Quantity Break 3,4--Quantity Break 4,

or 5--Quantity Break 5 (if quantity breaks exist).

If you enter M, L, or P, the system goes to the Multiplier prompt. The default
value is L for the first break, but subsequent breaks default to the previous
break’s basis. Options 1-5 are only valid for breaks 2 through 6, and the only
ones available are the breaks prior to the current break, so for break 4, you have
the option of breaks 1 through 3 as the basis.

6. Multiplier

Enter the multiplier. Press F4 to backup.

7. Memo

Enter the contract memo. Press F4 to backup.

Purchase Orders—7.40
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How to enter vendor cost contracts

1. Access this program by choosing Purchase Orders - Cost Contracts> Contract Entry.

2. In the Vendor field, enter the vendor for the cost contract. Press F2 or select the # icon to
perform a vendor search. The system displays any existing contacts for the vendor, in the
browser in the lower portion of the screen.

3. To add a contract for this vendor, select the =+ icon. Toedita contract, highlight it in the
browser and select the [ icon to displays the Cost Contract Information where you edit
the contract expiration date, costing information, or memo. To delete a contract,
highlight it in the browser and select the # icon.

4. For new contracts complete the following:

Enter the warehouse for this contract. Press F1 or the L icon for All, F4 to backup, F2 or
the # icon to search for warehouses.

Enter the effective contract date

Enter the item scope of the contract. You can select from | Specific Item, C Cost Class, or
A All Items. Press Enter (CR) to accept A, the default. If you select I, the next prompt is
Item. If you select C, the next prompt is Cost Class. If you select A, the system disables

the next prompt.

Enter the item for this contract. Press F2 or the # icon to search or F4 to back up.
-OR-
Enter the cost class for this contract. Press F2 or the # icon to search or F4 to back up.

Enter customer number for contracts used for special orders (i.e. a purchase order tied to

sales order). If you enter a customer number for the cost contract, then it is available only
for special orders for the customer indicated. Press F1 or the @ icon to enter N/A, F2 to
search for customers, or F4 to backup.

5. Press Enter (CR) to display the Cost Contract Information screen to enter contract detail
information.

6. Enter the contract expiration date. Press F1 or the @ icon to enter None or F4 to backup.
If the date causes the contract to overlap another contract with the same scope, a message
will be given, and a new date must be entered.

7. Select the Required checkbox to indicate that this is the required cost when selling to this
customer.

8. Select the Quantity Breaks checkbox to include quantity breaks.

If you select the Quantity Breaks checkbox, for level 1:
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Enter the quantity for break 1. Press F1 to enter None or F2 to change the UM, or F4 to backup.
You can leave the quantity blank, and if it is, all remaining breaks are disabled and blanked. If this
is the first break and the value is left blank, you can still enter a cost. But if you enter a blank in
the quantity of subsequent breaks, you cannot enter a cost. The quantity must be greater that the
previous break’s quantity. The cost entered should be lower than the previous break’s cost, and if it
isn’t, the system displays a message indicating this.

You can press F2-Change UM only for the first break and only when the scope is for a specific
item. Press F1 to set the field to blank and move on to next field.

Press F2 to select any valid buying UM for the item. If quantities are already entered, the system
converts the quantities to the new UM.

For Break 1, you can press F1 to enter Basis/Multiplier instead. Press F4 to backup.

OR

Enter the basis for the contract cost. You can press F1 to enter a Fixed Cost or F4 to backup. For
the Basis you can select from: M--Manual Cost, L--List Price, 1--Quantity Break 1, 2--Quantity
Break 2, 3--Quantity Break 3,4--Quantity Break 4, or 5--Quantity Break 5 (if available).

If you enter M, L, or P, the system goes to the Multiplier prompt. The default value is L for the
first break, but subsequent breaks default to the previous break’s basis. Options 1-5 are only valid
for breaks 2 through 6, and the only ones available are the breaks prior to the current break, so for
break 4, you have the option of breaks 1 through 3 as the basis.

OR

Enter a Fixed Cost for the contract cost. The Fixed Cost field is only available if the scope is for a
specific item.

9. Enter the contract memo. Press F4 to backup.
10. Press the OK button when you have entered the contract costs details. The system

returns you to the Contract Entry screen, where you can add, edit or delete contracts for
the specified vendor.

11. When you have finished with contracts for this Vendor, select the Done button. You can
enter another vendor or press F4 or the Done button (again) to exit the program.
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Cost Contract Listing (POR510)

Use the Cost Contract Listing program to print the detail of contracts that are on
file.

You can select to print Current, Future, and/or Expired contracts and optionally
include actual costs for contracts for specific items that are basis/multipliers.

Input Descriptions

Use the following inputs to print contract information:
1.  Vendor

Enter the vendor for whom you want to print contracts. Press F1 for Any or F4
to backup

2. Warehouse Scope

Enter the warehouse scope for printing contracts. You can select from: A All
Contract Warehouse Scopes, L Contracts for All Warehouses, W Contracts for a
Specific Warehouse. Press F4 to backup.

3. Warehouse

Enter the warehouse to print contracts for. Press F2 to search or F4 to backup.
4. Include All Whse Contracts

Indicates you want to include warehouse contacts that are setup for All
warehouses

5. Item Scope

Enter the item scope for printing contracts. You can select: A All Contract Item
Scopes, | Contracts for Specific Item, C-Contracts for a Cost Class. Press F4 to
backup. Press Enter (CR) to select A, the default.

6. Item

Enter the item to print contacts for. Press F2 to search or F4 to backup.

7. Cost Class

Enter the cost class to print contracts for. Press F2 to search or F4 to backup.

8.  Customer Scope

Enter the customer scope for printing contracts. You can select from: A--All
Contract Customer Scopes or S--Contracts for a Specific Customer.

9. Customer

Enter the customer to print contracts for. Press F2 to search or F4 to backup.

You can select to print expired, current or future contracts. You can further
narrow your print range by effective and expiration dates. You can also print
by effective and expiration dates and not select to print the print expired,
current or future contracts by category.
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10. Print Expired Contacts

Indicate whether to print expired contracts.

11. Print Current Contacts

Indicate whether to print current contracts.

12. Print Future Contacts

Indicate whether to print future contracts.

13. Beginning Effective Date Prompt

Enter beginning effective date to print. Press F1 for First or F4 to backup.

14. Ending Effective Date Prompt

Enter ending effective date to print. Press F1 for Last or F4 to backup.
15. Beginning Expiration Date Prompt

Enter beginning expiration date to print. Press F1 for First or F4 to backup.

16. Ending Expiration Date Prompt

Enter ending expiration date to print. Press F1 for Last or F4 to backup.

17. Print Actual Costs

Indicate whether to print actual calculated cost for contracts on specific items.
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Cost Contract Removal (POU510)

Use the Cost Contract Removal (POU510) program to purge contracts as they
expire.

You can use this program to remove batches of related contracts — for example,
all contracts for a specific customer, a specific item, expired contracts, etc.

You have the option to:

Select whether to remove based on warehouse, customer or item scope.

Select the warehouse scope.

Select the customer scope.

Select the item scope.

Select to remove expired, current, future or all contracts.

Select the beginning and ending expiration dates.

Select the beginning and ending effective dates.

It may be helpful to first run the Cost Contract Listing program to generate the
list of contracts to delete.

Input Descriptions

Use the following inputs to remove contracts:
1.  Vendor

Enter the vendor for whom you want to remove contracts. Press F1 for Any or
F4 to backup.

2. Warehouse Scope

Enter the warehouse scope for removing contracts. You can select from: A All
Contract Warehouse Scopes, L Contracts for All Warehouses, W Contracts for a
Specific Warehouse. Press F4 to backup.

3. Warehouse

Enter the warehouse to remove contracts for. Press F2 to search or F4 to backup.

4. Item Scope

Enter the item scope for removing contracts. You can A All Contract Item
Scopes, | Contracts for Specific Item, C-Contracts for a Cost Class. Press F4 to
backup. Press Enter (CR) to select A, the default.

If you select A, the system disables both the item and cost class prompts, blanks
both item and cost class variables, displays “All Contract Item Scopes in the
description field. If you select I, the system enables the item prompt, disables
cost class prompt, blanks the cost class variable, displays “Contracts for specific
items in the description field. If you enter C, the system disables the item
prompt, enables the cost class prompt, blanks the item variable, displays
“Contracts for a cost class in the description field.
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5. Item

Enter the item to remove contacts for. Press F2 to search or F4 to backup.

6. CostClass

Enter the cost class to remove contracts for. Press F2 to search or F4 to backup.

7. Customer Scope

Enter the customer scope for removing contracts. You can select from A All
Contract Customer Scopes or S Contracts for a Specific Customer.

8. Customer
Enter the customer to remove contracts for. Press F2 to search or F4 to backup.

9. Expired/Current/Future

Remove expired, current, future or all contracts? You can select from E-Expired
Contracts Only, C-Current Contracts Only, F-Future Contracts Only, or A-All
Contracts.

10. Beginning Effective Date Prompt

Enter beginning effective date to remove. Press F1 for First or F4 to backup.

11. Ending Effective Date Prompt

Enter ending effective date to remove. Press F1 for Last or F4 to backup.

12. Beginning Expiration Date Prompt

Enter beginning expiration date to remove. Press F1 for First or F4 to backup.

13. Ending Expiration Date Prompt

Enter ending expiration date to remove. Press F1 for Last or F4 to backup.
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¥ 01-Demo Company, Cost Contract Removal [POUS10]

Y110
A Al Contract Warehousze Scopes |—
f
Al o Seopes o

A~ All Customer Scopes I_

e Sores Comace 5
—
1

L Cost Contract Removal [POUS510)
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Cost Class Search

You can search for cost classes by cost class code or description. Double click a line in the browser to select a
cost class or press the Cancel button or F4 to return to the calling program.
For details about using the Go to and filters options, refer to the Search Features topic in FACTS Basics.

I L Cost Class Search =[] x]

| Optionz  Export  Print

CostClass
GoTa |
' CFilter
Keywords | and| | Gﬂl

CLH CLEANING SUPPLIES
DSE DOCK SUPPLY EQUIPHMENT
SAF SAFETY SUPPLIES

a1 o

ok | Cancel |
1
| |Enterbeginning costelasstogoto o
Li¥ Cost Contract Removal [POUS10) M[=] 3
Help
81-Demo Company Cost Contract Removal Pous1d
Uendor All

r Cost Class Search
KEYWORDS Hone AHND Hone

LN Class Description
2 DSE DOCK SUPPLY EQUIPHMENT
3 SAF SAFETY SUPPLIES

Enter beg cost class, F1-Set Filters, *+F1-Options, F4-Backup ...

Arrows: Up=Prev, Down=Hext, PqUp, PgDn, Home, End

Copyright © 1984-2004 Aperum, Inc. 5-17



Cost Contracts Purchase Orders—7.40

Cost Search

Use the Cost Search feature to search for costs. The system displays costs in
order of the cost hierarchy and uses the following information when displaying
costs: vendor, warehouse, customer (optional, for special orders only), item,
order quantity, and order quantity UM. The customer number field will only be
displayed when working with a special order line tied to a SO.

You can:
» press Enter (Cr) to select the highlighted cost,
» press D or the Default button to select the default cost,

* highlight a contract cost in the browser and press C or the Contract button
to view cost contract details,

* press F3 to exit without selecting a cost.

For details about using the Go to and filters options, refer to the Search Features
topic in FACTS Basics.
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Cost Origin Screen

You can access Cost Origin information for open and past purchase orders.

This screen displays from the PO Document Inquiry or from PO Entry
programs: PO Entry, Non-PO Receipt Entry, and Receipt Entry when you select
the View—>Cost Origin option.

The Cost Origin screen indicates source of the cost on the line and includes
whether the cost is from a contract or not and for contracts, the basic
information including scope, basis, multiplier, and quantity break information.
Line item information also indicates whether the default cost is selected or has
been overridden by the user.
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FACTS

Inquiries (POS600)

The Purchase Orders Inquiry menu allows the user to view purchase order
information by vendor, item and document.

The Vendor Inquiry program allows the user to view purchase order
information by the vendor chosen. Information includes open purchase orders,
past purchase orders, suggested purchase orders, receipts, vendor notes, items,
vendor-item numbers and ship-froms.

The Document Inquiry Program allows the user to view purchase order
documents in detail by the type and status selected. The type options are: open
purchase orders, backorders and noninvoice receipts. The various status codes
include: purchase orders entered, but not printed, purchase orders printed,
received purchase orders, deleted purchase orders and voided printed purchase
orders. Inquiry information includes an overview of the document’s current
status, the actual document as it appeared at time of entry (with updated
amounts and units) and as purchase orders are line-item receivable, each receipt
per line may also be displayed.

The Items-in-Process Inquiry Program allows the user to inquire about the
status of a purchase order item. This inquiry displays in item order all the
purchase orders that contain the selected item. The user chooses the beginning
item to view. Information includes item, type, status, order amount, unit of
measure, cost and warehouse.

The Item Inquiry Program allows the user to display specific information for
items in the Inventory Control Item File. Items may be displayed individually
or sequentially. The user has the option to display general information,
packaging information, warehouse information, open purchase order
information, costing information, pricing information, sales history information
and item activity information. This inquiry is also found on the inventory
control inquiries menu.
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Vendor Inquiry (POI610)

Function

Use the PO Vendor Inquiry program to view purchase order information by vendor and warehouse.

Program Details

When you first access Vendor Inquiry, the upper portion of the screen contains a Go to field, which is
used locate specific vendors. The Go to field is case sensitive. This means that if you enter v100 to
lookup a vendor number when someone entered it as V100, the customer record you are looking for
will not appear in the browser.

You can select the W (filters) icon if you want to limit the number of records that appear in the
inquiry browser. In GUI mode, you can also choose Options 2Filter Values. In character mode, press F1.

Sync Feature

Sync is a method of connecting the entry programs with information displayed in customer, item and
vendor inquiries. It is a helpful feature because it enables you to get real-time information such as
customer balances, vendor balances and warehouse quantities, while you are working in entry
programs.

You can select the EFElicon to change or update the information displayed in this inquiry. When
you use the Sync feature, the icon display changes to Bk Use this display to note whether your
inquiry is in Sync mode.

Inquiries are synchronized on a per user basis. In other words, if you are signed on to FACTS in one
window with one name and signed on in another window with another name, it will appear as if the
Sync function is not working.

Processing

The General view displays by default. From the Windows menu, you can select other windows of
information to open.

The GUI version of the Vendor Inquiry program you can access six views of information in the lower
portion of the screen. The available views are:

e Items, which displays the item number, item description and vendor/item number.

« Past purchase orders, which displays past PO information including PO number, receipt
number, date received, warehouse code, ship-to, warehouse or direct ship type, buyer and
amount.

e Purchase orders, which displays purchase order information including document number, type
(purchase order, backorder, non-invoiced receipt), status (entered but not printed, printed,
received, deleted, voided after received), requested date, promised date, warehouse, ship-to
location, buyer code and the amount. Job Cost users: If the item was purchased for a job, the job
number, cost code, entry memo and bill extension also appears in the view area.
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» Receipts, which displays purchase order receipts information including document number,
receipt number, received date, warehouse, terms code, amount and invoice. The Receipts view
displays the receipt in its entirety, including original cost figures and PO receipt all lines.

e Ship-from addresses, which displays ship-from information from the vendor ship-from file
including ship-from code, vendor name, contact person and phone number.

e Suggested purchase orders, which displays suggested PO information including item number,
item description, warehouse code, units, unit of measure, order number, line number for which
the suggested PO was created and suggested PO type (R-restocking or S-special order).

e Contracts, which displays all cost contracts on file for the vendor.
« Costing, which displays the vendor’s default cost class, cost hierarchy, and use lowest cost flag.

» User-Defined, which displays data from the User-Defined view of PO Vendor Inquiry comes
from the User-Defined view of Vendor F/M (APF910).

From the Options menu you can view, change, add, or delete vendor notes for the specified vendor.

To view vendor information:
1. Enter the vendor for which you want to view information.

Select filters if you want to limit the number of records that appear in the
inquiry browser. In GUI, choose Options 2Filter Values. In character, press F1.

The Go to input is case sensitive. This means that if you enter v100 to lookup a
vendor number when someone entered it as V100, the customer record you are
looking for will not appear in the browser.

2. Select the warehouse for which you want to view information.

The program defaults to the warehouse assigned to the terminal you are using.
To choose another warehouse:

Graphical users: Choose Options 2Filter Views.
Character users: Type ! and press F1.

In the window or popup box, press F1 to select the next warehouse on record.
Press F2 to search for a warehouse code. Press F3 to choose ALL warehouses.

3. Select a view.

Graphical users: Choose a view from the View menu or select one from the view
bar.

Character users: Use the right and left arrow keys to select a view from the view
bar.

View descriptions

Item Displays item number, item description and vendor/item number.
To get more information on items:

Graphical users: In the view area, select the line that you want more detail on
and choose the Line Detail button, or you can double click the icon at the
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Past Purchase
Orders

Purchase
Orders

Receipts

Inquiries

beginning of that line.
Character users: Press F3-Bottom, highlight the line and press CR.

The Item Detail window provides information on last receipt, manual cost,
month-to-date, year-to-date and prior year history.

Displays past PO information including PO number, receipt number, date
received, warehouse code, ship-to, warehouse or direct ship type, buyer
and amount.

To get more information on past purchase orders:

Graphical users: In the view area, select the line that you want more detail on
and choose the Line Detail button, or you can double click the icon at the
beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

The Past Purchase Order detail window provides document header
information, line items and gives you access to receipts.

Displays purchase order information including document number, type
(purchase order, backorder, noninvoiced receipt), status (entered but not
printed, printed, received, deleted, voided after received), requested date,
promised date, warehouse, ship-to location, buyer code and the amount.

Job Cost users: If the item was purchased for a job, the job number, cost code,
entry memo and bill extension also appears in the view area.

To get more information on past purchase orders:

Graphical users: In the view area, select the line that you want more detail on
and choose the Line Detail button, or you can double click the icon at the
beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

The Purchase Order detail window provides header and line item information.
You can choose to view the status of the purchase order since it was created
(Overview), including any received quantities, or you can view it as it
appears in the entry program (Current), with extended cost.

Access additional detail on listed line items by entering the line number.
Select the next purchase order on file by typing N and pressing CR.

Use the Receipts view to display purchase order receipts information in its
entirety including, document number, receipt number, received date,
warehouse, terms code, amount (original cost), and invoice that the receipt
line is attached to. In the lower portion of the screen, the system displays all
lines for the receipt.

Receipts Detail Window

In the view area, highlight the line that you want more detail on and choose
the Line Detail button, or you can double click the icon at the beginning of
that line.

Character users: Press F3-Bottom, highlight the line and press CR.

The Receipts detail window enables you to view line details for items that
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appear on the receipt. The detail information includes the status of the line,
located in the ‘S’ column (blank is ‘open’ and C is ‘complete’), as well as the
invoice number that a line is attached to.

Ship-from Displays ship-from information from the vendor ship-from file including
ship-from code, vendor name, contact person and phone number.

To get more information on ship-from listings:

Graphical users: In the view area, select the line that you want more detail on
and choose the Line Detail button, or you can double click the icon at the
beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

The Ship-from detail window provides address information, both contacts, ship
via method, F.O.B., and buyer code.

Suggested Displays suggested PO information including item number, item description,
Purchase warehouse code, units, unit of measure, order number, line number for
Orders which the suggested PO was created and suggested PO type (R-restocking or
S-special order).

Vendor Displays all notes recorded for this vendor. Use this view to add, change or
Notes delete notes as well.

Contracts Use the Contracts view to display all cost contracts on file for the vendor.
Contracts Detail Window

In the view area, select the line that you want more detail on and choose the
Line Detail button, or you can double click the icon at the beginning of that
line.

For contracts with fixed costs, the detail displays either fixed cost and UM or
basis and muiltiplier information, memo information, and customer info (if
available).

Costing Use the Costing view to display the vendor’s default cost class, cost
hierarchy, and use lowest cost flag.

Notes Displays notes for the specified vendor. In the browser in the lower portion
of the screen the system displays the date the note was created, note
category, urgent note indicator, and subject. You can double click a note line
in the browser to display the View Note screen, which lists the note subject
and text, note type, category, date created, and date edited.

You can access the Notes Entry (SME710) program from the Options—>1
Vendor Note Entry to enter or modify notes for the specified vendor.

User-Defined The data that appears on the User-Defined view of PO
Vendor Inquiry comes from the User-Defined view of
Vendor F/M (APF910). Many users have a few pieces of
information about customers, vendors, and items that are
unique to their business that they would like to enter into
FACTS for reference purposes. The User-Defined view
displays user-defined fields entered the major file
maintenances and makes them available in FACTS Inquiry
programs for information only. There are 5 user-defined
fields that can be entered on the User-Defined screen of
Vendor F/M (APF910). There user-defined field must first
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be configured by a user that has administrator privileges
for User-defined Fields setting on the Security tab of User
Code F/M (SMF410).

Technical Notes

Information displayed is accessed from the following files:

* Purchase orders (PORDER, POVNDX)
* Receipts (PORECT)

e Items (POVNIT)

e Past purchase orders (POPAST)

* Vendor-items (POVITX)

*  Ship-froms (POSHIP)

* Vendor notes (APNOTE)

* Suggested PO’s (POSUGG)

FILES USED - SMCNTL, APVEND, PORDER, POVNDX, PORECT, POVNIT,
POPAST, POVITX, ICMAST, POSHIP, APVALX, POLOTS, POSUGG, POPASX,
ARCUST, SORDER, POPALX

FILES UPDATED - APNOTE
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L# 01-Demo Company, PO ¥Yendor Inguiry - Vendor # Order (POIG10) M= 3
Options  View SortBy Esxport Print Help

GaTo | | Stars with | == | |

Vendor City, State Contact 1%
U180 General Industrial HFG Atlanta, GA

U161 Industrial Supply Distributors Atlanta, GA Jon Eske
U182 S_E. Industrial Prod. & Equip. Atlanta, GA Jerry Cli-|
L4
jl Contracts Costing ltems FPast PO Burchase Orders Beceipts ﬂ
Effect Expires WH | Scope | temiCost Class 1stBreak | L.
09/20/02 12131/02 :
08120002 1110102 02 Item 1101 EA 102,
10/01/02 10/01/03 o1 Al All terns List
L4l | |

Start Fram IE‘ffec‘ti\re date 5 | Ll Ll |_|

(7} Line Detail | g Exit |

|Emercharactersvendur#muststar‘[with i
L# Yendor Inquiry (POIG10) [_ O] %]
Help
1-Demo Company PO Vendor Inquiry - Uendor # Order POIG1d
Uendor Hame Cit State Contact 1
U188 General Industrial MFG
U181 Industrial Supply Distributors Atlanta, GA Jon Eskew
U182 S.E. Industrial Prod. & Equip. Atlanta, GA Jerry Clark
Go To Starts With Filters Off
Uiew Filter:81 Sync OFF
Costing Items Past PO -
Effect Expires WH Scope Item/Cost Class 1st Break UH Cost
a9/28/782 12731782 All Class DSE 18 List = .-@88
a9s28/82 11781782 82 Item 1161 EA 162.868 En
18781782 18781783 81 All All Items List = .40888

Flo-lMenu; FZ2-Drder: Uendor ¥, Alpha, Contact {(Vendor # Search)
Enter beqinning vendor #, F1-Edit filters, F3-View, F4-End ..........
Arrows: Up=Prev, Down=Mext, Left/Right=Uiew, Pglp, PgDn, Home, End First Line
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¥ 01-Demo Company, PO Yendor Inquiry - Yendor # Order (FOI610]
Options  Yiew SotBy Export Prnt Help

Go T | Starts with | ErE |!|

Yendor City, State
U188 General Industrial HFG Atlanta, GA
U181 Industrial Supply Distributors Atlanta, GA Jon Eske
U182 S.E. Industrial Prod. & Equip. Atlanta, GA Jerry C1 =

j Contracts I Costing Items FPast PO Eurchase Orders Eeceipts ﬂ

Default Cost Class  None

CostHierarchy  ICAS I=Contracts for specific items
C=Contracts for a costelass
A=Contracts for all items
S=Standard PO Cost
Use Lowest Cost No

=

|Emer characters vendor # must start with o
L# Yendor Inquiry [POIG10) =] E3
Help
81-Demo Company PO Vendor Inquiry - Vendor # Order POIG1E
Uendor Hame Cit State Contact 1
U188 General Industrial HFG Atlanta, GA Roger Smith
U181 Industrial Supply Distributors Atlanta, GA Jon Eskew
U182 S.E. Industrial Prod. & Equip. atlanta, GA Jerry Clark
Go To Starts With Filters OFF
Uiew Filter:81 Sync OFf
Contracts I1tens Past PO ->

Default Cost Class Hone
Cost Hierarchy ICAS I=Contracts for specific items
C=Contracts for a cost class
A=Contracts for all items
S=Standard PD Cost
Use Lowest Cost Ho

FZ-0rder: Uendor #, Alpha, Contact {(Uendor # Search)
Enter beqginning vendor #, F1-Edit filters, F4-End, F18-Henu |..........

Arrows = Up=Prev, Doun=Hext, Left/Right=Uiew, PgUp, PgDn, Home, End First Line
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2 PO Vendor Inquiry - Yendor # Order (POIG10]) M= E
Options  VWiew Sort By Help

GoTo | Starts with | Er2 | |

Vendor City, State Contact 1.2
U128 Yarehouse Interiors, Inc. Dallas, TX JefFf Ke |

U121 Southern Electric Company Lawrenceville, GA Marian H
U122 Premium Insurance Company Atlanta, GA Robert F -]
13
j Iterms I Past PO Purchase Orders Receipts Ship Erom Sugnested FO u

Received
Qo009 20000MEia 1 ATLA Qg W 200

001021

2000008131 ATLANTAVWAREHOUSE W
001046 00001 200000814 01 ATLANTAWAREHOUSE W 200 1
001073 00001 200000927 01 ATLANMTAWAREHOUSE W 200 14

Start From IFast PO¥ | | ﬂl I_|

T LineDetail | g Exit |

|Enter heginning vendor # to go to

4
;2 Win with ProvideX M= E3
Help
81-Demo Company PO UVENDOR IMQUIRY Cu i PoIG1d
CP=89/797 SEP|
UENDOR U113 Atlanta Crane & Hoists PHOME 1 484-949-210808
147 5. Dekalb Drive 2
COHTACTA Frank Carter
Doraville, GA 38341 2
SUGGESTED FD'S
ITEM DESCRIPTIOHN WH UHITS UM ORDER LH# T|
I[122 Electric Hoist/2888 1b cap. a1 2 EA R

PO*S, PAST PD°5, SUGG PD'S, RECEIFTS, HWOTES, ITEMS, VWEHDOR-ITEMS, SHIP-FROMS
ENTER DISPLAY CODE, CR-HEXT UVENDOR, F3-SELECT WAREHOUSE, F4-BACKUP

ARROYW: UP=PREU VEHDOR, DOWH=HEXT VEHDOR, LEFT=PFREU CODE, RIGHT=MEXT CODE
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2 PO Vendor Inquiry - Yendor # Order (POIG10])
Options  VWiew Sort By Help

IS 3

Statswith [ Er2 | |

GoTo |
Vendor | Mame | City, State | Contact 1=
[
U121 Southern Electric Company Lawrenceville, GA Marian H
U122 Premium Insurance Company Atlanta, GA Robert F -]
4 13
j Iterms Past PO Purchase Orders Receipts Ship Erom ISgggested FO u

ltern | Description

ench

1106 Forerrien Shop Cabinet Desk
1110 Steel Starage Cabinet

Start From [suggested PO | |

M ]

Inquiries
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;% Win with ProvideX H=] 3
Help
81-Demo Company PO UEHDOR IHQUIRY cW m POIG1G
CP=09797 SEP
UEHDOR U113 Atlanta Crane & Hoists FHOHE 1 4B84-949-2100
147 5. Dekalbh Drive 2
COHTACTA Frank Carter
Doraville, GA 38341 2
RECEIPTS
LH DOCH RCPT# RECEIUED WH TERHS AMOUNT IHNUDICE
1 881864 8881 B9/727/797 81 Het 148 782.34
2 981227 00001 18/03/97 81 Het 10 1366.54

ENTER DOCH# TD BEGIN LIST, LH# FOR DETAIL IHQUIRY, CR-CONTINUE, F4-BACKUP |......
ARROYW: UP=PREV UENDOR, DOWH=MEXT UEHDOR, LEFT=PREU CODE, RIGHT=HEXT CODE

2L PO Vendor Inquiry - Yendor # Order [POIG10)
Optiong  Wiew SortBy  Help

Go To Starts with | B |!|

Vendor City, State Cortact 1.+ ]
U128 Warehouse Interiors, Inc. Dallas, T Jeff Ke _|
U121 Southern Electric Company Lawrenceville, GA Marian H

U122 Premium Insurance Company Atlanta, GA Robert F -
*
j Iterms PastPC Purchase Ordersl Receipts Ship Erom Suggested PO u

Coc¥ | Roph# Received Armaumnt
001073 00001 2000008727 01 1% 10 Met 30 Dy 147572
001165 00001 2001/03M2 01 1% 10 Met 30 Dy 26.40
001212 00001 2000/0916 01 1% 10 Met 30 Oy 132172

Invaoice

Start From |oocument j I ﬂ |_I

) LineDetail | f] Bt

Enter beginning vendor # 1o go to
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“\¥endor Inquiry (POIE10) M=l E3
Help
81-Specialty Distributors, InP0 Uendor Inquiry - Uendor # Order POIG1g
City, State Vendor Hame Contact 1

ROX ROX

U188 General Industrial Hfg
Atlanta, GA U181 Industrial Supply Distributors Jon Eskew
Go To Starts With Filters Off

Sync Off

<{- Purchase Drders Receipts Ship From
Date Created Category Urgent Subject
81/14/2083 General Information HMUST PLACE ORDERS ON UWEEKDAYS BEFORE

g1/02/20083 General Information ¥ TEST

Fi6-Menu; FZ2-0rder: Vendor #, Alpha, Contact {(Vendor # Search)
Enter beginning vendor #, F1-Edit filters, F3-Uiew, F4-End ..........
Arrows: Up=Prev, Down=Hext, Left/Right=Uiew, PgUp, PgDn, Home, End

\\ 01-Specialty Distributors, Inc., PO Yendor Inquiry - Yendor # Order [FOI610]

Options  Wiew SortBy  Esport Print Help

GoTo | | Starts with | ErE | |

City, State | This field is case-sensitive Contact 1221
Atlanta, GA U188 General Industrial MfgQ....... _|
Atlanta, GA U181 Industrial Supply Distributors Jon Eske

Atlanta, GA U182 S.E. Industrial Prod. & Equip. Jerry C1 -|
1
ﬂ ltems Past PO Purchase Orders Receipts Ship From I Motes u
e Fitter 0t

Diate Created Category Suhbject
0171472003 General Information MUST FLACE ORDERS QR YWEEKD,
0150252003 General Information A TEET

A5 BEFOR

Start From IDate =] | Ll ﬂl I_|

) LineDetail | 0 Exit |

Enter characters vendor # must start with
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Inquiries

IS 3

2 PO Vendor Inquiry - Yendor # Order (POIG10])

Options  VWiew Sort By Help
Starts with I Em=] | Tl

Vendor City, State Contact 1=

U188 General Industrial Mfg....... + Atlanta, GA
U181 Industrial Supply Distributors Atlanta, GA

U182 S.E. Industrial Prod. & Equip. Atlanta, GA Jerry C1 -]
13

jl Iterms Past PO Purchase Orders Receipts Ship Erom u

GoTo |

Jon Eske

Yendor-[terms#
ARD'S TEST

L1
=] PR

Smnme|nm
T LineDetail | g Exit |

o

|Enter characters wvendor # must start with

;2 Win with ProvideX M= E3

Help
81-Demo Company PO UVENDOR IMQUIRY Cu i PoIG1d
CP=89/97 SEP
UENDOR U113 Atlanta Crane & Hoists PHOME 1 484-949-210808
147 5. Dekalb Drive 2
COHTACTA Frank Carter
Doraville, GA 38341 2
UEHDOR-ITEHS
———————— COST--—-—-
HANUAL LAST UM

UEHDOR-ITEH # ITEM DESCRIPTION WH
NO UEHDOR-ITEHWS FOR THIS WAREHOUSE

PO*S, PAST PD°5, SUGG PO'S, RECEIPTS, HOTES, ITEMS, VEMDOR-ITEMS, SHIP-FROMS
ENTER DISPLAY CODE, CR-HEXT UVENDOR, F3-SELECT WAREHOUSE, F4-BACKUP

ARROYW: UP=PREU UVEHDOR, DOWH=HEXT VEHDOR, LEFT=PREU CODE, RIGHT=MHEXT CODE
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XL PO Vendor Inquiry - Yendor # Order (POIG10) M= E
Options  VWiew Sort By Help

GoTo | Starts with | Er2 | |

Vendor City, State Contact 1.2
U128 Yarehouse Interiors, Inc. Dallas, TX JefFf Ke |
U121 Southern Electric Company Lawrenceville, GA Marian H

U122 Premium Insurance Company Atlanta, GA Robert F -]
L3
j Iterms Past PO Eurchase Orders Receipts Ship Erom Sugnested FO u

| Reguested Fromised W Ship-To Buyer Amount

R 2000/06/27 2O000062T istems Supply C 200 834,24
H R 2000/08/26 2000/08/26 01 AtlantaWarehouse 200 1224.0
PR 2000/08727 200008727 01 AtlantaWarehouse 200 1213.68
PR 2000/08727 200008727 01 AtlantaWarehouse 200 27 .66
PR 2000/08727 200008727 01 AtlantaWarehouse 200 182.14
F O 2001/03M10 200100310 01 Barnes Machinery & Equipmen 200 oo
FE  2000/08/14 2000/08M14 01 Atlanta Warehouse 200 .00

4 ]
Start From |Document j I LI |_|

T LineDetail | g Exit |

|Enter heginning vendor # to go to

%
™ ¥endor Inquiry (POIE10) (O] x]
Help
81-Specialty Distributors, InPO Uendor Inquiry - Vendor # Order POIA1d
City, State Uendor Hame Contact 1
a ROX ROX
Atlanta, GA U188 General Industrial MWfgQ....... smith
Atlanta, GA U181 Industrial Supply Distributors Jon Eskew
Go To Starts With Filters Off
Sync OfFfF
L&l Purchase Orders Receipts Ship From Hotes
Doc#t T S Requested Promised WH Ship-To Buyer Amo
881355 B P 685/36/20080 85/30/20088 81 Atlanta Warehouse 188 28
8@1357 P P 86781720080 86/891/2888 81 Atlanta Warehouse 188
BE1358 P P 86781720080 86/891/2888 81 Atlanta Warehouse 188
8813692 P R 06/05/20080 86/05/2088 81 Atlanta Warehouse 188 18
8g1371 P P 867085720008 8678572888 81 Atlanta Warehouse 188
8@1373 P P B6/86/200808 B86/86/2888 A1 Atlanta Warehouse 188
881374 P P 06/06/2000 B86/06/2088 81 Atlanta Warehouse 188
81375 P P B6/06/2000 06/86/2000 81 Atlanta Warehouse 188
Fi8-Menu: FZ2-0rder: UVendor #, Alpha, Contact {(Uendor # Search)
Enter beginning vendor #, F1-Edit filters, F3-Uiew, F4End ..........

Arrows: Up=Prev, Down=Mext, Left/Right=View, PglUp, PqDn, Home, End
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;% Win with ProvideX H=] 3
Help
81-Demo Company PO UEHDOR IHQUIRY cW m POIG1G
CP=09797 SEP
UEHDOR U113 Atlanta Crane & Hoists FHOHE 1 4B84-949-2100
147 5. Dekalbh Drive 2
COHTACTA Frank Carter
Doraville, GA 38341 2
SHIP-FROHS
LH SHIP-FROHM HAHE COHTACT PHOHE #

NO SHIP-FROM FOR THIS UENDOR

PO'5, PAST PO'S, SUGG PO'S, RECEIPTS, HOTES, ITEMS, UEHMDOR-ITEMS, SHIP-FROMS
EHTER DISFLAY CODE, CR-HMEXT UENMDOR, F3-SELECT WAREHOUSE, F4-BACKUP |..
ARROYW: UP=PREV UENDOR, DOWH=MEXT UEHDOR, LEFT=PREU CODE, RIGHT=HEXT CODE

2L PO Vendor Inquiry - Yendor # Order [POIG10)
Optiong  Wiew SortBy  Help

GoTo | Starts with | Er2 | P

Vendor | Mame | City, State | Cortact 1.2 ]
U120 Warehouse Interiors, Inc. Dallas, T Jeff Ken—l

U121 Southern Electric Compan Lawrenceville, GA Marian H
U122 Premium Insurance Compan Atlanta, GA Robert FJE
<] | ,
j Iterms PastPC Purchase Orders Receipts I Ship Erom Suggested PO u

Mo infarmation for 4122 |

0 e Detail | [y Exit

Enter beginning vendor # 1o go to i
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_-\ 01-7.4 Development. PO Yendor Inquiry - Yendor # Order [POIG10) M= E3

|_|_ - ,ﬁl_

U117 D'Anconia Copper and Electric
U118 Georgia Insurance Services

Stone HMountain, GA 308278
U119 Industrial Chemicals Inc.

Atlanta, GA 3a3m
Dallas, T 75289

™y V¥endor Inquiry (POIG10)

Copyright © 1984-2004 Aperum, Inc.
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Purchase Orders—7.40

How to view vendor information

Access this program by choosing Purchase Orders 2Inquiries PO Vendor Inquiry.
Enter the vendor for which you want to view information.

Select filters if you want to limit the number of records that appear in the inquiry
browser. In GUI, choose Options 2Filter Values. In character, press F1.

Use the up and down arrow keys or the Page Down and Page Up keys to scroll
through the displayed list of vendors. Graphical users can also use the vertical
scroll bar.

2 The Go to input is case sensitive. This means that if you enter v100 to lookup
a vendor number when someone entered it as V100, the customer record you are
looking for will not appear in the browser.

Select the warehouse for which you want to view information.

The program defaults to the warehouse assigned to the terminal you are using. To
choose another warehouse:

Graphical users: Choose Options 2Filter Views.

Character users: Type ! and press F1.

In the window or popup box, press F1 to select the next warehouse on record.
Press F2 to search for a warehouse code. Press F3 to choose ALL warehouses.

Select a view.

Graphical users: Choose a view from the View menu or select one from the view
bar.

Character users: Use the right and left arrow keys to select a view from the view
bar.

View descriptions

Item  Displays item number, item description and vendor/item number. To get more information on
items:

Graphical users: In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.
The Item Detail window provides information on last receipt, manual cost, month-to-date, year-to-

date and prior year history.

Past Purchase Orders  Displays past PO information including PO number, receipt number, date
received, warehouse code, ship-to, warehouse or direct ship type, buyer and amount.
To get more information on past purchase orders:

Graphical users: In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line.
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Character users: Press F3-Bottom, highlight the line and press CR.

The Past Purchase Order detail window provides document header information, line items and
gives you access to receipts.

Purchase Orders Displays purchase order information including document number, type (purchase
order, backorder, noninvoiced receipt), status (entered but not printed, printed, received, deleted,
voided after received), requested date, promised date, warehouse, ship-to location, buyer code and
the amount.

Job Cost users: If the item was purchased for a job, the job number, cost code, entry memo and bill
extension also appears in the view area.

To get more information on past purchase orders:

Graphical users: In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

The Purchase Order detail window provides header and line item information. You can choose to
view the status of the purchase order since it was created (Overview), including any received
quantities, or you can view it as it appears in the entry program (Current), with extended cost.

Access additional detail on listed line items by entering the line number.

Select the next purchase order on file by typing N and pressing CR.

Receipts Displays purchase order receipts information in its entirety including, document
number, receipt number, received date, warehouse, terms code, amount (original cost),
and invoice. In the lower view portion of the screen, the system displays all lines for the
receipt. In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line. The Receipts
detail window enables you to view line details for items that appear on the receipt. The
detail information includes the status of the line, located in the ‘S’ column (blank is ‘open’
and C is ‘complete’), as well as the invoice number that a line is attached to.

To get more information on receipts:

Graphical users: In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

Ship-from Displays ship-from information from the vendor ship-from file including ship-from code,
vendor name, contact person and phone number.

To get more information on ship-from listings:

Graphical users: In the view area, select the line that you want more detail on and choose the Line
Detail button, or you can double click the icon at the beginning of that line.

Character users: Press F3-Bottom, highlight the line and press CR.

Copyright © 1984-2004 Aperum, Inc. 6-19



Inquiries Purchase Orders—7.40

The Ship-from detail window provides address information, both contacts, ship via method,
F.0.B., and buyer code.

Suggested Purchase Orders Displays suggested PO information including item number, item
description, warehouse code, units, unit of measure, order number, line number for which the
suggested PO was created and suggested PO type (R-restocking or S-special order).

Vendor Notes  Displays notes for the specified vendor. In the browser in the lower portion of the screen
the system displays the date the note was created, note category, urgent note indicator, and subject.
You can double click a note line in the browser to display the View Note screen, which lists the
note subject and text, note type, category, date created, and date edited.

You can access the Notes Entry (SME710) program from the Optionsal Vendor Note Entry to
enter or modify notes for the specified vendor.

Contracts Use the Contracts view to display all cost contracts on file for the vendor.
Contracts Detail Window.

In the view area, select the line that you want more detail on and choose the Line Detail
button, or you can double click the icon at the beginning of that line.

For contracts with fixed costs, the detail displays either fixed cost and UM or basis and
multiplier information, memo information, and customer info (if available).

Costing Use the Costing view to display the vendor’s default cost class, cost hierarchy,
and use lowest cost flag.
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Document Inquiry (POI620)
Function

This program allows the user to view purchase order documents (past and
current) in detail.

The user has the option to view PO documents by warehouse. The system also
displays a detailed history of a line-item for a PO or past PO. Receipt
information is also available.

In Document Inquiry, if you enter a purchase order that has been completely
received and updated, the system displays the message: "Updated PO XXXXXX
can be viewed in Receipt Entry programs”. To view a purchase order that has
been completely received and updated, access Receipt Entry (POE210) and

Non-PO Receipt Entry (POE220) as appropriate for the PO. Select the = icon
or F3 to search for purchase orders. If the "Update in Receipt Entry" option is set
to yes in PO Static Control F/M (POF980), the PO Search window contains an
Updated PO button that displays a search window containing purchase orders
that been completely updated in the PO Receipt Entry or Non-PO Receipt Entry
programs. If you select a purchase order from this search, the system displays
the PO Receipts Search Window where you can select to view a receipt. Refer to
the PO Receipts Search window for detailed information about this feature.

Inquiry information for each document includes:

e Shipping information
*  Purchase amounts
e Item description

User Inputs

The following inputs are involved in displaying purchase order document
inquiry information:

1. Warehouse

Graphical Users: When you first access Document Inquiry, the upper portion of the screen contains a
Whese input, which is used to locate specify the warehouse used in the inquiry. The system defaults to
the initiating warehouse for the user. You can also use the drop-down list to select open documents or
PO documents. You can select the # icon or F2 if you want to search for a specific document number.
You can also select the VCR buttons to display the next document on file.

Enter the warehouse code for the inquiry. By selecting a specific warehouse, the
system displays only the information for the specified vendor in the specified
warehouse. The default warehouse for the current user is displayed at the top
right of the screen (CW). Once the user has chosen to select warehouse, the
current warehouse and its description are displayed at the bottom of the screen.

You can press any of the following: F3 or the Sh icon to default to the all
warehouses and displays all information on file for the vendor, F2 or the # icon
allows a search Enter (CR) defaults to the current warehouse.
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2. PO Number

Character Users: To display open purchase orders, enter O here. To display past purchase orders,
enter P here. To access the Warehouse input, press F4.

GUI Users: Select the type of PO document to display. You can select from: O-open purchase orders
or P-past purchase orders.

Enter the PO number to display. Entering a valid PO document number displays the document as it
would be in the corresponding entry program PO Entry or Receipt Entry (based on its status as a
OPEN or PAST PO), and displays the status OPEN or PAST in the top center of the screen. F2 or the
# allows a search

The detail or lower portion of the screen may display the open PO’s line-items
in C-current mode. Past PO’s may be displayed in R-receipt mode. Both open
and past PO line-items can be displayed in O-overview mode. The user selects
the mode, and once selected, the mode is displayed in the center of the border
line separating the header from the line-items. The tax, freight and new total for
the PO is displayed in the lower right hand corner of the screen.

The overview mode displays the status of the past PO since it was created. For
each line, it displays the original order amount, the amount already received,
the amount currently on order and the unit of measure for these amounts. The
cost for each item and its unit of measure is also included.

The current mode displays the document as it appears in PO Entry: the item
and its ordered, received and backordered amounts, as well as the
corresponding unit of measure. The amounts displayed are the updated current
amounts (the amounts on order but not yet received). The cost of the item and
the line’s extended cost are also included.

The receipt mode displays the document as it appears in Receipt Entry: the line
number, item and its ordered, received and backordered amounts, as well the
corresponding unit of measure. The amounts displayed are the amounts that
appeared on the receiving document the day it was receipted.

GUI Users:

You can select from the following:

The Receipts button to display past POs.

The Open PO button to display open purchase orders (if you are receipt mode.)
The Footer button to display footer information for the PO document number.

The Line Detail button to display details for the PO line number highlighted in the browser in the
lower portion of the screen.

The Done button to exit the program.
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Character Users:

The system displays the following:
3. Document Type

If F2 was not selected at input #1, inputs #3-8 are skipped. Enter whether the
document type to be displayed is O-open purchase orders or P-past purchase
orders.

If O is selected the system displays the PO number, type, status, warehouse,
ordered date, vendor number and name, and reference number. If P is selected
the system displays the same information with the exception of type and status.
The program proceeds through the same inputs for past and open PO
documents. CR defaults to O.

4. Search

Enter whether to search by D-document or VV-vendor. Entering a V allows the
user to enter a beginning vendor, whose documents are to list for the current
warehouse. Entering D allows the user to enter a beginning document to list for
the current warehouse. F2 allows the user to set the parameters for the search
(only available if searching for open PO’s). CR defaults to D.

5. Document Type

If F2 was not selected in input #4, this input is skipped. Enter whether to
display P-open purchase orders, B-backorders and/or R-non-PO receipts. CR
defaults to ALL.

6. Status Code

If F2 was not selected in input #4, this input is skipped. Enter whether the
status code to display is E -purchase order entered, not printed, P-purchase
order printed, R-received purchase order, D-document deleted and/or V-
printed purchase order voided. CR defaults to ALL.

7. Beginning Document/Vendor

Enter the number of the first document or vendor (as selected in input #4) to
display. CR defaults to NEXT. This displays a summary screen listing the
purchase orders by the status(es) and type(s) selected. Information includes line
number, document number, type, status, order date, vendor number, vendor
name, warehouse, and reference number.

8. Select Line Number

Select the line number of the document to display. The selected purchase order
document is displayed in detail.

9. Options Are:

# - Enters line number to detail

CR - Continues listing

N - Next PO document of the same status (open or past) or next receipt if in receipt
display mode and there are multiple receipts

L - Option to begin listing at an entered line numbers
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C - Changes display mode to current

R - Changes display mode to receipts

O - Changes display mode to overview

P - Displays line-items of the opposite status if a PO is partially received
F4 - Backs up

The detail or lower portion of the screen may display the open PO’s line-items
in C-current mode. Past PO’s may be displayed in R-receipt mode. Both open
and past PO line-items can be displayed in O-overview mode. The user selects
the mode, and once selected, the mode is displayed in the center of the border
line separating the header from the line-items. The tax, freight and new total for
the PO is displayed in the lower right hand corner of the screen.

The overview mode displays the status of the past PO since it was created. For
each line, it displays the original order amount, the amount already received,
the amount currently on order and the unit of measure for these amounts. The
cost for each item and its unit of measure is also included.

The current mode displays the document as it appears in PO Entry: the item
and its ordered, received and backordered amounts, as well as the
corresponding unit of measure. The amounts displayed are the updated current
amounts (the amounts on order but not yet received). The cost of the item and
the line’s extended cost are also included.

The receipt mode displays the document as it appears in Receipt Entry: the line
number, item and its ordered, received and backordered amounts, as well the
corresponding unit of measure. The amounts displayed are the amounts that
appeared on the receiving document the day it was receipted.

The user may enter the line number to be selected for a detailed display. Only
non-memo (M) lines may be detailed. Select the line number to detail. The
system automatically displays the item number, descriptions 1 and 2, and the
line’s status (ordered, partially received, or complete). The detail also displays
a recap of the item’s status: original order amount, amount currently on order,
amount received on the last receipt for this line, backordered amount, and the
total amount that has been received. It also displays the cost of the item and its
corresponding unit of measure. The freight factor, GL posting table, weight,
vendor-item number, and whether the item is a stocked or nonstocked item is
also included. Also displayed are the requested, promised and the most current
received date. Whether this line should affect/update the average lead time in
the item file and if it is taxable are also included.

For line items, you can select Cost Origin from the View menu to display the
Cost Origin screen.

If the displayed PO document is open and the user is using Job Cost and this
line’s item was purchased for a job, the job number, cost code, entry memo, and
bill extension is displayed. If the item is a serial or lot item the serial or lot
numbers can be seen by selecting S. If the item is partially received and the
receipts are on file, then the receipt history can be displayed by selecting R.
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Technical Notes

FILES USED - SMCNTL, PORDER, APVEND, POSHIP, POVNDX, APVALX,
POLOTS POPALX, POPAST, POPASX, POPLTS, SORDER, ARCUST

FILES UPDATED - NONE

L# Document Inquiry (POI620) [_ O] %]
Help

1-Demo Company PO Document Inquiry POIGZH
Whse 01 Atlanta Wa Open PO Humber 881164

Vendor U188 Whse 91 Atlanta Warehou Receipt#

Ship From  SAKE Ship-to Received

General Industrial HFG Atlanta Warehouse

2618 Dunwoody, P1. 685 Fulton Industrial Buyer 1688 Ronald Patt
Suite 133-134 Atlanta, GA 33825 Terms B2 2% 18th Het
Atlanta, GA. 36338 Dept Hot on file
Ship Via Freight Prepaid FOB Atlanta
Reference Upd LT Yes

OUERUIEW {CURRENHT UIEW}Y

Item Desc 1 Original Received Current UM

1112 Portable 2 2 ER

Tax il ] Freight -aa Total 397 .00
Open PO: Prew, Search, Hext - Line Detail, Fooler
F18-Henu, F9-CURRENT UIEW, F4-Done I
Arrows: Up=Prev, Doun=Hext, Left/Right=Lines, PqgUp

, Pgbn, Home, End First line

B Document Inquiry for Open PO 001173 - Yendor ¥104

File “iew Options GoTo Help

whse [ 01 4| &yl atlanta warehou 0-open PO =] ([ 00T173] (84| Purchase Order | 4| b
Vendor V104 Whse 01 Atlanta Warehouse Ordered  DB8/27,2000
Ship Fram SAME Ship-ta c104 Direct Requested 087272000
Rearder Metals, Inc. NOT OM FILEinery & Equipment Fromised D8/27/2000
34 Morth Buford Street 18 Sauth Dixan Ave. Buyer 100 Ronald Patton
Aflanta, GA 30309 Atlanta, GA 30302 Terms 30 Het 3D
Dept 1 WholeSal e
Ship Via UPS Freight Prepaid FOB  Atlanta
Reference SO DOCHD01673 Update LT HNo
OVERVIEW CURRENT YIEWY
Item | Description 1 Qriginal Received Current | UM Cost| Uh | Ful

19123 NONSTOCKED 1 1.00 EA NOK

L4l | |
Tax 00 Freight 00 Total 5.95
Receipts | | Open o | Footer | Line Detail | Done |

v

Inquiries
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ltems-In-Process Inquiry (POI630)

Function

This program allows the user to inquire about the status of a purchase order
item.

Inquiry information for each item in process includes item number and
description. The number of each purchase order with the item is then listed,
giving the following information: document number, type, status, date, vendor,
name, quantity ordered, received and backordered, buying unit of measure,
cost, and costing unit of measure.

User Inputs

The following inputs are involved in displaying purchase order items-in-
process inquiry information:

1. Document Type

Enter whether the document type(s) to display is P-open purchase order, B-
backorders and/or R-non-PO receipt. CR defaults to ALL. F3 allows changes
to the current warehouse.

2. Warehouse

If F3 was not selected at input #1, this input is skipped. By selecting a specific
warehouse, the user sees only the information for the specified vendor in the
specified warehouse. The current warehouse is displayed at the top right of the
screen (CW). Once the user has chosen to select warehouse, the current
warehouse and its description are displayed at the bottom of the screen. The
user may enter a valid warehouse or select any of the following: F1 defaults to
the next warehouse on file; F2 allows a search (ref. 9); F3 defaults to all
warehouses and displays all information on file for the vendor; CR defaults to
the current warehouse.

3. Status Code

Enter whether the status code(s) to display are E-purchase order entered, not
printed, P-purchase order printed and/or R-received purchase order. CR
defaults to ALL.

4. Beginning Item
Enter the beginning item number to begin listing.
CR Next
F2 - Searches
F3 - Ends the program
F4 - Backs up to the status prompt
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Technical Notes

FILES USED - SMCNTL, PORDER, POITMX, ICMAST, APVEND, ICALPX,
ICCLSX

FILES UPDATED - NONE

L2 Items-In-Process Inguiry [PO1630]
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ltem Inquiry (IC1610)

Function

This program allows the user to display item information by warehouse in
inventory. Refer to the Item Inquiry topic in Chapter 8 of IC Users Guide for
detailed information about this program.
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Reports & Prints

The purchase order reports and prints allow the user to obtain hard copy
information about purchase orders. This information may be helpful in the
management of purchase orders. The user may view open orders, backorders,
and future cash requirements based on purchase orders. The user may also
view information on vendor-item numbers.

1. The Status Report allows the user to view all entered and printed purchase
orders by vendor, document or item. This report is warehouse specific.

2. The Receiving Schedule allows the user to print a report of open purchase
orders by expected receiving dates. The report may be printed by date,
vendor or item. This report is warehouse specific. The printout may be in
summary (PO number’s and totals) or detail (PO numbers and each line-
item). This report is helpful in determining when incoming shipments will
arrive, so that customer orders may be filled.

3. The Cash Requirements Report allows the user to print a report showing
future payments due to vendors for purchases made through the purchase
orders system. This report is helpful in cash management and budget
planning. Amounts due are printed for each vendor. Selection may be
based on due date or discount date. Dates to print may be selected.
Reports may include purchase orders or registered receipts, and may be
printed in summary or detail.

4. The Vendor/Item Listing prints vendor-item numbers by vendor or by
item. The report is useful in viewing general information from the vendor-
item records on file.

5. The Vendor/Item History Report allows the user to obtain a report by
vendor or by item of the historical information in the vendor/item file.
This report is helpful in locating active or inactive vendors or items and
determining vendors or items to purge from the file. 1t may also be useful
in viewing purchasing patterns. Month-to-date, year-to-date and prior
year figures may be included in the report.
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6. The PO Code List prints a listing of all buyer codes and their descriptions
on file.
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Software - Purchase Orders [POS000)

Leaders in Distribution Solutions

LTS ) FACTS 7.4 Development - Campany 01 01/05/04 - 2:53 pm

A |

Purchase Orders Reports & Prints Tasks:

Receiving Schedule
ﬁ %ﬂ ﬂ w Cash Requirements
endorfltem Listing

Wendarfterm History
Entry Receiving Inwoice Receiving Cost Contracts FO Code List

Inquiries Reports & Frints End of Period File Maintenances

? Access Code I ﬂl

| | Y

-\\Eumpan}l 01. FACTS 7.4 Development =] E3
Help
81785784 Honday Purchase 0Orders JLW T5d 3:8% pn
B81-FACTS 7.4 Developme ——— Heports & Prints ——— POS788
1. PO Status Report
2. Receiwving Schedule
3. Cash Requirements
4. UVendor/Item Listing
5. Uendor/Item History
6. PO Code List
Selection
EMTER SELECTIOW #, ACCESS CODE, 'OFF°, ARROWS, F4-PREVIOUS HEHU
| Y
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PO Status Report (POR710)

Function

This program allows the user to view open and/or backordered PO’s that are
entered and/or printed.
The user has the option to:

»  Select the order to print - document, vendor or item.

» Select the beginning and ending order choice.

»  Select warehouse(s) to print.

*  Print costing information.

»  Select document types to print - open and/or backordered.
»  Select a cutoff date.

Report information includes the following: the item and description, requested
and promised dates for each line-item, as well as the original ordered amount,
the amount received thus far, and the current amount still on order. The Cost of
each item may also be printed. The total number of PO’s, vendors or items
listed is also included.

User Inputs
The following inputs are involved in printing the PO Status Report:

1. Order

Enter the order in which the report should print (ref. 6).

2. Beginning order choice

Select the beginning order choice to print (ref. 1). Press F1 to enter the first
record on file. Press F2 to search vendors, documents, and items.

3. Ending order choice

Select the ending order choice to print (ref. 4). Press F1 to enter the first record
on file. Press F2 to search vendors, documents, and items.

4, Warehouse

Enter the warehouse code to print. The entry must be a valid warehouse code.
CR defaults to the warehouse assigned to the terminal. F3 defaults to ALL.
Press F2 to search.

5. Cost

Enter N or Y to indicate whether to include cost information. CR defaults to N.

6. Type

Enter whether to print P-open purchase orders, B-backorders and or R-received
purchase orders. CR defaults to ALL.
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7. Cutoff Date

Enter promised date after which PO’s will not print; i.e., any purchase orders
with a promise date after the entered cutoff date are not included. CR defaults
to NO CUTOFF (ref. 2).

Technical Notes

The printing proceeds by reading through the purchase orders file (PORDER).
Records meeting all criteria entered are printed.

FILES USED - SMCNTL, PORDER, APVEND, ICMAST, POVNDX, POITMX
FILES UPDATED - NONE
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Receiving Schedule (POR720)

Function

This program allows the user to obtain a report of open purchase orders by
expected receiving date.

The user has the option to:

» Select the beginning and ending promised delivery dates to print.
»  Select the order to print - document, vendor or item.

» Select the beginning and ending order choice.

»  Select warehouse(s) to print.

e Print summary or detail information.

Report information includes the following:

* Summary: promised date, purchase order number, type, status,
warehouse, requested date, vendor number, name and purchase order
amount.

*  Detail: all summary information plus each item, description and number
of units ordered on each purchase order.

User Inputs

The following inputs are involved in printing the Receiving Schedule:

1. Beginning Date

Enter the beginning date to print (ref. 2). F1 defaults to FIRST.
2. Ending Date

Enter the ending date to print (ref. 2). F1 defaults to LAST.
3. Order

Select the order the report should print (ref. 6).
4. Beginning Order Choice

Select the beginning order choice to print (ref. 1). F1 defaults to FIRST. Press F2
to search vendors and items.

5. Ending Order Choice

Select the ending order choice to print (ref. 4). F1 defaults to LAST. Press F2 to
search.

6. Warehouse

Enter the warehouse to print. The entry must be a valid warehouse. CR
defaults to the warehouse assigned to the terminal. F3 defaults to ALL. Press
F2 to search.
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7. Scope

Enter whether to print S-summary or D-detail information. If | was entered in
input #3, this input automatically defaults to D and is skipped. CR defaults to
S.

Technical Notes

7-8

Printing proceeds by reading through the purchase order file (PORDER) for all
purchase orders meeting the entered criteria.

The program builds a sort file (SMSRT?) to put records into proper printing
order. The accounts payable vendor file (APVEND) is referenced to obtain
vendor names.

FILES USED - SMCNTL, APVEND, PORDER, ICMAST, POVNDX, POITMX
FILES UPDATED - NONE
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Cash Requirements (POR730)
Function

This program allows the user to print a report showing the future payments due to vendors
for purchases made through the purchase orders system. The report prints all open PO
receipt lines regardless of whether they are assigned to invoice.

This report may be useful in cash management by showing the upcoming cash
outlays. The report contains dated columns showing amounts due to each
vendor for each purchase order during that time period. Information on this
report comes from the purchase orders file and/or the purchase order receipts
file.

The user has the option to:

»  Select the beginning and ending vendor to print.

»  Select warehouse(s) to print.

» Select due date or discount due date as the date to determine time
period the document falls.

*  Print up to six time groupings.

»  Select up to 99 days to be used for automatic date increments.

»  Select the dates for the time groupings.

»  Print purchase orders and/or registered receipts.

*  Print summary, detail information.

Report information includes the following:

e Summary: vendor number, name, terms and vendor’s balance due in
each of the date columns.

e Detail: summary plus document number, type (purchase order or
receipt), due date and the document amount due in each of the date
columns. Both vendor and report totals are included.

« Detail by item: detail plus each line-item on each document and the
document amount due in each of the date columns.

The total number of vendors listed is also included.

User Inputs

The following inputs are involved in printing a Cash Requirements Report:

1. Beginning Vendor

Enter the beginning vendor number to print. F1 defaults to FIRST. Press F2 to
search.

2. Ending Vendor

Enter the ending vendor number to print. F1 defaults to LAST. Press F2 to
search.
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3. Warehouse

Enter the warehouse to print. The entry must be a valid warehouse. CR
defaults to the warehouse assigned to the terminal. F3 defaults to ALL. Press
F2 to search.

4. Due/Discount Date

Enter whether the DU-due date or DI-discount due date should be used to
determine which aging column an amount is placed in. The due date and
discount due dates are calculated by the system, based on the terms code
entered during Purchase Order Entry or Receipts. CR defaults to DU.

5. Groupings

Enter the number of date groupings to print (2-5). CR defaults to 5.

6. Auto Increment

Enter the number of days to be used for automatic date increments (1-99). The
system may determine column dates using a beginning date and incrementing
from that date. For example, if each aging column is to contain a seven-day
time period, enter 7. Enter 0 to enter each column date manually.

7. Dates

Enter the ending date for the first date grouping (ref. 2). If automatic
increments are to be used, the next groups calculate automatically. If automatic
increments are not used, enter each group ending date up to the number of
groups selected. CR defaults to the system date.

8. Type

Enter whether O-orders and/or R-registered receipts should print on the report.
If O is entered, the report uses information from the purchase orders file. If R is
entered, the report uses information from the purchase order receipts file. Only
receipts that have been updated by the purchase order Receipts Register are
found in the receipts file. CR defaults to ALL and includes both document

types.
9. Scope

Enter whether the report should print S-summary, D-detail, or I-detail by item
information. CR defaultsto S.

Technical Notes

Printing proceeds by building a temporary sort file (SMSRT?) based on the
purchase order by vendor sort file (POVNDX) and/or the purchase order
receipts file (PORECT). Due and discount due dates are calculated and
documents are placed in the appropriate columns.

FILES USED - SMCNTL, POVNDX, APVEND, PORECT, PORDER,
FILES UPDATED - SMSRT?
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Vendor/Item Listing (POR740)

Function

This program allows the user to obtain a report by vendor or item, of records in
the vendor/item file. This report is useful to view general information from the
vendor/item records on file.

Report information includes the following: vendor number, name, item number
and description, vendor-item number, and freight factor. Manual cost
information is optional. The total number of items listed is also included.

User Inputs

The following inputs are involved in printing the Vendor/Item listing:
1. Order

Enter whether to print the report by VV-vendor or I-item. CR defaults to V.
2. Beginning Order Choice

Select the beginning order choice to print (ref. 1). F1 defaults to FIRST. Press F2
to search.

3. Ending Order Choice

Select the ending order choice to print (ref. 4). F1 defaults to LAST. Press F2 to
search.

4. Item Type

Enter the type of item to print: Stocked items or Nonstocked items. CR defaults
to SN.

4. Warehouse

Enter up to twenty 2-character warehouse codes side by side to print. CR
defaults to the warehouse assigned to the terminal. F3 defaults to ALL. Press
F2 to search.

5. Cost

Enter Y or N to indicate whether to include cost information. CR defaultsto Y.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (POVNIT) or item
(POVNIX) for all records that meet the entered criteria. The accounts payable
vendor file (APVEND) is referenced to obtain vendor names and the inventory
control item file (ICMAST) is referenced to obtain item descriptions.

FILES USED - SMCNTL, POVNIT, POVNIX, APVEND, ICMAST
FILES UPDATED - NONE
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Vendor/Item History (POR750)

Function

This program allows the user to obtain a report, by vendor or item, of the
historical information in the vendor/item file.

This report has a variety of uses including locating active or inactive vendors or
items, determining vendors or items to purge from the file and viewing
purchasing patterns.

Report information includes the following: vendor number, name, item number
and description, date of last purchase, units purchased, number of receipts and
average days late for month-to-date, year-to-date and/or prior year. The total
number of items listed is also included.

The user has the option to:
»  Select the order to print - vendor or item.
» Select the beginning and ending order choice.
»  Select the warehouse(s) to print.
* Include MTD, YTD and/or PYR figures.

» Determine which purchase dates to print.
»  Determine dollar amount or number of units to print.

User Inputs
The following inputs are involved in printing the Vendor/Item History Report:

1. Order

Enter whether to print the report by VV-vendor or I-item.

2. Beginning Order Choice

Select the beginning order choice to print (ref. 1). F1 defaults to FIRST. Press F2
to search.

3. Ending Order Choice

Select the ending order choice to print (ref. 4). F1 defaults to LAST. Press F2 to
search.

4, Warehouse

Enter up to 20 two-character warehouse codes side by side to print. CR defaults
to the warehouse assigned to the terminal. F3 defaults to all figures. Press F2 to
search.

5. Time Period

Enter whether to print M-month-to-date, Y-year-to-date and/or P-prior year
figures. CR defaults to all figures.
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6. Cutoff

Enter whether amounts A-above or B-below the cutoff amount are to print. CR
defaults to N and the program then proceeds to the Cutoff Basis Input.

7. Amount

If N was entered in input #6, this input is skipped. Enter the cutoff amount (up
t0 9999999.99) to determine which records are to print. CR defaults to 0.

8. Cutoff Date Basis

Enter whether last purchase dates B-before or A-after the cutoff date should
print; i.e., if A is entered, vendor/items with a last purchase date after the date
entered (next input) are not included on the report. CR defaults to NO
CUTOFF.

9. Date

If NO CUTOFF was selected in Cutoff Date Basis, this input is skipped. Enter
the cutoff date (ref. 2). F1 defaults to the system date.

Technical Notes

Printing proceeds by reading through the chosen file - vendor (POVNIT) or item
(POVNIX) for all records that meet the entered criteria. The accounts payable
vendor file (APVEND) and the inventory control item file (ICMAST) are
referenced to obtain vendor names and item descriptions.

FILES USED - SMCNTL, APVEND, POVNIT, POVNIX, ICMAST
FILES UPDATED - NONE
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PO Code List (POR760)

Function

This program allows the user to obtain a list of the codes used by the purchase
order system. Currently, the purchase orders system contains only buyer codes.

User Inputs

The following inputs are involved in printing the PO Code List;
1. Select number

Enter 1 to print buyer codes.

2. Beginning

Enter the beginning buyer code to print. F1 defaults to FIRST. Press F2 to
search.

3. Ending

Enter the ending buyer code to print. F1 defaults to LAST. Press F2 to search.

Technical Notes

The program prints by reading through the purchase orders control records
(SMCNTL) for the appropriate records.

FILES USED - SMCNTL
FILES UPDATED - NONE
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FACTS

End of Period (POS800)

This menu contains programs, which should be run at the end of each purchase
orders period to close it correctly (please refer to the normal procedures
section).

The PO Period Receipts Report provides a list of all purchase order receipts
made during the period. The report may be printed by purchase order, vendor
or item number. Printed receipts should be removed at the close of the period,
from the PO receipts file, through the optional update.

The Period Invoice Receipts Report provides a report of all invoices received
and entered into the purchase order invoice receipts system. The report may be
printed in vendor or item order. Printed receipts should be removed at the
close of the period, from the invoice receipt file, through the optional update.

The Period Receipts Discrepancy Report provides a report showing any
discrepancies between purchase order receipts and invoice receipts. The report
may be printed in vendor or item order.

The purchase order End-of-Period Update closes the current purchase orders
period by setting the period-to-date purchase figures in the vendor/item file to
zero and incrementing the current period by one.
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Period Receipts Report (POR810)

Function

This program allows the user to print a report of all purchase order receipts made
during the period. The optional update removes printed records from the file. The
user determines if this report is available through a flag in the Purchase Order
Static Control Record. If the Use Period Receiving Report flag is set to N, this
report is not available.

The user has the option to:

»  Select the print order — document, vendor or item.
» Select the beginning and ending order choice.
»  Select the period to print.

Report information includes the following:

» Printed by purchase order number: for each purchase order, purchase
order number, warehouse, vendor number, name, receipt number and
receipt date. The line-item information includes item number and
description, units, cost and extension. The total number of PO’s listed is
also included.

* Printed by vendor: the same information is included but purchase
orders are grouped according to vendor. Totals by vendor are also
printed. The total number of vendors listed is also included.

* Printed in item order: the information is grouped by item and includes
item number and description, purchase order number, warehouse,
vendor number, name, receipt number, receipt date, units, cost and
extension. Totals by item are also printed. The total number of items
listed is also included.

User Inputs

The following inputs are involved in printing and updating the Period Receipts
Report:

1. Order

Select the order to print (ref. 6). (Printing in vendor or item order requires extra
time for the sorting of records.)

2. Beginning Order Choice

Select the beginning order choice to print (ref. 1). In order to access the update,
you must press F1 for FIRST. Press F2 to search.

3. Ending Order Choice

Select the ending order choice to print (ref. 4). In order to access the update,
you must press F1 for LAST. Press F2 to search.
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4, Period

Enter the period to print (PPYY). F1 defaults to the current purchase orders
period.

5. Warehouse

Enter the warehouse code to print. The entry must be a valid warehouse code.
CR defaults to the warehouse assigned to the terminal. F3 defaults to ALL. In
order to access the update, you must press F3 for ALL. Press F2 to search.

6. Remove All Records for Period Just Printed?

Upon completion of printing, select OK or enter Y to remove the records just
printed. Select CANCEL or enter N to leave the records in the system.

Technical Notes

Printing proceeds by reading through the period receipts file (POPDRC) or the
required sort file (SMSRT?). Records meeting the entered criteria are printed.

FILES USED - SMCNTL, APVEND, ICMAST
FILES UPDATED - POPDRC, SMSRT?
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Period Invoice Receipts Report (POR820)

Function

This program allows the user to print a report of all invoices received and
entered into the Purchase Orders Invoice Receipts system. The optional update
removes printed records from the period invoice receipts file. The user
determines if this report is available through a flag in the Purchase Order Static
Control Record. If the Use Period Invoice Receipts Report flag is set to N, this
report is not available.

The user has the option to:

»  Select the print order - vendor or item.

» Select the beginning and ending order choice.
»  Select the period to print.

*  Select branch to print.

Report information includes the following:

*  Printed in vendor order: for each vendor, vendor number, name,
document number, date and line number. Each line-item includes
purchase order number, item number, description, units, cost and
extension. The total number of vendors listed is also included.

e Printed in item number order: the same information is included,
grouped by item. The total number of items listed is also included,
grouped by item. The total number of items listed is also included.

User Inputs

7-6

The following inputs are involved in printing and updating the Period Invoice
Receipts Report:

1. Order

Enter whether to print the report by VV-vendor or I-item. (Printing in item
number order requires extra time for the sorting of records.) CR defaults to V.

2. Beginning Order Choice

Select the beginning order choice to print (ref. 1). In order to access the update,
you must press F1 for FIRST. Press F2 to search.

3. Ending Order Choice

Select the ending order choice to print (ref. 4). In order to access the update,
you must press F1 for LAST. Press F2 to search.

4. Period

Enter the period to print (PPYY). F1 defaults to the current purchase order
period.

Purchase Orders—7.40
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5. Branch

Enter the branch to print. The entry must be a valid branch. The program
defaults to the branch assigned to the terminal. F3 defaults to ALL. Press F2 to
search.

6. Remove all records for period just printed?
Upon completion of printing, select OK or enter Y to remove the records just
printed. Select CANCEL or enter N to leave the records in the system.

Technical Notes

Printing proceeds by reading through the period invoice receipts file (POPDIN)
or the sort file (SMSRT?). Records meeting the above criteria are printed.
Records are removed by the period invoice receipts file.

FILES USED - SMCNTL, APVEND, ICMAST
FILES UPDATED - SMSRT?, POPDIN
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Period Receipts Discrepancy (POR830)

Function

This program allows the user to print a report showing any discrepancies
between purchase order receipts and invoice receipts.

This program is only available if the Use Invoice Receipts and Use Period
Receipts Discrepancy Report flags in the purchase orders static control record
aresetto.

During the Invoice Receipts Entry Program, both the invoiced amounts and the
actual received amounts are stored in the invoice receipts file. During the
Invoice Receipts Register, the extension (cost multiplied by the units invoiced)
of each line-item on the invoice is compared to the extension (cost multiplied by
the units received) of each line-item on the received purchase order. Any
discrepancies in the two extensions are recorded in the period receipts
discrepancy file. These records are available to be printed at any time by this
report. The optional update following this report removes all of the records just
printed.

The user has the option to:

»  Select the print order - vendor or item.

» Select the beginning and ending order choice.
»  Select the period to print.

»  Select the branch to print.

»  Select to include freight discrepancies.

»  Select to include tax discrepancies.

Report information includes the following: vendor, document (invoice)
number, document date, item number, description, units received, units
invoiced, cost at time of receipt, cost on the invoice and the dollar amount of the
discrepancy. Totals by vendor or by item are also printed. The total number of
vendors or items listed are also included.

User Inputs

The following inputs are involved in printing and updating the Period Receipts
Discrepancy Report:

1. Order

Enter whether to print the report by VV-vendor or I-item. (Printing in item
number order requires more time for the sorting of records.)

2. Beginning Order Choice

Enter the beginning order to print (ref. 1). In order to access the update, you
must press F1 for FIRST. Press F2 to search.

3. Ending Order Choice

Enter the ending order choice to print (ref. 4). In order to access the update, you
must press F1 for LAST. Press F2 to search.
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4, Period

Enter the period to print (PPYY). F1 defaults to the current purchase order
period.

5. Branch

Enter the branch to print. The entry must be a valid branch. The program
defaults to the branch assigned to the terminal. F3 defaults to ALL. Press F2 to
search.

6. Include Freight

Enter whether to include freight discrepancies or not. The program defaults to
Yes.

7. Include Tax

Enter whether to include tax discrepancies or not. The program defaults to Yes.

8. Remove All Records for Period Just Printed?

Upon completion of printing, select OK or enter Y to remove the records just
printed. Select CANCEL or enter N to leave the records in the system.

Technical Notes

Printing proceeds by reading through the period receipts discrepancy file
(POPDRD) for all records that meet the criteria entered. The accounts payable
vendor file (APVEND) is referenced to obtain vendor names. If printing in item
order, a temporary sort file (SMSRT?) is built to place discrepancy records in
item order. The update removes, from the period receipts discrepancy file, only
those records just printed.

FILES USED - SMCNTL, APVEND, ICMAST
FILES UPDATED - POPDRD, SMSRT?

7-10 Copyright © 1984-2004 Aperum, Inc.



Purchase Orders—7.40 End Of Period

;¥ Period Receipts Discrepancy [PORE30)

L2 Peniod Receipts Discrepancy [POR830)

Copyright © 1984-2004 Aperum, Inc. 7-11



End Of Period Purchase Orders—7.40

End-Of-Period Update (POU890)

Function

This program allows the user to close the current purchase orders period and
set the period-to-date purchase figures in the vendor/item file to zero. If itis
the end of the year, year-to-date figures are rolled to prior year.

User Inputs

The following inputs are involved in running the purchase orders End-of-
Period Update:

1. End-Of-Period Reports Run

Enter Y or N to indicate if all reports have been printed. End-of-period reports
include the Period Receipts Report, the Period Invoice Receipts Report and the
Period Receipts Discrepancy Report. It may also be required to print the
Vendor/Item History Report prior to this update as period-to-date figures are
included on the report. If N is entered, a message advising that the end-of-
period reports should be run is displayed. The user may then continue with the
update or choose to exit the program.

Technical Notes

Updating proceeds by reading through the vendor/item file (POVNIT) and for
each record, setting to zero the period-to-date units purchased, units returned,
dollar amount purchased, dollar amount returned, number of receipts and
average days late. If itis the last period of the year, YTD figures are rolled to
PYR. Finally, the current purchase orders period is incremented by one and is
recorded in the PO nonstatic control record along with the date the update was
run.

FILES UPDATED - POVNIT, SMCNTL
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File Maintenances (POS900)

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
explained in the next chapter.

All files, once set up by the system are maintained and updated by the system.
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Vendor/Item F/M (POF910)

Function

Use the Vendor/Item F/M program to create, store and maintain information
on items purchased from each vendor. You can enter information for this
program on the General and History screens.

This program is most useful when you want to create individual records. If you
need to create large groups of records for a vendor or an item, you can save
time by using the Create Vendor/Item Records program.

Information in this file includes vendor number, item number, vendor-item
number, lead time, manual and last costs and last purchase order number and
date. Also stored is the number of units purchased, number of units returned,
dollar amount purchased, dollar amount returned, number of receipts and
average days late for the MTD, YTD and PYR.

The MTD, YTD and PYR information is updated through the Receipt Register.
Information in this file may be displayed through the purchase orders Vendor
Inquiry program and printed through the Vendor/Item Listing and
Vendor/Item History Report.

NOTE: Only records created through this program or the Create Vendor/Item
Records program will be updated as to MTD, YTD and PYR through the Receipt
Register. Therefore, the user must create all needed vendor-item combination
records in the vendor/item file prior to beginning normal purchase order
operations.

User Inputs

The following inputs are involved in creating a vendor/item record:

General Screen

1* Warehouse

Enter the warehouse code. The entry must be a valid warehouse. F2 allows a
search (ref. 8). CR defaults to the warehouse assigned to the terminal.

2* Vendor Number

Enter the vendor number for this record. F2 allows a search (ref. 8). F3 displays
the first record for the selected warehouse.

3. Cost Class

Enter the valid cost class associated with this vendor. Press F2 to search. Press
F1 to enter “None”.

4 Item Number
Enter a valid item number or its interchange for this record. Entering a valid
item displays the description, costing unit of measure and buying unit of

measure. F2 allows a search (ref. 8). F3 displays the first record for the selected
vendor in the selected warehouse.
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5. Vendor-ltem Number

If the vendor uses a code other than the item number to identify this item, enter
the vendor-item number (up to 20 characters). This number may print on the
purchase order along with the user’s item number. If the vendor is listed in the
inventory item file as the primary vendor for this item, the vendor-item number
stored in that file is the displayed default value.

6. Manual Cost

Enter the manual cost for this item. CR defaults to cost stored for that item in
the item file.

7. Last PO Number

Enter the last purchase order number from this vendor (up to 6 characters).
8. Last Units

Enter number of units last purchased from this vendor.

9. Last Cost

Enter the most recent cost incurred for this item. If this vendor is listed in the
inventory item file as the primary vendor for this item, the last cost stored in the
item file with this item is the displayed default value. If this is not the primary
vendor, no default value is displayed.

10. Last Date

Enter the date of the most recent purchase of this item from this vendor. If this
vendor is listed in the item file as the primary vendor for this item, the last
purchase date stored with the item in the inventory file is the displayed default
value. CR initially defaults to 01/01/00 (ref. 2).

11. Lead Time

Enter the number of days of lead time required by this vendor (0-999). If this
vendor is listed in the inventory item file as the primary vendor for this item,
the lead time stored in the vendor file for this vendor is the displayed default
value.

At this point, the user may elect to end inputs and allow normal processing to
update the remaining fields. F3 ends the entry function and adds this record to
the vendor-item file.

At the initial prompt for each time period (MTD, YTD, PYR), the user again has
the option to end entry and allow the remaining fields to be updated through
normal processing. F3 ends inputs and adds this record to the vendor/item file.
The following inputs are available for users who do not elect to end entry:

History Screen

Note: The Warehouse, Item and Vendor fields remain at the top of the screen for reference.
1. Units Purchased

Enter the number of units of this item purchased from this vendor so far this
month (0-9,999,999). This number should be based on the displayed buying
unit of measure.
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2. Units Returned

Enter the number of units of this item returned to this vendor so far this month
(0-9,999,999). CR initially defaults to 0.

3. Dollars Purchased

Enter the dollar amount of this item purchased from this vendor so far this
month (0-99,999,999.99). CR initially defaults to 0.

4. Dollars Returned

Enter the dollar amount of this item returned to this vendor so far this month (0-
99,999,999.99). CR initially defaultsto 0

5. Number Of Receipts

Enter the number of purchase orders received from this vendor so far this
month (0-999). CR initially defaults to 0.

6. Average Days Late

Enter the average number of days late in receiving purchase orders containing
this item from this vendor so far this month (0-9999). CR initially defaults to 0.

Technical Notes

FILES USED - SMCNTL, APVEND, ICMAST, APVALX, ICALPX, ICCLSX,
ICINTR

FILES UPDATED - POVNIT, POVNIX, POVITX
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L® 01-Demo Company. Vendor/Item F/M [POF310)

L® Yendor/ltem F/M [POF310)
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¥ 01-Demo Company. Yendor/ltem F/M [POFI10)

L® Yendor/ltem F/M [POF310)
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Ship-From F/M (POF930)

Function

This program allows the user to create and maintain records in the ship-from
file.

Purchase orders are normally sent to the vendor address stored in the AP
vendor file. However, should the vendor use different billing and shipping
addresses, the address to which the purchase order is to be sent may be entered
here. As many ship-from addresses needed for a vendor may be entered.

User Inputs

The following inputs are involved in creating a vendor ship-from address:

* Vendor Number

Enter the vendor number (ref. 9).

* Ship-From #

Enter ship-from number that is assigned to the vendor location from which the
vendor may ship the purchase order.

3. Name

Enter the vendor name (up to 30 characters). CR defaults to the name assigned

to this vendor in the accounts payable vendor file. The name entered here
appears on the purchase order.

4-6. Address
Three lines of 30 characters each are provided to enter the vendor address as it

should appear on the purchase order. Enter the city, state and zip code on one
line. If only two lines are needed, use the first two. Press CR to skip this entry.

7. Phone Number

Enter the vendor phone number including the area code, dashes and an
extension (if needed) (up to 17 characters).

8-9. Contact1and 2

Enter the names of the people you work with at this address (up to 25
characters).

10. Ship Via

Enter the manner goods are usually shipped from this vendor (up to 15
characters). This code will be the default ship via in the Purchase Order Entry
program when this ship-from is used.

11. Freight

Enter whether the default freight is B-bill later, P-prepaid, C-collect, or A-
prepay/add. CR defaults to P.
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12. Freight On Board

Enter the default freight on board in the Purchase Order Entry program (up to
15 characters).

13. Buyer

Enter the buyer code as set up in the Buyer Code F/M (up to 3 characters). CR
defaults to the first buyer on file. F2 allows a search (ref. 8).

Technical Notes

FILES USED - SMCNTL, APVEND, APVALX
FILES UPDATED - POSHIP
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i Ship-from F/M [POF930)

G ral In al
2235 8. Rolling Rock Circle
Birmingham, AL, 35223

205-321-0934
Samuel Jacksan

June Inglewood

200 |_

X poiste [ tiow | O et |

L Ship-From F/M [POF930)
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Create Vendor/Iltem Records (POU910)

Function

This program allows the user of the FACTS system to create vendor/item
records for a range of vendors and/or items.

You can create these records by item number, alpha, vendor number or item
class. The vendor-item number, lead time, date of last purchase and normal
and last cost information are retrieved from the inventory control item file and

Vendor/item records may be created through this program for a range of items
by item number, alpha, vendor number or item class. The vendor-item number,
lead time, date of last purchase and normal and last cost information are
retrieved from the inventory control item file the cost class information is
retrieved from the vendor file and used in the vendor/Zitem file. This program
is useful during initial purchase order setup or when adding large numbers of
new vendors or items to be used in the Purchase Orders system. This program
creates vendor/item records only for vendor/item combinations of the primary
vendor assigned to the item in the item file (Item F/M program). The program
saves the user the time required to create individual vendor/Zitem records
through the file maintenance program.

The user has the option to:

» Select the order to create - item, alpha, vendor or item class.

» Select the beginning and ending order choice.

»  Select a specific item class if creating by vendor.

» Select a specific vendor if creating by item, alpha or item class.
»  Select warehouse(s) to create.

User Inputs

The following inputs are involved in creating vendor/item records:
1. Order

Enter whether records should be created in I-item number, A-item alpha, V-
vendor number or C-item class order. CR defaults to I.

2. Beginning Item Choice

Select the beginning order choice to create (ref. 1).

3. Ending Item Choice

Select the ending order choice to create (ref. 4).

4, Vendor/Item Class

Enter the vendor (item class if vendor was selected in input #1) to print. The
entry must be a valid vendor (or item class). CR defaults to ALL.
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5. Warehouse

If vendor/item records for only those items stored in a specific warehouse are
needed, enter the warehouse code(s). Enter up to twenty 2-character warehouse
codes side by side to create. Records are created only for items on file in the
warehouse/item file for the selected warehouse(s). CR defaults to the
warehouse assigned to the terminal. F3 defaults to ALL.

Technical Notes

Record creating proceeds by reading through the selected file for all
vendor/item combinations that meet the entered criteria. Records are written to
the vendor/item file and its sort files if not already there.

FILES USED - APVEND, ICMAST, ICALPX, ICVNDX, ICCLSX, ICWHSE,
SMCNTL

FILES UPDATED - POVNIT, POVNIX, POVITX
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¥ 01-Demo Company, Create Yendor/Item Records (FOUS10]
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L2 Create Yendor/Item Records (POU310)
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Remove Vendor/ltem Records (POU920)

Function

This program allows the user of the FACTS system to remove groups of records
from the vendor/item file.
The user has the option to:

»  Select the order in which to remove- item, alpha, vendor or item class.

» Select the beginning and ending order choice.

» Select a specific item class to remove if removing by vendor.

» Select a specific vendor to remove if removing by item, alpha, or item
class.

» Select the last purchase date through which to remove.

»  Select the warehouse from which to remove.

This program is particularly useful if it is necessary to remove all items of a
vendor or a certain item from all vendors. It may also be used to purge old

records. It saves the user the time necessary to remove records individually
through the Vendor/Item F/M.

User Inputs

The following inputs are involved in removing vendor/item records:
1. Order

Enter whether records should be removed in I-item number, A-item alpha, V-
vendor number or C-item class order. CR defaults to I.

2. Beginning Item Choice

Select the beginning order choice to remove (ref. 1).

3. Ending Item Choice

Selecting the ending order choice to remove (ref. 4).

4. VVendor/Item Class

Enter the vendor (item class if vendor was selected in input #1) to print. The
entry must be a valid vendor (or item class). CR defaults to ALL.

5. Warehouse

If vendor/item records for only those items stored in a specific warehouse are
needed, enter the warehouse code. Enter up to twenty 2-character warehouse
codes side by side to remove. Records are removed only for items on file in the

warehouse/item file for the selected warehouse. CR defaults to the warehouse
assigned to the terminal. F3 defaults to ALL.

6. Cutoff Date

Enter the most recent purchase date to remove through. Vendor/item records
with last purchase dates after the entered date are not removed. CR defaults to
no cutoff date (ref. 2).
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Technical Notes

Record removal proceeds by reading through the selected file for all records
that meet the entered criteria. Records are removed from the vendor/item file
and its sort files.

FILES USED - SMCNTL, ICALPX, ICVNDX, ICCLSX, ICMAST, APVEND
FILES UPDATED - POVNIT, POVNIX, POVITX

;2 Win with ProvideX M= E3
Help

81-Demo Company REMOUE UENWDOR/ITEM RECORDS Pl]U92j
THIS PROGRAM WILL REMOVE VEHDOR/ITEM RECORDS BASED OH THE CRITERIA ENTERED BELOD

ORDER 1

BEGIMNMING ITEM FIRST %

EMDIHG ITEM LAST
ITEH TYPE SH UENHDOR ALL
WAREHOUSE 81 Atlanta Warehouse

CUTOFF DATE HO CUTOFF

EHD OF IHPUTS. ENTER 'YES' TO CONTIHUE, F4-BACKUP ...
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Manual Cost Change Update (POU930)

Function

This program allows the user of the FACTS system to change the manual cost
stored in the vendor/item file for selected items of a vendor.

The user has the option to:

»  Select the vendor for whom costs are to be updated.

» Select the beginning and ending item for which costs are to be updated
for the selected vendor.

» Select the item class for which costs are to be updated.

» Update the manual cost using last vendor, standard, average, last or
manual costs or by percent.

»  Select the warehouse for which costs are to be updated.

The manual cost field may also be accessed through the Vendor/Item F/M
program. This update program provides a quick way to update large groups of
records.

User Inputs

The following inputs are involved in using the Manual Cost Change Update;
1. Vendor

Enter the number of the vendor for whom manual costs are to be updated. The
entry must be a valid vendor number.

2. Beginning Item

Enter the beginning item to update. CR defaults to the first item on file in the
vendor/item file for this vendor.

3. Ending Item

Enter the ending item to update. CR defaults to the last item on file in the
vendor/item file for this vendor.

4. Item Class

Enter the item class to which an item must belong to be updated. The entry
must be a valid item class code. CR defaults to ALL.

5. Change
Enter P, V, S, L, A or M to determine how the manual cost is updated.

P -Percent. Enter the percent to change by. For example, to increase the manual cost by five
percent, enter 5. To decrease the manual cost by two percent, enter -2.

V -Vendor last. The manual cost is set equal to the last cost stored in the vendor/item file.

S -Standard. The manual cost is set equal to the standard cost stored with the item in the
inventory control item file.
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File Maintenances

L -Last. The manual cost is set equal to last cost stored with the item in the inventory item

file.

A -Average. The manual cost is set equal to the average cost stored with the item in the

inventory item file.

M -Manual. The manual cost is set equal to manual cost stored with the item in the inventory

item file.

6. Warehouse

If manual costs for only those items stored in a specific warehouse are needed,
enter the warehouse code. Enter up to twenty 2-character warehouse codes side

by side to update. Records are updated only for items on file in the

warehouse/Zitem file for the selected warehouse. CR defaults to the warehouse

assigned to the terminal. F3 defaults to ALL.

Technical Notes

Updating proceeds by reading through the vendor/item file (POVNIT) for all
records meeting the entered criteria. The manual cost is updated accordingly.

The program locks POVNIT, and reads through it, updating all records that
meet the criteria.

FILES USED - SMCNTL, ICMAST, APVEND, ICWHSE
FILES UPDATED - POVNIT

L;2 Win with ProvideX IS[=] E3
Help

81-Demo Company HAHUAL COST CHAHGE UFPDATE Pou93 g
UEHDOR U182 Office Products International

BEGINMIHNG ITEM FIRST
EHDIHG ITEM LAST

ITEM CLASS ALL

CHAHNGE P PERCEHNT 10.8%

WAREHOUSE 81 Atlanta Warehouse

END OF IHNPUTS. ENTER 'YES" TO CONTINUE, F4-BACKUP |
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Past Purchase Order Removal (POU940)

Function

This program allows the user of the FACTS system to remove past purchase
orders based on vendor number, warehouse and date. This program is
available only if the Store Past Purchase Orders flag in the Purchase Orders
Static Control Record is set to Y. Records may be viewed by vendor in the
Purchase Orders Vendor Inquiry or individually in the Purchase Orders
Document Inquiry.

User Inputs

The following inputs are involved in using the Past Purchase Order Removal
program:

1. Beginning Vendor

Enter the beginning vendor for which past purchase orders are to be removed.
CR defaults to FIRST.

2. Ending Vendor

Enter the ending vendor for which past purchase orders are to be removed. CR
defaults to LAST.

3. Warehouse

Enter up to 20 two-character warehouse codes side by side to remove past
purchase orders. CR defaults to the warehouse assigned to the terminal. F3
defaults to ALL.

4, Cutoff Date

Enter the last purchase date to remove through (ref. 2). Purchase orders with
dates after the cutoff date are not removed. CR defaults to the last closed GL
period ending date.

Technical Notes

Updating proceeds by reading through the past purchase order by vendor file
sort file (POPASX). Records of the appropriate vendors and items with last
purchase dates on or before the selected cutoff date are removed from the past
purchases file (POPAST).

FILES USED - SMCNTL, APVEND, PORDER
FILES UPDATED - POPAST, POPASX, POPLTS, POPALX
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L Past Purchase Order Removal [POU940)
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Transfer/Change Vendor/ltem Codes (POU950)

Use this program to change the Cost Class information in the Vendor/item Files
for a range of vendor items. These changes do not affect transaction files or
other modules.

When running this program, you have the option to:

Select the change order - item, alpha, item class, vendor
Select the beginning and ending order to change

Select the Change From field

Select the Change To field

Select the warehouse to change for vendor/Zitem information
Select the vendor to change for vendor/item information
Access this program by choosing Purchase Orders >File
Maintenances-> Transfer/Change Vendor/Item Codes.

Input Descriptions

Use the following inputs to change cost class information in the Vendor/Item file:
1.  Vendor

Enter the vendor for the change.

2.  Warehouse

Enter the warehouse for the change.
3. Order

Enter the order the field is to update. The available options are item, alpha, item
class and vendor.

4. Beginning Order Choice

Set the beginning of the range.
5. Ending Order Choice.

Set the end of the range.

6. Change From Cost Class

Enter the cost class that is being changed. Press F3 to default to ALL.
7. Change To Cost Class

Enter the cost class to which to change. Press F3 to default to user selection. If
F3 is selected, the program stops at every item whose item class is to be changed
and requires input of the new item class.
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L® Transfer/Chg Vendor-ltem Codes (POU350)
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FACTS

Infrequent F/M (POS900)

File maintenance programs allow the user to enter, change and delete data.
These programs are used to enter the initial data required to set up the system
(refer to the Installation Manual).

The user can add, change and delete the records in a file. This is called
maintaining the file. Some file maintenance programs may be used often where
others are used less frequently. There is an Infrequent File Maintenances menu
for the latter programs; most of these are used only one time during the initial
set up of the system. However, the information in the infrequent file
maintenances may be updated by the system. An example would be the
Nonstatic Control F/M, which keeps track of the sales orders period and all the
register trace numbers.

All files, once set up, are maintained and updated by the system. Most file
maintenances in the sales orders system do not need to be maintained by the
user and it is unlikely that they will be used.
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\FAETS 7.4 Distribution Software - Purchase Orders [POS000)

Leaders in Distribution Solutions

LWITSd) FACTS 7.4 Development- Company 01 01/05/04 - 2:54 pm

ha |

Purchase Orders Infrequent File Maintenances Tasks:
E'Eu A ——
Caostclass Fi
ﬁ ﬁi—‘%‘i ﬂ %“‘ FO Entry Options Fibd
- PO to GL Posting Fi
Static Cantral FiM

Entry Receiving Invaice Receiving Cost Cantracts Manstatic Contral Fibd
Rebuild PO Sort Files

Inquiries Reapors & Prints End of Pariod File Maintanances

? Access Code I ﬂl

| | y

1\[anp-:mj,l 01, FACTS 7.4 Development [_ (O] x]

Help

81/085/8% HMonday Purchase Orders JLW TE5d 3:86 pm
O1-FACTS 7.4 Developme — Infrequent File Haintenances — POS910

1. Buyer Code F/H

2. Cost Class F/H

3. PO Entry Options F/H
4. PO to GL Posting F/H
5. Static Control F/H

6. Honstatic Control F/H

7. Rebuild POD Sort Files

Selection

EHWTER SELECTIOH #, ACCESS CODE, 'OFF°, ARROWS, F4-PREVIOUS HEHU
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Buyer Code F/M (POF920)

Function

This program allows the user to maintain the buyer code records.

Buyer codes are used in purchase order entry to keep track of who authorized
the purchase of goods.

User Inputs

The following inputs are involved in creating a buyer code record:

* Buyer Code

Enter a 3-character buyer code. Entering a valid buyer code displays the code
and its description. F2 allows a search (ref. 8).

2. Name

Enter the buyer code name (up to 30 characters).

Technical Notes

FILES UPDATED - SMCNTL
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;¥ Buyer Code F/M [POF920)

L2 Buyer Code F/M [POF320)
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Cost Class F/M (POF950)

Use Cost Class F/M to enter cost classes used for creating cost contracts. The
Cost Class is specific to a Vendor.

Using Cost Contract Entry (POE510), you can create cost contracts for items
from a vendor that are in a specific cost class.

Access this program by choosing Purchase Orders > File Maintenances
- Infrequent File Maintenances - Cost Class F/M.

Input Descriptions

Use the following inputs to create and edit cost class codes:

1. CostClass

Enter up to three characters to create a cost class. If this code already exists in
the system, the corresponding description appears.

If the code doesn’t already exist, FACTS asks if you want to create a new cost
class. Select OK.

Press F2 to search existing cost classes.

2. Description

Enter up to 30 characters for the cost class description.
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L# 01-Demo Company, Cost Clazs F/M [POF340)

¥ Delete | [] Mew | W Eit |
[Entercostclass descripon

L Cost Class F/M [FOF940]
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PO Entry Options F/M (POF915)

Use the PO Entry Options F/M program to streamline purchase order entry, receipt entry, non-PO
receipt entry, and invoice receipt entry.

2 PO Entry Option settings are not user-specific; they affect all PO Order Management Suite users.

In this program, you define whether header, line item entry and footer inputs are:

« required to complete a document and whether they should appear on the main screen.
* not required.

« can be initially skipped, but can be edited later if necessary.

can be disabled i.e un-editable but visible to the user.

You can also select which totals appear on the entry screen, set item browser flags to indicate
backordered items, temporary items, nonstock items, direct ships and items shipping from alternate
warehouses, and set the notes pop-up display for item and customer notes.

Programs that can be modified through this file maintenance are

 Purchase Order Entry
* Receipt Entry

* Non-PO Receipt Entry
« Invoice Receipt Entry

2 Use the PO Static Control F/M to set the many flags that activate or deactivate the features
available in the Purchase Order module. For instance, from this program you can determine whether
or not to use job costing, store past POs, include tax and freight, just to name a few of the possibilities.

What do you want to do?

Refer the procedure topics listed below for more information about setting PO
entry options.

Modify a PO document header section

Modify a PO line-item entry section

Modify a PO footer section

Set item flags to appear in item browsers

Select document to totals to appear on the main screen

Select the Unit of Measure to use in the PO Entry, Receipt Entry, Non-PO Receipt Entry and PO
Document Inquiry programs

Set Notes pop-up functionality

See Also

For more detailed information on file maintenance programs, consult the following topics.
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How to use File Maintenance programs

More about the types of file maintenance programs

Modifying PO document header inputs:

E% 01-Specialty Distributors. Inc.. PO Entry Options F/M (POF915)
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m PO Entry Options F/M [POF315) M=l E3
Help

B81-Specialty Distributors, InPD Entry Options F/H POF915
*_ Document Type P PD Entry

2. Ship From Y 16. Reference # Y H

3. Ship-to Whse ¥ 17. GL Table ¥

4. Order Date ¥ 18. Doc Group ¥

5. Request Date ¥ 19. Branch ¥

6. Promise Date ¥ 28. Doc Amount ¥

7. Receipt # v 21. Doc Discount 3 v

8. Receipt Date Y 22. Doc Date Y

9. Buyer ¥ H 23. Due Date B

18. Terms Y 24, Discount B

11. Department ¥ N 25. Disc Due Date B

12. Lead Time Y H 26. Hemo Y 1
13. Freight Code ¥ H 27. ¥ H

14. Ship Via ¥ H 28. ¥ H i
15. FOB ¥ H 29. ¥ H

16. Contact N H

Header, Line, Footer, Totals, Flags, Hotes

Line to Change (FZ2-Cont), D-Delete, F18-Henu, F4-Backup

Arrows: Up-Prev Rec, Dn-Hext, Pgup-First, Pgdn-Last

1.  Select the type of entry program you want to change.

Choose from PO Entry, Receipt Entry, Non-PO Receipt Entry, or Invoice Receipt Entry.
Once you have a document type selected, you can use the VVCR buttons to scroll to
another document type.

2.  Select the Header Fields tab.

The Header Fields tab lists possible header inputs for Purchase Order Entry
Management Documents. Each of these inputs can be accessed through the program’s
Header Detail window even if they don’t appear in main screen’s header section.

If an input appears disabled, it either means it is not available for the type of document
selected or the feature may not be available on your system.

You can set edit options for each input or accept the defaults.
Edit options:

Y-Allow Edits to the Field.  Select this option to allow users free access to this
field, whether it appears on the main screen or just
in the Header Detail. This is the default Edit
option.

N-SKip. Select this option if you want the field disabled in
the Header Detail window of the selected
program.

B-Allow Backup into Field.  Select this option to initially skip a field, but
allow users to back up to it if they need to edit the
information later in the entry process. This option
does not disable the field.

D-Disable. Select this option to make this field un-editable. A disabled
field is usually grayed out in appearance and the value
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cannot be changed. It is important to also note that even if
a field is disabled, the field and its value can still be seen by
the user.

Required options:

N-No, Not Required. This is the default. Fields set to Not Required
appear, but the program does not force users to
enter information in them to finish the entry.

S-Required Input and Main  Use this setting when the input is not only

Screen Display. required, but you want it to appear on the main
window of the SO document that you selected.
You can set up to three inputs to appear on the
main window in addition to the standard inputs.
Ship-to, Order Date, Request Date, Invoice Date
and Ship Date always appear on their respective
main windows so the Require on Main Screen
option is not available for these inputs.

Modifying line-item entry sections:

m 01-Specialty Distributors, Inc.. PO Entry Options F/M [POF915])

Help
Document Type [P - FO Entry =l IPTINES
Header Line | Eooter | Totals | Flags | Motes
Ordered Oty | xee=kLd - Description 1 |Y- Edit j |N- Mot Req j
Received Gty |Y- Edit -] Descripion 2 |- Edit =l w-notrea =]
Backord Gty IY- Edit "l IN- Skip E IN- MotReq |
Cost IY- Edit "l IN- Skip E IN- MotReq |
Request Date IY- Edit 7 IN- MotReq | IN- Skip = IN- MotReq |
Promise Date |- Edit = [n-notreq 5]
Lead Time |[v- Edit =zl w-motres ]
Taxable |v- Edit =l n-notreq 5
GLTable |v- Edit =l uonotreq 5

Warehouse IY- Edit -I

0 save | ¥ Deete | [ Mew | 0 Ext |

Edit ardered guantity during PO Entry? (YHIB) i
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E% PO Entiy Options F/M (POF915) [_ (O] x|
Help
81-Specialty Distributors, InP0 Entry Options F/H POF915

*. Document Type P PD Entry

2. Ordered Qty ¥ 12. Description 1 v H
3. Received Qty ¥ 13. Description 2 v H
4. Backord Qty Y 14. N N
5. Cost ¥ 15. H |
6. Request Date ¥ N 16. N N
7. Promise Date ¥ H

8. Lead Time ¥ H

2. Taxzable ¥ N

18. GL Table Y H

11. Warehouse ¥

Header, Line, Footer, Totals, Flags, Hotes
Line to Change (F2-Cont), D-Delete, F18-HMenu, F4-Backup
Arrows: Up-Prev Rec, Dn-MHext, Pgup-First, Pgdn-Last

1.  Select a document type.
Use the VCR buttons to scroll through the document options or select New to return to
the dropdown list.

2.  Select the Line Fields tab.

All the possible detail inputs for line-item entry are listed on this tab. Each of these
inputs can be accessed through the program’s Line Detail window even if they don’t
appear in a popup window during line-item entry.

Set Edit options.

Y-Allow Edits. The input appears on the screen and users can edit the field once they
select it or tab into it.

N-Do Not Allow Edits. Use this option if you want the field disabled in the Line Detail
window for the selected program.

B-Allow Backup into Field. Select this option to initially skip a field, but allow users to
back up to it if they need to edit the information later in the entry process. This option
does not disable the field.

D-Disable. Select this option to make this field un-editable. A disabled field is usually grayed out in
appearance and the value cannot be changed. It is important to also note that even if a field is
disabled, the field and its value can still be seen by the user.

Set Required options.

Certain inputs always appear in the line-item entry portion of PO document entry
screens. Your business may require other item-related information during document
entry. Required fields other than the standard line-item entry fields appear in a popup
window.

You can set the following:
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1. Ordered

Enter N-the quantity to be ordered cannot be changed (i.e., skipped), Y-the
guantity to be ordered can be changed, B-the quantity to be ordered cannot
initially be changed but the user can back up to change it for each line-item in
purchase orders programs. Press Enter to initially default to N.

2.  Received

Enter N-the quantity to be received cannot be changed (i.e., skipped), Y-the
guantity to be received can be changed, B-the quantity to be received cannot
initially be changed but the user can back up to change it for each line-item in
purchase orders programs. Press Enter to initially default to N.

3. Requested And Promised Dates

Enter N-the requested and promised dates of the item cannot be changed (i.e.,
skipped), Y-the requested and promised dates of the item can be changed, B-the
requested and promised dates are skipped initially but the user may press F4 to
back up to change it for each line-item in purchase orders programs. Press
Enter to initially default to N.

4. Backordered (Quantity)

Enter N-the item cannot be backordered, Y-the item can be backordered, or B-
the item is not initially backordered but the user can backorder it for each line-
item in purchase orders programs. Press Enter to initially default to N.

5. Cost

Enter N-the cost of the item cannot be changed (i.e., skipped), Y-the cost of the
item can be changed, B-the cost is skipped initially but the user may press F4 to
back up to change it for each line-item in purchase orders programs. Press
Enter to initially default to N.

6. Lead Time

Enter N-the item’s lead-time cannot be updated (i.e., skipped), Y-the item’s
lead-time may be updated, or B-the lead time is skipped initially but the user
may press F4 to back up to change it for each line-item in purchase orders
programs. Press Enter to initially default to N.

7. Taxable
Enter N-the item’s taxable status may not be changed (i.e., skipped), Y-the
item’s taxable status may be changed, or B-the item’s taxable status is skipped

initially but the user may press F4 to back up to change it for each line-item in
purchase orders programs. Press Enter to initially default to N.

8. GL Table

Enter N-the GL posting table may not be changed (i.e. skipped), Y-the GL
posting table may be changed or B-the GL posting table is skipped initially but
the user may press F4 to back up to change it for each line-item in purchase
orders programs. Press Enter to initially default to N.

9. Warehouse

Enter N-the warehouse code may not be changed (i.e. skipped), Y-the
warehouse code may be changed or B-the warehouse code is skipped initially
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but the user may change it for each line-item in purchase orders programs.
Press Enter to initially default to N.

10. Descriptions 1 & 2
Enter N-the item’s description 1 or 2 cannot be updated (i.e., skipped), Y-the
item’s description 1 or 2 may be updated, or B-the description 1 or 2 cannot be

modified initially but the user may change it for each line-item in purchase
orders programs. Press Enter to initially default to N.

Modifying PO document footer inputs

B 01-Specialty Distributors, Inc.. PO Entiy Options F/M [POF915)
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ES PO Entiy Options F/M [POF915)

The following fields can be modified on PO document footers:

* Memo

*  Acknowledge and Confirmation
e Tax Percent

*  Freight

e Freight Factor

Define whether users edit, skip, disable or back into these fields for the selected program.
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Displaying totals on PO entry main screens

5": 01-Specialty Distributors. Inc., PO Entry Options F/M [POF915)

|
|
_
_
_
_
_
_
_
_

ES PO Entry Options F/M [POF915)

1.  Select the document type if you have not already done so.
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Use the VCR buttons to scroll through the document options or choose New to access
the dropdown list.

2. Select the Totals tab.

3. Select to display total units and/or total weight during receipt and non-PO receipt entry to display at
the bottom of the main entry screen.

Setting the Unit of Measure

4.  Select the Unit of Measure to display in PO entry programs and PO Document Inquiry.

In the Total UM input select the UM to use in PO Entry, Receipt Entry, Non-PO
Receipt Entry and PO Document Inquiry. You can select from S-smallest Um
for an item, B-buying UM for the item, or T-stocking UM for the item. For the
Invoice Receipt document type, this entry is disabled.

Setting Item Flags

You may find it necessary to flag certain items so they stand out in the item browser. The flags make it
easy for you to see which items on a document are temporary, non-stock or backordered; which
require job numbers; which are special orders, and which are past the requested date or the promise
date.

Each input also displays the letter associated with each flag that displays in the line-item browser in
the designated entry program. You can use this as a reference to understand the meaning of the

letters shown in the entry browser.

2 Note that more than one flag can appear for each item.
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5": 01-5pecialty Distributorz, Inc., PO Entry Options F/M [POF915)

i

| |
L
L
| |
I |
L
L
_
_
_

E% PO Entry Options F/M [POF915)

Setting Notes pop-up functionality

Use this screen to set Item and Vendor notes to display in a pop-up window in Purchase Order Entry
programs. For the Vendor Notes and Item Notes inputs, indicate whether Vendor and Item notes
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should display in the Important Notes on File pop-up window from Purchase Order Entry programs
when you access a vendor or item that has notes associated with it. You can select to display U-urgent
notes only, A-all notes or N-no notes at all in the pop-up window.

5": 01-5pecialty Distributors, Inc., PO Entry Options F/M [POF915)

T
TR -

E% PO Entry Options F/M [POF915)
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PO To GL Posting F/M (POF970)

Function

This program allows the user to determine how purchase orders (Receipt
Register) will post to general ledger (if at all).

This record contains information (such as journal and account numbers) which
the system references in performing the automatic posting of Receipt Register
data to the general ledger in the Receipt Register Update. All general ledger
numbers must be valid general ledger numbers.

The user sets up the GL distribution; i.e., how the distribution is to post into the
journal file in general ledger (example: summary, detail). See input #1 for
options. In addition to the GL distribution, the user sets up where in the journal
file in general ledger the distribution is to post; e.g., the inventory journal.

There are standard entries made to general ledger when posting receipts. For
example, when an item is sold, the inventory account is debited and the receipts
account is credited. The user must set up where these standard GL account
numbers used will come from, what they are and how they are to be used.

The basis is asking where the number is to come from. The system either
always uses the same (a default) account number or gives a choice to the user as
to where the number is pulled from, (e.g., item GL posting table).

The department and branch flags have to do with imbedding the department
and/or branch within the GL account number (if applicable). When entering a
receipt, the department and branch may be entered. If the user imbeds the
department and/or branch within the GL account number, the system looks at
the department and/or branch assigned to each purchase order. For example, if
the GL number to post is 415-00-00 (department is fourth and fifth digits,
branch is sixth and seventh digits), the department is 01 and the branch is 02,
then the system posts to 415-01-02. The system inserts the department and/or
branch in the proper place within the GL account number.

Finally, a default GL account number is set up. Even if the default is not to be
used, it must be entered.

Following is information about setting up each entry:

Inventory

Basis- determines where the inventory GL number comes from. The user has a
choice of always posting to the default inventory GL number (from this record)
or posting to the inventory GL number assigned in the item’s GL posting table.
The system may always post to one inventory GL number or break out
inventory to multiple inventory account numbers (example: Inventory - Dock
Equipment, Inventory - Warehouse Equipment).

Department - determines if the system should insert the department in the
inventory GL number.

Branch - determines if the system should insert the branch in the inventory GL
number.
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Default GL Account Number - is used for posting purposes if the basis is set to
D - default. If basis is set to | - inventory GL posting table, the number is
entered but not used for posting purposes.

Receipts

Basis - determines where the receipts GL number comes from. The user has a
choice of always posting to the default receipts GL number (from this record) or
posting to the receipts GL number assigned in the item’s GL posting table. The
system may always post to one receipts GL number or break out receipts to
multiple receipts account numbers (example: Receipts - Dock Equipment,
Receipts - Warehouse Equipment).

Department - determines if the system should insert the department in the
receipts GL number.

Branch - determines if the system should insert the branch in the receipts GL
number.

Default GL Account Number - is used for posting purposes if the basis is set to
D - default. If basis is set to | - inventory GL posting table, the number is
entered but not used for posting purposes.

Tax, Freight, Freight Discrepancy

Freight discrepancy is an account for holding freight amounts that could not be
fully factored between line-items because of rounding errors.

Basis-determines where each account number comes from. The numbers used
always come from the default GL number (from this record).

Department and Branch - determine if the system should insert the department
and branch in the GL account number.

Default GL Account Number - is used for posting purposes because the basis is
set to D-default.

Nonstock Inventory

This number is used as the inventory GL number to post instead of the standard
inventory account when receiving a nonstocked item (an item that does not
exist in the item file). Nonstocked items are only allowed in purchase orders if
coming from a special order in the Sales Orders module. This entry is set up
like the inventory entry.

Non Inventory

This number is used as the inventory GL number to post instead of the standard
inventory account when receiving a non inventory item (an item that exists in
the item file but does not exist in the warehouse/Zitem file, i.e. warehouse
guantities are not maintained). Nonstocked items are only allowed in purchase
orders if coming from a special order in the Sales Orders module. This entry is
set up like the inventory entry.

Note: If your company uses freight factoring, the system posts the freight amount to the GL account
setup for receipts, regardless of the way the basis is set. If posting by receipts and the basis is set to
inventory and you factor freight, the system will not follow the basis setting. It will post to the GL
account you have listed for freight.
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User Inputs

The following inputs are involved in creating the PO to GL posting record:

1. GL Distribution

The PO receipts system may post to General Ledger automatically. The Receipt
Register may print a general ledger distribution and make a journal posting to
GL during the update. Enter 0, 1, 2 or 3 to indicate how PO receipts are tied in
with general ledger. CR initially defaults to 0.

0 - no GL distribution is printed or posted.

1 - the GL distribution is printed (printing is in detail format) but not posted to GL.

2 - the GL distribution is printed (printing is in detail format) and posted to GL in summary
(posting includes the total amount posted to each account number).

3 - the GL distribution is printed (printing is in detail format) and posted to GL in detail

(posting includes each item contributing to the amount for each account number).
2. Posting Journal

Enter the general ledger journal to post to. The entry must be a valid journal
number entered through the GL Journal F/M. F2 allows a search (ref. 8).

3. Inventory

Enter whether to post based on D-default GL number or I-inventory GL posting
table. CR initially defaults to D.

Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

4. Receipts

Enter whether to build distribution based on D-default GL number or I-
inventory GL posting table. CR initially defaults to D.

Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

5. Tax

The basis is skipped and set to D.
Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

Copyright © 1984-2004 Aperum, Inc. 10-21



Infrequent F/M Purchase Orders—7.40

6. Freight

The basis is skipped and set to D.
Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

7. Nonstock Inventory

Enter whether to post based on D-default G/L number or I-inventory GL
posting table. CR initially defaults to D.

Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

8. Freight Discrepancy

The basis is skipped and set to D.
Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

9. Non Inventory

Enter whether to post based on D-default G/L number or I-inventory GL
posting table. CR initially defaults to D.

Enter N or Y to indicate whether to departmentalize. CR initially defaults to N.

Enter N or Y to indicate whether to insert the branch in the account number
when posting to general ledger. CR initially defaults to N.

Enter the default GL account number used. The entry must be a valid GL
number. F2 allows a search (ref. 8).

Technical Notes

FILES USED - GLMSTR, GLALPX
FILES UPDATED - SMCNTL
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L# 01-Demo Company. PO to G/L Posting F/M (POF970) ME E
Help

GIL Distribution =il ummans

GIL Posting Journal | A000 Mllmrenturv

Entry Basis Dept Branch  GIL# Descriptian
Inventary |0 - Default 'I [ M [|175-01-0 Ml Inventory
Receipts |0 - Default 'I I |39'3-U1-U Ml Purchases-Inventory
Tax ID N~ |54U-D1-1 Ml Sales Tax
Freight |D v |54n-m-1 M| Freight
Temparary Inventary ID-DefauIt 'I N~ |1?6-D1-D Ml Nonstocked Inventory
Freight Discrepancy |D - |84IJ-D1-1 #t | Freight
Mon Inventory ID-DefauIt 'I r W |1??-D1-D ¢t | Mon Inventory
@ save | ¥ Detete || ew | @ Eat |
|PO distribution to GIL (0=nat used, 1=print only, 2=print post summary, 3=print_post detaily P
;% Win with ProvideX H=] 3
Help
81-Demo Company PO to G/L Posting F/H FOF97H
1. G/L Distribution 2
2. Posting Journal 4888 Payroll
Entry Basis Dept Branch G/L # Description

3. Inventory 188-81-8 Cash

4. Receipts 118-81-8 Petty Cash

5. Tax 121-81-8 Interwvarehouse
6. Freight 158-81-8 Equipment Owned

7. Honstock Inventory
8. Freight Discrepancy
9. Hon Inventory

174-88-8 Repair Parts In
318-82-8 Accounts Payabl
338-81-8 Sales Tax Payab

[l — N — N — ]
X< IXT<C X<
=T XT-CIZXT<CX

Line to Change {(F2-Cont}), D-Delete, F4-End .
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Static Control F/M (POF980)

Function

This program allows the user to create and maintain the PO static control
record. The PO static control record is critical to the proper functioning of the
PO system. The record contains information which the PO system references in
performing various functions.

CAUTION! Itis strongly advised that a password be assigned to this program.
Changes should be made only with extreme caution and under the supervision
of your affiliate.

User Inputs

The following inputs are involved in creating the purchase orders static control
record:

General Screen
1. Store Past POS

Enter N or Y to indicate whether to store past purchase orders. CR initially
defaults to N.

2. Allow Backorders

Enter N or Y to indicate if the user’s company accepts backorders for
unavailable merchandise. CR initially defaults to N.

3. Use Job Cost

Enter N or Y to indicate if the job costing module is used and tied into Purchase
Orders. CR initially defaults to N.

4. Include tax on purchase orders

Enter N or Y to indicate if expected sales tax is entered during PO Entry and
included in the total purchase order amount. CR initially defaults to N.

5. Include Freight

Enter N or Y to indicate if anticipated freight charges are entered during
Purchase Order Entry and included in the total purchase order amount. If
freight charges are entered during Purchase Order Entry, the Tax Freight flag in

the accounts receivable Tax Table F/M determines whether tax is calculated
including the freight charge. CR initially defaults to N.

6. Default PO Cost

Enter whether the default PO cost is M-manual or L-last. CR initially defaults
to M.

7. Freight Factor

Enter whether the default freight factor is N-none, U-units, W-weight or $-
dollars. CR initially defaults to N.
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8. Change By Line - Requested and Promised Dates

Enter N-the requested and promised dates of the item cannot be changed (i.e.,
skipped), Y-the requested and promised dates of the item can be changed, B-the
requested and promised dates are skipped initially but the user may press F4 to
back up to change it for each line-item in purchase orders programs. CR
initially defaults to N.

9. Change By Line - Lead Time

Enter N-the item’s lead-time cannot be updated (i.e., skipped), Y-the item’s
lead-time may be updated, or B-the lead time is skipped initially but the user
may press F4 to back up to change it for each line-item in purchase orders
programs. CR initially defaults to N.

10. Change By Line - Taxable

Enter N-the item’s taxable status may not be changed (i.e., skipped), Y-the
item’s taxable status may be changed, or B-the item’s taxable status is skipped
initially but the user may press F4 to back up to change it for each line-item in
purchase orders programs. CR initially defaults to N.

11. Change By Line - GL Table

Enter N-the GL posting table may not be changed (i.e. skipped), Y-the GL
posting table may be changed or B-the GL posting table is skipped initially but
the user may press F4 to back up to change it for each line-item in purchase
orders programs. CR initially defaults to N.

12. Use Period Receipts Report

Enter N or Y to indicate if the Period Receipts Report is used. CR initially
defaults to N and eliminates the Period Receipts Report feature. If Y is entered,
the period receipts file is active and the Period Receipts Report is available.

13. Print on Receiving Document

Enter N or Y to indicate whether to print alternate bin locations on receiving
documents. Press Enter to initially default to Y and print the alternate bin
locations on receiving documents.

14. Print on PO Fill Report

Enter N or Y to indicate whether to print alternate bin locations on the PO Fill
Report. Press Enter to initially default to Y and print the alternate bin locations
on the PO Fill Report.

15. Use Invoice Receipts

This is available only if the accounts payable module is active. Enter N or Y to
indicate if the Invoice Receipts system is used. This consists of the Invoice
Receipt Entry, the Invoice Receipt Register and the Uninvoiced Receipts Report
programs. If N is entered, none of the above programs are available. CR
initially defaults to N.

16. Use Period Invoice Receipts Report

This is available only if the invoice receipts feature is used. Enter N or Y to
indicate if the Period Invoice Receipts report is used. CR initially defaults to N
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and eliminates the Period Invoice Receipts Report feature. If Y is entered, the
period invoice receipts file is active and the report is available.

17. Use Period Discrepancy Report

This is available only if the invoice receipts system is used. Enter N or Y to
indicate if the Period Receipts Discrepancy Report is desired. CR initially
defaults to N and eliminates the Period Receipts Discrepancy Report feature. If
Y is entered, the period receipts discrepancy file is active and the report is
available.

Print Control Screen
1. Purchase Order Form Depth

Enter the depth (number of lines) of the purchase order form at 6 lines per inch
(29-99) usually 42 (7-inch form and prints 14 line-items per form), 51 (8 1/2-inch
form and prints 24 line-items per form) or 66 (11-inch form and prints 40 line-
items per form). CR initially defaults to 66. If both descriptions are printed, the
number of line-items above is cut in half.

2. Preprinted Form

Enter N or Y to indicate whether to use a preprinted purchase order form. CR
initially defaults to N.

3. Print Item/Vendor-ltem

Enter whether the I-item and/or V-vendor item number is to print on the
purchase order. CR initially defaults to VI (indicating both are to print).

4. Print Item Description

Enter whether to print for item description on the PO, 1-first description, 2-
second description, or B-both as set up in the Item F/M. CR initially defaults to
1.

5. Standard Memo

Enter the standard memo to be printed on each purchase order (up to 50
characters). This may be greetings, information, instructions, etc. The user may
override or change this memo for any particular purchase order during PO
Entry. F2 defaults to NONE (a blank memo).

Technical Notes

FILES UPDATED - SMCNTL
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Nonstatic Control F/M (POF990)

Function

This program allows the user to create and maintain the PO nonstatic control
record. The PO nonstatic control record is critical to the proper functioning of
the PO system. The record contains information that the PO system references
in performing various functions.

CAUTION! It is strongly advised that a password be assigned to this program.
Changes should be made with extreme caution and only under the supervision
of your affiliate.

User Inputs

The following inputs are involved in creating the nonstatic control record:
1. Period
Enter the current period or period when actual processing in PO will begin

(PPYY). The entry must be in the current or next GL period. CR initially
defaults to the current GL period.

2. Date Of Last End-Of-Period Update

During normal processing, this field is maintained by the End-of-Period Update
program. CR initially defaults to 01/01/00, indicating that no update has
previously been run.

*3-6. Numbers Used
These numbers keep track of the last number used and as a (non)PO is created
or a register is updated, the last number used is incremented by one. Upon

installation, these fields should be set to 0. These fields will automatically be
updated through normal processing. CR initially defaults to 0.

*7. Terminal Running Receipt Register

Enter the 3-character ID of the terminal that is currently running the PO Receipt
Register. Enter blanks to indicate that the register is not running. The register
usually sets this field automatically. You can override it if, for instance, a user
has aborted out of a register and you need to set this field back to blanks. F2
allows a search of terminal 1Ds.

NOTE: You must enter the predefined password to access this field.

* indicates that changing the field after initial installation may have serious
repercussions.
Please refer to your affiliate before any changes are made.

Technical Notes

FILES UPDATED - SMCNTL

Copyright © 1984-2004 Aperum, Inc.
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L2 01-Demo Company. PO Monstatic Control F/M [POF390]

09/2002
0873142002

001352
011
040

L2 Nonstatic Control F/M (POF930])
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Rebuild PO Sort Files (POU990)

Function

This program allows the user o rebuild sort files which may not be up to date
with the rest of the system.

Sort files are used throughout the FACTS system to enable the user to report or
retrieve information in an order other than the order in which the main file is
stored. For example, the records of the vendor file are stored in vendor number
order. To access this file in alphabetical order requires a sort file which is stored
in vendor number by alpha lookup by vendor number. The corresponding
record in the main file may then be accessed for the needed information.

The Rebuild PO Sort Files program should only be run under the supervision of
your affiliate.

User Inputs

The following inputs are involved in rebuilding purchase orders sort files:
1. POITMX

Enter N or Y to indicate whether to rebuild POITMX. This file is the purchase
order by item cross-reference sort file to the purchase orders open order file
(PORDER). Itis used when printing in item order in both the PO Status Report
and the Receiving Schedule. CR defaults to N.

2. POPASX

Enter N or Y to indicate whether to rebuild POPASX. This file is the past
purchase order by vendor cross-reference sort file to the past purchase orders
file (POPAST). This file is used in the purchase orders Vendor Inquiry and the
purchase orders Document Inquiry. CR defaults to N.

3. POPALX

Enter N or Y to indicate whether to rebuild POPALX. This file is the past
purchase order by receipt cross-reference sort file to the past purchase orders
file (POPAST). This file is used in the purchase orders Vendor Inquiry and the
purchase orders Document Inquiry. CR defaults to N.

4. POPRTX

Enter N or Y to indicate whether to rebuild POPRTX. This file is the purchase
orders ready-to-print sort file to the purchase orders file (PORDER). The file is
used in the Purchase Order Print program. CR defaults to N.

5. POREGX

Enter N or Y to indicate whether to rebuild POREGX. This file is the purchase
orders ready-for-receipts register cross-reference sort file to the purchase orders
file (PORDER). It is used by the purchase orders Receipt Register to determine
which orders are to appear on the register and are to be updated. CR defaults
to N.
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6. POVITX

Enter N or Y to indicate whether to rebuild POVITX. This is the vendor/item
sort file to the vendor/item file (POVNIT). Itis used by several entry programs
when entering vendor-item numbers. It is updated by the Vendor/Item F/M.
CR defaults to N.

7. POVNDX
Enter N or Y to indicate whether to rebuild POVNDX. This file is the purchase
order by vendor cross-reference sort file to the purchase orders file (PORDER).

It is used when printing the PO Status Report and the Receiving Schedule in
vendor order. CR defaults to N.

8. POVNIX

Enter N or Y to indicate whether to rebuild POVNIX. This file is the vendor by
item cross-reference sort file to the vendor/item file (POVNIT). It is updated by
the Vendor/Item F/M and is used by the Vendor/Item Listing and
Vendor/Item History report when printing in item order. CR defaults to N.

9. PODSSP

Enter N or Y to indicate whether to rebuild PODSSP. This file is SO/PO Line
Cross Reference File.

Files will be rebuilt for all companies.

Technical Notes

FILES USED - SMCNTL, PORDER, POVNIT, POPAST

FILES UPDATED - POITMX, POPASX, POPALX, POPRTX, POREGX, POVITX,
POVNDX, POVNIX

L# Rebuild PO Sort Files (POU390) [_ (O] ]
Help

81-Demo Company REBUILD PO SORT FILES rouood
POPRTX .
POREGX
POUITX

POUNIX

THIS PROGRAM IS NOT TO BE RUN WITHOUT SYSTEM MANAGER'S SUPERUISION?

REBUILD P.0.'S TO PRINT - POPRTX? (Ms/Y), F4-EHND illl E“dl DKI

—_—
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1. Beginning Order Choice Enter the beginning order choice to process. For example, if vendor
number was chosen in the previous input, enter the first vendor number to be included. CR defaults
to FIRST.

2. Date Dates will be displayed according to the format set in the Company Control Record. For
viewing purposes, all dates will be displayed with a two-digit year. For editing purposes, all dates
will allow the entry and display of a four-digit year. An entry date can be viewed in its entirety by
using the left and right arrow keys or by using the HOME and END keys to scroll through the date
field. The system will allow the full date or a partial date to be entered. Special dates that were
previously displayed and stored as 01/01/00 and 12/31/99 will no longer be handled in the same
manner. Tag names such as NONE, ASAP, FIRST, LAST, etc. will now be used in place of ‘generic’
dates. These tag names will also be accepted as the valid input dates in some data entry prompts.

If you are upgrading from FACTS 6.05 (or earlier) to FACTS 6.06 (or later), the dates stored in your
system are converted for you behind the scenes. Dates that display as **/**/** indicate that data is
present for the field but the system does not know how to interpret the date. Contact your affiliate for
support.

The Rule of 50: FACTS programs uses a “rule of 50” logic to expedite date processing. If the two
digit year is greater than or equal to 50, the system will assume the date to be in the 1900s; if the two
digit year is less than 50, the system will assume the date to be in the 2000s.

During data entry, if the system is unable to interpret the date entered, the date mask will be
displayed in the prompt. If the system is able to interpret the date entered, the date will be displayed
in the prompt. Dates prior to 01/01/1800 or after 12/31/2199 are not allowed during date entry.

FACTS programs contain 8-character and 10-character date fields. The date editing/entry display
varies slightly depending on whether it is an 8-character or 10-character field. When editing a date,
using the right arrow or the END key, will advance the cursor to the end of the date field and using
the left arrow or the HOME key, will advance the cursor to the beginning of the date field.

8-Character 10-Character
Date Field
Date Field

When entering a date in the 1900s (as defined by the ORDERED ORDERED
50-rule), the date will be displayed as follows: 01/02/96< 01/02/96 <
Use the right arrow key or the END key to display the ORDERED ORDERED
full 4-digit year: /02/1996< 01/02/1996<
A plus sign at the end of the date field indicates that ORDERED ORDERED
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the year is not in the default century.

01/02/96+

01/02/2096<

End Of Inputs In all report and update programs, this is the last input before processing begins. It
provides the user a chance to check that all information entered is correct. Should an input need to be
changed, use F4 to back up. Once everything is correct, press CR or enter YES and the program will

continue.

Ending Order Choice Enter the ending order choice to process. For example, if vendor number was
chosen in the previous input, enter the last vendor to be included. CR defaults to LAST.

Item Search Items may be searched in alphabetical order or by interchange, item number or class,
and these searches can be restricted by class, keyword (except in item number searches), item type,
warehouse, or the first numbers that the item starts with (available only in Item Number Searches).

When F2 is selected at a vendor number input, a new screen appears with a list of items and other
related information. The search order can be changed by pressing F2 again and selecting a new search
order from the popup window that appears.

To set a restriction, press F1 and tab to the desired restriction type in the search screen’s header. The
restriction types will default either to NONE or ALL.

ARROMS -

LINE #+4 TO DISPLAY WAREHOUSE QUANTITIES
P2-CHANGE SEARCH ORDER: ALPHA, INTERCHANGE, ITEM MUMBER, CLASS
ENTER BEG ALPHA, Fi-5ET RESTRICTIONS, F3-ALT SRCH, F4-BHUP
UP=FREVIOUS, DOMN=NEXT, LEFT=PGUP, RIGHT=PGIN

TOF OF LINES

Search shortcuts. As shown in the graphic above, search order and restrictions are represented by
bold, underlined letters. If you combine these letters at the entry prompt with first several characters
of the item you are searching for, followed by F1 or F2, you can reduce the number of steps it takes to
switch search orders or set restrictions. In a vendor search, for example, you can find vendors with
contacts named Ellis by entering CK.Ellis at the entry prompt and then press F1 or F2. Following are

more examples of search shortcuts.

If you want to...

Then

Switch to an Item Number
search

Enter N plus F2

Switch to an Item Number
search and begin your search
at entries starting with 1310

Enter N.1310 plus F2
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Switch to an Alpha search Enter AK.ladder plus F1 or F2
order and set a keyword
restriction of ladder

6. Order In many purchase order reports, the user may select the order in which the reports may print.
Choices may include V-vendor number, I-item number or D-document number order. CR defaults to
the first order choice displayed.

7. Prompt-Selection Input Usually found at the bottom, right-hand corner of most screens, this prompt
allows the user to perform a number of functions:

# - Changes or deletes line-items. Line-items may be changed or deleted by entering the number
of the line to be changed. During this change routine, F1 defaults to the current value of the input
which may not be the same as the displayed default value.

L - Lists line-items. A limited number of line-items appear on the screen at any one time. The list
function allows line-items to be redisplayed. The user selects the beginning line number to list.

A - Adds aline-item. Line-items may be added as needed.

F2 - Changes header. Header information in the upper portion of the screen may be changed as
necessary. During this change routine, F1 defaults to the displayed value of the input.

D - Deletes the document. The purchase order or purchase order receipt may be deleted at any
time. All line-item records are removed, sort files are updated and the header record status is
changed to DELETED. The screen is then cleared and the program returns to the purchase order
number input to await further entries.

F3 - Ends. F3 will end line-item entry and cause the program to proceed to the ending routine for
further entries.

8. Search The search feature allows the user to search for various fields (example:
salesperson/territory) when little or no information may be known about them. Press F2 and a new
screen appears displaying a number of entries. The user may enter a search key, continue, select the
line number of one of the fields displayed or return to the program input from which the search was
activated.

9. Vendor Number When entering the vendor number, the entry is automatically padded to 10
characters. The number must be a valid vendor number found in the AP vendor file. F2 calls the
search program.

Copyright © 1984-2004 Aperum, Inc. A-3



References Purchase Orders—7.40

10.

11.

Vendor Search Vendors can be searched in alphabetical, contact name or vendor number order, and
these searches can be restricted by class, keyword (only available in alphabetical and contact search
orders) or the beginning characters of the vendor number (only available in vendor number searches).

When F2 is selected at a vendor number input, a new screen appears with a list of vendors and other
related information. The search order can be changed by pressing F2 again and selecting a new search
order from the popup window that appears.

To set a restriction, press F1 and tab to the desired restriction type in the search screen’s header. The
Class restriction defaults to ALL; the Keyword and Vendor # Starts With restrictions default to
NONE. See Item Search (ref. 5) for shortcut instructions.

Serial Number Auto Assign ‘F1-Auto Assign’ has been added to the Serial Number entry screen,
during ‘ADD’ mode. If selected, the user will enter the quantity of serial numbers to be generated.
This quantity will default to the undistributed quantity or the largest number that does not exceed the
mask, whichever is lower. Using the previously entered serial number as a starting point, the
program will generate the requested serial numbers and then return control of data entry back to the
user.

The automatic serial number assignment will increment the last series of numeric digits found within a
user entered string. For example, if the previously entered serial number is ‘WW-123’, the automatic
serial number assignment will generate a series of numbers by incrementing the ‘123’ portion of the
serial number. If a problem should occur during the automatic assignment process the program will
stop generating numbers and return the control to the user so that the necessary corrections can be
made.
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Available Quantity An item’s available quantity is the On Hand quantity - Committed quantity.

Average Usage The average for each item is the sum of the usage of the periods displayed divided by the
number of periods displayed.

Backorder A purchase order document which contains open items that were not received on the original
shipment. The items on the document are backordered.

Branch Branches are created/maintained through System Management Branch F/M. Branches may be
referred to as stores or profit centers. The length of the branch is two digits (01-99).

Buyer Code Buyer codes are created/maintained through Purchase Order Buyer Code F/M. The buyer
code is used to track an authorized purchase of goods on a purchase order.

Catalog Item Catalog items are goods that are provided by a vendor but are not carried in inventory. A
record tracking price information exists in a catalog file.

Dead Stock Items whose percentage of sales are so small that an investment in inventory cannot be
justified. Dead stock items are discontinued for replenishment.

Department GL departments are used to track revenues and expenses by division. The GL department
is imbedded in the G/L number for posting purposes. General ledger financial reports may be
printed by department.

Direct Shipment A direct shipment is the shipment of goods from the vendor to the customer, as
opposed to, a warehouse shipment where the goods are shipped by the distributor to the
customer. This is also referred to as a drop shipment.

FOB Freight on board indicates at what point freight is charged. If FOB is destination, the seller bears the
freight cost. If FOB is shipping point, the buyer bears the freight cost.

Freight The cost associated with the transportation of goods by means of a carrier.
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Freight Factor Freight factor is the means to distribute the freight cost between the line-item on the order.
The freight factor is applied to the cost of line-items during the Receipt Register. Freight Factor
options include: to divide the freight by the total units, to divide the freight by the total pounds,
to divide the freight by the dollar amount, or to not factor the freight at all.

General Ledger Account Number A GL number that exists on file is valid. Valid G/L number’s are set
up through the general ledger Account F/M program. General ledger account numbers are user-
defined and are used throughout the FACTS system for posting purposes to GL. For more
information, refer to the Account F/M in general ledger.

GL Posting Table A GL posting table that exists on file is valid. Valid GL posting tables are set up
through the IC GL Posting Table F/M program. The length of the GL posting table is up to three
characters (alphanumeric, user-defined). Each customer is assigned to a GL posting table for
purposes of posting purchase order transactions to general ledger. For more information, refer to
the GL Posting Table F/M in inventory control.

Initiating Warehouse The warehouse that originate the order is the initiating warehouse.

Interchange Item The interchange number is a means of identifying an item by other references other
than the item number. The interchange number is used in inquiries and entry programs
throughout the Inventory Control, Purchase Order, and Sales Order modules.

Item Class Item classes are created/maintained through Inventory Control Item Class F/M. Item classes
are used to group items.

Item Price Class Item price classes are created/maintained through Inventory Control Item Price Class
F/M Program. Item price classes are used as a way of categorizing items for pricing purposes.

Journal Number Journal numbers are used for separating journal entries in general ledger by type of
entry (example: sales, payroll, receivables, etc.). Each module determines the journal number to
post the transactions of that module to in general ledger.

Last Cost The costing method normally used in a manufacturing environment that is considered the
replacement method. Last cost reflects the cost of replacing inventory at current market prices.
Last cost is used when jointly produced output proportions are changed from a previously
established mix of components. Joint cost allocation is based on the change in costs arising from a
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change in the mix of these components. Since inventory is valued at replacement cost versus
actual cost, reconciliation of Inventory to the GL is often impossible with this method.

Lead Time Lead time is the number of days from the date a purchase order is placed for an item until
the date the item is received. Average lead time is calculated as the current average lead time
plus the lead time from the two most recent receipts divided by 3. An item will be flagged for
lead time if the new average is 50% less or greater than the previous average lead time.

Lot Item An item which is flagged as a lot item through the Item F/M is one which when received or
sold must be assigned a lot number per unit. Multiple units may be assigned to the same lot.
Examples of lots are reels (wire, etc.) or lots in lumberyards or brickyards.

Manual Cost The costing method normally used in a manufacturing environment that is considered the
standard method. Manual cost reflects an anticipated cost of producing and/or selling a unit.
All manufacturing costs are charged to cost objects at standard cost. Every time a unit is
produced, its standard (manual) cost is entered. Standards are pre-established per cost object,
predetermined (standard) hourly rates are established for each job. Manual cost is used often by
companies that use mass-production methods. Standard costs are used to reflect the transfer of
units between work in process inventory to finished goods inventory and from finished goods
inventory to cost of goods sold. Detailed (actual) costs are not kept per unit and not normally
used for managerial purposes. Since detailed costs are not kept per unit, reconciliation of
Inventory to the GL is often impossible with this method.

Nonstock Items Refers to items that are not replenished but may exist in the warehouse, for example
items that may have been special ordered but were not purchased by the customer.

Past POs Purchase orders which have been completely received and are no longer open or backordered
purchase orders. A past PO is stored in a separate file from open PQO’s once completely received.

Promise Date The date the vendor indicated the merchandise of a PO would be in the user’s warehouse
(received).

Receipt Date The date the merchandise is delivered to the user’s warehouse.

Request Date The date the users request the merchandise be delivered to their warehouse.
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Serial Item An item which is flagged as a serial item through the Item F/M is one which when received
or sold must be assigned a serial number per unit.

Ship-From Ship-From records are set up through Purchase Order Ship-From F/M. Purchase orders can
be sent to the vendor’s address stored in the AP Vendor File or to a different billing and shipping
(warehouse) address.

Ship via The carrier for the freight. The method of transportation for the purchase order.

Special Order A sales order which is tied to an associated purchase order is considered a special order.

Temporary Item Temporary items are goods offered to your customer as a value added service but are
not carried in inventory. They do not exist in the item file.

Terms Code Two-character codes that represent different types of payment terms and are used in the
ending routines of most Purchase Order Entry Programs. Terms codes used in Purchase Order
programs are created and maintained the Inventory Control Item F/M.

Uninventoried Item A uninventoried item is an one that exists in the item file but is not kept in
inventory, for instance supply items used internally by the company.

Usage Rate The rate of usage (sales, transfers out, manufacturing components) for a stocked item in a
period (month, i.e., the usage rate is the quantity of an item used in a month) Usage rates form
the basis for replenishment control calculations (e.g., order point).

For highly seasonal items the usage rate is the anticipated average usage of the upcoming 3 periods based
on those 3 periods as of a year ago. For (low) seasonal items the usage rate is the anticipated
average usage of the upcoming 6 periods based on those 6 periods a year ago. For non-seasonal
items the usage rate is calculated as the average usage of the last six periods.

Vendor-ltem Number The vendor-item number is the code number that the manufacturer uses to
identify this item. This number may print on the purchase order in addition to the user’s item
number.

Vendor Notes Optional instructions, memo lines, notes recorded on a specific vendor available for
inquiry and reporting. Vendor notes are entered through the Vendor Inquiry program.

Warehouse The space allocated for the storage of merchandise.
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Warehouse Shipment A warehouse shipment is the shipment of goods from a warehouse to the
receiving customer.
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PROGRAM

POR110
POP110
POR210
POR220
POR230
POR232
POR310
POR310
POR320
POR710
POR720
POR730
POR740
POR750
POR760
POR810
POR820
POR830

NAME

SUGGESTED PO REPORT

SAMPLE PURCHASE ORDER

RECEIVING DOCUMENT PRINT
PURCHASE ORDER FILL REPORT
PURCHASE ORDER RECEIPT REGISTER
PURCHASE ORDER RECEIPT GL DISTRIBUTION
PURCHASE ORDER INVOICE REGISTER
PO INVOICE REGISTER GL RECAP
UNINVOICED RECEIPTS REPORT
PURCHASE ORDER STATUS REPORT
RECEIVING SCHEDULE

CASH REQUIREMENTS REPORT
VENDOR/ITEM LISTING

VENDOR/ITEM HISTORY

PO BUYER LIST

PERIOD RECEIPTS REPORT

PERIOD INVOICE RECEIPTS REPORT
PERIOD RECEIPTS DISCREPANCY REPORT
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PAGE

C-2

C-4
C-5

C-7
C-8

C-10
C-11
C-12
C-13
C-14
C-15
C-16
C-17
C-18
C-19



Sample Reports

DATE: 09/ 28/ 02

DEMO COVPANY

Purchase Orders—7.40

POR110 PAGE: 1

USER: SSI ToW SUGGESTED PO REPORT TIME 11:13 AM
VENDOR V100 TO V105
WAREHOUSE 01
RESTOCKI NG ONLY
| TEM DESCRI PTI ON UNI TS UM COST UM EXTENSI ON EI GHT
War ehouse 01 ATLANTA WAREHOUSE
Vendor : V100 GENERAL | NDUSTRI AL MFG Review Cycle: 10 Last PG 01/05/01 Buy Target: 2000$ 300l bs.
1101 PALLET TRUCK 10 EA 288.15 EA 2881. 50 1960.0
1 102 ADJUSTABLE HEI GHT STEEL STOOL 5 EA 42.28 EA 211. 40 145.0
1 103 ROTARY DRUM PUMP 4 EA 97.22 EA 388. 88 144.0
Requi renments: 50% OFF FREI GHT FOR BUY TARCET VENDCOR TOTAL 3481.78 2249.0 174.09% OF BUYI NG TARGET $
Vendor : V101 | NDUSTRI AL SUPPLY DI STRI BUTORS Revi ew Cycl e: 9 Last PO 02/22/01 Buy Target: 0$ 0l bs.
1120 HAND HELD STRETCH WRAP 361 EA 2.22 EA 801. 42 2888.0
Requi renments: USE VENDOR- | TEM NUMBERS ON PO VENDCOR TOTAL 801. 42 2888.0
Vendor : V102 S.E. I NDUSTRIAL PROD. & EQUI P. Review Cycle: 12 Last PO 09/24/02 Buy Target: 400% 350l bs.
1141 SCAFFOLD SUPPORTS FOR PLATFORM 13 EA 33.67 EA 437.71 260.0
1 142 SW VEL CASTER 2 Dz 23.57 Dz 47.14 120.0
Requi renents: | NCLUDE TAX EXEMPT # ON PO VENDOR TOTAL 484. 85 380.0 121. 21% OF BUYI NG TARGET $
Vendor : V105 WAREHOUSE EQUI PMENT UNLIM TED Review Cycle: 14 Last PO 09/03/02 Buy Target: 0% 0l bs.
1101 PALLET TRUCK 14 EA 288.15 EA 4034. 10 2744.0
1 125 WAREHOUSE SPACE HEATER - ELEC. 7 EA 132.50 EA 927.50 1050.0
Requi renent s: VENDCOR TOTAL 4961. 60 3794.0
WAREHOUSE TOTAL 9729. 65 9311.0
REPORT TOTAL 9729. 65 9311.0
| TEMS: 8 END OF REPORT
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PURCHASE ORDER

VE ENJOY DOl NG BUSI NESS W TH YOU! ' !

| |
| |
! DEMD COMPANY NO 001155 !
! 69 SOUTH PEACHTREE STREET !
! ATLANTA, GA 30030 Page 1 !
! (404) 962- 9900 !
! 02/22/02 !
| |
! !
! VENDOR: V101 SHI P-TO 01 !
! I NDUSTRI AL SUPPLY DI STRI BUTORS ATLANTA WAREHOUSE !
! 19874 MOUNTAI N | NDUSTRI AL PARK 685 FULTON | NDUSTRI AL !
! ATLANTA, GA 30335 ATLANTA, GA 33025 !
| |
! !
| BUYER! TERVB ISHP VIA | FOB | FREI GHT! REF# | EXPECTED! CUSTOVER !
|
! 200 11% 10 NET 30 ! | ATLANTA | PREPAI D! 1 02/ 22/ 02! CS- 90888 !
| |
! VENDOR- | TEM #! | TEM DESCRI PTI ON ! UNI TS! UM COST! UM EXTENSI ON!
| |
! Mi470- 8! 1 119! STEEL SHELVI NG SHELF ! 8.00!Dz!  110. 03! DZ! 880. 24!
| | | | | | | | |
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! ! ! ! Lo Lo !
! !
! ! AMDUNT! TAX! FREI GHT! TOTAL!
| | e e e e e e e e e e e e e e e e e m e e e e e e e e m = |
! ! 880. 24! 00! 00! 880. 24!
|

|

|

Copyright © 1984-2004 Aperum, Inc. C-3



Sample Reports

DATE: 09/13/02
USER: SSI TOn

VENDOR- | TEM #

| TEM

Purchase Orders—7.40

PO#: 001443 Wise: 01

POS 1

DATE: 06/ 06/ 02
USER GU T1

VENDOR- | TEM #

Prom sed: 09/13/02

1103
1106
1115
1134
1116
1125
1109
1111

| TEM DESCRI PTI ON

DEMO COVPANY POR210 PAGE: 1
RECEI VI NG DOCUMENT PRI NT TIME: 11:17 AM
DESCRI PTI ON UNI TS UM LOC SPECI AL RECEI VI NG | NFORNMATI ON
Vendor : V103 OFFI CE PRODUCTS | NTERNATI ONAL
ROTARY DRUM PUWP 200 EA B73
TELESCOPI C LI FT BOOM 50 EA F27
PLASTI C DOLLY 55 EA E51
DRUM WRENCH STEEL 60. 00 BX H24
ALUM NUM DOCK PLATE 50 EA E78
WAREHOUSE SPACE HEATER - ELEC. 100 EA B30
FOREMEN SHOP CABI NET DESK 45 EA A49
PLASTI C SHELF BI N BLUE 400. 000 EA B67

Deno Conmpany
RECEI VI NG DOCUMENT PRI NT

UNI TS UM

END OF REPORT

RECEIVING DOCUMENT PRINT WITH ALTERNATE BIN LOCATIONS

POR210 PAGE: 1
TIME: 10:39 AM

PRI
LOC SPECI AL RECEI VI NG | NFORNMATI ON

PO#: 001297 Whise: 01

V1 102

POS 1
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Prom sed: 02/26/03 Vendor:

1101

1102

V100 Ceneral

Pal | et Truck 10
At Loc: A99

Adj ust abl e Hei ght Steel Stool 10

I ndustrial MG

EA

EA

A85
A85

End of Report
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DATE: 06/ 04/02 DEMO COMPANY POR220 PAGE: 1
USER: SSI T8D PURCHASE ORDER FI LL REPCRT TIME: 9:52 AM

WAREHOUSE 01
PURCHASE ORDERS ALL

SALES BIN REQUEST BACKORDERED
| TEM DESCRI PTI ON RECEI VED UM ORDER LN# LOC DATE CUSTOVER + COW TTED UM
PO#: NP0101 Vendor: V100 General Industrial MG Wise: 01
1108 STEEL TOP WORK BENCH 2 EA 001592 001* C54 09/ 27/ 02 Sout heastern Service Conp 2 EA
1109 FOREMEN SHOP CABI NET DESK 2 EA 001592 002* A49 09/ 27/ 02 Sout heastern Service Conp 2 EA

*=SPECI AL ORDER, c=COVPONENT

| TEMS: 2 END OF REPORT
PURCHASE ORDER FILL REPORT WITH ALTERNATE BIN LOCATIONS
DATE: 06/06/02 Demo Company POR220 PAGE: 1
USER: GUI T1 PURCHASE ORDER FILL REPORT TIME: 10:45 AM
WAREHOUSE 01
SALES PRI REQUEST BACKORDERED
ITEM DESCRIPTION RECEIVED UM ORDER LN# LOC DATE CUSTOMER + COMMITTED UM

PO#: 001297 Vendor: V100 General Industrial MFG Whse: 01

1101 Pallet Truck 10 EA 001586 002 A85 ASAP  Southeastern Industrial S 1EA
001586 005 ASAP  Southeastern Industrial S 2 EA
001882 001 A85 ASAP  Deluxe Equipment Warehous 10 EA
001893001 A85 ASAP  Barnes Machinery & Equipm 15 EA
E00005 004  A85 09/23/02 Equipment Handling System 2 EA
Alt Loc: A99
1102 Adjustable Height Steel Stool 10 EA 001584 002 B73 ASAP  Southeastern Industrial S 4EA
001586 007 ASAP  Southeastern Industrial S 2 EA
001587 002 B73 ASAP  Roark Architectural, Inc. 2 EA
001892 001 B73 ASAP  Taggart Transcontinental 15 EA
001893002 B73 ASAP  Barnes Machinery & Equipm 10 EA
E00001 003 B73 09/23/02 Southeastern Industrial S 2 EA
E00003 003 B73 09/23/02 Equipment Handling System 2 EA
*=SPECIAL ORDER, c=COMPONENT, s=SERVICE REPAIR PART
ITEMS: 2 End of Report
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Sample Reports

Purchase Orders—7.40

DATE: 09/28/02 DEMO COMPANY POR230 PAGE: 1
USER SSI Tow RECEI PT REG STER #0367 TIME 10:15 AM
WAREHOUSE 01
DATE 09/ 28/ 02
----------- DATE---=--=-=-« -=-==-<=-=QUANTI TY-------- BY cT
LN# | TEM DESCRI PTI ON REQUESTD PROM SED RECEI VED ORDERED RECEI VED BACKORD UM COST UM EXTENSI ON
PO#: 001074 Rcpt #: W: 01 Vendor: V110 GECRG A SHI PPI NG EQUI P Shi p: C101 DELUXE EQUI PMENT Buyer: 100 DELETED
PO#: NPO101 Rcpt#: 00001 Wh: 01 Vendor: V100 GENERAL | NDUSTRI AL MFG Ship: 01 ATLANTA WAREHOUSE Buyer: 100
001 1108 STEEL TOP WORK BENCH 09/ 28/ 02 09/ 28/ 02 09/ 28/ 02 1 2 0 EA 94. 14 EA 188. 28
002 1109 FOREMEN SHOP CABI NET 09/28/02 09/ 28/ 02 09/ 28/ 02 1 2 0 EA  141.54 EA 283.08
PO TOTAL 471. 36
PO TOTAL (+TAX+FRT) 494. 43
REG STER TOTAL 471.36
PO TOTAL (+TAX+FRT) 494. 43

POS. 1

Copyright © 1984-2004 Aperum, Inc.

END OF REG STER



Purchase Orders—7.40

DATE: 09/ 28/ 02
USER. SSI TowW

GL PERI OD 09/ 02 SEP

DEMO COMPANY
RECEI PT REG STER GL DI STRI BUTI ON #0367

POR230 PAGE: 1
TIME: 10: 15 AM

G L# DESCRI PTI ON VENDOR NAME PO DEBI T CREDI T NET
175-01-0 | NVENTCORY V100 CGENERAL | NDUSTRI AL MFG NP0101 471. 36
ACCONT TOTAL a71.36 .00 471. 36
390- 01- 0 PURCHASES- | NVENTORY V100 GENERAL | NDUSTRI AL MFG NP0101 471. 36
ACCONT TOTAL .00 47136 (471.36)
REPORT TOTAL 47136 47136 .00

ACCOUNTS: 2

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT
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Sample Reports

DATE: 09/ 28/ 02

DEMO COVPANY

Purchase Orders—7.40

POR310 PAGE: 1

USER SSI Tow PO | N\VOI CE REG STER #0226 TIME 10:18 AM
VENDOR V100 TO V110
BRANCH 01

------- QUANTI TY-- ===« «ccmcaezCOBT-=-n--n--
LN¢  PO# RCPT# WH | TEM DESCRI PTI ON RECEI VED |NVO CE UM RECEIVED |INVOCE UM EXTENSION @ L#
Vendor : V100 GENERAL | NDUSTRIAL MFG  Doc#: 1370 Br: 01 Ant: 46.32 Pd: 09/02 Due: 11/30/02 TC. 2% 10TH NET 30
001 001060 00001 01 BLOCK NONSTOCKED - CENENT 24 24 EA 1.93 1.93 EA 46.32 390-01-0

Vendor : V100 GENERAL | NDUSTRIAL MFG  Doc#:
001 000000 00000 01
002 000000 00000 01

003 000000 00000 01

TAX TAX
FRT FREI GHT

WH=WAREHOUSE, Pd=PERI OD, Br=BRANCH, TC=TERMS CODE,

DOCUMENTS: 2

Copyright © 1984-2004 Aperum, Inc.

1102 PALLET TRUCK 8"

002064 Br: 01 Ant: 376.72 Pd: 09/02 Due:
VHE 0 5 EA .00 42.28 EA
0 1 EA .00 165.32 EA
0 1 EA .00 .00 EA
DI SCREPANCY

REG STER DI SCREPANCY

REG STER TOTAL

*=DI SCREPANCY BETWEEN | NVO CE AND RECEI PT COSTS

10/30/02 TC:

2% 10TH NET 30
211.40* 390-01-0

165. 32* 175-01-0
.00 175-01-0

END CF REG STER



Purchase Orders—7.40

DATE: 09/ 28/ 02 DEMO COMPANY POR310 PAGE: 1

USER. SSI TowW PO I N\VO CE REGQ STER #0226 d L# RECAP TIME: 10: 18 AM

VENDCR V100 TO V110

BRANCH 01

G L# DESCRI PTI ON AMOUNT

175-01-0 | NVENTORY 165. 32

390-01-0 PURCHASES- | NVENTCRY 257.72
423. 04

G L NUMBERS: 2 END CF RECAP

Copyright © 1984-2004 Aperum, Inc.
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DATE: 09/ 28/ 02 DEMO COVPANY POR320 PAGE: 1
USER. SSI TowW UNI N\VO CED RECEI PTS REPCRT TIME: 10: 23 AM
VENDCR V100 TO V110
DATES FI RST TO LAST
WAREHOUSE 01
VENDOR NAME PO RCPT# DATE WH AMOUNT
V101 | NDUSTRI AL SUPPLY DI STRI BUTORS 001078 00001 09/27/02 01 515. 27
VENDCR TOTAL 515. 27

V110 GEORG A SHI PPI NG EQUI P. CO. 001072 00001 09/26/02 01 2784.75

VENDCR TOTAL 2784.75

REPORT TOTAL 3300. 02

VENDCRS: 2 END OF REPCRT

Copyright © 1984-2004 Aperum, Inc. C-10



Purchase Orders—7.40

DATE: 09/ 28/ 02
USER. SSI TowW

DEMO COMPANY
PO STATUS REPORT

POR710 PAGE: 1
TIME: 10: 24 AM

| TEM 1100 TO 1110
PURCHASE ORDERS ALL, WAREHOUSE 01
TOTAL

PO# T S WH VENDCR NAME REQUESTD PROM SED ORI G NAL RECEIVED CURRENT UM
Item 1100 PALLET LOADI NG HAND TRUCK
001075 P P 01 V102 S.E. | NDUSTRI AL PRCD. & EQUI P. 09/24/02 09/28/02 5 5 EA
001084 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001085 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001086 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001087 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001088 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001089 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001090 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001091 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001092 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001093 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001094 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001095 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001096 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001097 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001098 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001100 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001102 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
001103 P P 01 V100 GENERAL | NDUSTRI AL MFG 01/05/01 01/05/01 1 1 EA
Item 1102 ADJUSTABLE HEI GHT STEEL STOOLS
001082 P P 01 V100 GENERAL | NDUSTRI AL MFG 09/27/02 10/ 03/02 28 28 EA
001083 P P 01 V100 GENERAL | NDUSTRI AL MFG 10/ 03/ 02 10/03/02 10 10 EA
Item 1 103 ROTARY DRUM PUWP
001083 P P 01 V100 GENERAL | NDUSTRI AL MFG 10/ 03/ 02 10/03/02 1 1 EA
Item 1108 STEEL TOP WORK BENCH
NP0101 R R 01 V100 GENERAL | NDUSTRI AL MFG 09/ 28/ 02 09/ 28/ 02 2 1 1 EA

T=TYPE (P=PURCHASE ORDER, B=BACKORDER, R=NON- PO RECEI PT),

| TEMS: 4

DATE: 09/ 28/ 02
USER. SSI TowW

DATE FI RST TO LAST
VENDCR V101 TO V102

Copyright © 1984-2004 Aperum, Inc.

S=STATUS (E=ENTERED, P=PRI NTED, R=RECEI VED)
END CF REPCRT

DEMO COVPANY

RECEI VI NG SCHEDULE

Sample Reports

POR720 PAGE: 1
TIME: 11: 07 AM

C-11



Sample Reports

Purchase Orders—7.40

WAREHOUSE 01
VENDCOR NAME PROM SED PO# T S WH AMOUNT | TEM DESCRI PTI ON ORDERED UM
V101 | NDUSTRI AL SUPPLY DI 02/22/01 001155 P P 01 880. 24 1119 STEEL SHELVI NG SHELF 8.00 Dz
02/22/01 001156 P P 01 1100. 30 1119 STEEL SHELVI NG SHELF 10.00 Dz
V102 S.E. | NDUSTRI AL PRCD 09/28/02 001075 P P 01 2046. 25 1141 SCAFFOLD SUPPORTS FOR PLATFORM 10 EA
1 156 PLASTI C SPRAY BOTTLES 10 CT
1116 ALUM NUM DOCK PLATE 4 EA
1100 PALLET LOADI NG HAND TRUCK 5 EA

T=TYPE (P=PURCHASE ORDER, B=BACKORDER, R=NON-PO RECEI PT)

S=STATUS (E=ENTERED, P=PRI NTED, R=RECEI VED)

VENDCRS: 2

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT
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Purchase Orders—7.40

DATE: 09/ 28/ 02
USER. SSI TowW

DEMO COMPANY
CASH REQUI REMENTS REPCRT

Sample Reports

POR730 PAGE: 1
TIME: 10: 26 AM

VENDCR V100 TO V120
PO S & REG STERED RECEI PTS
WAREHOUSE 01
----------------------------- DATES---------------"-"-"-"-"--"-------
VENDOR NAME TERMS BALANCE THRU 09/28 09/29-10/05 10/06-10/12 10/13-10/19 10/20-10/26
V100 GENERAL | NDUSTRI AL MFG 2% 10TH NET 30 2013. 64 2013. 64 .00 .00 .00 .00
V101 | NDUSTRI AL SUPPLY DI STRI BUTCR 1% 10 NET 30 1980. 54 1980. 54 .00 .00 .00 .00
V110 GEORG A SHI PPI NG EQUI P. CO. NET 30 2784.75 .00 .00 .00 .00 2784.75
V113 ATLANTA CRANE & HQO STS NET 10 782. 34 .00 .00 782. 34 .00 .00
V114 LINDA'S FLONER SHOP NET 10 19.76 .00 .00 19.76 .00 .00
REPORT TOTAL 7581. 03 3994. 18 .00 802. 10 .00 2784.75

TOTALS | NCLUDE TAX+FREI GHT

VENDCRS: 5

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT
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Sample Reports

DATE: 09/ 28/ 02
USER. SSI TowW

DEMO COMPANY
VENDOR/ | TEM LI STI NG

Purchase Orders—7.40

POR740 PAGE: 1
TIME: 10: 27 AM

VENDOR V100 TO V105
BY LAST LEAD ----COST----
VENDOR NAME | TEM DESCRI PTI ON UM VENDOR- | TEM # PO# TI ME MANUAL UM
War ehouse 01 ATLANTA WAREHOUSE
V100 GENERAL | NDUSTRI AL M 1100 PALLET LOADI NG HAND TRUCK EA 2094- THPG 000916 7 118. 38 EA
1102 ADJUSTABLE HEI GHT STEEL STOOL EA VI 102 001026 3 42.28 EA
1103 ROTARY DRUM PUWP EA 20278M 001061 3 97.22 EA
1104 RUBBER Tl RE MAT EA ML80SB 001061 3 3.88 EA
1116 ALUM NUM DOCK PLATE EA 504WR- 16 001042 5 88.38 EA
1126 GRAVI TY ROLLER CONVEYER EA G -31468- 0 001082 4 166. 39 EA
V101 | NDUSTRI AL SUPPLY DI 1120 HAND HELD STRETCH WRAP EA HHSW 1500 001032 4 2.22 EA
1121 HEAVY DUTY SHI PPI NG SCALE EA ML10PS250 001032 4 55.53 EA
1123 20 GAL WASTE CONTAI NER EA WC20G 001032 4 13.25 EA
1131 PANOCRAM C HALF DOVE 180 EA MPD180- M 001078 2 30.31 EA
1132 STEEL SWVEL CASTER 2" D A (o1) MS5102LC 001000 2 23.40 CT
1133 STEEL SWVEL CASTER 2 1/2"DIA CT MS015LCC 001000 2 48.40 CT
V102 S.E. | NDUSTRI AL PROD 1100 PALLET LOADI NG HAND TRUCK EA SI EL- 541 000953 2 114.86 EA
1111 PLASTIC SHELF BI N BLUE EA 206BP 001034 4 240. 37 EA
1114 DI G TAL UPS/ PARCEL POST SCALE EA MLOPS100L 001034 4 144.77 EA
1140 SCAFFOLD PLATFORM EA 201SA 001034 4 64.63 EA
1141 SCAFFOLD SUPPORTS FOR PLATFORM EA 001034 4 33.67 EA
1142 SW VEL CASTER Dz 001011 4 23.57 Dz
1143 SAFETY RAI L ASSEMBLY EA 001053 5 134. 67 EA
1 144 PORTABLE SCAFFOLD SYSTEM EA 199. 30 EA
1145 PORTABLE SCAFFOLD SYSTEM DELUX EA 428. 23 EA
1156 PLASTI C SPRAY BOTTLE (61) BOTTLE- P8 001034 4 66.99 CT
V105 WAREHOUSE EQUI PMENT 1101 PALLET TRUCK EA VI 101 001037 7 288.15 EA
1110 STEEL STORAGE CABI NET EA 2470- K 001037 7 159. 82 EA
1115 PLASTI C DOLLY EA PD2090-8 001037 7 25.56 EA
1125 WAREHOUSE SPACE HEATER - ELEC. EA 8015CD 000946 7 132.50 EA
1129 SEALER TOCL EA 402-2/ S 001037 7 19.00 EA
1130 HEAVY DUTY DOCK BUMPER EA VB620- 6 001037 7 35.06 EA

| TEMS: 28

Copyright © 1984-2004 Aperum, Inc.
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Purchase Orders—7.40 Sample Reports

DATE: 09/ 28/ 02 DEMO COVPANY POR750 PAGE: 1
USER SSI ToW VENDOR/ | TEM HI STORY TIME: 10:28 AM
VENDOR V100 TO V100
AVG
———————————————— LAST RECEIPT---------------- BY # DAYS
| TEM DESCRI PTI ON PO# UNI TS COST UM DATE LT UNI TS UM DOLLARS RCT LATE
War ehouse 01 ATLANTA WAREHOUSE
Vendor V100 GENERAL | NDUSTRI AL MFG
1100 PALLET LOADI NG HAND TRUCK 000916 5 591.90 EA 07/02/02 7 0 EA 0.00 O 0 MID
16 1889.57 3 1 YTD
0 0.00 O 0 PYR
1 102 ADJUSTABLE HEI GHT STEEL STOO 001026 17 42.29 EA 08/30/02 3 0 EA .00 O 0 MID
444 18312.28 24 6 YTD
663 25856. 00 37 6 PYR
1 103 ROTARY DRUM PUWP 001061 8 97.22 EA 09/20/02 3 8 EA 777.76 1 3 MID
196 18627.79 25 6 YTD
274 24622.00 37 6 PYR
1104 RUBBER TI RE MAT 001061 63 3.88 EA 09/20/02 3 63 EA 244,44 1 3 MID
2098 7938.62 25 6 YTD
2923 10469.00 37 6 PYR
1116 ALUM NUM DOCK PLATE 001042 1 88.38 EA 09/10/02 5 1 EA 88. 38 1 5 MID
86 7406.98 25 6 YTD
136 11121.00 37 6 PYR
1126 GRAVI TY ROLLER CONVEYER 001082 10 166.39 EA 09/27/02 4 13 EA 2163. 07 2 0 MID
118 19183.14 14 -2 YTD
160 24581.23 19 -1 PYR

Copyright © 1984-2004 Aperum, Inc. C-15



Sample Reports

DATE: 09/ 28/ 02 DEMO COMPANY
USER. SSI ToW BUYER LI ST

FI RST TO LAST
BUYER NAME

POR760 PAGE: 1
TI ME: 10: 28 AM

100 RONALD PATTON
200 SALLY FURNESS
300 DANI EL SI MVONS

BUYERS: 3

Copyright © 1984-2004 Aperum, Inc.

END OF REPCRT

Purchase Orders—7.40
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Purchase Orders—7.40

DATE: 09/ 28/ 02 DEMO COVPANY POR810 PAGE: 1

USER SSI ToW PERI OD RECEI PTS REPORT TIME: 10:29 AM

| TEM 1100 TO 1108

PERI QD 09/ 02 SEP

WAREHOUSE 01

BY )
PO# VWH VENDOR NANMVE RCPT#  DATE UNI TS UM COST UM EXTENSI ON

Item 1 100 PALLET LOADI NG HAND TRUCK

001035 01 V110 GEORG A SHI PPI NG EQUI 00001 09/ 06/ 02 9 EA 118.95 EA  1070.55

001072 01 V110 GEORG A SHI PPI NG EQUI 00001 09/ 26/ 02 25 EA 111.39 EA  2784.75
| TEM TOTAL 3855. 30

Item 1101 PALLET TRUCK

001037 01 V105 WAREHOUSE EQUI PMENT U 00001 09/10/02 7 EA 290.11 EA  2030. 77
| TEM TOTAL 2030. 77

Item 1 103 ROTARY DRUM PUWP

001061 01 V100 GENERAL | NDUSTRI AL MF 00001 09/20/02 8 EA 97.57 EA 780. 56
| TEM TOTAL 780. 56

Item 1 104 RUBBER Tl RE MATS

001061 01 V100 GENERAL | NDUSTRI AL MF 00001 09/20/02 63 EA 3.98 EA 250. 74
| TEM TOTAL 250. 74

Item 1 105 NESTI NG CONVEYOR BOXES

001039 01 V116 WORLD MATERI ALS HANDL 00001 09/06/02 20 EA 6.58 EA 131. 60
| TEM TOTAL 131. 60

Item 1108 STEEL TOP WORK BENCH

001046 01 V120 WAREHOUSE | NTERI ORS, 00001 09/ 14/02 2 EA 93.14 EA 186. 28

001073 01 V120 WAREHOUSE | NTERI ORS, 00001 09/27/02 7 EA 91.64 EA 641. 48
| TEM TOTAL 827.76

I TEMS: 6 END OF REPORT

DATE: 09/ 28/ 02 DEMO COVPANY

USER. SSI TowW

VENDCR V100 TO
PERI OD 09/ 02 SEP
BRANCH 01

PERI CD | NVO CE RECEI PTS REPORT

V100

Copyright © 1984-2004 Aperum, Inc.

POR820 PAGE: 1
TIME: 11: 00 AM

Sample Reports
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Sample Reports

Purchase Orders—7.40

DOCUMENT BRANCH DATE  LN# PO# | TEM DESCRI PTI ON UNI TS SP\(/I COST UM EXTENSI ON
Vendor V100 GENERAL | NDUSTRI AL MFG

1345 01 09/14/02 001 001042 1116 ALUM NUM DOCK PLATE 1 EA 88.38 EA 88. 38

002 001042 FRT FREI GHT 1 EA .50 EA .50

INVOICE TOTAL éé_ éé

1361 01 09/21/02 001 001061 1103 ROTARY DRUM PUWP 8 EA 97.22 EA 777.76

002 001061 1 104 RUBBER Tl RE MATS 63 EA 3.88 EA 244, 44

003 001061 FRT FREI GHT 1 EA 9.00 EA 9.00

I N\vO CE TOTAL o 21.6_321._ _26

1364 01 09/21/02 001 001050 1 832 NONSTOCKED - CONVEYOR ROLLER 5 EA 14.71 EA 73.55

I N\vO CE TOTAL """7_3._:5%:

VENDCR TOTAL o _1_1§_3_ 6_3

REPORT TOTAL o _1_1§_3_ 6_3

VENDCRS: 1 END OF REPORT

Copyright © 1984-2004 Aperum, Inc.
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Purchase Orders—7.40 Sample Reports

DATE: 09/ 28/ 02 DEMO COMVPANY POR830 PAGE: 1
USER SSI ToW PERI OD RECEI PTS DI SCREPANCY REPCRT TIME: 10:30 AM
VENDOR V100 TO V110
PERI OD 09/ 02 SEP
BRANCH 01
--------- UV} (SR 0’0 )
DOCUMENT BR  DATE | TEM DESCRI PTI ON RECEI VED | NVOI CED UM RECEI VED | NVOI CED UM DI SCREPANCY
Vendor V110 GEORG A SHI PPI NG EQUI P. CO.
1348 01 09/21/02 1118 LI GHTWEI GHT HAND TRUCK 5 5 EA 64.88 65.23 EA 1.75
1128 SELF STANDI NG HAND TRUCK 10 11 EA  114.45  114.45 EA 114. 45
1100 PALLET LOADI NG HAND TRUCK 8 8 EA  111.99  111.39 EA -4.80
DOCUNENT TOTAL 111. 40
VENDOR TOTAL 111. 40
REPORT TOTAL 111. 40
VENDORS: 1 END OF REPCRT

Copyright © 1984-2004 Aperum, Inc.
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